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Regulatory Requirements

Conformance Standards

The following classifications are in accordance with the IEC/
EN 60601-1: 

• According to 93/42/EEC Medical Device Directive, this is 
Class IIa Medical Device.

• According to IEC/EN 60601-1, 

• Equipment is Class I, Type BF Applied Parts.

• Continuous Operation

• According to CISPR 11, 

• Equipment is Group 1, Class A ISM Equipment.

• According to IEC 60529,

• The footswitch rate is IPX8.

• Probe head (immersible portion) and cable are IPX7

Probe connector is not waterproof.

This product complies with the regulatory requirement of the 
following:

• Council Directive 93/42/EEC concerning medical devices: 
the CE label affixed to the product testifies compliance to 
the Directive.

The location of the CE marking is shown in the safety 
chapter of this manual.

Authorized EU Representative

European registered place of business:

GE Medical Systems Information Technologies GmbH

(GEMS IT GmbH)

Munzinger Strasse 5, D-79111 Freiburg, Germany

Tel: +49 761 45 43 -0; Fax: +49 761 45 43 -233
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Conformance Standards  (continued)

• International Electrotechnical Commission (IEC).

• IEC/EN 60601-1 Medical Electrical Equipment, Part 1 
General Requirements for Safety.

• IEC/EN 60601-1-2 Electromagnetic compatibility - 
Requirements and tests.

• IEC/EN 60601-1-6 (Usability), EN 1041 (Information 
supplied with medical devices)

• IEC/EN 60601-2-37 Particular requirements for the 
safety of ultrasonic medical diagnostic and monitoring 
equipment.

• International Organization of Standards (ISO)

• ISO 10993-1 Biological evaluation of medical devices.

• ANSI/AAMI ES60601-1 Medical Electrical Equipment, Part 
1 General Requirements for Safety.

• Canadian Standards Association (CSA).

• CSA 22.2, 601.1 Medical Electrical Equipment, Part 1 
General Requirements for Safety.

• NEMA/AIUM Acoustic Output Display Standard (NEMA 
UD3).

• Medical Device Good Manufacturing Practice Manual 
issued by the FDA (Food and Drug Administration, 
Department of Health, USA).

Certifications

• General Electric Medical Systems is ISO 13485 certified. 

Original Documentation

• The original document was written in English. 
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Country-Specific Approval

• JAPAN

Certified Number: 

Importer Information

• Turkey
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Chapter 1

Introduction

This chapter consists of information concerning 
indications for use/contraindications, and how this 
documentation is organized.
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Overview

Attention

This manual is for LOGIQ V2 and LOGIQ V1, .

This manual contains necessary and sufficient information to 
operate the system safely. Advanced equipment training may be 
provided by a factory trained Applications Specialist for the 
agreed-upon time period.

Read and understand all instructions in all manuals supplied 
with the system before attempting to use the LOGIQ V2/LOGIQ 
V1 system.

Keep this manual with the equipment at all times. Periodically 
review the procedures for operation and safety precautions.

Disregarding information on safety is considered abnormal use.

Not all products, features, probes or peripherals described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

NOTE: Please note that orders are based on the individually agreed 
specifications and may not contain all features listed in this 
manual.

NOTE: All references to standards / regulations and their revisions are 
valid for the time of publication of the user manual.

NOTE: The system color varies.

CAUTION Safety instructions must be reviewed before operating the unit.
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Documentation

LOGIQ V2/LOGIQ V1 documentation consists of various 
manuals:

• The Basic User Manual (ENGLISH ONLY), and Online Help 
(ENGLISH ONLY) provides information needed by the user 
to operate the system safely. It describes the basic functions 
of the system, safety features, operating modes, 
measurements/calculations, probes, user care and 
maintenance.

• The User Guide (TRANSLATED) is a condensed user 
instruction guide.

• The Release Notes (TRNASLATED) provide precautions 
and instructions that supplement the Basic User Manual.

• The Advanced Reference Manual (ENGLISH ONLY) 
contains data tables, such as OB and Acoustic Output 
tables.

• The Basic Service Manual (ENGLISH ONLY) supplies block 
diagrams, lists of spare parts, descriptions, adjustment 
instructions or similar information which help adequately 
qualified technical personnel in repairing those parts of the 
system which have been defined repairable by the 
manufacturer.

• AIUM Booklet (USA only)

The LOGIQ V2/LOGIQ V1 manuals are written for users who 
are familiar with basic ultrasound principles and techniques. 
They do not include sonographic training or detailed clinical 
procedures.

NOTE: Dates on screenshots are represented in MM/DD/YYYY format 
throughout the manual. Information on how to change the 
system’s date can be found in Customizing Your System. 

NOTE: The Electronic Documentation CD includes English and all 
translations.

NOTE: The screen graphics in this manual are only for illustrational 
purposes. Actual screen output may differ with the different 
software versions.
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Principles of Operation

Medical ultrasound images are created by computer and digital 
memory from the transmission and reception of mechanical 
high-frequency waves applied through a transducer. The 
mechanical ultrasound waves spread through the body, 
producing an echo where density changes occur. For example, 
in the case of human tissue, an echo is created where a signal 
passes from an adipose tissue (fat) region to a muscular tissue 
region. The echoes return to the transducer where they are 
converted back into electrical signals.

These echo signals are highly amplified and processed by 
several analog and digital circuits having filters with many 
frequency and time response options, transforming the 
high-frequency electrical signals into a series of digital image 
signals which are stored in memory. Once in memory, the image 
can be displayed in real-time on the image monitor. All signal 
transmission, reception and processing characteristics are 
controlled by the main computer. By selection from the system 
control panel, the user can alter the characteristics and features 
of the system, allowing a wide range of uses, from obstetrics to 
peripheral vascular examinations.

Transducers are accurate, solid-state devices, providing multiple 
image formats. The digital design and use of solid-state 
components provides highly stable and consistent imaging 
performance with minimal required maintenance. Sophisticated 
design with computer control offers a system with extensive 
features and functions which is user-friendly and easy to use.



Overview

LOGIQ V2/LOGIQ V1 - Basic User Manual 1-5
Direction 5610735-100 English Rev. 2

Indications for Use 

The LOGIQ V2/LOGIQ V1 is intended for ultrasound imaging, 
measurement and analysis of the human body for multiple 
clinical applications including: Fetal/OB; GYN; Abdominal; 
Pediatric; Small Organ (breast, testes, thyroid); Neonatal and 
Adult Cephalic; Cardiac (adult & pediatric); Peripheral Vascular; 
Musculoskeletal Conventional & Superficial; Urology;  
Transrectal; Transvaginal; imaging guidance of interventional 
procedures (e.g Nerve Block; Vascular Access; Tissue Biopsy/
Fluid Drainage).

Frequency of Use

Daily (Typically 8 hours)

Operator Profile

• Qualified and trained physicians or sonographers with at 
least basic ultrasound knowledge.

• The operator must have read and understood the user 
manual.

NOTE: Only qualified physicians or sonographers should perform 
ultrasound scanning on human subjects for medical 
diagnostic reasons. Request training, if needed.
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Clinical Applications

Specific clinical applications and exam types include:

• Abdominal

• Obstetrics

• Gynecological

• Cardiac

• Vascular

• Transcranial

• Musculoskeletal

• Urological

• Small parts

• Pediatric and Neonatal

Image Acquisition is for diagnostic purposes including 
measurements on acquired image.

CAUTION This machine should be used in compliance with law. Some 
jurisdictions restrict certain uses, such as gender 
determination.
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Contraindication 

The LOGIQ V2/LOGIQ V1 ultrasound system is not intended for 
ophthalmic use or any use causing the acoustic beam to pass 
through the eye.

Prescription Device

CAUTION: United States law restricts this device to sale or use 
by, or on the order of a physician.
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Contact Information

Contacting GE Ultrasound

For additional information or assistance, please contact your 
local distributor or the appropriate support resource listed on the 
following pages:

INTERNET http://www.gehealthcare.com

http://www.gehealthcare.com/usen/ultrasound/products/
probe_care.html

Clinical Questions For information in the United States, Canada, Mexico and parts 
of the Caribbean, call the Customer Answer Center. 
TEL: (1) 800-682-5327 or (1) 262-524-5698

In other locations, contact your local Applications, Sales, or 
Service Representative. 

Service Questions For service in the United States, call GE CARES. 

TEL: (1) 800-437-1171

In other locations, contact your local Service Representative.

Information 
Requests

To request technical product information in the United States, 
call GE Healthcare. 

TEL: (1) 800-643-6439

In other locations, contact your local Applications, Sales, or 
Service Representative.

Placing an Order To order accessories, supplies, or service parts in the United 
States, call the GE Healthcare Technologies Contact Center.

TEL: (1) 800-558-5102

In other locations, contact your local Applications, Sales, or 
Service Representative.
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Contacting GE Ultrasound  (continued)

AMERICAS

ARGENTINA GEME S.A.
Miranda 5237
Buenos Aires - 1407
TEL: (1) 639-1619 FAX: (1) 567-2678

BRAZIL GE Healthcare do Brasil Comércio e Serviços para 
Equipamentos Médico- Hospitalares Ltda 
Av. Das Nações Unidas, 8501
3º andar parte - Pinheiros 
São Paulo SP – CEP: 05425-070
C.N.P.J.: 02.029.372/0001-40
TEL: 3067-8010 FAX: (011) 3067-8280

CANADA GE Healthcare
Ultrasound Service Engineering
9900 Innovation Drive
Wauwatosa, WI 53226
TEL: (1) 800-668-0732
Customer Answer Center TEL: (1) 262-524-5698

LATIN & SOUTH
AMERICA

GE Healthcare
Ultrasound Service Engineering
9900 Innovation Drive
Wauwatosa, WI 53226
TEL: (1) 262-524-5300
Customer Answer Center TEL: (1) 262-524-5698

MEXICO GE Sistemas Medicos de Mexico S.A. de C.V.
Rio Lerma #302, 1° y 2° Pisos
Colonia Cuauhtemoc
06500-Mexico, D.F.
TEL: (5) 228-9600 FAX: (5) 211-4631

USA GE Healthcare
Ultrasound Service Engineering
9900 Innovation Drive
Wauwatosa, WI 53226
TEL: (1) 800-437-1171 FAX: (1) 414-721-3865
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Contacting GE Ultrasound  (continued)

ASIA

ASIA PACIFIC
JAPAN

GE Healthcare Asia Pacific 
4-7-127, Asahigaoka
Hinoshi, Tokyo
191-8503, Japan
TEL:  +81 42 585 5111

AUSTRALIA Building 4B, 21 South St
Rydalmere NSW 2116
Australia
TEL: 1300 722 229

CHINA GE Healthcare - Asia
No. 1, Yongchang North Road
Beijing Economic & Technology Development Area
Beijing 100176, China
TEL: (8610) 5806 8888 FAX: (8610) 6787 1162

INDIA Wipro GE Healthcare Pvt Ltd
No. 4, Kadugodi Industrial Area
Bangalore, 560067
TEL: +(91) 1-800-425-8025

KOREA 8F, POBA Gangnam Tower
343, Hakdong-ro, Gangnam-gu
Seoul 135-820, Korea 
TEL: +82 2 6201 3114

NEW ZEALAND 8 Tangihua Street
Auckland 1010
New Zealand
TEL: 0800 434 325

SINGAPORE ASEAN
1 Maritime Square #13-01
HarbourFront Center
Singapore 099253
TEL:  +65 6291 8528 
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Contacting GE Ultrasound  (continued)

EUROPE

For all other European countries not listed, please contact your 
local GE distributor or the appropriate support resource listed on 
www.gehealthcare.com.

AUSTRIA General Electric Austria GmbH
Filiale GE Healthcare Technologies
EURO PLAZA, Gebäude E
Wienerbergstrasse 41
A-1120 Vienna
TEL: (+43) 1 97272 0 FAX: (+43) 1 97272 2222

BELGIUM &
LUXEMBURG

GE Medical Systems Ultrasound
Eagle Building
Kouterveldstraat 20
1831 DIEGEM
TEL: (+32) 2 719 7204 FAX: (+32) 2 719 7205

CZECH REPUBLIC GE Medical Systems Ultrasound
Vyskocilova 1422/1a
140 28 Praha

DENMARK GE Medical Systems Ultrasound
Park Alle 295, 2605 Brøndby
TEL: (+45) 43 295 400 FAX: (+45) 43 295 399

 ESTONIA &
FINLAND

GE Medical Systems
Kuortaneenkatu 2, 000510 Helsinki
P.O.Box 330, 00031 GE Finland
TEL: (+358) 10 39 48 220 FAX: (+358) 10 39 48 221

FRANCE GE Medical Systems Ultrasound
and Primary Care Diagnostics
F-78457 Velizy
General Imaging TEL: (+33) 13 449 52 43
Cardiology TEL: (+33) 13 449 52 31
FAX: (+33) 13 44 95 202
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EUROPE  (continued)

GERMANY GE Healthcare GmbH
Beethovenstrasse 239
42655 Solingen
TEL: (+49) 212-28 02-0 FAX: (+49) 212-28 02 28

GREECE GE Healthcare
8-10 Sorou Str. Marousi
Athens 15125 Hellas
TEL: (+30) 210 8930600 FAX: (+30) 210 9625931

HUNGARY GE Hungary Zrt. Ultrasound
Division, Akron u. 2.
Budaors 2040 Hungary
TEL: (+36) 23 410 314 FAX: (+36) 23 410 390

IRELAND NORTHERN IRELAND
GE Healthcare
Victoria Business Park
9, Westbank Road, Belfast BT3 9JL.
TEL: (+44) 28 90229900

REPUBLIC OF IRELAND
GE Healthcare
Unit F4, Centrepoint Business Park
Oak Drive, Dublin 22
TEL: (+353) 1 4605500

ITALY GE Medical Systems Italia spa
Via Galeno, 36, 20126 Milano
TEL: (+39) 02 2600 1111 FAX: (+39) 02 2600 1599

LUXEMBORG See Belgium.

NETHERLANDS GE Healthcare
De Wel 18 B, 3871 MV Hoevelaken
PO Box 22, 3870 CA Hoevelaken
TEL: (+31) 33 254 1290 FAX: (+31) 33 254 1292



Contact Information

LOGIQ V2/LOGIQ V1 - Basic User Manual 1-13
Direction 5610735-100 English Rev. 2

EUROPE  (continued)

NORWAY GE Medical Systems Ultrasound
Tåsenveien 71, 0873 Oslo
TEL: (+47) 2202 0800

GE Medical Systems Ultrasound 
Strandpromenaden 45
P.O. Box 141, 3191 Horten
TEL: (+47) 33 02 11 16

POLAND GE Medical Systems Polska
Sp. z o.o., ul. Woloska 9
02-583 Warszawa, Poland
TEL: (+48) 22 330 83 00 FAX: (+48) 22 330 83 83

PORTUGAL General Electric Portuguesa
SA. Avenida do Forte, n° 4
Fraccao F, 2795-502 Carnaxide
TEL: (+351) 21 425 1309 FAX: (+351) 21 425 1343

RUSSIA GE Healthcare
Krasnopresnenskaya nab.
18, bld A, 10th floor
123317 Moscow, Russia
TEL: (+7) 4957 396931 FAX: (+7) 4957 396932

SPAIN GE Healthcare Espana
C/ Gobelas 35-37
28023 Madrid
TEL: (+34) 91 663 2500 FAX: (+34) 91 663 2501

SWEDEN GE Medical Systems Ultrasound
PO Box 314, 17175 Stockholm
TEL: (+46) 8 559 50010
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EUROPE  (continued)

SWITZERLAND GE Medical Systems Ab
Europastrasse 31
8152 Glattbrugg
TEL: (+41) 1 809 92 92 FAX: (+41) 1 809 92 22

TURKEY GE Healthcare Türkiye
Istanbul Office
Levent Ofis
Esentepe Mah. Harman Sok.
No:8 Sisli-Istanbul
TEL: +90 212 398 07 00 FAX: +90 212 284 67 00

UNITED ARAB
EMIRATES (UAE)

GE Healthcare
Dubai Internet City, Building No. 18
P. O. Box # 11549, Dubai
U.A.E
TEL: (+971) 4 429 6101 or  4 429 6161
FAX: (+971) 4 429 6201

UNITED KINGDOM GE Medical Systems Ultrasound TEL: (+44) 1707 263570
71 Great North Road FAX: (+44) 1707 260065
Hatfield, Hertfordshire, AL9 5EN

Manufacturer

GE Medical Systems (China) Co., Ltd.
No. 19, Changjiang Road
WuXi National Hi-Tech Development Zone
Jiangsu, P.R. China 214028
TEL: +86 510 85225888; FAX: +86 510 85226688
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Chapter 2

Safety

Describes the safety and regulatory information 
pertinent for operating this ultrasound system. 
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Owner Responsibility

It is the responsibility of the owner to ensure that anyone 
operating the system reads and understands this section of the 
manual. However, there is no representation that the act of 
reading this manual renders the reader qualified to operate, 
inspect, test, align, calibrate, troubleshoot, repair or modify the 
system. The owner should make certain that only properly 
trained, fully-qualified service personnel undertake the 
installation, maintenance, troubleshooting, calibration and repair 
of the equipment.

The owner of the ultrasound unit should ensure that only 
properly trained, fully qualified personnel are authorized to 
operate the system. Before authorizing anyone to operate the 
system, it should be verified that the person has read, and fully 
understands, the operating instructions contained in this 
manual. It is advisable to maintain a list of authorized operators.

Should the system fail to operate correctly, or if the unit does not 
respond to the commands described in this manual, the 
operator should contact the nearest field GE Ultrasound Service 
Office.

For information about specific requirements and regulations 
applicable to the use of electronic medical equipment, consult 
the local, state and federal agencies.

Notice against user modification

Never modify this product, including system components, 
software, cables, and so on. User modification may cause safety 
hazards and degradation in system performance. All 
modification must be done by a GE qualified person.
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Safety Precautions

Precaution Levels

Icon description

Various levels of safety precautions may be found on the 
equipment and different levels of concern are identified by one 
of the following flag words and icons which precede the 
precautionary statement.

NOTE: Indicates precautions or recommendations that should be used 
in the operation of the ultrasound system, specifically:

• Maintaining an optimum system environment

• Using this Manual

• Notes to emphasize or clarify a point.

DANGER
 

Indicates that a specific hazard is known to exist which through 
inappropriate conditions or actions will cause:

• Severe or fatal personal injury

• Substantial property damage.

WARNING Indicates that a specific hazard is known to exist which through 
inappropriate conditions or actions may cause:

• Severe personal injury

• Substantial property damage.

CAUTION Indicates that a potential hazard may exist which through 
inappropriate conditions or actions will or can cause: 

• Minor injury

• Property damage.
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Hazard Symbols

Icon Description

Potential hazards are indicated by the following icons:

Table 2-1:  Potential Hazards

Icon Potential Hazard Usage Source

Biological Hazard
Describes precautions necessary to 
prevent the risk of disease transmission 
or infections.
• Patient/user infection due to 

contaminated equipment.

• Cleaning and care 
instructions

• Sheath and glove 
guidelines

ISO 7000
No. 0659

Electrical Hazard
Describes precautions necessary to 
prevent the risk of injury through electric 
hazards.
• Electrical micro-shock to patient, e.g., 

ventricular

• Probes
• Connections to back 

panel

Moving Hazard
Describes precautions necessary to 
prevent the risk of injury through moving 
or tipping hazard!
• Console, accessories or optional 

storage devices that can fall on patient, 
user, or others.

• Collision with persons or objects may 
result in injury while maneuvering or 
during system transport.

• Injury to user from moving the console.

• Moving
• Using brakes
• Transporting

Acoustic Output Hazard
• Patient injury or tissue damage from 

ultrasound radiation.

• ALARA, the use of 
Power Output following 
the ‘as low as 
reasonably achievable’ 
principle

Explosion Hazard
Describes precautions necessary to 
prevent the risk of injury through 
explosion hazard!
• Risk of explosion if used in the 

presence of flammable anesthetics.

• Flammable anesthetic

Fire and Smoke Hazard
• Patient/user injury or adverse reaction 

from fire or smoke.
• Patient/user injury from explosion and 

fire.

• Replacing fuses
• Outlet guidelines
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Important Safety Considerations

The following topic headings (Patient Safety, and Equipment 
and Personnel Safety) are intended to make the equipment user 
aware of particular hazards associated with the use of this 
equipment and the extent to which injury can occur if 
precautions are not observed. Additional precautions may be 
provided throughout the manual. 

CAUTION Improper use can result in serious injury. The use of the system 
outside the described conditions or intended use, and 
disregarding safety related information is considered abnormal 
use. The user must be thoroughly familiar with the instructions 
and potential hazards involving ultrasound examination before 
attempting to use the device. Training assistance is available 
from GE if needed.

Disregarding information on safety is considered abnormal use.

The manufacturer is not liable for damage caused by abnormal 
use of the device.
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Patient Safety

Related Hazards

Patient identification

Always include proper identification with all patient data and 
verify the accuracy of the patient's name and ID numbers when 
entering such data. Make sure correct patient ID is provided on 
all recorded data and hard copy prints. Identification errors could 
result in an incorrect diagnosis.

The ultrasound system is not meant to be long term storage for 
patient data or images. The customers are responsible for the 
data on the system and a regular backup is highly 
recommended. 

It is advisable to back up system data prior to any service 
repairs to the hard drive. It is always possible during system 
failure and repair to lose patient data. GE will not be held 
responsible for the loss of this data.

WARNING The concerns listed can seriously affect the safety of patients 
undergoing a diagnostic ultrasound examination.
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Diagnostic information

The images and calculations provided by the system are 
intended for use by competent operators, as a diagnostic tool. 
They are explicitly not to be regarded as the sole, irrefutable 
basis for clinical diagnosis. Operators are encouraged to study 
the literature and reach their own professional conclusions 
regarding the clinical utility of the system.

The operator should be aware of the product specifications and 
of the system accuracy and stability limitations. These limitations 
must be considered before making any decision based on 
quantitative values. If in doubt, the nearest GE Ultrasound 
Service Office should be consulted.

Equipment malfunction or incorrect settings can result in 
measurement errors or failure to detect details within the image. 
The equipment user must become thoroughly familiar with the 
equipment operation in order to optimize its performance and 
recognize possible malfunctions. Applications training is 
available through the local GE representative. Added 
confidence in the equipment operation can be gained by 
establishing a quality assurance program.

CAUTION The system provides calculations (e.g estimated fetal weight) 
and charts based on published scientific literature. The 
selection of the appropriate chart and clinical interpretation of 
calculations and charts is the sole responsibility of the operator. 
The operator must consider contraindications for the use of a 
calculation or chart as described in the scientific literature. The 
diagnosis, decision for further examinations and medical 
treatment must be performed by qualified personnel following 
good clinical practice. 

CAUTION Be certain to ensure privacy data of patient information.
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Mechanical hazards

The use of damaged probes or improper use and manipulation 
of intracavity probes can result in injury or increased risk of 
infection. Inspect probes often for sharp, pointed, or rough 
surface damage that could cause injury or tear protective 
barriers. Become familiar with all instructions and precautions 
provided with special purpose probes.

Electrical
Hazard

A damaged probe can also increase the risk of electric shock if 
conductive solutions come in contact with internal live parts. 
Inspect probes often for cracks or openings in the housing and 
holes in and around the acoustic lens or other damage that 
could allow liquid entry. Become familiar with the probe's use 
and care precautions outlined in Probes and Biopsy.

CAUTION Ultrasound transducers are sensitive instruments which can 
easily be damaged by rough handling. Take extra care not to 
drop transducers and avoid contact with sharp or abrasive 
surfaces. A damaged housing, lens or cable can result in 
patient injury or serious impairment or operation. 
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Scanner and electrosurgical units

ALARA

Training

It is recommended that all users receive proper training in 
applications before performing them in a clinical setting. Please 
contact the local GE representative for training assistance.

CAUTION This equipment provides no special means of protection from 
high frequency (HF) burns that may result from using an 
electrosurgical unit (ESU). To reduce the risk of HF burns, 
avoid contact between the patient and ultrasound transducer 
while operating the ESU. Where contact cannot be avoided, 
make sure the transducer is not located between the ESU 
active and dispersive electrodes and keep the ESU cables 
away from the transducers.

CAUTION Ultrasound can produce harmful effects in tissue and 
potentially result in patient injury. Always minimize exposure 
time and keep ultrasound levels low when there is no medical 
benefit. Use the principle of ALARA (As Low As Reasonably 
Achievable), increasing output only when needed to obtain 
diagnostic image quality. Observe the acoustic output display 
and be familiar with all controls affecting the output level. See 
the Bioeffects section of the Acoustic Output chapter in the 
Advanced Reference Manual for more information. 

CAUTION The operator of the device must sufficiently understand the 
acoustic output and be able to obtain the related thermal index 
values. The probe with self-heating in the air cannot be used in 
transvaginal scanning. Always minimize exposure time to the 
irradiation and keep ultrasound acoustic output level low for 
embryos or fetuses.
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Equipment and Personnel Safety

The concerns listed below can seriously affect the safety of 
equipment and personnel during a diagnostic ultrasound 
examination.

Related Hazards 

CAUTION Do not use this equipment if a safety problem is known to exist. 
Have the unit repaired and performance verified by qualified 
service personnel before returning to use.

WARNING This equipment contains dangerous voltages that are capable 
of serious injury or death.

If any defects are observed or malfunctions occur, stop 
operating the equipment and perform the proper action for the 
patient. Inform a qualified service person and contact a Service 
Representative for information.

There are no user serviceable components inside the console. 
Refer all servicing to qualified service personnel only.

Ensure that unauthorized personnel do not tamper with the 
unit. 

Electrical
Hazard

To avoid injury:

• Do not remove protective covers. No user serviceable 
parts are inside. Refer servicing to qualified service 
personnel.

• To assure adequate grounding, connect the attachment 
plug to a reliable (hospital grade) grounding outlet (having 
equalization conductor ).

• Never use any adaptor or converter of a 
three-prong-to-two-prong type to connect with a mains 
power plug. The protective earth connection will loosen.

• Do not place liquids on or above the console. Spilled liquid 
may contact live parts and increase the risk of shock.

Smoke &
Fire Hazar

The system must be supplied from an adequately rated 
electrical circuit. The capacity of the supply circuit must be as 
specified.
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Related Hazards  (continued)

WARNING Only approved and recommended peripherals and accessories 
should be used. 

All peripherals and accessories must be securely mounted to 
the LOGIQ V2/LOGIQ V1.

WARNING The LOGIQ V2/LOGIQ V1 is not intended to be used as a data 
storage device; backup of the Patient and Image Database is 
your institution’s responsibility. GE is NOT responsible for any 
lost patient information or for lost images.

Explosion
Hazard

Risk of explosion if used in the presence of flammable 
anesthetics.

Explosion
Hazard

Never operate the equipment in the presence of flammable or 
explosive liquids, vapors or gases. Malfunctions in the unit, or 
sparks generated by fan motors, can electrically ignite these 
substances. Operators should be aware of the following points 
to prevent such explosion hazards.

• If flammable substances are detected in the environment, 
do not plug in or turn on the system.

• If flammable substances are detected after the system has 
been turned on, do not attempt to turn off the unit, or to 
unplug it.

• If flammable substances are detected, evacuate and 
ventilate the area before turning off the unit.

CAUTION Do not unpack the LOGIQ V2/LOGIQ V1. This must be 
performed by qualified service personnel only.
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Related Hazards  (continued)

Biological
Hazard

For patient and personnel safety, be aware of biological 
hazards while performing invasive procedures. To avoid the 
risk of disease transmission:

• Use protective barriers (gloves and probe sheaths) 
whenever possible. Follow sterile procedures when 
appropriate.

• Thoroughly clean probes and reusable accessories after 
each patient examination and disinfect or sterilize as 
needed. Refer to Probes and Biopsy for probe use and 
care instructions.

• Follow all infection control policies established by your 
office, department or institution as they apply to personnel 
and equipment.

CAUTION To avoid injury or system damage, NEVER place any object or 
liquid on the operator panel.

CAUTION Archived data is managed at the individual sites. Performing 
data backup (to any device) is recommended.

CAUTION • Make sure to verify the media after writing of data, such as 
EZBackup, SaveAs or Export.     

• Before deleting a patient or image from the patient screen, 
make sure you have saved the data by EZBackup/Backup 
or Export and verify that the media transfer of data was 
successful.

CAUTION DO NOT load non-system software on the system computer. 
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Related Hazards  (continued)

CAUTION DO NOT touch the patient and any of the connectors on the 
ultrasound unit simultaneously, including ultrasound probe 
connectors.

DO NOT touch the conducting parts of the USB, Ethernet, 
Video, Audio cables when connecting equipment to the unit.

CAUTION To minimize accidental loss of data, perform EZBackup and 
Backup on a regular basis.

1. First, perform EZBackup to save the images.

2. Next, perform Backup at Utility -> Backup/Restore. Enable 
the following checkboxes under Backup:

• Patient Archive

• Report Archive

• User defined configuration

• Service

CAUTION • DO NOT scratch or press on the panel with any sharp 
objects, such as a pencil or pen, as this may result in 
damage to the panel.

• To avoid injury or damage, make sure nothing is within the 
range of motion before moving the system. This includes 
both objects and people.

• The LCD screen may have defective pixels. These pixels 
may appear as a slightly light or dark area on the screen. 
This is due to the characteristics of the panel itself, and not 
the product. 

• The backlight of the LCD panel has a fixed life span. When 
the screen becomes dark or begins to flicker, contact a 
qualified Service Representative for information. 
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Material Safe Data

Rubber part

Material: Silicon

Where Used: Handle Screw Cap/LCD Rubber

Allergic reactions to latex-containing medical devices

CAUTION Due to reports of severe allergic reactions to medical devices 
containing latex (natural rubber), the FDA advises health-care 
professionals to identify latex-sensitive patients, and be 
prepared to treat allergic reactions promptly. Latex is a 
component of many medical devices, including surgical and 
examination gloves, catheters, incubation tubes, anesthesia 
masks and dental dams. Patient reaction to latex has ranged 
from contact urticaria, to systemic anaphylaxis.

For more details regarding allergic reaction to latex, refer to 
FDA Medical Alert MDA91-1, March 29.
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EMC (Electromagnetic Compatibility)

NOTE: This equipment generates, uses and can radiate radio 
frequency energy. The equipment may cause radio frequency 
interference to other medical and non-medical devices and radio 
communications. To provide reasonable protection against such 
interference, this product complies with emissions limits for a 
Group 1, Class A Medical Devices Directive as stated in EN 
60601-1-2. However, there is no guarantee that interference will 
not occur in a particular installation.

NOTE: If this equipment is found to cause interference (which may be 
determined by turning the equipment on and off), the user (or 
qualified service personnel) should attempt to correct the 
problem by one or more of the following measure(s):

• reorient or relocate the affected device(s)

• increase the separation between the equipment and the 
affected device

• power the equipment from a source different from that of the 
affected device

• consult the point of purchase or service representative for 
further suggestions.

NOTE: The manufacturer is not responsible for any interference caused 
by using other than recommended interconnect cables or by 
unauthorized changes or modifications to this equipment. 
Unauthorized changes or modifications could void the users’ 
authority to operate the equipment.

NOTE: To comply with the regulations on electromagnetic interference 
for a Class A FCC Device, all interconnect cables to peripheral 
devices must be shielded and properly grounded. Use of cables 
not properly shielded and grounded may result in the equipment 
causing radio frequency interference in violation of the FCC 
regulations.



Safety

2-16 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

EMC (Electromagnetic Compatibility)  (continued)

NOTE: Do not use devices which intentionally transmit RF Signals 
(cellular phones, transceivers, or radio controlled products) 
other than those supplied by GE (wireless microphone, 
broadband over power lines, for example) in the vicinity of the 
equipment as it may cause performance outside the published 
specifications. Keep the power to these type devices turned off 
when near this equipment.

The medical staff in charge of this equipment is required to 
instruct technicians, patients, and other people who maybe 
around this equipment to fully comply with the above 
requirement.

EMC Performance

All types of electronic equipment may characteristically cause 
electromagnetic interference with other equipment, either 
transmitted through air or connecting cables. The term EMC 
(Electromagnetic Compatibility) indicates the capability of 
equipment to curb electromagnetic influence from other 
equipment and at the same time not affect other equipment with 
similar electromagnetic radiation from itself.

Proper installation following the service manual is required in 
order to achieve the full EMC performance of the product.

The product must be installed as stipulated in ‘Notice upon 
Installation of Product’ on page 2-18.

In case of issues related to EMC, please call your service 
personnel.

The manufacturer is not responsible for any interference caused 
by using other than recommended interconnect cables or by 
unauthorized changes or modifications to this equipment. 
Unauthorized changes or modifications could void the users’ 
authority to operate the equipment. 



Safety Precautions

LOGIQ V2/LOGIQ V1 – Basic User Manual 2-17
Direction 5610735-100 English Rev. 2

EMC Performance  (continued)

Portable and mobile radio communications equipment (e.g. 
two-way radio, cellular/cordless telephones and similar 
equipment) should be used no closer to any part of this system, 
including cables, than determined according to the following 
method: 

Table 2-2:  Portable and mobile radio communications equipment distance 
requirements

Frequency Range: 150 kHz - 80 MHz 80 MHz - 800 MHz 800 MHz - 2.5 GHz

Calculation Method: d=[3.5/V1] square root 

of P

d = [3.5/E1] square root 

of P

d = [7/E1] square root of 

P

Where: d= separation distance in meters, P = rated power of the transmitter, V1=compliance value for 

conducted RF, E1 = compliance value for radiated RF

If the maximum 
transmitter power in 
watts is rated

The separation distance in meters should be

5 2.6 2.6 5.2

20 5.2 5.2 10.5

100 12.0 12.0 24.0
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Notice upon Installation of Product

Separation distance and effect from fixed radio communications 
equipment: field strengths from fixed transmitters, such as base 
stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast, and TV 
broadcast transmitter cannot be predicted theoretically with 
accuracy. To assess the electromagnetic environment due to 
fixed RF transmitters, an electromagnetic site survey should be 
considered. If the measured field strength in the location in 
which the ultrasound system is used exceeds the applicable RF 
compliance level as stated in the immunity declaration, the 
ultrasound system should be observed to verify normal 
operation. If abnormal operation is observed, additional 
measures may be necessary, such as re-orienting or relocating 
the ultrasound system or using an RF shielded examination 
room may be necessary.

1. Use either power supply cords provided by GE or ones 
designated by GE. Products equipped with a power source 
plug should be plugged into the fixed power socket which 
has the protective grounding conductor. Never use any 
adaptor or converter to connect with a power source plug 
(e.g. three-prong-to-two-prong converter).

2. Locate the equipment as far away as possible from other 
electronic equipment.

3. Be sure to use only the cables provided by or designated by 
GE. Connect these cables following the installation 
procedures (e.g. wire power cables separately from signal 
cables).

4. Lay out the main equipment and other peripherals following 
the installation procedures described in the service manuals 
and peripherals manufacture’s manuals.
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General Notice

1. Designation of Peripheral Equipment Connectable to This 
Product.

The equipment indicated in the Supplies/Accessories 
section can be hooked up to the product without 
compromising its EMC performance.

Avoid using equipment not designated in the list. Failure to 
comply with this instruction may result in poor EMC 
performance of the product.

2. Notice against User Modification

The user should never modify this product. User 
modifications may cause degradation in EMC performance.

Modification of the product includes changes in:

a. Cables (length, material, wiring, etc.)

b. System installation/layout

c. System configuration/components

d. Securing system parts (cover open/close, cover 
screwing)

3. Operate the system with all covers closed. If a cover is 
opened for some reason, be sure to shut it before starting/
resuming operation.

4. Operating the system with any cover open may affect EMC 
performance.
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Peripheral Update for EC countries

The following is intended to provide the users in EC countries 
with updated information concerning the connection of the 
LOGIQ V2/LOGIQ V1 to image recording and other devices or 
communication networks.

Peripherals used in the patient environment

The LOGIQ V2/LOGIQ V1 has been verified for overall safety, 
compatibility and compliance with the image recording devices 
listed in Supplies/Accessories section.

The LOGIQ V2/LOGIQ V1 has also been verified for 
compatibility, and compliance for connection to a local area 
network (LAN) via the rear panel Ethernet connection, provided 
the LAN components are IEC/EN 60950 compliant. 

The LOGIQ V2/LOGIQ V1 has also been verified for 
compatibility, and compliance for connection to a DVD-RW via 
the system USB port, provided the DVD-RW is IEC/EN 60950 
compliant.

A Wireless LAN option is available.

The LOGIQ V2/LOGIQ V1 may also be used safely while 
connected to devices other than those recommended above if 
the devices and their specifications, installation, and 
interconnection with the system conform to the requirements of 
IEC/EN 60601-1.

Accessory equipment connected to the analog and digital 
interfaces must be certified according to the respective IEC 
standards (i.e., IEC60950 for data processing equipment and 
IEC60601-1 for medical equipment). Furthermore, all complete 
configurations shall comply with the valid version of the system 
standard IEC60601-1. Everyone who connects additional 
equipment to the signal input part or signal output part of the 
LOGIQ V2/LOGIQ V1 system configures a medical system, and 
is therefore responsible to ensure that the system complies with 
the requirement of the valid version of IEC60601-1. If in doubt, 
consult the technical service department or your local GE 
representative.
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Peripherals used in the patient environment  (continued)

General precautions for installing an alternate on-board device 
would include:

1. The added device(s) must have appropriate safety standard 
conformance and CE Marking.

2. The total power consumption of the added devices, which 
connect to the LOGIQ V2/LOGIQ V1 and are used 
simultaneously, must be less than or equal to the rated 
supply of the LOGIQ V2/LOGIQ V1.

3. There must be adequate heat dissipation and ventilation to 
prevent overheating of the device.

4. There must be adequate mechanical mounting of the device 
and stability of the combination.

5. Risk and leakage current of the combination must comply 
with IEC/EN 60601-1.

6. Electromagnetic emissions and immunity of the combination 
must conform to IEC/EN 60601-1-2.

General precautions for installing an alternate off-board, remote 
device or a network would include:

1. The added device(s) must have appropriate safety standard 
conformance and CE Marking.

2. The added device(s) must be used for their intended 
purpose having a compatible interface.

3. Signal or mains isolation devices and additional protective 
earth may be needed to assure compliance with IEC/EN 
60601-1.

CAUTION The connection of equipment or transmission networks other 
than as specified in the user instructions can result in an 
electric shock hazard or equipment malfunction. Substitute or 
alternate equipment and connections requires verification of 
compatibility and conformity to IEC/EN 60601-1 by the installer. 
Equipment modifications and possible resulting malfunctions 
and electromagnetic interference are the responsibility of the 
owner.
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Declaration of Emissions

This system is suitable for use in the following environment. The 
user must assure that it is used only in the electromagnetic 
environment as specified. 

Table 2-3:  Declaration of Emissions

Guidance and manufacturer’s declaration - electromagnetic emissions

The system is intended for use in the electromagnetic environment specified below. The 
user of the system should assure that it is used in such an environment.

Emission Type Compliance Electromagnetic Environment

RF Emissions
CISPR 11

Group 1 This system uses RF energy only for its internal function. 
Therefore, its RF emissions are very low and are not likely to 
cause any interference in nearby electronic equipment. 

RF Emissions
CISPR 11

Class A This system is suitable for use in all establishments, other than 
domestic establishments and those directly connected to the 
public low-voltage power supply network that supplies buildings 
used for domestic purposes, provided the following warning is 
heeded:
WARNING: This system is intended for use by healthcare 
professionals only. This system may cause radio interference or 
may disrupt the operation of nearby equipment. It may be 
necessary to take mitigation measures, such as re-orienting or 
relocating the system or shielding the location. 

Harmonic Emissions
IEC 61000-3-2

Class A

Voltage 
Fluctuations/Flicker 
Emissions
IEC 61000-3-3

Complies
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Declaration of Immunity

This system is suitable for use in the following environment. The 
user must assure that the system is used according to the 
specified guidance and only in the electromagnetic environment 
listed. 

Table 2-4:  Declaration of Immunity

Immunity 
Type

Equipment 
Capability

Regulatory 
Acceptable Level

EMC Environment and 
Guidance

IEC 61000-4-2
Static discharge
(ESD)

± 6 kV contact

± 8 kV air

± 6 kV contact

± 8 kV air

Floors should be wood, concrete, or 
ceramic tile. If floors are covered with 
synthetic material, the relative 
humidity should be at least 30%.
Mains power quality should be that of 
a typical commercial and/or hospital 
environment. If the user requires 
continued operation during power 
mains interruptions, it is 
recommended that the system be 
powered from a UPS or a battery.
NOTE: UT is the a.c. mains voltage 
prior to application of the test level.
Power frequency magnetic fields 
should be at levels characteristic of a 
typical location in a typical commercial 
and/or hospital environment.
Separation distance to radio 
communication equipment must be 
maintained according to the method 
below. Interference may occur in the 
vicinity of equipment marked with the 
symbol:

Image degradation or interference 
may occur due to conducted RF noise 
on the equipment mains power supply 
or other signal cable. Such 
interference is easily recognized and 
distinguishable from patient anatomy 
and physiological waveforms. 
Interference of this type may delay the 
examination without affecting 
diagnostic accuracy. Additional mains/
signal RF isolation or filtering may be 
needed if this type interference occurs 
frequently.

IEC 61000-4-4
Electrical fast
transient/burst

± 2 kV for mains

± 1 kV for SIP/SOP

± 2 kV for mains

± 1 kV for SIP/SOP

IEC 61000-4-5 
Surge Immunity

± 1 kV differential

± 2 kV common

± 1 kV differential

± 2 kV common

IEC 61000-4-11
Voltage dips, 
short 
interruptions and 
voltage 
variations on 
mains supply

< 5% UT (> 95% dip 

in UT) for 0.5 cycle;

40% UT (60% dip in 

UT) for 5 cycles;

70% UT (30% dip in 

UT) for 25 cycles;

< 5% UT (>95% dip in 

UT) for 5 sec

< 5% UT (> 95% dip 

in UT) for 0.5 cycle;

40% UT (60% dip in 

UT) for 5 cycles;

70% UT (30% dip in 

UT) for 25 cycles;

< 5% UT (>95% dip in 

UT) for 5 sec

IEC 61000-4-8
Power 
frequency (50/
60 Hz) magnetic 
field

3 A/m 3 A/m

IEC 61000-4-6
Conducted RF

3 VRMS

150 kHz - 80 MHz

3 VRMS

150 kHz - 80 MHz

IEC 61000-4-3
Radiated RF

3 V/m
80 MHz - 2.5 GHz

3 V/m
80 MHz - 2.5 GHz

NOTE: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects, and people. If noise generated from other electronic equipment is near 
the probe’s center frequency, noise may appear on the image. Good power line isolation is required. 
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Patient Environmental Devices

Figure 2-1. Patient Environmental Devices for LOGIQ V2/
LOGIQ V1

1. Rear panel:

• Port for DC In (AC Adapter)

• Composite out

• S-Video Out

• 1 HDMI Port

• 1 Network Port

• 1 Security Lock

2. Left side:

• 1 Isolated USB printer port

• 2 general USB ports — USB Flash Drive, USB HDD, 
DVD-RW, Footswitch, Wireless Lan Adapter

• 1 SD Card port

3. Bottom side: Lithium-ion battery port

4. Right side: Probe port
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Acceptable Devices

The Patient Environmental devices shown on the previous page 
are specified to be suitable for use within the PATIENT 
ENVIRONMENT.

Unapproved Devices

Accessories, Options, Supplies 

CAUTION DO NOT connect any probes or accessories without approval 
by GE within the PATIENT ENVIRONMENT.

See ‘Supplies/Accessories’ on page 18-47 for more 
information.

CAUTION DO NOT use unapproved devices. 

If devices are connected without the approval of GE, the 
warranty will be INVALID.

Any device connected to the LOGIQ V2/LOGIQ V1 must 
conform to one or more of the requirements listed below:

1. IEC standard or equivalent standards appropriate to 
devices.

2. The devices shall be connected to PROTECTIVE EARTH 
(GROUND).

CAUTION Unsafe operation or malfunction may result. Use only the 
accessories, options and supplies approved or recommended 
in these instructions for use.

CAUTION For compatibility reasons, use only GE-approved probes, 
peripherals, or accessories.

DO NOT connect any probes or accessories without approval 
by GE.
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Acoustic Output

When the “Auto Freeze” preset is selected on the Utility -> 
System -> System Imaging screen, the system auto freezes if it 
detects no change in the image.

Located on the upper right section of the system display monitor, 
the acoustic output display provides the operator with real-time 
indication of acoustic levels being generated by the system. See 
the Acoustic Output chapter in the Advanced Reference Manual 
for more information. This display is based on NEMA/AIUM 
Standards for Real-time Display of Thermal and Mechanic 
Acoustic Output Indices on Diagnostic Ultrasound Equipment.

Acoustic Output Display Specifications

The display consists of three parts: Thermal Index (TI), 
Mechanical Index (MI), and a relative Acoustic Output (AO) 
value. Although not part of the NEMA/AIUM standard, the AO 
value informs the user of where the system is operating within 
the range of available output. 

Always be aware of the acoustic output level by observing the 
Acoustic Output Display. In addition, become thoroughly familiar 
with the Acoustic Output Display and equipment controls 
affecting output.

Thermal Index

Depending on the examination and type of tissue involved, the 
TI parameter will be one of three types:

• Soft Tissue Thermal Index (TIS). Used when imaging soft 
tissue only, it provides an estimate of potential temperature 
increase in soft tissue.

• Bone Thermal Index (TIB). Used when bone is near the 
focus of the image as in the third trimester OB examination, 
it provides an estimate of potential temperature increase in 
the bone or adjacent soft tissue.

• Cranial Bone Thermal Index (TIC). Used when bone is 
near the skin surface as in transcranial examination, it 
provides an estimate of potential temperature increase in 
the bone or adjacent soft tissue.

CAUTION Allowing the machine to transmit acoustic output with the probe 
not in use (or in its holder) can cause the transducer to build up 
heat. Always lower the acoustic power or freeze the image 
when not in use.
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Acoustic Output Display Specifications  (continued)

Mechanical Index

MI recognizes the importance of non-thermal processes, 
cavitation in particular, and the Index is an attempt to indicate 
the probability that they might occur within the tissue.

Changing the Thermal Index Type

You can select the displayed TI type on Utility -> Imaging -> 
B-Mode. This preset is application dependent so each 
application could specify a different TI type.

TI and MI Display and Accuracy

The TI and MI display starts at a value of 0 and increments do 
not exceed 0.2 for the entire range of display. 

When display MI>= 0.6, TI>= 3.6, the displayed values of MI and 
TI is not lower than 50% or higher than 150% of the measured 
value.

When display MI < 0.6, TI < 3.6, the absolute error of MI <= 0.3, 
the absolute error of TI <= 1.8.

Controls Affecting Acoustic Output

The potential for producing mechanical bioeffects (MI) or 
thermal bioeffects (TI) can be influenced by certain controls. 

Direct. The Acoustic Output control has the most significant 
effect on Acoustic Output. 

Indirect. Indirect effects may occur when adjusting controls. 
Controls that can influence MI and TI are detailed under the 
Bioeffects portion of each control in the Optimizing the Image 
sections. 

Always observe the Acoustic Output display for possible effects. 
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Best practices while scanning

NOTE: Refer to the Optimizing the Image sections for a complete 
discussion of each control. 

Acoustic Output Default Levels

In order to assure that an exam does not start at a high output 
level, the LOGIQ V2/LOGIQ V1 initiates scanning at a reduced 
default output level. This reduced level is preset programmable 
and depends upon the exam category and probe selected. It 
takes effect when the system is powered on or Patient is 
selected.

To modify acoustic output, adjust the Power Output level.

HINTS Raise the Acoustic Output only after attempting image 
optimization with controls that have no effect on Acoustic 
Output, such as Gain and TGC. 

WARNING Be sure to have read and understood control explanations for 
each mode used before attempting to adjust the Acoustic 
Output control or any control that can effect Acoustic Output. 

Acoustic
Output
Hazard

Use the minimum necessary acoustic output to get the best 
diagnostic image or measurement during an examination. 
Begin the exam with the probe that provides an optimum focal 
depth and penetration. 
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RoHS LOGIQ V2/LOGIQ V1 Hazardous Substances

This symbol indicates the product contains hazardous materials 
in excess of the limits established by the Chinese standard GB/T 
26572 Requirements for Concentration Limits for Certain 
restricted Substances in electrical and electronic Products.

The number in the symbol is the Environment-friendly Use 
Period (EFUP), which indicates the period during which the 
hazardous substances contained in electrical and electronic 
products will not leak or mutate under normal operating 
conditions so that the use of such electrical and electronic 
products will not result in any severe environmental pollution, 
any bodily injury or damage to any assets. The unit of the period 
is "Year".

In order to maintain the declared EFUP, the product shall be 
operated normally according to the instructions and 
environmental conditions as defined in the product manual, and 
periodic maintenance schedules specified in Product 
Maintenance Procedures shall be followed strictly.

Consumables or certain parts may have their own label with an 
EFUP value less than the product. Periodic replacement of 
those consumables or parts to maintain the declared EFUP shall 
be done in accordance with the Product Maintenance 
Procedures. This product must not be disposed of as unsorted 
municipal waste, and must be collected separately and handled 
properly after decommissioning. 
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Name and Concentration of Hazardous Substances

Table 2-5:  Table of hazardous substances' name and concentration for LOGIQ V2/
LOGIQ V1

Component Name

Hazardous substances' name

Pb Hg Cd Cr (VI) PBB PBDE

LCD Panel X O O O O O

Printed Circuit Board 
Assemblies

X O O O O O

Keyboard Assemblies X O O O O O

Power Assemblies X O O O O O

Battery X O O O O O

Ultrasound Probes X O O O O O

This table is prepared according to SJ/T 11364.
O: Indicates that hazardous substance contained in all of the homogeneous materials for this part is below 
the limit requirement in GB/T 26572.
X: Indicates that hazardous substance contained in at least one of the homogeneous materials used for this 
part is above the limit requirement in GB/T 26572. 
• Data listed in the table represents best information available at the time of publication.
• Applications of hazardous substances in this medical device are required to achieve its intended clinical 

uses, and/or to provide better protection to human beings and/or to environment, due to lack of reasonably 
(economically or technically) available substitutes. For example: Lead is could be used in Printed circuit 
solder.



Device Labels

LOGIQ V2/LOGIQ V1 – Basic User Manual 2-31
Direction 5610735-100 English Rev. 2

Device Labels

Label Icon Description

The following table describes the purpose and location of safety 
labels and other important information provided on the 
equipment.

Table 2-6:  Label Icons

Label/Icon Purpose/Meaning Location

Identification and Rating Plate • Manufacture’s name and 
address

• Date of manufacture
• Model and serial numbers
• Electrical ratings (Volts, Amps, 

phase, and frequency)

Rating Plate, labels

Identification and Rating Plate Date of manufacture: The date 
could be a year, year and month, 
or year, month and day, as 
appropriate. See ISO 8601 for 
date formats.

Rating Plate, labels

Serial Number Rating Plate, labels

Catalog Number Rating Plate, labels

Direct Current: For products to 
be powered from a DC supply

Rating Plate, labels

Input Rating Plate, labels

Description Rating Plate, labels

Made in China Rating Plate, labels
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Model Rating Plate, labels

AC adapter for LOGIQ V2/LOGIQ 
V1

AC adapter

No-Load power consumption AC adapter

Average Active Efficiency AC adapter

Test Battery

Rechargeable Smart Battery 
Pack

Battery

Only for LOGIQ V2/LOGIQ V1 
system

Battery

Output Rating Plate, labels

Type/Class Label Used to indicate the degree of 
safety or protection.

IP Code (IPX8)
IPX8: FSU-1000, MKF 2-MED 
GP26

Indicates the degree of protection 
provided by the enclosure per 
IEC60 529.

Bottom of footswitch

Authorized European 
Representative address.

Bottom panel

United States only
Prescription Requirement label.
CAUTION: United States law 
restricts this device to sale or use 
by, or on the order of a physician.

Bottom panel

Type BF Applied Part (man in the 
box) symbol is in accordance 
with IEC 60878-02-03.

Beside the probe connector

General Warning. Various

Table 2-6:  Label Icons (continued)

Label/Icon Purpose/Meaning Location
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“CAUTION” - Dangerous voltage” 
(the lightning flash with 
arrowhead) is used to indicate 
electric shock hazards.

Various

Indicates the power on and 
power off position of the power 
switch.
CAUTION: This Power Switch 
DOES NOT ISOLATE Mains 
Supply.

See the Console Overview 
section for location information.

“Protective Earth” indicates the 
protective earth (grounding) 
terminal.

Inside Power Box and Console

NRTL Listing and Certification 
Mark is used to designate 
conformance to nationally 
recognized product safety 
standards. The Mark bears the 
name and/or logo of the testing 
laboratory, product category, 
safety standard to which 
conformity is assessed and a 
control number.

Bottom

Do not use the following devices 
near this equipment: cellular 
phone, radio receiver, mobile 
radio transmitter, radio controlled 
toy, broadband power lines, etc. 
Use of these devices near this 
equipment could cause this 
equipment to perform outside the 
published specifications. Keep 
power to these devices turned off 
when near this equipment.

Bottom of the system

Be careful of static Bottom of the system

“Consult accompanying 
documents“ is intended to alert 
the user to refer to the operator 
manual or other instructions 
when complete information 
cannot be provided on the label.

Various

The CE Mark of Conformity 
indicates this equipment 
conforms with the Council 
Directive 93/42/EEC

Various

Table 2-6:  Label Icons (continued)

Label/Icon Purpose/Meaning Location
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CISPR CAUTION: The LOGIQ 
V2/LOGIQ V1 conforms to the 
CISPR11, Group 1, Class A of 
the international standard for 
Electromagnetic disturbance 
characteristics.

Bottom of the system

This symbol indicates that waste 
electrical and electronic 
equipment must not be disposed 
of as unsorted municipal waste 
and must be collected separately. 
Please contact an authorized 
representative of the 
manufacturer for information 
concerning the decommissioning 
of your equipment.

Bottom and probe connector

The separate collection symbol is 
affixed to a battery, or its 
packaging, to advise you that the 
battery must be recycled or 
disposed of in accordance with 
local or country laws. The letters 
below the separate collection 
symbol indicate whether certain 
elements 
(Pb=Lead,Cd=Cadmium, 
Hg=Mercury) are contained in the 
battery. To minimize potential 
effects on the environment and 
human health, it is important that 
all marked batteries that you 
remove from the product are 
properly recycled or disposed. 
For information on how the 
battery may be safely removed 
from the device, please consult 
the service manual or equipment 
instructions. Information on the 
potential effects on the 
environment and human health of 
the substances used in batteries 
is available at this url: http://
www.gehealthcare.com/euen/
weee-recycling/index.html

Battery Pack if contains Pb/Cd/
Hg

Table 2-6:  Label Icons (continued)

Label/Icon Purpose/Meaning Location
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This symbol indicates that this 
electrical and electronic product 
does not contain any hazardous 
substances above the maximum 
concentration value established 
by the Chinese standard GB/T 
26572, and can be recycled after 
being discarded, and should not 
be casually discarded.

This symbol indicates the product 
contains hazardous materials in 
excess of the limits established 
by the Chinese standard GB/T 
26572 Requirements of 
concentration limits for certain 
restricted substances in electrical 
and electronic products.
The number in the symbol is the 
Environment-friendly Use Period 
(EFUP), which indicates the 
period during which the 
hazardous substances contained 
in electrical and electronic 
products will not leak or mutate 
under normal operating 
conditions so that the use of such 
electrical and electronic products 
will not result in any severe 
environmental pollution, any 
bodily injury or damage to any 
assets. The unit of the period is 
"Year"

Probe and Bottom, China Rating 
Plate.

When closing the LCD cover, use 
caution to avoid injuring hands or 
fingers as there is a closing 
mechanism which allows the 
LCD cover to automatically close.

Bottom of the system

Do not connect the DVD-RW to 
the system while scanning.

DVD-RW

GOST symbol: Russia 
Regulatory Country Clearance.

Rating plate 
Note: Only after Russian 
regulatory registration is 
complete, this label will be 
located on the console.

Table 2-6:  Label Icons (continued)

Label/Icon Purpose/Meaning Location
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INMETRO Certification: TUV 
Rheinland Brazil

Rating plate
Note: Only after Brazilian 
regulatory registration is 
complete, this label will be 
located on the console.

“Eurasian Conformity” mark; the
single conformity mark for
circulation of products on the
markets of member-states of
Customs Union.
This product passed all
conformity assessment
(approval) procedures that
correspond to the requirements
of applicable technical
regulations of the Customs
Union.

Bottom.

This machine should be used in 
compliance with law. Some 
jurisdictions restrict certain uses, 
such as gender determination.

Bottom of the system
Note: For China, Korea and India 
only.

Table 2-6:  Label Icons (continued)

Label/Icon Purpose/Meaning Location
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Label Locations

LOGIQ V2/LOGIQ V1 labels are provided in English.

The labels are at the bottom of the system. The label content 
may be different for different regions. Please refer to the labels 
on the system for the actual content

 Figure 2-2. LOGIQ V1 Label Locations
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Label Locations  (continued)

 Figure 2-3. LOGIQ V2 Label Locations

1. Warning label

2. Rating Plate

3. Gender Caution (For China, Korea and India only)
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Label Locations  (continued)

 Figure 2-4. LOGIQ V2/LOGIQ V1 Label Locations (for China)

1. Warning label

2. Rating Plate for China

3. Gender Caution (For China, Korea and India only)
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Label Locations  (continued)

 Figure 2-5. AC Adapter label
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Label Locations  (continued)

Figure 2-6. Battery Label

1. Do not put the battery in fire.

2. Do not disassemble or mistreat the battery. 

CAUTION Do not disassemble or mistreat the battery. Do not put the 
battery in fire. Replace the battery with the same battery type 
only. Failure to follow these instructions many present risk of 
explosion fire or high temperature. See the battery user manual 
for additional safety instructions.
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Chapter 3

Preparing the System for Use

Describes the site requirements, console overview, 
system positioning/transporting, powering on the 
system, adjusting the display monitor, probes and 
operator controls.
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Site Requirements

Introduction

Do not attempt to install the system alone. General Electric, 
Affiliate, or Distributor Field Engineers and Application 
Specialists will install and setup the system. See ‘Contact 
Information’ on page 1-8 for more information.

The LOGIQ V2/LOGIQ V1 does not contain any operator 
serviceable internal components. Ensure that unauthorized 
personnel do not tamper with the unit.

Perform regular preventive maintenance. See ‘System Care and 
Maintenance’ on page 18-10 for more information.

Maintain a clean environment. Turn off the system and 
disconnect the power cord before cleaning the unit. See 
‘Cleaning the system’ on page 18-13 for more information.

Never set liquids on the unit to ensure that liquid does not drip 
into the control panel or unit.

WARNING All the warnings in the Safety chapter should be read and 
understood before operating the unit.

CAUTION Always use the system on a flat surface in the patient 
environment.

CAUTION The LOGIQ V2/LOGIQ V1 system and probe connector are not 
waterproof. Do not expose the device to water or any kind of 
liquid.
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Before the system arrives

The ultrasound unit must operate within the proper environment 
and in accordance with the requirements described in this 
section. Before using the system, ensure that the requirements 
are met.

Power Requirements

• A separate power outlet with a 6.5 amp circuit breaker.

• Frequency: 50/60 Hz

• 100V - 240V AC (+/-10%)

Electromagnetic interferences

This medical equipment is approved, in terms of the prevention 
of radio wave interference, to be used in hospitals, clinics and 
other institutions which are environmentally qualified. The use of 
this equipment in an inappropriate environment may cause 
some electronic interference to radios and televisions around 
the equipment.

Ensure that the following is provided for the new system: 

• Take precautions to ensure that the console is protected 
from electromagnetic interference.

Precautions include: 

• Operate the console at least 15 feet away from motors, 
typewriters, elevators, and other sources of strong 
electromagnetic radiation.

• Operation in an enclosed area (wood, plaster or 
concrete walls, floors and ceilings) helps prevent 
electromagnetic interference.

• Special shielding may be required if the console is to be 
operated in the vicinity of radio broadcast equipment.

CAUTION Do not operate the system in the vicinity of a heat source, of 
strong electric or magnetic fields (close to a transformer), or 
near instruments generating high-frequency signals, such as 
HF surgery. These can affect the ultrasound images adversely.
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Before the system arrives  (continued)

Figure 3-1. Example Plug and Outlet Configurations

1. 100-120 VAC, 10A

Plug and Outlet Configuration

2. 220-240 VAC, 10A

Plug and Outlet Configuration

NOTE: Country-specific power cords are currently available for 
Argentina, Australia/New Zealand, China, Denmark, India/South 
Africa, Switzerland, United Kingdom, Europe, the United States, 
Israel, Brazil and Japan.

WARNING To avoid risk of fire, the system power must be supplied from a 
separate, properly rated outlet. See ‘Before the system arrives’ 
on page 3-3 for more information. 

Under no circumstances should the AC power plug be altered, 
changed, or adapted to a configuration rated less than 
specified. Never use an extension cord or adapter plug.

To help assure grounding reliability, connect to a “hospital 
grade” or “hospital only” grounded power outlet.
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Environmental Requirements

The system should be operated, stored, or transported within 
the parameters outlined below. Either its operational 
environment must be constantly maintained or the unit must be 
turned off.

NOTE: You may get an overheating message with regard to fan speed. 
Ensure adequate system/room ventilation.

Operating Environment

Ensure that there is sufficient air flow around the ultrasound unit 
when installed in a fixed location.

Table 3-1:  System Environmental Requirements

Operational
(with probe)

Storage
(LOGIQ V2/LOGIQ 

V1)

Transport
(LOGIQ V2/LOGIQ 

V1)

Temperature 10 - 40° C 
50 - 104° F

-5 - 50° C
23 - 122° F

-5 - 50° C
23 - 122° F

Humidity 30 - 80% 
non-condensing

10 - 90% 
non-condensing

10 - 90% 
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

CAUTION Do not cover the ventilation holes of the LOGIQ V2/LOGIQ V1.

CAUTION The LOGIQ V2/LOGIQ V1 system and probe connector are not 
waterproof. Do not expose the device to water or any kind of 
liquid.
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Console Overview

Console Graphics

The following are illustrations of the console:

Figure 3-2. LOGIQ V2/LOGIQ V1 System - an example

1. Handle

2. LCD

3. Primary Menu keys

4. Alphanumeric keys

5. Control Panel
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Console Graphics  (continued)

Figure 3-3. LOGIQ V2/LOGIQ V1 System

CAUTION Do not push objects into air vents and openings of LOGIQ V2/
LOGIQ V1. Doing so can cause fire or electric shock by 
shorting out interior components.

WARNING DO NOT touch the patient and any of the connectors on the 
ultrasound unit simultaneously, including ultrasound probe 
connectors.

DO NOT touch the conducting parts of the USB, Ethernet, 
Video, Audio cables when connecting equipment to the unit.



Preparing the System for Use

3-8 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Battery
The lithium ion battery provides power when an AC power 
source is not available. A battery in the battery bay is standard 
with the LOGIQ V2/LOGIQ V1. Lithium ion batteries last longer 
than conventional batteries and do not require replacement as 
often. You can expect 30 minutes of battery life with a single fully 
charged battery in use to supply power to the system.

NOTE: While scanning with the battery supplying power only, the 
battery life may be shorter. Always archive the data and keep 
your attention on the battery status. When the battery power is 
low, charge the battery immediately in case that scanning will be 
interrupted and the data will be lost due to the automatic 
shutdown of the system.

The lithium ion technology used in your system’s battery is 
significantly less hazardous to the environment than the lithium 
metal technology used in some other batteries (such as watch 
batteries). Used batteries should not be placed with common 
household waste products. Contact local authorities for the 
location of a chemical waste collection program nearest you.

NOTE: The battery is designed to work with LOGIQ V2/LOGIQ V1 
systems only. Only use the batteries authorized by GE.

Temperature Requirements

The battery should be charged, discharged and stored within the 
parameters outlined below:

• Operating temperature:

• Charge: 10 - 40°C (50 - 104°F). 

• Discharge: 10 - 40°C (50 - 104°F)

• Storage temperature:

NOTE: It is recommended that the battery remaining capacity 
should be 40% ~ 60% when the battery storage begins.

It is recommended that the battery remaining capacity 
should be 40%~60% when the battery storage begins.

• Storage time < 3 months: -20 - 40°C (-4 - 104°F)

• Storage time >= 3 months: -20 - 20°C (-4 - 68°F)

WARNING Do not expose the battery to temperature over 60°C (140°F). 
Keep it away from fire and other heat sources.
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Battery  (continued)

WARNING • The battery has a safety device. Do not disassemble or 
alter the battery.

• Do not short-circuit the battery by directly connecting the 
negative terminals with metal objects.

• Do not heat the battery or discard it in a fire.

• Do not charge the battery near a heat source, such as a 
fire or heater.

• Do not leave the battery in direct sunlight.

• Do not pierce the battery with a sharp object, hit it, or step 
on it.

• Do not use a damaged battery.

• Do not solder a battery.

• Do not connect the battery to an electrical power outlet.

WARNING If the LOGIQ V2/LOGIQ V1 is not being used on a monthly 
basis, the battery needs to be removed during the lengthy 
non-use period.

CAUTION To avoid the battery bursting, igniting, or fumes from the battery 
causing equipment damage, observe the following precautions:

• Do not immerse the battery in water or allow it to get wet.

• Do not put the battery into a microwave oven or 
pressurized container.

• If the battery leaks or emits an odor, remove it from all 
possible flammable sources.

• If the battery emits an odor or heat, is deformed or 
discolored, or in a way appears abnormal during use, 
recharging or storage, immediately remove it and stop 
using it. If you have any questions about the battery, 
consult GE or your local representative.
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Discharge/Charge Cycle

When the battery is stored for three months or more, the 
customer should perform one full discharge/charge cycle.

NOTE: A full discharge/charge cycle means the system is turned on 
using battery power until the battery loses its charge completely 
and the system shuts down. Plug the LOGIQ V2/LOGIQ V1 in 
until the battery is fully charged as indicated by a green LCD 
light.

Upon receipt of the LOGIQ V2/LOGIQ V1 and before first time 
usage, it is highly recommended that the customer perform one 
full discharge/charge cycle.

If the battery has not been used for >2 months, the customer is 
recommended to perform one full discharge/charge cycle. It is 
also recommended to store the battery in a shady and cool area 
with FCC (full current capacity).

One Full Discharge/Charge Cycle Process:

1. Full discharge of battery to let the LOGIQ V2/LOGIQ V1 
automatically shut down.

2. Charge the LOGIQ V2/LOGIQ V1 to 100% FCC (full current 
capacity).

3. Discharge of LOGIQ V2/LOGIQ V1 for complete shut down 
(takes about one hour for discharge).

When storing packs for more than 6 months, charge the pack at 
least once during the 6 month timeframe to prevent leakage and 
deterioration in performance.

CAUTION Use only GE recognized batteries.
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View current battery status

When the system is running on battery, there is a battery icon in 
the system status bar, When there is no battery, the AC plug 
Icon is displayed in the system status bar. 

Figure 3-4. Battery icon

Figure 3-5. Low Power Battery Icon 

Figure 3-6. Warning Battery Icon

If the battery is in charge, the battery icon appears as being 
charged in the system status bar.

Figure 3-7. Charging Battery icon

Select the battery icon and the following information window 
appears:

Figure 3-8. Battery Status Message
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Battery power low warning

If the battery is in use and the battery power is low, the battery 
icon become yellow. A warning message appears to warn the 
user that the battery power is low and it needs to be charged.

Figure 3-9. Low battery power warning

The same warning message in red will continually appears in 
the status bar at the bottom of the screen.

 Figure 3-10. Low battery power warning on status bar

When the estimated current power remaining time is less than 3 
minute, the below warning message appears on the screen to 
warn the user to charge the battery immediately, or the system 
will shut down automatically in 1 minute.

Figure 3-11. System shutdown warning

NOTE: When the battery power is low and the user cannot charge the 
battery in time, the system automatically shuts down in 1 minute. 
This protects the whole system. You need to charge the battery 
immediately before the system shuts down or you may lose 
useful information.
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Battery error

If there is an error on the battery, the battery error icon displays.

Figure 3-12. Battery Error Icon

Follow below steps to resolve the issue:

1. Shutdown the system and disconnect AC power cable if it is 
connected.

2. Remove and install the battery

3. Connect the AC power cable

4. Power on the system with AC power supply

5. Disconnect AC power cable to use the battery to supply 
power to the system.

If it is still error, shutdown the system, disconnect AC power 
cable if it is connected, remove the battery and contact GE 
Service.
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Battery Installation

To install the battery to the bottom cover of the system:

1. Shut down the system and disconnect the AC/DC power 
cord.

2. Put the battery into the battery box through the opening 
place.

Figure 3-13. Place the battery on the bottom cover

3. Push the battery completely into the box until the battery is 
locked and the battery lock is in the lock position.

Figure 3-14. Lock the battery
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Battery Removal

To remove the battery from the bottom cover of the system:

1. Shut down the system and disconnect the AC/DC power 
cord.

2. Push up the battery lock to another end of the slot. While 
hold on to the lock without release, put another hand at the 
embossed position on the battery and push the battery in 
the direction away from the battery box.

Figure 3-15. Unlock and push the battery

3. When the battery is away from the lock, remove it from the 
battery box.

Figure 3-16. Remove the battery



Preparing the System for Use

3-16 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

AC Adapter

CAUTION Do not use an AC adapter without approval by GE.

Be sure that nothing rests on the AC adapter’s power cable 
and that the cable is not located where it can be tripped over or 
stepped on.

Place the AC adapter in a ventilated area, such as a desk, 
when you use it to run LOGIQ V2/LOGIQ V1. Do not cover the 
AC adapter with paper or other items that will reduce cooling; 
do not use the AC adapter inside a carrying case.

To prevent damage to the power cable of the AC adapter, DO 
NOT pull excessively on the cable; DO NOT make any sharp 
bends; DO NOT bend the power cable frequently.
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Peripheral/Accessory Connection

Peripheral/Accessory Connector Panel

LOGIQ V2/LOGIQ V1 peripherals and accessories can be 
properly connected using the connector panel.

CAUTION Each outer (case) ground line of peripheral/accessory 
connectors are Earth Grounded.

Signal ground lines are Not Isolated.

CAUTION For compatibility reasons, use only GE-approved probes, 
peripherals, or accessories.

DO NOT connect any peripherals and accessories without 
approval by GE.

CAUTION The connection of equipment or transmission networks other 
than as specified in these instructions can result in electric 
shock hazard. Alternate connections will require verification of 
compatibility and conformity to IEC/EN 60601-1 by the installer.

CAUTION DO NOT touch the patient and any of the connectors on the 
ultrasound unit simultaneously, including ultrasound probe 
connectors.

DO NOT touch the conducting parts of the USB, Ethernet, 
Video, Audio cables when connecting equipment to the unit.

CAUTION When using peripheral device, observe all warnings and 
cautions given in peripheral operator manuals.
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Peripheral/Accessory Connector Panel  (continued)

 Figure 3-17. Peripheral/Accessory Connector Panel

1. LCD Monitor Locker

2. Security lock

3. Port for DC In (AC Adapter)

4. Composite out port

5. S-Video out port

6. HDMI Port

7. Network Port

8. 1 Isolated USB printer port

9. 2 general USB ports — USB Flash Drive, USB HDD, 
DVD-RW, Footswitch, Wireless Lan Adapter

10. 1 SD Card port

11. 1 Probe Connector Port

12. Probe Connector Locking Lever
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Peripherals Connection

1. Connect the printer to the system. The printer can be 
properly connected using the Isolated USB printer port.

Table 3-2:  Printers Connection

Printers Illustration

Sony UP-D897 printer

Sony UP-D898MD printer
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Sony UP-D25MD printer

HP Officejet 100 printer

HP Officejet Pro 8100 
printer

Table 3-2:  Printers Connection

Printers Illustration
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Peripherals Connection  (continued)

2. The USB connection peripherals in below table can be 
properly connected using general USB ports.

Table 3-3:  Peripherals Connection

Peripherals Illustration

1 Pedal Footswitch 

3 Pedal Footswitch

You can configure 3-pedal 
Footswitch functionality via 
the Utility -> 
Applications -> Footswitch 
parameters. 

DVD-RW
Note: Do not connect the 
DVD-RW to the system 
while scanning.
Note: Be sure the 2 
connectors on the USB Y 
cable are connected to the 
system at the same time.
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Wireless Card

USB Flash Drive

USB Hard Disk

Table 3-3:  Peripherals Connection

Peripherals Illustration
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Peripherals Connection  (continued)

3. Other peripheral ports connection

Table 3-4:  Other Peripheral ports connection

Peripherals Illustration

SD Card connection

Ethernet connection

HDMI port connection

VGA output connection (through 
an external video adapter from 
HDMI)
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NOTE: Please refer to the manufacture’s operation manual of each 
peripheral for information needed by the user to operate the 
peripheral safely.

Composite out port
You can configure the output 
format via the Utility -> System -> 
Peripherals. 

S-Video out port
You can configure the output 
format via the Utility -> System -> 
Peripherals.

Table 3-4:  Other Peripheral ports connection

Peripherals Illustration

CAUTION When using the Footswitch, DO NOT hold down the footswitch 
pedal. Press and release the Footswitch pedal. Pushing and 
holding down the pedal behaves the same way as pushing and 
holding down a key on the keyboard. 
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Attaching the Security Cable

To ensure that the LOGIQ V2/LOGIQ V1 is not removed from 
the premises, attach the security cable.

1. Wrap the cable around an immovable object.

Figure 3-18. Security Cable

2. Be sure to rotate the key to the unlocked position (to the 
right).

3. Insert the lock into the security slot to the system’s rear side.

Figure 3-19. LOGIQ V2/LOGIQ V1 with Security Cable

4. Rotate the key to the locked position (to the left).
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Set Up Wired Footswitch 

Use only the GE recommended footswitch. The footswitch may 
be used as select keys.

You can attach this Footswitch to the system by connecting it to 
the USB port on the system. 

You can configure its functionality via the Utility -> 
Applications -> Settings -> Footswitch parameters. 

For 3-pedal footswitch, you can configure its functionality from 
the pull-down menu list of Left, Middle and Right.

Figure 3-20. 3-footswitch setting

For 1-pedal footswitch, you can configure its functionality from 
the pull-down list of the Middle.

Figure 3-21. 1-footswitch setting

CAUTION When using the Footswitch, DO NOT hold down the footswitch 
pedal. Press and release the Footswitch pedal. Pushing and 
holding down the pedal behaves the same way as pushing and 
holding down a key on the keyboard. 
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Powering the System

Voltage level check

Check the rating label at the bottom of the system. Check the 
voltage range indicated on the label.

Connecting to the electrical outlet

To connect the system to the electrical supply:

1. Ensure that the wall outlet is of the appropriate type.

2. Unwrap the power cable. Make sure to allow sufficient slack 
in the cable so that the plug is not pulled out of the wall if the 
system is moved slightly.

3. Attach the power plug to the system.

4. Connect the power cable to the adapter, if it is not 
connected.

5. Push the power plug securely into the wall outlet.

NOTE: Do not use an extension cord or adapter plug.

WARNING POWER OUTAGE MAY OCCUR. The ultrasound unit requires 
a dedicated single branch circuit. To avoid circuit overload and 
possible loss of critical care equipment, make sure you DO 
NOT have other equipment operating on the same circuit.

CAUTION Use the appropriate power cord provided by or designated 
by GE.
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Connecting to the electrical outlet  (continued)

Figure 3-22. Connect the system to the electrical supply

CAUTION To avoid leakage current above safety limits as prescribed by 
IEC 60601-1 and to ensure continuity of protective earth. Only 
connect LOGIQ V2/LOGIQ V1 and mains-operated 
accessories to the appropriate wall outlet. DO NOT connect 
them to a single or multiple socket outlets, an extension cord, 
power strip or an adapter plug. 

CAUTION Disconnect the plug from the wall outlet in case an emergency 
should occur. Ensure easy access to the power outlet.
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Connecting to the electrical outlet  (continued)

WARNING The system should rest on the handle to allow an air gap to 
prevent overheating.

WARNING DO NOT use the LOGIQ V2/LOGIQ V1 on plastic foam, paper 
or similar type surfaces. The system could overheat and slow 
down. Ensure that the is on a sturdy, heat resistant surface.

WARNING To avoid risk of fire, the system power must be supplied from a 
separate, properly rated outlet. See ‘Before the system arrives’ 
on page 3-3 for more information.

Under no circumstances should the AC power plug be altered, 
changed, or adapted to a configuration rated less than 
specified. Never use an extension cord or adapter plug.

To help assure grounding reliability, connect to a “hospital 
grade” or “hospital only” grounded power outlet.

CAUTION Use caution to ensure that the power cable does not 
disconnect during system use.

If the system is accidentally unplugged, data may be lost.

WARNING Failure to provide an adequate earth circuit can cause electrical 
shock, resulting in serious injury.

Connection of additional protective earth conductors or 
potential equalization conductors is not necessary in most 
cases and is only recommended for situations involving 
multiple equipment in a high-risk patient environment to 
provide assurance that all equipment is at the same potential 
and operates within acceptable leakage current limits. An 
example of a high-risk patient would be a special procedure 
where the patient has an accessible conductive path to the 
heart such as exposed cardiac pacing leads.
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Connecting to the electrical outlet  (continued)

Figure 3-23. Example Plug and Outlet Configurations

1. 100-120 VAC, 10A

Plug (a) and Outlet (b) Configuration example

2. 220-240 VAC, 10A

Plug (a) and Outlet (b) Configuration example

NOTE: Country-specific power cords are currently available for 
Argentina, Australia/New Zealand, China, Denmark, India/South 
Africa, Switzerland, United Kingdom, Europe, United States, 
Israel, Brazil and Japan.

Acclimation Time

After being transported or stored, the system requires one hour 
for each 2.5 degree increment or decrement when its 
temperature is beyond the operational temperature.

WARNING To avoid risk of electric shock, this equipment must only be 
connected to a supply mains with protective earth.

Table 3-5:  System Acclimation Time Chart

Degree C 50 45 40 35 30 25 20 15 10 5 0 -5

Degree F 122 113 104 95 86 77 68 59 50 41 32 23

hours 4 2 0 0 0 0 0 0 0 2 4 6
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Power On 

To turn on the system

1. Check the rating label at the bottom of the system. Check 
the voltage range indicated on the label.

2. Momentarily press the On/Off switch to turn the power on.

3. The system should now go through its boot-up process with 
no further user intervention.

Figure 3-24. Power On/Off Switch Location
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Power Up Sequence 

The system is initialized. During this time:

• The system boots up and the status is reflected on the 
monitor.

Figure 3-25. Power Up Graphic Sequence

• Probes are initialized for immediate operation.

NOTE: If no probe is connected, the system goes into freeze mode.

• Peripheral devices are activated on power up.

After initialization is complete, the default B-Mode screen is 
displayed on the monitor (if a probe is connected).
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LED

Press the On/Off switch to turn the power on. 

After a successful boot-up process, the Power On/Off switch 
illumination turns to green.

Figure 3-26. LED Indicators

1. Indicates hard disk working status. When the LED is 
flashing, the system is writing or reading from the hard disk.

Color: Green

2. Indicates battery status. When the battery is charged, the 
LED is green. When battery power is low, the LED is 
orange.

Color: Green and Orange

Keyboard Backlight

The keyboard backlight is lit for operation in dimly lit room.
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Login

Personal IDs and associated passwords can be preset in Utility 
-> Admin -> Users on the LOGIQ V2/LOGIQ V1. 

If the User Auto Logon preset in Utility -> Admin -> Logon is 
blank, you are prompted to login. 

Figure 3-27. Operator Login Window

1. Operator: Select the Operator.

2. Password: Enter Operator’s password (optional).

3. Select type of Logon or Cancel.

• OK: Standard logon

• Cancel: Cancel logon

Logoff

To logoff, press the Power On/Off switch momentarily and a 
SYSTEM-EXIT window appears.
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Power Off

For optimum system operation, we recommend that you restart 
the system at least once every 24-hour period. If you shut down 
the system at the end of the day, no other action is needed. 

To power off the system:

1. When you shutdown the system, enter the scan screen and 
lightly press the Power On/Off switch on the control panel. 
The System-Exit window is displayed.

NOTE: DO NOT press and hold down the Power On/Off switch to 
shutdown the system. Instead, lightly press the Power On/
Off switch and select Shutdown.

2. Using the Trackball, select Shutdown.

The shutdown process takes a few seconds and is 
completed when the Power On/Off switch illumination turns 
from green to off.

NOTE: DO NOT select Exit for Shutdown. Exit is only available to 
Service representative.

NOTE: If the system has not fully shut down in 60 seconds in the 
power-off sequence, press and hold down the On/Off switch 
until the system shuts down. 

3. Disconnect the probes.

Clean or disinfect all probes as necessary. Store them in 
their shipping cases or another appropriate probe storage 
system to avoid damage. 

4. Disconnect AC adapter mains plug from the power outlet.

NOTE: Disconnect the AC adapter mains plug from the outlet if the 
system has been fully charged. Connect the AC adapter 
mains plug to the outlet if the system needs to be charged 
and then disconnect it when the system has been fully 
charged.
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Check System Date and Time

A warning message “Please check the system date and time are 
correct” appears on the screen when the system is powered up. 
This warning message appears for the possible reasons: 

• The system is not boot up for more than 14 days.

• The system time has been changed by 24 hours earlier than 
the current system time of last boot-up.

This warning message is to remind the user to check the system 
date in case the system date and time is incorrect.

Figure 3-28. Check system date and time message

Move the cursor to OK and press the Cursor key to select OK. 
The system enters scanning mode.

Check the system date and time. If it is incorrect, follow below 
steps to reset the system date and time.

1. Enter Utility -> System -> General -> Date/Time.

2. Reset the system date and time. 

3. Select Apply and select OK.

4. Select Save.
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Crash Recovery Instructions

In cases where the system detects an internal error, the system 
may reboot on its own. If this happens, the system will 
automatically end the current exam and permanent store all the 
images and measurements.

The system automatically ends the current exam and 
permanently stores all the images and measurements. When 
the system reboots, check whether all the images and 
measurements have been preserved in the system. Then, 
simply hold down the power switch to initiate a normal power 
down sequence.

NOTE: If the image is not updated properly when the system is up, shut 
down the system again.

NOTE: Generic worksheets are not saved if the system crashes before 
you save it.

WARNING The system crash may cause the internal HDD corruption. 
Avoid using the internal HDD as a permanent storage device. 
Backup data on a regular basis. 
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System Positioning/Transporting

Moving the system

When moving or transporting the system, follow the precautions 
below to ensure the maximum safety for personnel, the system, 
and other equipment. 

Before moving the system

1. Shut down the system. See ‘Power Off’ on page 3-35 for 
more information.

2. Unplug the power cord (if the system is plugged in).

3. Disconnect all cables from off-board peripheral devices 
(external printer, etc.) and the ethernet connection from the 
console.

NOTE: To prevent damage to the Power Cord, DO NOT pull 
excessively on the cord or make sharp bends while 
wrapping.

4. Store all probes in their original cases or in soft cloth or foam 
to prevent damage.

5. Store sufficient gel and other essential accessories in the 
special storage case.

CAUTION DO NOT attempt to move the console using any cables or 
fixtures, such as the probe connectors.

CAUTION Handle carefully. A drop of more than 5 cm can cause 
mechanical damages.
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When moving the system

1. Always use the handle to move the system.

Transporting the System

Use extra care when transporting the system using vehicles. In 
addition to the instructions used when moving the system (see 
‘Moving the system’ on page 3-38 for more information), also 
perform the following:

1. Before transporting, place the system in its special storage 
case.

2. Ensure that the system is firmly secured while inside the 
vehicle.

CAUTION The system weighs approximately 6 kg (13.23 lbs). To avoid 
possible injury and equipment damage:

• Do not let the system strike walls or door frame.
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Attaching the Security Cable

To ensure that the LOGIQ V2/LOGIQ V1 is not removed from 
the premises, attach the security cable.

1. Wrap the cable around an immovable object.

Figure 3-29. Security Cable

2. Be sure to rotate the key to the unlocked position (to the 
right).

3. Insert the lock into the security slot to the system’s side 
cover.

Figure 3-30. LOGIQ V2/LOGIQ V1 with Security Cable

4. Rotate the key to the locked position (to the left).
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LCD Monitor

Locking/unlocking the LCD monitor

The LCD monitor will be locked automatically when the system 
is closed with a little force.

Push and slide the LCD latch slider to the right and hold on to 
unlock the LCD, LCD monitor can be opened.

Figure 3-31. Unlock the LCD Monitor

Adjusting the LCD monitor

The LCD monitor position can be adjusted for easy viewing.

• Tilt the LCD monitor for the optimum viewing angle. The 
maximum angle is 170.

NOTE: Bright light could impact readability of screen.

CAUTION To avoid damage, DO NOT push the LCD monitor over the 
maximum opening angle.

DO NOT scratch or press on the panel with any sharp 
objects, such as a pencil or pen, as this may result in 
damage to the panel.
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Brightness 

Adjusting the monitor's brightness is one of the most important 
factors for proper image quality. If these controls are set 
incorrectly, the Gain, TGC, Dynamic Range and even Power 
Output may have to be changed more often than necessary to 
compensate.

The proper setup displays a complete gray scale. The lowest 
level of black should just disappear into the background and the 
highest white should be bright, but not saturated.

To adjust the brightness:

On the alphanumeric keyboard, adjust brightness with the Fn + 
Left/Right keys

Figure 3-32. Brightness

1. Brightness

NOTE: After readjusting the LCD monitor's Brightness, readjust all 
preset and peripheral settings.

NOTE: The brightness of the LCD monitor should be set first as it 
affects the Gain and Dynamic Range settings of your image. 
Once set, this should not be changed unless the brightness of 
your scanning environment changes.
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Volume

To adjust the volume:

On the alphanumeric keyboard, adjust volume with the Fn + Up/
Down keys

Figure 3-33. Volume

1. Volume
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Probes

Introduction

Only use approved probes. 

All approved imaging probes can be connected into the probe 
port of the LOGIQ V2/LOGIQ V1.

See ‘Probes and Biopsy’ on page 17-1 for more information.

Selecting probes

• Always start out with a probe that provides optimum focal 
depths and penetration for the patient size and exam.

• Begin the scanning session by choosing the correct 
application and preset for the examination by selecting 
Preset.

• Begin the scan session using the default Power Output 
setting for the probe and exam.
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Connecting the Probe

Probes can be connected at any time, regardless of whether the 
console is powered on or off. To ensure that the ports are not 
active, place the system in the image freeze condition.

To connect a probe:

1. Place the probe's carrying case on a stable surface and 
open the case.

2. Carefully remove the probe and unwrap the probe cord.

CAUTION Remove any dust or foam rests from the probe pins.

CAUTION Inspect the probe before and after each use for damage or 
degradation to the housing, strain relief, lens, seal, cable and 
connector. DO NOT use a transducer which appears damaged 
until functional and safe performance is verified. A thorough 
inspection should be conducted during the cleaning process.

CAUTION Fault conditions can result in electric shock hazard. Do not 
touch the surface of probe connectors which are exposed 
when the probe is removed. Do not touch the patient when 
connecting or disconnecting a probe.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.
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Connecting the Probe  (continued)

3. Align the connector with the probe port and carefully push 
into place with the cable facing the front of the system.

Figure 3-34. Probe connection to LOGIQ V2/LOGIQ V1

4. Flip the connector locking lever up.

Figure 3-35. Probe connector locking lever

5. Carefully position the probe cord so it is free to move and is 
not resting on the floor.

6. When the probe is connected, it is automatically activated.

CAUTION Make sure that the probe and application names displayed on 
the screen correspond to the actual probe and application 
selection.
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Cable Handling 

Take the following precautions with probe cables:

• Do not bend the cable acutely

• Avoid crossing cables between probes.

Deactivating the Probe

To deactivate a probe:

1. Ensure LOGIQ V2/LOGIQ V1 is in freeze mode. If 
necessary, press the Freeze key.

2. Gently wipe the excess gel from the face of the probe.

CAUTION Make sure that the probe and application names displayed on 
the screen correspond to the actual probe and application 
selection.
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Disconnecting the Probe

Probes can be disconnected at any time, regardless of whether 
the console is powered on or off.

1. Press the connector locking lever down.

Figure 3-36. Probe connector unlocking lever

2. Pull the probe connector straight out of the probe port 
carefully.

Figure 3-37. Probe disconnection from LOGIQ V2/LOGIQ V1

3. Ensure the cable is free.

4. Be sure that the probe head is clean before placing the 
probe in its storage box or wall hanging unit.
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2-Probe Port Adapter (option)

Mounting 2-Probe Port Adapter to LOGIQ V2/LOGIQ V1

1. Turn over LOGIQ V2/LOGIQ V1 and 2-Probe Port Adapter 
to let the back upward.

Figure 3-38. 2-Probe Port Adapter connection 1

2. Align the 2 location pins of 2 Probe Port with the location 
holes of LOGIQ V2/LOGIQ V1 and carefully push into place, 
then screw 3 screws.

 Figure 3-39. 2-Probe Port Adapter connection 2
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Mounting 2-Probe Port Adapter to LOGIQ V2/LOGIQ V1  (continued)

3. Flip the connector locking lever down.

 Figure 3-40. 2-Probe Port Adapter connection 3

4. Turn over the system with 2-Probe Port Adapter, now the 
2-Probe Port Adapter is connected successfully.

Figure 3-41. 2-Probe Port Adapter connection 4



Probes

LOGIQ V2/LOGIQ V1 – Basic User Manual 3-51
Direction 5610735-100 English Rev. 2

Connecting Probes to the 2-Probe Port Adapter

Follow the probe connection procedure to connect the probe to 
the 2-Probe Port Adapter. 

Figure 3-42. 2-Probe Port Adapter connection 5

Selecting the probe

Press Patient or Preset on the control panel to select the probe.

Figure 3-43. Select the probe
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Transporting Probes

When transporting a probe a long distance, store it in its carrying 
case.

Storing the Probe

It is recommended that all probes be stored in the provided 
carrying case for probe storage.

Carrying case:

• First place the probe connector into the carrying case.

• Carefully wind the cable into the carrying case.

• Carefully place the probe head into the carrying case. DO 
NOT use excessive force or impact the probe head.
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Operator Controls

Control Panel Map 

Controls are grouped together by function for ease of use. See 
the call-out for this figure on the following page.

 Figure 3-44. Console panel map

NOTE: Do not apply too much force to the TGC slide pots as this could 
damage the slide pots.

1. Power On/Off
2. Primary Menu keys
3. Next key
4. TGC
5. A/N Keyboard
6. User Defined keys
7. Report key
8. Utility key
9. Patient key
10. Preset key
11. Worksheet key

12. End Exam key
13. Archive key
14. Gain/AO key
15. Scan Coach keys 
16. Mode keys
17. Cursor key
18. Clear key
19. Comment key
20. Active key
21. Measure key
22. Body Pattern key

23. M/D Cursor key
24. Scan Area key
25. Set/B Pause key
26. Trackball
27. Depth/Zoom/Ellipse key
28. Left/Right key
29. Freeze key
30. Print key
31. Store key
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Keyboard

The standard alpha-numeric keyboard has some special 
functions.

Esc Exit current display screen.

Help (F1 Key) Access Online help.

Arrow (F2 Key) Annotation arrow.

Eject (F3 Key) Eject media.

Spooler (F4 Key) Activates DICOM Job Spooler screen.

Create a Fast Key 
(F5 Key)

Creates a Fast Key. 

Play a Fast Key (F6 
Key)

Plays a Fast Key. 

Home/Set Home 
(F7 Key)

Move annotation cursor to home position; shift+key to set 
current annotation cursor position as the new home position.

Text1/Text2 (F8 
Key)

Switch between user text annotation overlays.

Grab Last (F9 Key) Activate the last selected data for edit.

Word Delete (F10 
Key)

Erase word associated with comment cursor.

If you encounter a problem and cannot collect the logs 
immediately:

Alt+D Collect the logs.

Once the logs are collected, the engineering team would be able 
to see the marker you added which will help engineering to 
troubleshoot the problem.

NOTE: Logs can be collected by pressing Alt+D, Only when peripheral 
storage devices are connected.

Detachable keys

Report key, Scan Coach key, CF key, PDI key and User defined 
keys are detachable keys. 

Report, Scan Coach, CF and PDI are option features for the 
system, after the options are installed on the system, use the 
key caps in the option kits to replace the blank key caps.
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User Defined Key 

NOTE: The factory default settings for the User Defined Keys are TVI, 
LOGIQ View, Easy 3D and Report from top to bottom. The 
settings can be modified in Utility ->System -> User 
Configurable Key.

After programming the user defined keys in utility page, please 
adjust the key caps of user defined key on the control panel to 
match with the assigned function.

 Figure 3-45. User Configurable Key Preset Menu

Primary Menu keys

The Primary Menu keys contain exam function and mode/
function specific controls.

NOTE: Different Primary Menu are displayed depending on which 
function is selected.

Figure 3-46. Primary Menu keys

Press up/down buttons to adjust the value of the softmenu 
associated with it. Press Next to display the next group of 
Primary Menu.

The Primary Menu can be configured in Utility -> Application -> 
Imaging Controls.
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Button description

Mode, Display and Record

This group of controls provides various functions relating to the 
display mode, display orientation, image recording/saving, 
freeze, gain and Cine scroll.

The Mode Controls select the desired display mode or 
combinations of display modes.

• During dual display modes the L and R keys activate the 
Left or Right displayed image. See ‘Split Screen’ on 
page 6-6 for more information.

• Gain/AO is used to:

• Gain: rotate to adjust gain

• AO: press to initiate/turn off auto optimize.

• Depth/Zoom/Ellipse controls the image depth/width and 
activates the area/ellipse measurement function.

• Print key is used to activate/print the designated recording 
device.

• Store key is used to store the images/loops to the defined 
designation.

• The Freeze key is used to stop the acquisition of ultrasound 
data and freeze the image in system memory. Pressing 
Freeze a second time continues live image data acquisition. 

• To activate a specific mode, press the appropriate mode 
key. 
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Measurement and Annotation

This group of controls performs various functions related to 
making measurements, annotating and adjusting the image 
information.

• The Comment key enables the image text editor and 
displays the annotation library.

• The Clear key is generally used to erase functions, such as 
annotations/comments, body patterns and measurements. 
Pressing the Clear key again exits the selected function. 

• Press the Body Pattern control, it enables the Body Pattern 
and displays the default pattern on the screen. When body 
patterns are active, the knob rotates the probe position 
indicator. 

• Press Set to fix the measurement after the ellipse 
adjustment is complete. The measurement is then displayed 
in the measurement result window.

• The Measure key is used in all types of basic 
measurements. When the Measure key is pressed, the 
measurement menu is displayed. 

• The Set key is used for various functions, but is generally 
used to fix or finish an operation (e.g. to fix a measurement 
caliper).

• The Trackball is used with almost every key function in this 
group. Trackball control depends on the last key function 
pressed.
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Monitor Display

Monitor Display

 Figure 3-47. Monitor Display Tour
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Monitor Display  (continued)

1. Institution/Hospital Name, Date, Time, Operator 
Identification

2. Patient Name, Patient Identification
3. Power Output Readout
4. Probe Identifier. Exam Preset
5. Imaging Parameters by Mode     
6. Cine Gauge
7. Image manage controls 
8. Primary Menu 
9. Trackball Functionality Status
10. System messages
11. Caps Lock: (lit when on), network connection 

indicator (PC=connected, PC with X=not 
connected), Battery Icon/Plug Icon, InSite 
status, InSite controls

12. Current date and time

13. Image Preview 
14. Measurement Summary Window
15. Worksheet/Direct Report
16. Probe Orientation Marker
17. Region of interest. 
18. Gray/Color Bar 
19. Measurement Calipers
20. Measurement Results Window
21. Image Clipboard
22. Image
23. TGC
24. Depth Scale
25. Focal Zone Indicator
26. Body Pattern
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Using the Monitor Display Controls to Manage Images

You can manage images from the display via these on-display 
controls. 

Figure 3-48. Menu Icons

Active Images Page

Press Active Images Page to go to the Patient Active Images 
page. See ‘Active Images’ on page 4-19 for more information. 

Delete

You can use this to delete an image from the clipboard. 

To delete an image from the clipboard

1. Select the Cursor key to obtain a cursor arrow.

2. Place the cursor on the clipboard image you want to delete, 
then press Set to select the image.

3. Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm 
the action to perform.

4. Select Yes.

1. Active Images Screen
2. Delete Image
3. Next/Previous Image(s).

4. Save As Menu
5. Number of Images in Exam
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Next Clipboard Image

Press the left arrow to move to the previous image; press the 
right arrow to move to the next image.

Clipboard Slide Show

The Clipboard Slide Show plays all images on the clipboard and 
wraps around the ends. To activate, press and hold [Ctrl] + 
[Previous Arrow] or [Ctrl] + [next Arrow].

• Each image recalls for three seconds, or the length of the 
loop, whichever is longer.

• You can manually skip to a new image during the slide show 
by recalling it, as usual.

• To end the slide show manually, press [Ctrl] + [Previous]/ 
[Next] again.

• Slide Show ends when you go to live scanning, or if the 
clipboard is not shown when it’s time for the next image to 
load.

SaveAs menu

Activate SaveAs feature. See ‘Save As’ on page 15-9 for more 
information.

Number of Images in Exam

The number of images in an exam is tracked on the bottom of 
these Monitor Display Controls. 
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Chapter 4

Preparing for an Exam

Describes how to begin an exam.
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Beginning an Exam

Introduction

Begin an exam by entering new patient information.

The operator should enter as much information as possible, 
such as:

1. Dataflow

2. Exam category

3. Patient ID

4. Patient name

5. Exam Information

The patient's name and ID number is retained with each 
patient's image and transferred with each image during 
archiving or hard copy printing. 

CAUTION To avoid patient identification errors, always verify the 
identification with the patient. Make sure the correct patient 
identification appears on all screens and hard copy prints.
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Beginning a New Patient 

Pressing the Patient on the control panel displays the patient 
screen on the monitor.

Patient Screen

 Figure 4-1. Patient Screen Example

1. Patient Information

2. Probe information

3. Category Selection

4. Exam Information

Enter Patient Data with the alphanumeric keyboard.

To navigate through the Patient Entry menu, use the Tab key or 
Trackball and Set to move and fix the cursor.
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Patient Information

• Patient ID Number

• Other ID

The Other ID is used to add additional information of the 
patient, such as Citizen ID.

NOTE: To enable/disable the Other ID field, go to Utility --> 
Connectivity --> Miscellaneous.

NOTE: To select Other ID format, go to Utility --> Connectivity --> 
Miscellaneous.

• Patient Name–Last and First

• DOB- Date of Birth

• Age

• Gender

Probe information

It displays the active probes connected to the system. Select the 
appropriate probe for current exam.

Category Selection

Select from 8 exam application categories: Abdomen, 
Obstetrics, Gynecology, Cardiology, Vascular, Urology, Small 
Parts or Pediatrics.

When a category is selected, the measurement and category 
presets are displayed.

Exam information

Shows the Current/Active Exam information. Information 
pertinent to the selected exam category appears in the window. 
All possible information needs to be entered.
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Archive Screen

Pressing the Archive on the control panel displays the Archive 
screen on the monitor.

 Figure 4-2. Archive Screen 1

1. Image management: Select to manage the images

• Archive View–Provides a list of images per exam for the 
currently selected patient.

• Active Images–Provides preview of the currently 
selected exam.

• Data Transfer–Provides an interface to handle patient 
data from a remote device.

2. EZBackup: One-step method to backup patient images to 
an external media.

EZMove: Move and delete patient images.

3. Review: Select to review the image.

4. Thumbnail image: Provide a thumbnail image of current 
selected image.

5. Scan: Select to start scanning.
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Archive Screen  (continued)

 Figure 4-3. Archive Screen 2

6. Patient View: List the patients in the database.

7. Dataflow Selection: Select the appropriate patient dataflow.

8. Delete: Select to delete the selected patient.

9. Delete All: Select to delete all the patient.

10. Folder Information: Displays the Exam History of the 
selected patient.
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Dataflow Selection

Select the appropriate dataflow.

NOTE: If you use a DVD-R, select DICOM CD Read in Dataflow.

If you place the cursor on the icon, the pop-up menu displays 
disk capacity.

Figure 4-4. Dataflow Pop-up

Patient View Screen

Lists the patients in the database.

NOTE: When you double-click the patient on the patient list with the Set 
key, the Review screen displays.

• Search key–select search key item.

NOTE: If “Exam Date Between” is selected, the Input Dialog 
displays and you can select the date from the displayed 
calender.

NOTE: Img. Archived means that the exam was backed up to 
external media by EZBackup or Export.

• String–enter appropriate information.

If you select Archived (Y, N) for the Search key, enter Y 
(Yes) or N (No).

NOTE: If “Exam Date Between” is used for the Search key, the 
From and To dates are separated by a “-” (dash) in the 
Search String.

• Clear–Clears the entered string.

• Listing XX of XXX -- Displays the quantity of patients in the 
search window and the quantity of patients in the database.

• Delete–Deletes Patient/Exam.

NOTE: “Delete” is only displayed when you login as Administrator.
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Archive Screen  (continued)

• Folder View–Displays the Exam History of the selected 
patient. 

Disk - Displays the disk name on which you saved the 
exam’s image data.

See ‘Review images in archive’ on page 4-18 for more 
information.

See ‘Send To (Send the image to the DICOM Device)’ on 
page 15-32 for more information.

1. Prepare the unformatted CD-R or DVD-R or USB HDD 
before EZBackup. 

NOTE: Formatted CD-R or DVD-R cannot be used for EZBackup.

2. First perform EZBackup and then Backup (Patient Archive 
and Report Archive).

3. Go to the archive screen, select the patients/exams to 
delete. Select “Delete” to delete the selected data.

NOTE: Removing image data with the “EZMove” function does not 
reduce the patient number in the database.

NOTE: Ensure that all patients are exported or backed up BEFORE 
deleting them. 

CAUTION To maintain optimum performance and to safeguard patient 
data, keep the total number of patients in the database below 
1,000.

To reduce the total number of patients in the database, perform 
the following procedure.
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Scanning a New Patient 

WARNING Imaging functions may be lost without warning. Develop 
emergency procedures to prepare for such an occurrence.

WARNING Ensure you have selected a dataflow. If No Archive is selected, 
no patient data is saved. It displays as below if No Archive is 
selected.

CAUTION To avoid patient identification errors, always verify the 
identification with the patient. Make sure the correct patient 
identification appears on all screens and hard copy prints.

CAUTION Always use the minimum power required to obtain acceptable 
images in accordance with applicable guidelines and policies.

CAUTION Always use the system on a flat surface in the patient 
environment.

CAUTION Ensure that the hands of the patient are away from the system 
during the exam. 

The position of the operator and the patient vary by scan 
region.

In most case, the operator sits/stands straight in front of the 
operator console and the patient lies on the bed on the right (or 
left) side of the system.
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Scanning a New Patient  (continued)

When starting a new patient’s exam, ensure you do the 
following: 

1. Select Patient on the control panel. 

Figure 4-5. Create a new patient

2. Patient ID will be generated automatically by the system. 
The operator is able to edit the Patient ID and fill in other 
patient information. 

3. Select the probe and application. 

4. Select Scan to start scanning. 

5. Perform the exam. 

If the patient information needs to change while scanning, 
select Patient again. If the probe or preset needs to change 
while scanning, select Preset again.

6. Press Store key to store the static image or cineloop saved 
in the exam to the clipboard.

7. When the scanning is complete, select End Exam on the 
control panel to end current patient. The system 
permanently stores all images of the current patient 
automatically.

The system creates the new patient and the new folder to 
store all images in the archive screen. Each patient has only 
one folder per day, regardless how many exams are 
performed in that day.
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Starting a new exam on an existing patient

1. Select Archive on the control panel.

2. Select the patient from the Patient List.

3. Select Scan to enter into scanning, perform the exam.

If the patient information needs to change while scanning, 
select Patient.

4. Select Preset on the control panel to select the probe and 
application.

If the probe and preset needs to change while scanning, 
select Preset again.

5. Press Store key to store the static image or cineloop saved 
in the exam to the clipboard.

6. When you have completed the study, select End Exam on 
the control panel to end current patient. The system 
permanently stores all images of the current patient 
automatically.

A new folder is automatically created on that patient unless 
an folder already exists on that day for that patient.
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Scanning without entering any patient data

To scan a patient without entering any patient data until the end 
of the exam:

1. Select End Exam on the control panel to end the last 
patient’s exam. The system permanently stores all images 
of that patient automatically.

2. Scan the new patient and save images to the clipboard 
without patient information. The system displays a warning 
message “Warning: A patient must be selected for 
permanent storage of image”. Select OK.

3. Select Patient on the control panel to create a new patient, 
the following dialog displays if there is unsaved exam data.

Figure 4-6. Unsaved Exam Data

a. Store All (Auto ID). Store the unsaved data to the 
patient that is auto created by the system, and then a 
new patient screen displays.

b. Link to new patient. A new patient screen displays, 
and link the unsaved images to the new patient.

c. Delete All. Delete all the unsaved images, and then a 
new patient screen displays.

d. Cancel. Do nothing with the unsaved data, and return to 
scanning.
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Changing Current Scanning Patient to an Existing Patient 

To change the current scanning patient (with/without patient ID) 
to an existing patient, when there are some unsaved images on 
the clipboard for the current patient:

1. Scan current patient and store images/cineloops to the 
clipboard

2. Press Archive on the control panel to go to Archive Screen 
and select the existing patient.

Figure 4-7. Unsaved Exam Data (Archive)

3. The option is different if the current patient is with or without 
patient ID. 

a. With Patient ID: Store All (xxx). Store the unsaved data 
under the patient ID. The patient ID should be the 
current patient ID.

Then Select Scan to begin scanning, a dialog displays: 
”Current Patient will be changed to ID: xxx. Do you want 
to continue?” Select Yes to change to the selected 
patient, select No to keep the current patient.

b. Without Patient ID: Store All (Auto ID). Store the 
unsaved data to the patient that is auto created by the 
system.

4. Review Images. Review the unsaved images in Active 
Image page.

Then Select Scan to begin scanning on the current patient.

5. Delete All. Delete all the unsaved images.

Then Select Scan to begin scanning, a dialog displays: ”Do 
you really want to delete all temporary images?” Select Ok 
to delete all temporary images, select Cancel to do nothing 
with the unsaved data, and return to Archive page.

6. Cancel. Do nothing with the unsaved data, and return to 
Archive page.
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End Exam

End Exam should be selected at the end of each exam. The 
system will automatically store all images of current patient 
permanently.

The system creates the new patient and the new folder to store 
all images in the archive screen. Each patient has only one 
folder per day, regardless how many exams are performed in 
that day.



Beginning an Exam

LOGIQ V2/LOGIQ V1 – Basic User Manual 4-15
Direction 5610735-100 English Rev. 2

Retrieving and editing archived information

Searching for an existing patient

1. Select Archive to display the Patient Screen.

2. Select the search key. Enter the search string.

NOTE: When the number of patients on a hard disk is in the 
hundreds, it takes time to search for a patient or switch to 
another screen. In this case, do one of the following:

• Uncheck the “Auto search for patient” preset, found 
under Patient/Exam Menu Options in Utility -> 
Connectivity -> Miscellaneous.

• Delete unnecessary patient data.

3. An appropriate patient is displayed.

Figure 4-8. Patient Search Screen

Select Delete to delete this patient. See ‘Deleting the 
existing patient’ on page 4-17 for more information..

NOTE: “Delete” is only displayed when you login as Administrator.
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Changing Patient Information

NOTE: The patient information can be changed only when the an folder 
already exists on that day for that patient.

To Change Patient information or an exam: 

1. Select the patient for the patient list in the Archive Screen if 
the patient is not active

2. Press Patient on the control panel to display patient screen

3. Modify patient information.

NOTE: The patient information can be changed only when the an folder 
already exists on that day for that patient.

CAUTION The user is responsible for patient data, diagnostic information 
or any other patient related information entered in the 
database.
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Deleting the existing patient/exam/image

Deleting the existing patient

1. Search and select the patient in the patient list.

2. Select Delete. The confirmation dialog box displays.

NOTE: “Delete” is only displayed when you login as Administrator.

3. Select OK to delete or Cancel.

Delete multiple patients from the patient list 

1. Select the multiple patients to be deleted from the patient list 
with Ctrl or Shift keys.

2. Select Delete. The confirmation dialog box displays.

3. Select OK to delete or Cancel.

Deleting the existing exam

1. Search the patient in the patient list.

2. Select Folder View or double click the patient name by Set 
key to review the exam.

3. The patient exam screen displays. Select the exam to be 
deleted.

4. Select Delete Folder. The confirmation dialog box displays.

5. Select OK to delete or Cancel. 

Deleting the existing image

1. Search and select the patient in the patient list.

2. Select the exam which contains the image to be deleted.

3. Select Active Images to display the image list.

4. Select the image to delete and select Delete. The 
confirmation dialog box displays.

5. Select Yes to delete or No to cancel. 

CAUTION Before deleting a patient or image from the Patient view page, 
make sure you have already saved the data with EZBackup/
EZMove or Export. Verify the media before deletion.
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Review images in archive

There are two ways to access to archived images:

• Review the images in Archive view Screen.

• Review the images in Active images screen.

Review the patient exam/image

To review the patient exam, 

1. Move the cursor to the patient in the Patient View and 
double-click. Folder View displays.

or

Move the cursor to the patient and select Folder View tab. 
Folder View Displays.

2. Move the cursor to the desired exam and double-click.

3. Active Images screen displays. Move the cursor to the 
image and double click or press Review. 

4. The review screen displays. Select the image from 
clipboard.

NOTE: See ‘Clipboard’ on page 15-6 for more information.
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Active Images

Active Images displays the images of the exam.

NOTE: CINE loops are not played interactively as you view the active 
images on the Archive screen.

 Figure 4-9. Active Images Screen

1. Select the exam which includes the image to review.

2. Select Active Images.

3. Select the image and press Review or double click on the 
image. The image is displayed.

If you select 2 - 4 images and select Review, the archived 
images are displayed in the split screen. 
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Active Images  (continued)

Analyzing Images

To analyze the archived images, select the image, then select 
Review. The archived images is displayed with the date and 
time of archival. 

To compare the analyzed image to a live image, press L/R. Now 
both the archived and live images appear on the monitor display. 
Unfreeze the live image area. 

Table 4-1:  Active Images

Parameters Description

Review Select the image and press Review, the image is displayed.

Permanent Store Select the images which you want save to the Local hard disk drive.

Standard Print To print an image, 
1. Select the image you want to print from the Active Images screen. You 

can print one (1) image per sheet or 2x3 images per sheet. 
2. Press Standard Print. 
NOTE: If the printer is not assigned to the button, you will get a message 
telling you to Check Printer Button Configuration. 
NOTE: There is no warning to let you know that the printer is not functioning. 
Check the printer. 
You need to configure the printer to the Standard Print button via Utility --> 
Connectivity --> Button. 

Delete To delete images, select the images in the active screen, then select 
“Delete” on the monitor display. 

Image Property Select to display image Property.

Select All/Unselect All Select SelectAll to select all images.
Select UnselectAll to deselect all images.

SaveAs Images Refer to ‘’SaveAs’ Images’ on page 15-13 for the detail.
You can select the multiple images collectively in Active Image screen which 
you want save by SaveAs.
NOTE: We suggest that you save the images page by page with ’SaveAs’ 
Images in Active Images. It takes time if you have many images or raw data. 

Send To Refer to ‘Send To (Send the image to the DICOM Device)’ on page 15-32 for 
the detail.
Note: “Send To” button is not displayed in Active Images menu if the patient 
is not selected.
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Selecting an Application Preset and a probe 

Selecting an Application Preset

The exam category preset that best describes the desired exam 
to be performed is chosen after the exam category is selected. 
The factory default preset selections are displayed on the menu 
area.

Use these parameters as a starting point for the exam.

User-Defined Application Presets

There are four user-defined application presets that can be set 
on the system.

To set up User-Defined Application Presets, 

1. Press Preset on the control panel, then select User Preset. 
The Create New Application menu appears.

 Figure 4-10. Create New User Application Menu
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User-Defined Application Presets  (continued)

2. Type the name of the new application, select Save. The new 
application now appears on the menu area.

 Figure 4-11. User Application Menu

NOTE: The name of the new application must start with letter or _, 
and contain a-z, A-Z, 0-9, _. 

NOTE: You can set up to four (4) user-defined model presets for 
each exam category. 

3. To view/edit the parameters for the user-defined preset, 
press Utility --> Imaging. 

NOTE: If you select Reload Factory Defaults for the User-Defined 
application that you created, the settings for this 
user-defined application revert back to the factory settings 
for the exam category and application it was based upon. 

NOTE: You cannot delete a user-defined application. However, you 
can change it by overwriting the user-defined application 
you want to delete with a new one. 

Selecting a probe

• Always start out with a probe that provides optimum focal 
depths and penetration for the patient size and exam.

• Begin the scan session using the default Power Output 
setting for the probe and exam.
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Chapter 5

Optimizing the Image

Describes how to adjust the image. This chapter is 
broken into the following sections: B-Mode, M-Mode, 
Color Flow Mode, M Color Flow, Doppler Mode, Using 
Easy 3D Mode and TruScan.



Optimizing the Image

5-2 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Optimizing B-Mode

Intended Uses

B-Mode is intended to provide two-dimensional images and 
measurement capabilities concerning the anatomical structure 
of soft tissue. 

Figure 5-1. B-Mode Display -- Representative Example

B Mode Primary Menu

Different parameters can be assigned to the Primary Menu, the 
Primary Menu can be configured in Utility -> Application -> 
Imaging Controls.
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Typical B-Mode Exam Protocol

A typical examination using B-Mode might proceed 

1. Record exam-related patient information. Verify system 
setup (probes and presets). 

2. Position the patient and the console for optimum operator 
and patient comfort. Perform the scan. 

3. Complete the study by collecting all the data. 

CAUTION Ensure that the hands of the patient are away from the system 
during the exam. 

The position of the operator and the patient vary by scan 
region.

In most case, the operator sits/stands straight in front of the 
operator console and the patient lies on the bed on the right (or 
left) side of the system.

CAUTION Always use the minimum power required to obtain acceptable 
images in accordance with applicable guidelines and policies.
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B-Mode Scanning Hints

HINTS These B-Mode controls produce the following results: 

Auto Optimize. Automatically improves the contrast resolution 
of the image by changing the gray scale to match the image 
data. Available in B-Mode and Doppler Mode. 

Coded Harmonics. Enhances near field resolution for 
improved small parts imaging as well as far field penetration. 

Frequency. Changes system parameters to best optimize for a 
particular patient type. 

Gray Map. Affects the presentation of B-Mode information. 
Choose the gray map prior to making other adjustments. There 
is an interdependency between gray maps, gain, and dynamic 
range. If you change a map, revisit gain and dynamic range 
settings. 

Dynamic Range. Changes the amount of gray scale 
information displayed. A higher dynamic range shows more 
gray scale information displayed, while a lower dynamic range 
displays less gray scale information onto the same display 
scale. If you increase the gain, you may want to decrease the 
Dynamic Range. 

Frame Average. Smooths the image by averaging frames. 
Affects the amount of speckle reduction. 

TGC. Adjust TGC to adjust Gain in specific areas. 

Focus Zones. Focal zones should be placed roughly in the 
lower half of the display depth, at or below the organ of interest.

Width. Sizes region of interest. Adjust the Width to the smallest 
reasonable size to maximize frame rate. 
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Depth

Description Depth controls the distance over which the B-Mode images 
anatomy, and the field of view. To visualize deeper structures, 
increase the depth. To visualize flatter structures, decrease the 
depth.

Adjusting Each adjustment cycles you to the next Depth setting. Imaging 
and display parameters adjust automatically. 

To increase/decrease, adjust Depth. 

Preset You can set the depth by probe and application on the Utility --> 
Imaging page. 

Values Depth increments vary by probe and application. Depth displays 
on the monitor in centimeters. 

Depth values are returned to the factory or user preset value 
when you change the following: Patient/Preset, Exam Calc, or 
End Exam. 

Benefits Depth adjusts your field of view. It increases your field of view to 
look at larger or deeper structures; it decreases your field of 
view to look at structures near the skin line. 

Affect on other 
controls

After adjusting the depth, you may need to adjust the TGC and 
focus. 

Changing the depth may change the TI and/or MI. Observe the 
output display for possible effects.

HINTS Make sure enough space is left below the anatomy of interest 
to demonstrate shadowing or enhancement. 
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Gain

Description B-Mode Gain increases or decreases the amount of echo 
information displayed in an image. It may have the effect of 
brightening or darkening the image if sufficient echo information 
is generated. 

Adjusting To decrease/increase, rotate Gain.

Gain values vary depending on the probe; they are not 
associated with a particular position of the knob. 

NOTE: B-Mode gain is independent of M-Mode and Doppler and Color 
Flow Gain. Changing the M-Mode Gain while in M-Mode does 
not affect the B-Mode image gain.

Preset You can set gain by probe and application on the Utility --> 
Imaging page. 

Values Gain displays on the monitor in Gn. Maximum gain varies by 
probe. Gain values vary by probe, application, and frequency 
setting. 

NOTE: Maximum gain is factory preset to an optimum setting to 
eliminate noise in the display. 

Gain values are returned to the factory or user preset value 
when you change the following: Probe, Exam Category/Exam 
Calc, or Patient. 

Benefits Gain allows you to balance echo contrast so that cystic 
structures appear echo-free and reflecting tissue fills in. 

Affect on other 
controls

After you adjust the Power Output, you may need to adjust the 
gain. Generally speaking, if you increase the Power Output, you 
need to decrease the gain; if you decrease the Power Output, 
you need to increase the gain. Gain and TGC interact by adding 
together. 

Bioeffects Gain has no affect on Power Output. However, with increased 
gain, the power output level can usually be reduced to produce 
an equivalent image quality. 

NOTE: Always optimize gain before increasing the Power Output. 
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Focus

Description Increases the number of focal zones, moves the focal zone(s) 
and changes the zone width so that you can tighten up the beam 
for a specific area. A graphic corresponding to the focal zone 
position(s) appears on the right edge of the image. 

Adjusting To increase/decrease the number of focal zones, adjust Focus 
Number.

To move the focal zone to the near/far field, adjust Focus 
Position.

NOTE: You can set the focus (Depth % and Number, and Number 
CrossXbeam) by probe and application on the Utility--> Imaging 
page. 

Values Focus zone number and position vary depending on the depth, 
zoom, probe, application, and frequency setting selected. 

Focal zone number values are returned to the factory or user 
preset value when you change the following: Probe, Exam 
Category, Exam Calc, or Patient.

Benefits Focus optimizes the image by increasing the resolution for a 
specific area. 

Affect on other 
controls

Changing the focal number affects the frame rate. The greater 
number of focal zones, the slower the frame rate. 

Bioeffects Changing the focal zone may change the TI and/or MI. Observe 
the output display for possible effects.
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Auto Optimize

Description Auto Optimize (Auto) lets you optimize the image based upon 
the actual B Mode image data (Auto Tissue Optimize, ATO). The 
preset levels (Low, Medium, and High) allow you to pick a 
preference for the contrast enhancement in the resulting image. 
Low does the least amount of contrast enhancement, high does 
the most. 

Auto is available in single or multi image, on live, frozen or CINE 
images (in B-Mode only), and while in zoom and in Spectral 
Doppler.

Auto in PW Doppler Mode (ASO: Auto Spectral Optimization) 
optimizes the spectral data. Auto adjusts the Velocity Scale/PRF 
(live imaging only), baseline shift, dynamic range, and invert (if 
preset). Upon deactivation, the spectrum is still optimized. 

Benefit Auto can be found in reduced optimization time and a more 
consistent and accurate optimization process. 

Adjusting To activate Auto, press AO key. 

Press AO key again to turn off Auto.

Preset Specify the ATO Level: Low, Medium, or High via Utility --> 
Imaging --> B-Mode. 

Specify the Auto Invert on ASO for Doppler mode: On or Off via 
Utility --> System -> System Imaging.   

Values Auto is active until you deactivate it or when you change the 
following: Probe, Exam Category, Exam Calc, or Patient. 

Affect on other 
controls

You may need to adjust the Gain. 
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CrossXBeam

Description CrossXBeam is the process of combining three or more frames 
from different steering angles into a single frame. CrossXBeam 
is available on Convex and Linear probes. 

CrossXBeam combines multiple co-planar images from different 
view angles into a single image at real-time frame rates, using 
bi-cubic interpolation. 

Adjusting To activate CrossXBeam, select CrossXBeam.

To adjust the number of frames being compounded, adjust 
CrossXBeam.

Select CrossXBeam Type (Off, Low, Medium or High) for 
Convex probe. Select CrossXBeam Type (Off, Low, Medium, 
High or Max) for Linear probe. Max detects maximum values; 
Mean detects averaged values; Hybrid detects a mix of both 
average and maximum values.

Preset You can preset B-Mode CrossXBeam: 

• Preset the CrossXBeam # 

• Preset Focus Number for CrossXBeam

• Preset Line Density CrossXBeam

• Preset Focus Width for CrossXBeam

• Frame Average CrossXBeam

These presets can be made via the Utility --> Imaging page. 
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CrossXBeam  (continued)

Values CrossXBeam is available on Convex and Linear probes. Multiple 
focal zones are supported. B-Mode CrossXBeam is available 
while in B-Mode, Color Flow, or PW Doppler Mode. Steering is 
optimized by probe. The displayed compound image depth is 
equal to the image depth of the non-steered frame. 

The following features are supported in CrossXBeam: 

• Harmonic Imaging

• CINE Loops acquired using CrossXBeam. 

• Read Zoom

• All Measurement and Analysis packages

• SRI HD, Rejection, Colorize, Revert, Edge Enhance, Gray 
Map, Rotation, Biopsy Kit, Dynamic Range, Depth, TGC, 
Gain, Acoustic Output, Auto, Virtual Convex, LOGIQ View 
and Easy 3D.

Benefits The combined single image has the benefits of reduced speckle 
noise, reduced clutter, and continuity of specular reflectors. 
Therefore, this technique can improve contrast resolution with 
increased conspicuity of low contrast lesions, better detection of 
calcifications, biopsy needle visualization, and cystic boundary 
definition. 
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SRI-HD (High Detection Speckle Reduction Imaging) 

Description SRI-HD (High Detection Speckle Reduction Imaging) is an 
adaptive algorithm to reduce the unwanted effects of speckle in 
the ultrasound image. Image speckle usually appears as a 
grainy texture in otherwise uniform areas of tissue. Its 
appearance is related to image system characteristics, rather 
than tissue characteristics, so that changes in system settings, 
such as probe type, frequency, depth, and others, can change 
the appearance of the speckle. Too much speckle can impair 
image quality and make it difficult to see the desired detail in the 
image. Likewise, too much filtering of speckle can mask or 
obscure desired image detail. Extra care must be taken to select 
the optimal SRI-HD level. 

SRI-HD is available in B-Mode imaging and may be used with 
any transducer or clinical application when image speckle 
appears to interfere with the desired image detail. 

Figure 5-2. B-Mode Image before SRI-HD (left) and 
After SRI-HD (right)
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SRI-HD (High Detection Speckle Reduction Imaging)  (continued)

Values We recommend that you select the SRI-HD level by observing 
the enhanced image in side-by-side dual image comparison with 
the original, unprocessed image. Dual display mode is activated 
by pressing the L and R keys simultaneously. 

In selecting the level of SRI-HD, you must observe the effects of 
SRI-HD in the desired region of interest and should make a 
real-time comparison with the original image. The optimal level 
depends on the clinical situation and improves with experience. 
Observing the original and SRI-HD-processed images together 
helps to determine whether too much or too little SRI-HD has 
been applied. 

Dual image mode for SRI-HD can also be activated on a stored 
CINE Loop. This allows you to always see the original, 
unprocessed or enhanced image by going into the Dual display 
mode and to change the SRI-HD settings when reviewing the 
CINE Loop. 

SRI-HD is available on 3D.

• You cannot change SRI-HD after the scan starts.

• The effects for the rendered image are less than the 
2D-image.

Benefits Smooths the image when image speckle interferes with the 
desired image detail. 
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Coded Harmonic Imaging (CHI)

Description Harmonic imaging utilizes Digitally Encoded Ultrasound (DEU). 
Coded Harmonics enhances near field resolution for improved 
small parts imaging as well as far field penetration. 

Adjusting To activate Coded Harmonic imaging, press CHI key on the 
control panel. 

NOTE: You can assign CHI On/Off function to the User Defined key. 
See ‘System/User Configurable Key’ on page 16-35 for more 
information. 

NOTE: You can specify the parameters for CHI in Utility -> Imaging -> 
HAR. 

Values On/Off. ’CHI’ appears in place of ‘B’ in the imaging parameters. 

Benefits Coded Harmonics diminishes low frequency high amplitude 
noise and improves imaging technically difficult patients. Coded 
Harmonics may be especially beneficial when imaging isoechoic 
lesions in shallow-depth anatomy in the breast, liver, and 
hard-to-visualize fetal anatomy. 

Bioeffects Activating CHI mode may change the TI and/or MI. Observe the 
output display for possible effects. 

Frequency

Description Multi Frequency mode lets you downshift to the probe's next 
lower frequency or shift up to a higher frequency. 

Adjusting Adjust Frequency until the desired frequency is selected.   

The selected frequency appears as “Frq” in the upper, 
right-hand portion of the monitor display.

NOTE: Frequency change is not active when the image is frozen. 

NOTE: Changing frequency resets those parameters which are 
presettable by frequency to their preset values for the current 
frequency. 

Values Vary, depending on the probe and application. 

Frequency values are returned to the factory or user preset 
value when you change the following: Probe, Exam Category, 
Exam Calcs, or begin a new patient. 

Benefits This optimizes the probe's wide band imaging capabilities at 
multiple frequencies to image at greater depths. 

Bioeffects Adjusting frequency may change the TI and/or MI. Observe the 
output display for possible effects. 
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B Steer

Description You can slant the B-Mode or Color Flow acoustic beam without 
moving the probe. The steer function only applies to linear 
probes. The steer function is only available in CrossXBeam Off.

Adjusting To slant the linear image to the left/right, adjust B Steer.

Values Linear probes can be steered left, center, or right up to a 
maximum of 15 degrees, depending on the probe.

Steer values are returned to factory or user preset value when 
you change: Probe, Exam Category, Exam Calcs, or Patient.

Preset Preset the steer angle via Utility --> Imaging --> B --> B Steer.

Benefits Slant the linear image left or right to get more information 
without moving the probe.

Bioeffects Activating steer may change the TI and/or MI. Observe the 
output display for possible effects.

M/D Cursor

Description Displays the M/D-Mode cursor on the B-Mode image. 

Adjusting To activate/deactivate the M/D-Mode cursor, press M/D Cursor 
key. Trackball to position M/D-Mode cursor. Adjust Angle and 
SV Length as necessary. 

Benefits Lets you position the cursor before you go into M-Mode or 
Doppler Mode so that you can make optimum use of the larger 
B-Mode image. 

Virtual Convex

Description On Linear and Sector probes, Virtual Convex provides a larger 
field of view in the far field. 

Adjusting To activate/deactivate Virtual Convex, select Virtual Convex.

Values On/Off

Benefits Virtual Convex allows for a wider field of view. Available in 
B-Mode, Color Flow Mode, and Doppler Mode. CrossXBeam is 
available on Virtual Convex with linear probes. 

Bioeffects Activating Virtual Convex may change the TI and/or MI. Observe 
the output display for possible effects. 
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TGC

Description TGC amplifies returning signals to correct for the attenuation 
caused by tissues at increasing depths. TGC slide pots are 
spaced proportionately to the depth. The area each pot 
amplifies varies as well. A TGC curve may appear on the display 
(if preset), matching the controls that you have set (except 
during zoom). You can choose to deactivate the TGC curve on 
the image. 

Adjusting To decrease/increase TGC, move slide pot to the left/right.

Values When you change the depth, TGC is rescaled across the new 
depth range. Each pot is proportionately scaled across the 
depth.

Preset TGC Display On/Off -- preset via Utility --> System --> System 
Imaging. 

Benefits TGC balances the image so that the density of echoes is the 
same throughout the image. 

Scan Area

Description You can widen or narrow the size of the sector angle to 
maximize the image's region of interest (ROI). 

Adjusting To narrow/widen the angle, press Scan Area until the Width is 
highlighted, then move the Trackball to move left/right to 
decrease/increase the angle size. Then press Scan Area to set 
the ROI.

Values Varies, depending upon the probe (not applicable to linear 
probes) and application.

Benefits Increase the sector angle to see a wide field of view; decrease 
the sector angle when you need to have a faster frame rate, as 
in fetal heart. 

Affect on other 
controls

Changing the sector angle affects the frame rate. The narrower 
the sector angle, the faster the frame rate. 

Bioeffects Changing the sector angle may change the TI and/or MI. 
Observe the output display for possible effects. 

CAUTION Do not apply too much power to the TGC slide pots as this 
could damage the slide pots.
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Tilt

Description You can steer the sector angle to get more information without 
moving the probe while in B-Mode, M-Mode, Doppler Mode, and 
Color Flow Mode. Tilt is not available on Linear probes. Tilt 
disappears when CrossXBeam is activated. 

Adjusting To tilt the angle to the left/right, press Scan Area until Tilt is 
highlighted, then move the Trackball to the left/right.

Values Varies, depending on the probe.

Benefits Allows you to move a reduced sector angle laterally, without 
moving the probe. Beneficial in GYN. 

Bioeffects Steering the sector angle may change the TI and/or MI. Observe 
the output display for possible effects. 

Dynamic Range

Description Dynamic Range controls how echo intensities are converted to 
shades of gray, thereby increasing the adjustable range of 
contrast.

Adjusting To increase/decrease, adjust Dynamic Range.

Values Dynamic Range values vary by probe, application, and 
frequency setting.

Dynamic Range levels are returned to the factory or user preset 
value when you change the following: Patient/Preset, Exam 
Calcs, Probe, or Multi Frequency.

Benefits Dynamic Range is useful for optimizing tissue texture for 
different anatomy. Dynamic Range should be adjusted so that 
the highest amplitude edges appear as white while lowest levels 
(such as blood) are just visible. 

Affect on other 
controls

Dynamic range operates in real-time, Freeze and CINE. It also 
affects Gain. 
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Revert 

Description Flips the image 180 degrees left/right. 

Adjusting To flip the image 180 degrees, select Revert. 

Values The image rotates in 180 degrees left/right. Revert settings vary 
by probe and application.

Revert settings are returned to the factory or user preset value 
when you change the following: Probe, Exam Category, Exam 
Calcs, or Patient.

Benefits Used for anatomical correctness. 

NOTE: The Image can be easily identified as being reversed as the 
LOGIQ V logo will be on the opposite side of the image monitor.

CAUTION When reading a reverse image, be careful to observe the probe 
orientation to avoid possible confusion over scan direction or 
left/right image reversal. 
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Line Density

Description Optimizes B-Mode frame rate or spatial resolution for the best 
possible image. 

Adjusting Adjust Line Density to increase resolution or to increase frame 
rate.

Select the default value via Utility -> Imaging -> B -> Line 
Density and press Save. 

Values Varies by probe.

NOTE: Not available in cine mode. 

Values vary by probe and application. Line Density values are 
returned to the factory or user preset value when you change 
the following: Probe, Exam Category, Exam Calcs, or Patient.

Benefits A lower line density is useful in fetal heart beat, adult cardiac 
applications and in clinical Radiology applications requiring 
significantly higher frame rates. 

A higher line density is useful in obtaining very high resolution, 
e.g., thyroid, testicles. 

Affect on other 
controls

Line density changes the vector density and frame rate.

Bioeffects Activating color flow line density may change the TI and/or MI. 
Observe the output display for possible effects. 

Line Density Zoom

Description You can set the default value for Line Density in zoom 
independently. 

Adjusting Select the default value via Utility -> Imaging -> B -> Line 
Density Zoom and press Save. 
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Colorize

Description Colorize is the colorization of a conventional B-Mode image or 
Doppler Spectrum to enhance the user's ability to discern B, M, 
and Doppler Mode intensity valuations. Colorize is NOT a 
Doppler Mode. 

NOTE: You can colorize real-time or CINE images. 

Colorizes the gray scale image to enhance the eye's 
discrimination capability. 

Spectrum Colorize colorizes the spectrum as a function of power 
using the inverse of the Colorize map for the signal intensity in 
each Doppler line. 

Colorize enhances the visibility of the spectrum's characteristics 
and enhances your ability to identify spectral broadening and 
the edge contours of the spectrum used to define the peak 
frequency/velocity. 

The gray bar displays while Colorize is activated. 

Adjusting To activate Colorize, 

1. Select Colorize. 

2. Trackball to cycle through available maps. 

3. Press Set to select. 

To deselect, select a gray map. 
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PRF

Description Reduces noise artifacts in the image. When you activate PRF, 
the frame rate decreases and the noise artifacts are filtered. 

NOTE: Available for only Cardiac application.

Edge Enhance

Description Edge Enhance brings out subtle tissue differences and 
boundaries by enhancing the gray scale differences 
corresponding to the edges of structures. Adjustments to 
M-Mode's edge enhancement affects the M-Mode only. 

Adjusting To cycle through settings, adjust Edge Enhance.

Values Values vary by probe, application and multi frequency setting. 
Edge Enhance values are returned to the factory or user preset 
value when you change the following: Probe, Exam Category, 
Exam Calcs, or Patient.

Benefits Edge Enhance cleans out the B-Mode image/M-Mode time line 
by subduing some of the gray scale in order to highlight the 
vessel wall or organ. This is helpful when you cannot 
differentiate between the chambers of the heart. 

Affect on other 
controls

Edge Enhance operates in real-time only; not in Freeze or CINE.

Frame Average

Description Temporal filter that averages frames together, thereby using 
more pixels to make up one image. This has the effect of 
presenting a smoother, softer image. 

Adjusting To adjust frame averaging, adjust Frame Average.

Values Values vary by probe, application and multi frequency setting. 
Frame Average values are returned to the factory or user preset 
value when you change the following: Probe, Exam Category, 
Exam Calcs, or Patient.

Benefits Smooths the image. 
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Gray Map

Description The system supplies B, M, and PW Mode system maps.

In Doppler mode, the Clear map offers a bluish coloring 
compared to the standard gray map. Clear Maps provide a more 
transparent map. Clear maps are displayed under gray maps.

Adjusting To select a map, select the Gray Map. A map window displays. 
The image reflects the map as you go through the selections.

Values Map values vary by probe, application, and frequency setting. 
Map values are returned to the factory or user preset value 
when you change the following: Probe, Preset, Exam Calcs, or 
Patient. 

Rejection

Description Selects a level below which echoes will not be amplified (an 
echo must have a certain minimum amplitude before it will be 
processed).

Benefits Allows for the elimination of lower echoes (caused by noise) 
from the display.

Rotation

Description Flips the image 180 degrees up/down. 

Benefits Beneficial in transvaginal scanning. 

Suppression

Description Suppresses the noise in the image. 

CAUTION When reading a rotated image, be careful to observe the probe 
orientation to avoid possible confusion over scan direction or 
left/right image reversal. 
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Needle Recognition

Description Needle recognition allows you to obtain better needle imaging in 
the area surrounded by the yellow dashed line (Figure 5-3.a). 
Needle recognition functionality is only available with linear 
probes (12L-RS, L6-12-RS). 
Figure 5-3.b illustrates the position between the needle and 
probe. Needle recognition can only enhance in-plane needles. 
The needle angle is defined as the angle between the needle 
and probe surface.

Figure 5-3. a. Enhanced area                b. Needle Angle

NOTE: Needle Recognition is only available in B/CF/PDI.

NOTE: Define a key from U1 - U4 on the control panel for activating/
deactivating Needle via Utility -> System -> User Configurable 
Key.

Adjusting • Activating Needle Recognition:

Press the key assigned for Needle on the control panel to 
activate Needle Recognition

• Adjusting steer direction:

Press the key assigned for Needle on the control panel to 
adjust the steer direction.

• Adjusting the needle recognition beam angle:

Adjust Beam Angle by rotating the Primary Menu control. 
Max available angles are up to 50 degrees on 12L-RS, 30 
degrees on L6-12-RS.

a b

1. Enhanced area
2. Needle guide line 
3. Unenhanced area

1. Needle
2. Probe
3. Needle angle
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Needle Recognition  (continued)

NOTE: Adjust the needle recognition steering angle to form the 
needle and the beam angle as perpendicular as possible to 
get the best needle enhancement.

NOTE: To help verify the location and trajectory of the needle tip, please 
use needle movement and / or fluid injection.

NOTE: Make sure the needle is always in the ultrasound plane by 
slightly moving or tilting the probe to get the best needle 
enhancement during the needle procedure.

Preset Needle Direction - preset via Utility -> Imaging -> B Tab.

Beam Angle - preset via Utility -> Imaging -> B Tab.

Needle Gain - preset via Utility -> Imaging -> B Tab.

Needle Thickness - preset via Utility -> Imaging -> B Tab.

Benefits Provides better biopsy needle visualization than normal B-Mode 
with steered beam angle and post processing.

Bioeffects Activating angle Needle Recognition may change the TI and/or 
MI. Observe the output display for possible effect.
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LOGIQ View (Option)

Description LOGIQ View provides the ability to construct and view a static 
2D image which is wider than the field of view of a given 
transducer. This feature allows viewing and measurements of 
anatomy that is larger than what would fit in a single image. 
Examples include scanning of vascular structures and 
connective tissues in the arms and legs. 

LOGIQ View constructs the extended image from individual 
image frames as the operator slides the transducer along the 
surface of the skin in the direction of the scan plane. The quality 
of the resulting image is somewhat user-dependent and requires 
some additional skill and practice to develop proper technique 
and become fully proficient. 

LOGIQ View is not available for the following: 

• Multi Image

• Timeline Modes

• Color Flow Mode

• PDI Mode

Benefits The user can look at a larger region of interest within one field of 
view that is wider than any given probe would normally provide. 

Clinical Use LOGIQ View is intended for scanning areas too large to fit on 
one image. 

Using LOGIQ View To perform an exam using LOGIQ View, 

1. Perform a detailed examination of the anatomy/pathology. 
Optimize parameters for tissue texture and visible window 
PRIOR TO activating LOGIQ View. 

2. Press the user defined key for LOGIQ View. 

3. To start acquiring the image, press L key.

HINTS When you scan, scan slowly and in a uniform motion 
lengthwise, end-to-end (with or against the probe orientation 
marker). LOGIQ View acquires images via leading edge 
vectors (and does not acquire slices, as in CINE). The image is 
being stored as you perform the scan and you can watch the 
LOGIQ View as it is being acquired. 
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LOGIQ View (Option)  (continued)

4. To restart the scan, press L again. You can back up the 
probe, realign it, then go forward to redo a portion of the 
scan. 

5. To complete the scan, press R or Freeze (or allow the scan 
to auto complete). The LOGIQ View is then displayed, 
scaled to fit entirely on the screen. 

6. Perform measurements and record images. 

Uniform Motion The quality and usefulness of LOGIQ View images is affected by 
transducer motion. Incorrect technique can contribute to image 
distortion. 

Guidance and precautions for uniform motion: 

• Continuous contact is required throughout the length of the 
extended image. DO NOT lift the transducer from the skin 
surface. 

• Always keep the transducer perpendicular to the skin 
surface. DO NOT rock the transducer. 

• Keep the motion within the same scan plane, if possible. DO 
NOT slide the transducer laterally. 

• Lateral turning (change in direction to follow anatomical 
structure) can be accommodated with slower motion. DO 
NOT make abrupt changes in direction. 

• The system accommodates a reasonable range of motion 
velocity. DO NOT make abrupt changes in speed of motion. 
Deeper scans generally require reduced speed. 

Bioeffects Activating LOGIQ View has no affect upon Acoustic Output 
values. 
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Optimizing M-Mode

Intended Use

M-Mode is intended to provide a display format and 
measurement capability that represents tissue displacement 
(motion) occurring over time along a single vector. 

Introduction

M-Mode is used to determine patterns of motion for objects 
within the ultrasound beam. The most common use is for 
viewing motion patterns of the heart. 

Typical exam protocol

A typical examination using M-Mode might proceed as follows:

1. Get a good B-Mode image. Survey the anatomy and place 
the area of interest near the center of the B-Mode image. 

2. Press M/D Cursor. 

3. Trackball to position the mode cursor over the area that you 
want to display in M-Mode. 

4. Press M-Mode. 

5. Adjust the Sweep Speed, TGC, Gain, Power Output, and 
Focus Position, as needed. 

6. Press Freeze to stop the M trace. 

7. Record the trace to disk or to the hard copy device. 

8. Press Freeze to continue imaging. 

9. To exit, press M-Mode. 
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M-Mode Display

Figure 5-4. M-Mode Display -- Representative Example

M Mode Primary Menu

Different parameters can be assigned to the Primary Menu, the 
Primary Menu can be configured in Utility -> Application -> 
Imaging Controls.
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Scanning Hints

Sweep Speed

Description Changes the speed at which the time line is swept. 

Available in M-Mode and Doppler Mode. 

Available in M Color Flow Mode.

Adjusting To increase/decrease, select Sweep Speed. 

Values Each selection represents a different sweep time. 

Sweep Speed values are returned to the factory or user preset 
value when you change the following: Probe, Exam Category, 
Exam Calcs, or Patient. 

Benefits You can speed up or slow down the time line to see more or 
fewer occurrences over time. 

NOTE: The sweep speed information represents the user selected 
sweep speed and should be used only as a reference to confirm 
that the image was acquired at the selected sweep speed. It is 
not to be used for measurements or analysis. This is not an 
absolute value, but simply a reference number. Users 
performing studies using standardized protocols may find this 
sweep speed information useful for reading studies from other 
institutions.

HINTS These M-Mode controls produce the following results: 

Sweep Speed. Controls speed of M-Mode update. 

Dynamic Range. Affects the amount of gray scale information 
displayed. 
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Anatomical M-Mode

Description Anatomical M-Mode gives you the ability to manipulate the 
cursor at different angles and positions. The M-Mode display 
changes according to the position of the cursor.

Anatomical M-Mode displays a distance/time plot from a cursor 
line, which is independent from the axial plane.

NOTE: To set up AMM, go to Utility--> Imaging--> AMM. Select the 
specific probe and parameters. 

Figure 5-5. Anatomical M Mode

Activating To activate Anatomical M-Mode:

NOTE: AMM is only available on the sector probe.

1. While in M-Mode, adjust Anatomical M.

2. Press Scan Area until Pos is highlighted, move the trackball 
to position the M cursor over the required area of the image.

3. Press Scan Area until Angle is highlighted, move the 
trackball to allow free rotation of the solid arrow line 
throughout the 2D image.

Benefits Anatomical M-Mode gives you the ability to manipulate the 
cursor at different angles and positions.

Bioeffects Activate Anatomical M-Mode change the TI and/or MI. Observe 
the output display for possible effects. 
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Optimizing Color Flow

Intended Use

Color Flow Mode is a Doppler Mode intended to add 
color-coded qualitative information concerning the relative 
velocity and direction of fluid motion within the B-Mode image.

Introduction

A typical examination using Color Flow Mode, 

1. Follow the same procedure as described under B-Mode to 
locate the anatomical area of interest. 

2. After optimizing the B-Mode image, add Color Flow. 

NOTE: Use all noise reduction controls with care. Excessive 
application may obscure low level diagnostic information.

3. Move the color flow area of interest as close to the center of 
the image as possible. 

4. Optimize the color flow parameters so that a high frame rate 
can be achieved and appropriate flow velocities are 
visualized. 

5. Press Freeze to hold the image in memory. 

6. Record color flow images as necessary. 

7. If more definitive information is needed about flow, utilize the 
procedures described under Doppler Mode.

8. To exit Color Flow, press CF-Mode or B-Mode.



Optimizing Color Flow

LOGIQ V2/LOGIQ V1 – Basic User Manual 5-31
Direction 5610735-100 English Rev. 2

Color Flow Mode

 Figure 5-6. Color Flow Mode screen -- Representative Example

Color Flow Mode Primary Menu

Different parameters can be assigned to the Primary Menu, the 
Primary Menu can be configured in Utility -> Application -> 
Imaging Controls.
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Uses

Color Flow is useful to see flow in a broad area. Color Flow 
allows visualization of flow in the CF ROI, whereas Doppler 
Mode provides spectral information in a smaller area. 

Color Flow is also sometimes used as a stepping stone to 
Doppler. You use Color Flow to locate flow and vessels prior to 
activating Doppler. 

HINTS Color Flow Mode controls produce the following results: 

Line Density. The spacing between the lines or pulses from 
each element. Low line density has widely spaced lines, fewer 
pulses per frame, shorter times for each frame, higher frame 
rate, superior temporal resolution, and inferior spatial 
resolution.

High line density has tightly packed lines, more pulses per 
frame, longer times for each frame, lower frame rate, inferior 
temporal resolution, and superior spatial resolution.

Lower line density is useful for applications that requires 
significantly higher frame rates like the fetal heartbeat.

High line density is useful where very small vessels are being 
images like the thyroid and testicle.

Wall Filter. Electronic erasers that can filter out clutter caused 
by tissue and vessel wall motion. Consider increasing for high 
velocity arterial flow with a lot of pulsatile wall motion. Consider 
lowering the wall filter for low flow situations. Increasing the 
wall filter eliminates the flow toward and away from the 
transducer, so use caution so you don’t eliminate real flow or 
the reversal component of a triphasic waveform. 

Threshold. Threshold prioritizes between color flow and the 
gray scale image. Select the gray-scale echo strength below 
which color, instead of gray, will be shown at each pixel 
location. Decrease threshold to reduce the color component of 
the image.

With threshold set low, weak, non-Doppler-shifted 
reverberation and off-axis echoes within the vessel take 
precedence over the Doppler-shifted echoes, and little color is 
displayed. With higher threshold, the Doppler-shifted echoes, 
and little color is displayed. With higher threshold, the 
Doppler-shifted echoes or color take precedence over weaker 
gray-scale echoes.
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HINTS Frame Average. Averages color frames, When more frames 
are used to make up the image, it is easier for the system to 
decide what portion of the image is noise and what part is true 
signal.

Higher frame averaging keeps the color displayed longer for 
increased flow visualization. Lower frame averaging provides 
real time dynamic.

Packet Size. The number of pulses used for each; line of color 
information. indirectly related to frame rate.

Improves CF when it is increased but this results in a decrease 
in your frame rate.

Greater ensemble lengths or packet size provide more 
accurate estimates of mean Doppler shift, improve detection of 
slow flow, and complete representation of flow within a vessel 
but at the expense of longer time per frame and therefore 
frame rate. 

Scan Area. The size of ROI has an effect on the frame.

The width of the ROI has a significant effect on FR and 
sensitivity even more than the height of the ROI.

Keep the box sized just to the anatomy of interest and as close 
to center as possible.

Focus Position. Moving the focus to the area of interest 
narrows the width of the beam at that point and increase the 
lateral or side to side resolution and improves the image quality 
in that area. 
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Flow Model

Flow Model provide flow state information. The values vary by 
application, and can be selected via Utility --> Imaging --> CF. 

Gain

Description Gain amplifies the overall strength of echoes processed in the 
Color Flow window or spectral Doppler time line.

Adjusting To decrease/increase Gain, rotate Gain.

Gain values change depending on the probe and application; 
they are not associated with a particular position of the button.

Values Values vary by probe, application, and frequency setting. Gain 
displays as Gn on the screen. Gain values are returned to the 
factory or user preset value when you change the following: 
Probe, Exam Category, Exam Calcs, Patient, or Multi 
Frequency. 

Benefits Allows you to control the amount of color within a vessel or to fill 
in or clean out spectral information. 

Bioeffects Gain has no affect on Power Output. However, with increased 
Gain, the power output level can usually be reduced to produce 
an equivalent image quality.

PRF/Scale (Velocity Scale)

Description Increases/decreases the Scale on the color bar. 

Adjusting To raise/lower the velocity scale, adjust PRF. 

Scale is displayed as PRF on the screen.

Values PRF/Velocity Scale values are returned to the factory or user 
preset value when you change the following: Probe, Exam 
Category, Exam Calcs, or Patient. 

Benefits Imaging of higher velocity flow requires increased scale values 
to avoid aliasing. 

Affect on other 
controls

Changing the PRF/Velocity Scale may affect Power Output, 
frame rate, and wall filter. When you adjust the PRF/velocity 
scale, CINE memory is cleared. 

Bioeffects Changing the PRF/Velocity Scale range may change the TI and/
or MI. Observe the output display for possible effects. 
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Wall Filter

Description Filters out low flow velocity signals. It helps get rid of motion 
artifacts caused from breathing and other patient motion. 

Values Values vary, depending upon probe, application, and packet 
size. The wall filter is displayed numerically on the monitor (Hz). 

Wall Filter values vary by probe and application and are 
returned to factory or user preset value when you change: 
Probe, Exam Category, Exam Calcs, or Patient. 

Benefits Gets rid of excess, unnecessary low frequency signals caused 
by motion. 

Wall Filter Target Override (Hz)

Description Wall filter target override sets to “0”.

The algorithm selects a new regression wall filter it updates the 
wall filter setting and the wall filter cutoff on the user display. If 
using this algorithm, then the system automatically maintains a 
target wall filter cutoff as the scale is changed. The target wall 
filter cutoff is initially set by the results of the user-defined 
presets for wall filter, scale. The target regression wall filter 
cutoff shall be updated when the user changes the wall filter 
setting. 

Wall filter target override sets to “-1".

The algorithm keeps a user selected regression wall filter, when 
the user changes the color scale.

Wall filter target override sets to other value.

The algorithm selects a new regression wall filter it updates the 
wall filter setting and the wall filter cutoff on the user display. In 
this case, the selected value from the user is the target cut off 
(Hz).

Values Set the value on the Utility -> Imaging -> PDF -> Wall filter 
Target Override (Hz) and press Save.
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Size/Position of the color window

Description Adjust size and position of the color window. 

Adjusting The window grows from the center of the color window. To 
adjust the size, press Scan Area until Size (Size/Position 
appears in the Trackball status area on the monitor display) is 
highlighted, then move the Trackball left/right, up/down. To 
adjust the position, press Scan Area until Pos is highlighted, 
then move the Trackball to position the color window. 

Benefits Increase the color window to see a larger area; decrease the 
color window to improve frame rate and spatial resolution.

Affect on other 
controls

The smaller the color window, the faster the frame rate and vice 
versa. 

Bioeffects Sizing the color window may change the TI and/or MI. Observe 
the output display for possible effects.

CF/PDI Width

Description You can set the default CF/PDI ROI width.

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 

CF/PDI Vertical Size

Description You can set the default CF/PDI ROI vertical size.

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 
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Invert (Color Invert)

Description Lets you view blood flow from a different perspective, e.g., red 
away (negative velocities) and blue toward (positive velocities). 
You can invert a real-time or frozen image. 

NOTE: Invert reverses the color map, NOT the color PRF. 

Adjusting To reverse the color flow, adjust Invert. 

In Triplex, both Color Flow and Doppler Mode velocity scales 
are inverted.

Values Invert values are returned to the factory or user preset value 
when you change the following: Probe, Exam Category, Exam 
Calcs, or New Patient. 

Benefits Allows you to view blood flow according to your personal 
preference, without flipping the probe. 

Baseline

Description Changes the Color Flow or Doppler spectrum baseline to 
accommodate higher velocity blood flow. Minimizes aliasing by 
displaying a greater range of forward flow with respect to 
reverse flow, or vice versa. 

Baseline adjusts the alias point. The default baseline is at the 
midpoint of the color display and at the midpoint of the color bar 
reference display. 

Adjusting To adjust the baseline, adjust Baseline. 

Values Zero velocity follows the baseline. The total PRF range remains 
the same. Values vary by probe and application.

Baseline values are returned to the factory or user preset value 
when you change the following: Probe, Exam Category, Exam 
Calcs, or new patient. 

Benefits Unwraps the alias during color flow imaging. Higher velocities 
can be displayed without reversal of colors. 
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Angle Steer

Description You can slant the ROI of the Color Flow linear image left or right 
to get more information without moving the probe. The Angle 
Steer function only applies to linear probes. 

Adjusting To slant the ROI of Color Flow linear image to the left/right, 
Adjust Angle Steer. 

Angle Steer can be set in Utility -> Imaging -> CF/PDI. 

Values Angle Steer values are returned to the factory or user preset 
value when you change the following: Probe, Exam Category, 
Exam Calcs, or new patient.

Benefits Provides a Doppler cursor angle suitable for linear probe 
orientation. Beneficial in Peripheral Vascular to image carotids.

Bioeffects Activating angle steer may change the TI and/or MI. Observe 
the output display for possible effects. 

Accumulation

Description Accumulation enhances the flow in an image. 

Values If Accumulation is turned off, then Frame Averaging is used; if 
Accumulation is set, then Accumulation is used. 

Availability Available in Color Flow, PDI. 

Benefit Accumulation detects the maximum signal and holds it for the 
level specified. 
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Color Flow Line Density

Description Optimizes the Color Flow frame rate or spatial resolution for the 
best possible color image. 

Adjusting To adjust the line density, adjust Line Density. 

Select the default value on the Utility -> Imaging -> CF -> Line 
Density and press Save. 

Values Values vary by: Probe, Exam Category, Exam Calcs, new 
patient, and Frequency. 

Settings are returned to factory or user preset value when you 
change any of the above. 

Benefits Low line density is useful in fetal heartbeat, adult cardiac 
applications, and clinical Radiology applications which require 
significantly higher frame rates. High resolution is useful in 
situations where very small vessels are being imaged, e.g., 
thyroid, testicles. 

Affect on other 
controls

Line density changes the vector density and frame rate. 

Bioeffects Modifying line density may change the TI and/or MI. Observe 
the output display for possible effects.

Line Density Zoom

Description You can set the default value for Line Density in zoom 
independently. 

Adjusting Select the default value via Utility -> Imaging -> CF -> Line 
Density Zoom and press Save. 
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Map

Description Allows you to select a specific color map. After you have made 
your selection, the color bar displays the resultant map.

Adjusting After you activate Color Flow, the Color Flow menu displays. To 
cycle through available maps, select Map, move the Trackball 
to view available maps, and press Set to select.

Values Velocity Maps (V). Flow shown as blue away/red toward the 
probe.

Velocity Variance Maps (VV). Provides a measure of turbulence 
(stenosis). Adds green to velocity maps.

Benefits Shows the direction of the flow and highlights the higher velocity 
flows.

Map Compress

Description When you increase the value, high velocity elements in the map 
are compressed so that the map darkens. When you decrease 
the value, low velocity elements in the map are compressed so 
that the map lightens. The effect is visible in the color bar. 

Benefits Changes the gradation in the map. 

Threshold

Description Threshold assigns the gray scale level at which color 
information stops. 

Adjusting To increase/decrease the gray scale threshold, adjust 
Threshold. 

Values High values display more color; low values displays more 
B-Mode gray scale data. 

Values vary by probe and application and are returned to factory 
or user preset value when you change: Probe, Exam Category, 
Exam Calcs, or new patient. 

Benefits Limits color flow overlay to low level echoes inside vessel walls. 
Helps minimize color `bleeding' outside vessel walls. 
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Frame Average

Description Averages color frames. 

Adjusting To smooth temporal averaging, adjust Frame Average. 

Values Frame Average values vary by probe and application. The 
values are returned to factory or user preset value when you 
change: Probe, Exam Category, Exam Calcs, or new patient. 

Benefits Higher frame averaging keeps the color displayed longer for 
increased flow visualization while lower frame averaging 
provides greater flow dynamics. 

Affect on other 
controls

Trades off between frame rate and color quality. As the color 
quality increases, the frame rate may decrease and as the frame 
rate increases, the color image quality decreases. 

Transparency Map

Description Brings out the tissue behind the color data. 

Adjusting Adjust Transparency Map.

Benefits Helps demonstrate the tissues behind the color. 

Spatial Filter

Description Smooths out the color, makes it look less pixely. 

Adjusting Select Spatial Filter to adjust. 

NOTE: Select the default value on the Utility -> Imaging -> CF -> Spatial 
Filter and press Save.

Benefits Smooths the image. 

Flash Suppression

Description Activates/deactivates Flash Suppression, a motion artifact 
elimination process. 

Values Values are returned to factory or user preset value when you 
change: Probe, Exam Category, Exam Calcs, or new patient. 

Benefits Beneficial to suppress flash. 
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Packet Size

Description Controls the number of samples gathered for a single color flow 
vector. 

Values Values vary by probe and application and are returned to factory 
or user preset value when you change: Probe, Exam Category, 
Exam Calcs, or new patient. Values are displayed on the 
monitor display as P. 

Benefits Allows you to improve the color sensitivity and accuracy of color 
averaging (increase packet size) or frame rate (decrease packet 
size), as needed. 

Affect on other 
controls

When you decrease the packet size, you increase the frame rate 
at the expense of image quality. When you increase the packet 
size, you improve image quality at the expense of frame rate. 

Bioeffects Changing packet size may change the TI and/or MI. Observe 
the output display for possible effects.

Sample Vol (Sample Volume)

Description Adjusts the size of the color flow doppler transmit wave (or 
pulse) and size (or length). Lower setting gives better flow 
resolution and a higher setting increases sensitivity.

CF/PDI Sample Volume

Description You can set the default CF/PDI Sample Volume. 

Adjusting Select the value on the Utility -> Imaging -> CF -> CF/PDI 
Sample Volume and press Save. 

CF/PDI Center Depth

Description You can set the default CF/PDI center depth. 

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 

CF/PDI Focus Depth (%)

Description You can set the default CF/PDI center depth. 

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 
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CF/PDI Frequency (MHz)

Description You can set the default CF/PDI Frequency (MHz). 

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 

CF/PDI Auto Frequency

Description You can set the default CF/PDI Auto Frequency. 

Adjusting Select the value on the Utility -> Imaging -> CF mode and press 
Save. 

CF/PDI Vertical Size

Description You can set the default CF/PDI ROI vertical size.

Adjusting Select the value on the Utility -> Imaging -> CF -> CF/PDI 
Vertical Size and press Save.

CF/PDI Width

Description You can set the default CF/PDI ROI width.

Adjusting Select the value on the Utility -> Imaging -> CF -> CF/PDI Width 
and press Save.
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Power Doppler Imaging (PDI) 

Description Power Doppler Imaging (PDI) is a color flow mapping technique 
used to map the strength of the Doppler signal coming from the 
flow rather than the frequency shift of the signal. Using this 
technique, the ultrasound system plots color flow based on the 
number of reflectors that are moving, regardless of their velocity. 
PDI does not map velocity, therefore it is not subject to aliasing. 

Adjusting Press PDI. The color flow window appears over the B-Mode 
image. Move the Trackball to move the CF window. To exit, 
press PDI or select a new mode. 

Values On/Off.

Benefits Since PDI does not display velocity, it does not alias. 

Affect on other 
controls

When PDI is activated, the following controls are adjusted: Color 
Map is set to a power map. Line Density is adjusted. Threshold 
is adjusted. Frame Averaging is adjusted. Packet Size is 
adjusted.

NOTE: These controls are reset to their previous values upon exiting 
PDI. 

Directional Power Doppler

You can select the P7 Directional Power Doppler map while in 
PDI. 

NOTE: If you store a PDI image and recall it, you can still switch to the 
Directional Power Doppler map and vice versa. However, an 
image stored as non-directional then switched to directional just 
adds direction to a non-directional map and vice versa. 

HINTS When changing maps, higher gain settings may be needed. 

HINTS If the image is aliasing while in Directional Power Doppler, 
increase the Scale and reduce the Wall Filter. 
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Tissue Velocity Imaging (Option) 

Intended Use

Tissue Velocity Imaging (TVI) calculates and color-codes the 
velocities in tissue. The tissue velocity information is acquired by 
sampling of tissue Doppler velocity values at discrete points.The 
information is stored in a combined format with gray scale 
imaging during one or several cardiac cycles with high temporal 
resolution.

TVI can be activated on the sector probes only.

Figure 5-7. Tissue Velocity Imaging Display 
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Activating TVI

1. Select the sector probe 3Sc-RS.

2. While in B-Mode, press the user defined key for TVI. The 
TVI image and the menu display.

While in TVI, press PW to activate TVD.

3. Press Scan Area until Pos is highlighted, then move the 
Trackball to position the ROI frame over the area to be 
examined.

4. Press Scan Area until Size is highlighted, then move the 
Trackball to adjust the dimension of the ROI.

Optimizing TVI

The use of preset gives optimum performance with minimum 
adjustment. If necessary, the following controls can be adjusted 
to further optimize the TVI display:

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

• TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.

NOTE: PW will be optimized for Tissue Velocities when activated 
from inside TVI.

NOTE: You can preset the value on the Utility -> Imaging -> TVI or TVD 
mode and press Save. 
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TVI Parameters

You can preset all parameters in Utility -> Imaging ->TVI.

The TVI parameters function the same as those described in the 
Color Flow specific section. The only differences would be that it 
pertains to tissue velocity rather than the color flow image. In the 
table below any TVI parameter or parameter specifics are noted.

About optimizing other parameters, see ‘Optimizing Color Flow’ 
on page 5-30 for details. 

TVD Parameters

About optimizing other parameters, see ‘Optimizing Spectral 
Doppler’ on page 5-50 for details.

Table 5-1:  TVI Parameters

Control Details

Visible In LIVE/Freeze/Archive, you can display TVI Color with TVI.
Select Visible.
On or Off.

Line Density 0 or 1. Optimizes B-Mode frame rate or spatial resolution for the best possible 
image.

Map Values: TVI1 and TVI2. 

Threshold High values display more color. Low values limit the color to lower tissue echo 
(Opposite of Threshold in Color Flow Mode). 

Spatial Filter Values 0, 1 and 2. 

TVI Gain Control color transparency. High values display more color; low values 
display more tissue. This parameter is assigned to the Color Gain control.
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Optimizing M Color Flow

M Color Flow Mode

Description M Color Flow is used for adult, pediatric and fetal cardiac 
applications. Color Flow overlays color on the M-Mode image 
using velocity and variance color maps. The Color Flow wedge 
overlays the B-Mode image and M-Mode time line.

The Color Flow maps available in M-Mode are the same as in 
Color Flow Mode. The size and position of the Color Flow 
window in B-Mode determines the size and position of the Color 
Flow window in M-Mode. 

All M-Mode measurements are available with M Color Flow 
active: depth, distance along a straight line, % stenosis, volume, 
trace, circumference, enclosed area, distance, time, slope, and 
heart rate. 

M Color Flow mode can be activated on the sector probes only.
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M Color Flow Mode  (continued)

Activating To activate M Color Flow Mode, press M (M-Mode). Then press 
CF (Color Flow) - or - press CF, then press M. CM tab is 
displayed. 

 Figure 5-8. M Color Flow screen -- Representative Example

Benefits Color Flow Mode and Color Flow M-Mode are Doppler Modes 
intended to add color-coded qualitative information concerning 
the relative velocity and direction of fluid motion within the 
B-Mode or M-Mode image. 

Bioeffects Changing the Sweep Speed, Packet Size, Frame Rate/
Resolution, Zoom, PRF, and ROI size may change the TI and/or 
MI. Observe the output display for possible effects. 
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Optimizing Spectral Doppler

Intended Use

Doppler is intended to provide measurement data concerning 
the velocity of moving tissues and fluids. PW Doppler lets you 
examine blood flow data selectively from a small region called 
the sample volume. 

Typical Use - PW Doppler

In Pulsed Wave Doppler (PW) Mode, energy is transmitted from 
the ultrasound probe into the patient, as in B-Mode. However, 
the received echoes are processed to extract the difference in 
frequency between the transmitted and received signals. 
Differences in frequencies can be caused by moving objects in 
the path of the ultrasound signal, such as moving blood cells. 
The resultant signals are presented audibly through the system 
speakers and graphically on the system display. The X axis of 
the graph represents time while the Y axis represents the shift in 
frequency. The Y axis can also be calibrated to represent 
velocity in either a forward or reverse direction. 

PW Doppler is typically used for displaying the speed, direction, 
and spectral content of blood flow at selected anatomical sites. 
PW Doppler operates in two different modes: conventional PW 
and High Pulse Repetition Frequency (HPRF). 

PW Doppler can be combined with B-Mode for rapidly selecting 
the anatomical site for PW Doppler examination. The site where 
PW Doppler data is derived appears graphically on the B-Mode 
image (Sample Volume Gate). The sample volume gate can be 
moved anywhere within the B-Mode image. 
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Spectral Doppler Display

Time zero (the start of the trace) appears on the left side of the 
graph. As time progresses, the trace moves to the right. The 
baseline of the graph (representing zero velocity, zero frequency 
shift, or no detected flow), appears as a solid line running 
horizontally across the display. By convention, movement 
toward the probe is positive and movement away from the probe 
is negative. Positive frequencies or velocities appear above the 
baseline. Negative frequencies or velocities appear below the 
baseline. 

Typically, blood flow is not uniform but is composed of a mix of 
blood cells moving at different velocities and in different 
directions. Thus, the display is composed of a spectrum as gray 
scale values. Strong signals are displayed as bright while weak 
signals are displayed as varying shades of gray. 

HPRF (High Pulse Repetition Frequency) is invoked when you 
are operating in PW Doppler Mode and conditions activate 
HPRF (when the velocity scale factor or sample volume gate 
depth exceeds certain limits). When HPRF is active, multiple 
sample volume gates appear along the Doppler mode cursor. 
Doppler information can be received from any of the multiple 
sample volume gates. The Doppler signals from all the gates are 
added together and displayed in one spectrum. 

Information about the PW Doppler display is automatically 
written on the screen and updated when scanning parameters 
are changed. 

This chapter includes: 

• A discussion of PW Doppler. 

• Activating Pulsed Wave Doppler. 

• Optimizing the Doppler spectrum. 
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Typical exam protocol

A typical examination using PW Doppler Mode might proceed as 
follows: 

1. Connect the appropriate probe, leaving the probes in their 
respective holders. 

2. Position the patient for the examination. 

3. Press Patient. Enter the appropriate patient data using the 
appropriate exam category. 

4. Select the preset, application and probe to be used.

5. Locate the anatomy to be examined. Get a good B Mode 
image. Press CF to help locate the vessel you wish to 
examine. 

6. Press M/D Cursor to display the sample volume cursor and 
gate. Press PW. The PW Doppler spectrum appears and 
the system operates in combined B+Doppler Mode. Adjust 
Volume to adjust Doppler audio. The Doppler signal is 
heard through the speakers.

7. Position the sample volume cursor by moving the Trackball 
left and right. Position the sample volume gate by moving 
the Trackball up and down. Size the gate by clicking SV 
Length. 

8. Optimize the PW Doppler spectrum, as necessary. Refer to 
the Doppler Optimization section of this chapter for more 
information. 
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Typical exam protocol  (continued)

9. Press Set/B Pause to toggle between real time B-Mode with 
Doppler Mode (with audio).

10. Sample along the whole length of the vessel. Make sure that 
the probe is parallel to flow. Listen, then look, when 
positioning the sample volume cursor. 

11. Press Freeze to hold the trace in memory and stop imaging. 
Activate CINE Timeline, as necessary. See ‘Activating CINE’ 
on page 6-10 for more information.

12. Perform measurements and calculations, as necessary. 
Refer to the Measurements and Calculations chapter for 
more information. 

13. Record results by pressing the appropriate store/print key, 
depending on the setup of your recording devices. 

14. Press Freeze to resume imaging. 

15. Repeat the above procedure until all relevant flow sites have 
been examined. 

16. Replace the probe in its respective holder. 

17. To exit PW, press PW. 

Doppler Mode Primary Menu

Different parameters can be assigned to the Primary Menu, the 
Primary Menu can be configured in Utility -> Application -> 
Imaging Controls.

Activating Doppler Mode

To activate PW Doppler Mode, press M/D cursor and place the 
cursor in the appropriate position, then press PW.

The Doppler spectrum displays along with the B-Mode image. 
The cursor changes to a Doppler cursor. 

You can now position and size the sample volume gate to get a 
velocity. Use Doppler Audio to listen for when the sample 
volume gate is positioned over an area of flow. 

M/D Cursor toggles between real time B-Mode/Color Flow with 
Doppler Mode and real time spectral display.

Use Doppler is used to examine blood flow information. 

To exit Press PW or B-Mode.
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Doppler Mode Display

 Figure 5-9. PW Doppler Mode Display -- Representative Example

Table 5-2:  Doppler Mode Display Explanations

Doppler Display Description, Format, Values

PRF Pulse repetition frequency, displayed as PRF in kHz. 

Wall Filter Wall filter size, displayed as WF in Hz. 

Doppler Gain Displays as GN in decibels (dB). 

Sample Volume Depth Displays (in Cm) when Doppler cursor is present. 

Doppler Angle
 (AC ##)

Indicates angle in degrees between the Doppler mode cursor and the angle 
correction indicator. Displays when Doppler cursor is present. The Doppler Angle 
displays in red when the angle exceeds 60°. Velocities obtained when the angle is 
greater than 80° are displayed as asterisks (***). 

Spectral Invert INVERT appears when the spectral trace is inverted and the plus/minus signs (+/-) 
are reversed. 

HPRF HPRF mode is used when detected velocities exceed the processing capabilities of 
the currently selected PW Doppler scale or when the selected anatomical site is too 
deep for the selected PW Doppler scale. 

Time Scale Each selection represents a different sweep time. 

Angle Correct Indicates flow direction. 

Sample Volume Gate Indicates sample volume box. Each probe defaults to a specific range gate. 

Doppler Velocity 
Scale

Flow direction has a positive and negative indicator, noted in centimeters per 
second (cm/sec.). The Doppler velocity scale adjust as you adjust the PRF.
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Doppler Sample Volume Gate Position (Trackball)

Description Moves the sample volume gate on the B-Mode's Doppler Mode 
cursor. The gate is positioned over a specific position within the 
vessel. 

Adjusting To move Doppler Mode cursor position, move Trackball left or 
right until positioned over the vessel. 

To move sample volume gate position, move Trackball up or 
down until positioned inside the vessel. 

Values Defaults to 50% of the depth and can move continuously 
throughout the field of view. 

Benefits Positions the sample volume gate to sample blood flow. 

Bioeffects Changing the sample volume gate position may change the TI 
and/or MI. Observe the output display for possible effects.

Doppler Sample Volume Length

Description Sizes the sample volume gate.

Adjusting To increase/decrease the gate size, adjust SV Length.

You can adjust the sample volume gate length whenever the 
sample volume gate appears on the display. 

NOTE: Adjustments to the sample volume gate size are made from the 
center point of the sample volume position. 

Values Values vary by probe and application. 

Sample volume gate size values are returned to the factory or 
user preset value when you change the following: Probe, Exam 
Category, Exam Calcs, or new patient. 

Benefits A smaller gate produces accurate sampling results because it is 
more sensitive. You can also enlarge the gate for sampling large 
vessels or areas. 

Bioeffects Changing the sample volume gate size may change the TI and/
or MI. Observe the output display for possible effects. 
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Angle Correct/Auto Angle

Description Estimates the flow velocity in a direction at an angle to the 
Doppler vector by computing the angle between the Doppler 
vector and the flow to be measured. 

NOTE: When the Doppler Mode Cursor and angle correct indicator are 
aligned (the angle is 0), you cannot see the angle correct 
indicator.

Adjusting Flow toward the probe is mapped above the baseline and vice 
versa. 

To adjust the angle relative to the probe face, adjust Angle 
Correct or Auto Angle. The velocity scale changes when you 
adjust angle correct. 

Angle Correct and Auto Angle values vary by probe and 
application. Angle Correct values are returned to the factory or 
user preset value when you change the following: Probe, Exam 
Category, Exam Calcs, or New Patient. 

Benefits Optimizes the accuracy of the flow velocity. This is especially 
useful in vascular applications where you need to measure 
velocity. 

Quick Angle

Description Quickly adjusts the angle by 60 degrees. 

Adjusting Adjust Quick Angle. 

Steer/Fine Steer

Description You can slant the mode cursor of the linear image left or right to 
get more information without moving the probe. The angle steer 
function only applies to linear probes.

Adjusting To slant the mode cursor to the left/right, adjust Steer or Fine 
Steer. 

Values Linear probes can be steered left, center, or right. 

Steer values are returned to factory or user preset value when 
you change: Probe, Exam Category, Exam Calcs, or new 
patient. 

Fine Steer value can be changed in small degree increments. 

Benefits Provides a doppler cursor angle suitable for linear probe 
orientation. Beneficial in Vascular applications. 

Bioeffects Activating angle steer may change the TI and/or MI. Observe 
the output display for possible effects. 
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Volume

Description Controls audio output.

Benefits An audio representation of the flow within a vessel can be used 
to evaluate proper probe angle and position. 

Auto Spectrum Optimize (Auto)

For details on Auto, See ‘Auto Optimize’ on page 5-8 for more 
information.

Cycles to Average

Description The average value over a number of cycles (from 1-5). For 
example, if you set the number of cycles at 3, values would be 
averaged for 3 cycles. If you have 5 cycles on the display, the 
PS would be the average of 3 of the 5 cycles, which are 
identified by a line drawn over the 3 averaged cycles. 

Available for live and frozen images. 

Display Format

Description Changes the horizontal/vertical layout between B-Mode and 
Doppler Mode, or time line only. 

Benefits You can select how to have your Doppler time line and anatomy 
displayed. 

CAUTION Audio sounds change rapidly, often abruptly. Increase the 
volume in small steps to avoid startling the patient. 
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Set/ B Pause

Description Toggles between simultaneous and update presentation while 
viewing the timeline. 

Adjusting To activate, press Set/ B Pause to toggle between simultaneous 
and Spectral Doppler display. Doppler Mode does not restart 
each time the image is updated; however, a black bar may 
appear with a lightning bolt signalling a break in the timeline. 

Values On/Off. 

Benefits Increases the Spectral Doppler display quality. 

Bioeffects May change the TI and/or MI. Observe the output display for 
possible effects.

Simultaneous

Description When you select Simultaneous, everything is live. For example, 
both B-Mode and PW Doppler Modes are active; or B-Mode, 
PW Doppler Mode, and CF Modes are active. 

If Simultaneous is not selected, use M/D Cursor to toggle 
between modes.

Adjusting Adjust Simultaneous. 

Benefits Allows the user to have multiple modes active at the same time.

Baseline

Description Adjusts the baseline to accommodate faster or slower blood 
flows to eliminate aliasing. 

Adjusting Baseline adjusts the point in the spectrum where the velocity 
trace is at zero. The default baseline is at the midpoint of the 
spectrum. 

The baseline displays as a solid line running across the 
spectrum. The baseline is raised and lowered in equal 
increments, depending on the current Doppler scale factor. The 
control does not wrap when the maximum baseline shift (in 
either direction) has been reached. 

Values Baseline values vary by probe and application and are returned 
to the factory or user preset value when you change: Probe, 
Exam Category, Exam Calcs, or New Patient. 

Benefits Unwraps the alias. Rearranges the velocity scale without 
changing the velocity scale. Readjusts the positive and negative 
velocities limit without changing the total velocity range. 
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Compression

Description Compression controls how echo intensities are converted to 
shades of gray, thereby increasing the range of contrast you can 
adjust. 

Values The values can be set in Utility -> Imaging -> PW. Compression 
values vary by probe and application and are returned to the 
factory or user preset value when you change the following: 
Probe, Exam Category, Exam Calcs, or New Patient. 

Benefits Optimizes the image's texture and smoothness by increasing or 
decreasing the amount of gray scale. 

Invert

Description Vertically inverts the spectral trace without affecting the baseline 
position. 

To invert the spectral trace, adjust Invert. The minus (-) signs on 
the velocity scale reverse when the spectrum is inverted. 

Positive velocities display below the baseline. 

Values The trace corresponds to flow direction (positive flow is forward 
flow toward the probe or negative flow is reverse flow away from 
the probe). The invert setting is returned to the factory or user 
preset value when you change the following: Probe, Exam 
Category, Exam Calcs, or New Patient. In simultaneous mode, 
both Color Flow and Doppler Mode velocity scales are inverted. 

Benefits If you change the probe angle to accommodate anatomy, blood 
flow still moves in the same direction, but the Doppler 
information will be reversed. It is easier in cases like this to 
invert the spectrum instead of reversing the probe orientation. 

Cursor Moving

Description On Utility--> Imaging --> PW, specify the value. 

Cursor Moving lets you ‘walk’ Doppler through a vessel while the 
Doppler gate is moving. Updates are more frequent on Fast vs. 
Medium vs. Slow. If you set the preset to Update 2D/CF, this 
causes the B Mode/Color Flow image to go live while you move 
the Doppler cursor. 
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PRF

Description Adjusts the PRF to accommodate faster/slower blood flow 
velocities. Pulse repetition frequency is determined by Velocity 
scale.

If the sample volume gate range exceeds single gate Scale 
capability, the system automatically switches to high PRF mode. 
Multiple gates appear, and HPRF is indicated on the display. 

High PRF High Pulse Repetition Frequency (HPRF) is a special operating 
mode of PW Doppler. In HPRF mode, multiple energy pulses 
are used. This allows higher velocities to be detected without 
causing aliasing artifacts. HPRF mode is used when detected 
velocities exceed the processing capabilities of the currently 
selected PW Doppler scale or when the selected anatomical site 
is too deep for the selected PW Doppler scale. The pulse 
repetition frequency (PRF) is displayed to the left of the 
spectrum in frames per second. 

NOTE: Ensure that only one gate overlays a blood vessel at a time. 
Otherwise, signals from more than one flow area are 
superimposed. 

Adjusting Adjust the PRF. The display updates velocity scale parameters 
after you adjust the PRF. 

Values PRF values vary by probe and application. In Simultaneous 
mode, when you change the PRF in Color Flow, the Doppler 
Mode velocity scale is also updated if Simultaneous is on. 

PRF values are returned to the factory or user preset value 
when you change the following: Probe, Exam Category, Exam 
Calcs, or New Patient. 

Benefits Blood flow information is not cut off due to the effect of aliasing. 

Affect on other 
controls

When you raise the PRF, the spectral waveform may decrease 
in size; when you lower the PRF, the spectral waveform may 
increase in size. Changes in the spectrum are relative to 
changes in the velocity scale, that is, it sizes accordingly. 
Adjustments may affect sample volume size and Doppler wall 
filter. 

Bioeffects Changing the PRF may change the TI and/or MI. Observe the 
output display for possible effects. 
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Wall Filter

Description Insulates the Doppler signal from excessive noise caused from 
vessel movement. 

Adjusting To increase/decrease, adjust Wall Filter. 

Values Values vary, depending upon the probe and application. The 
current value displays on the monitor. Wall Filter values are 
returned to the factory or user preset value when you change 
the following: Probe, Exam Category, Exam Calcs, New Patient. 

Benefits Gets rid of excess, unnecessary information. Cleans out low 
level noise above and below the baseline so you don't see or 
hear it on the spectrum. 

Affect on other 
controls

Wall filter may be changed by changes to the velocity scale.

Trace Method

Description Traces the average mean and peak velocities in real-time or 
frozen images.

Adjusting To get a peak trace, click MAX. A green trace displays on the 
spectrum. 

To get a mean trace, click MEAN. A green trace displays on the 
spectrum. 

Benefits Lets you trace the cardiac cycle. 

Trace Sensitivity

Description Adjust the trace to follow the waveform for signal strength.

Benefits If the signal is very faint, increasing the Trace Sensitivity will 
allow the system to trace that signal strength. 

Trace Direction

Description Specifies trace direction. 

Selecting Trace 
Position

You can select where on the waveform to perform the trace, 
above, below, or both (above and below). 
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Continuous Wave Doppler (CWD) (Option)

Allows examination of blood flow data all along the Doppler 
Mode cursor rather than from any specific depth. Gather 
samples along the entire Doppler beam for rapid scanning of the 
heart. Range gated CW allows information to be gathered at 
higher velocities.

Steerable

Allows viewing of the B-Mode image to position the Doppler 
cursor to the area of interest while viewing the Doppler spectrum 
(shown below in the B-Mode image) and listening to the Doppler 
Audio signal.

Works with the sector probes.

Activating CW Doppler

To activate CW Doppler Mode, press user defined key for CW. 

The Steerable CW Doppler spectrum displays along with the 
B-Mode image. The cursor changes to a Doppler cursor. 

You can now position and size the sample volume gate to get a 
velocity. Use Doppler Audio to listen for when the sample 
volume gate is positioned over an area of flow. 

Set/B Pause toggles between real time B-Mode with Doppler 
Mode and real time spectral display. 

Exiting CW Doppler

To exit CW Doppler Mode, press user defined key for CW again.
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TruScan

TruScan allows you to change imaging parameters to help 
optimize the images that are set/frozen or archived. TruScan is 
applicable on entire cine loops, not just single static DICOM 
images. This feature provides the user with an opportunity to 
review and manipulate images after the scan. 

The function allows you to select a specific area of interest, 
zoom in and optimize for closer observation.

TruScan on B-mode

To apply various post-processing tools to the image:

1. Recall a B-mode raw data image. For example: Fetal 
cardiac image.

2. Resize the acquired image by using the zoom function.

3. Adjust the image by using various imaging controls.

a. Use the Active key on control panel to access B-mode 
menu.

b. Reduce posterior saturation by adjusting the TGC.

c. Adjust the image gain and dynamic range.

d. Use the SRI function to reduce the speckle noise in the 
image and get an enhanced image.

e. Use the colorize option to further adjust the image.

f. Annotate and save the image.
TruScan on Color-Flow

To adjust an image acquired in the Color Flow mode using the 
post-processing controls:

Obtain an image in B-mode and color mode. For example: 
Carotid image.

1. Freeze and then store the image. 

2. Use the Invert function to flip the color map for correct color 
mapping.

3. Customize the Color Flow by adjusting color gain and 
choosing a different color map. Choose a transparency map 
instead of the regular color maps to see the underlying 
B-mode anatomy.

4. Adjust The baseline and threshold values to optimize the 
Color Flow and get maximum Color Flow information from 
the image.
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TruScan on Pulse Wave Doppler

To work on a Pulse Wave Doppler spectrum after image 
acquisition:

NOTE: Set Start M&A on Freeze (D) to Off in Utility - > Measure -> 
Measure -> Advanced.

1. Acquire a B+Color+spectral Doppler image of the carotid.

2. Obtain a PW spectrum and then freeze.

3. Store the image obtained.

4. Use the Angle correct function to optimize the angle 
between the Doppler cursor and the vessel to get a velocity 
measurement.

5. Adjust the baseline, sweep speed and the display format to 
customize the spectral display.

TruScan and Measurements

LOGIQ V2/LOGIQ V1 supports Auto Doppler calcs in both live 
and frozen mode. This is configured from the secondary menu in 
the measurement mode. The parameters selected for 
calculation can be changed later after the image is acquired.

Measurements are also supported on recalled grey scale 
images saved in DICOM format. This enables users to review 
patient images and redo measurements and calculations without 
reimaging or inconveniencing the patients. 

Reporting

The raw data acquisition capabilities of TruScan enables 
re-annotation and re-measurement during remote reporting 
using a reporting software. 
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Q Analysis (Option)

NOTE: Quantitative Analysis is optional in LOGIQ V2/LOGIQ V1.

Quantitative Analysis is available for the following CINE loops 
obtained in the following modes: Tissue Velocity Imaging, Color 
Flow Mode, Power Doppler Image. All of the Quantitative 
Analysis modes operate similarly, with some variation.

Activating QAnalysis

1. Scan and Freeze the patient in the desired live mode or 
recall a desired cine loop from the stored images.

NOTE: QAnalysis is only available when the system is in CINE 
mode.

NOTE: Images from the current scan session acquired in the 
desired analysis mode (already in CINE) or from a saved 
image loop can be used for QAnalysis.

2. QAnalysis displays on the Cine Primary Menu.

3. Select QAnalysis. The QAnalysis screen and QA Primary 
Menu displays. To toggle the trackball function between QA 
and Scroll, press the Scan Area on the control panel.
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Q-Analysis Screen Description

Figure 5-10. TVI mode Q-Analysis Example 

Table 5-3:  QAnalysis Screen Description

1. TVI Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

2. B Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

3. Analysis Window.
• Y axis: Velocity scale (cm/s)
• X axis: Time(s) 
• Time at cursor position.
• Velocity at Cursor position.
• Velocity at frame marker position (Color coded)

4. Sample Area

5. Time at cursor position and velocity at cursor position. Position the pointer cursor over the analysis 
window. 

6. Sample Area Tools.
• Pencil Icon: Creates a sample area based on freehand drawing.
• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.
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Q-Analysis Screen Description  (continued)

 Figure 5-11. CF Mode Q-Analysis Example

Selecting QAnalysis Image Range

A range of frames is selected for the Qanalysis in Cine mode 
(before accessing QAnalysis). Only the frames in this range are 
used for the QAnalysis.

If a range is not selected prior to accessing the QAnalysis, the 
system uses the default Cine start and end frames as the default 
start and stop frames.

1. The first frame in the analysis series is selected by adjusting 
the Start Frame control to the desired frame. Using the 
Trackball or the Frame by Frame control to select the 
desired first frame and then selecting the Start Frame 
control.

2. The last frame in the analysis series is selected by adjusting 
the CINE End Frame control to the desired frame. Using the 
Trackball or the Frame by Frame control to select the 
desired last frame and then selecting the End Frame 
control.
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Generating a Trace

Trace from a pre-defined sample area

1. Select the sample area Ellipse ROI button (shape icon on 
the monitor display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor 
display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Trace the outline of the desired ROI by moving the caliper 
with the Trackball.

4. Press Set to anchor the sample area.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.
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Manual tracking of the sample area (dynamic anchored sample area)

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press Scan Area key until the QA trackball assignment is 
selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

7. Press Scan Area key until the scroll trackball assignment is 
selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.

Moving a dynamic anchored sample area

1. Press Scan Area key until the scroll trackball assignment is 
selected.

2. Using the Trackball, browse thought the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

3. Press the Scan Area key until the QA trackball assignment 
is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to a new location.

7. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 
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Delete a trace

The user can delete all traces at once or one at a time.

1. Move the cursor over one of the sample area. Confirm that 
cursor is changed to hand icon.

2. Select Delete Current Sample or Delete all samples as 
necessary.

Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the 
corresponding eight traces plotted simultaneously on the graph. 
Each ROI display has a different color, and its corresponding 
trace data is plotted using that same color.

Once eight ROIs have been saved, the system does not 
automatically generate an active ROI when the cursor is 
positioned over the displayed reference image.

The saved ROIs can be a mixture of elliptical and freehand 
ROIs.

When the user repositions an ROI, the old trace data is erased 
from the plot and the trace data for the new position replotted.

If the ROI position on the last frame of the selected image range 
is moved, the corresponding ROIs on all frames are 
repositioned to match the last frame.

The user shall also have the capability of setting separate ROI 
positions on different frames of the images, and the system shall 
linearly interpolate the ROI positions for the frames in between 
the selected frames. 
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Manipulating the Sample Area  (continued)

Setting the default sample area shape

1. Position the cursor on the ROI on the Cineloop windows, a 
white hand appears.

Figure 5-12. A White hand appears

2. Select Set sample area shape. The Information Box 
displays.

Figure 5-13. Sample Area Information Box

3. Select Height, Width and Tilt angle.

4. Select Set as default. The current ROI size is set as the 
default for subsequent Ellipse ROIs.

Reshaping a Sample Area

To reshape the sample area:

1. Position the cursor on the ROI on the Cineloop windows, a 
white hand appears.

2. Select Set sample area shape.

3. Adjust Height, Width and Tilt angle.

4. Press OK. The selected ROI size changes.
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Manipulating the Sample Area  (continued)

Sample Area Shapes

There are two different methods for determining the shapes of 
the sample area.

Ellipse ROI

1. Select the ellipse icon (shape icon on the monitor display).

2. When the trackball positions the image display cursor over 
the reference image(s), an elliptical ROI is automatically 
generated and displays on the reference image(s). 

3. The average velocity value inside the ellipse is calculated 
for every image in the image analysis range and plotted in 
the image display area.

4. The last generated or selected ellipse is considered the 
active ROI, and its trace plot automatically updates as the 
user repositions it on the reference image. Old traces are 
erased.

5. When scanning with an elliptical ROI, press Set to fix the 
ROI position and freeze its corresponding trace on the plot. 
A new active ROI is generated whose position is 
manipulated by the trackball and whose velocity curve 
traces will be plotted as before, while the previous ROI and 
trace remain fixed at the points they were saved at.

NOTE: Elliptical ROIs can be positioned in any manner that keeps their 
center within the image boundaries. In the case that part of the 
ROI is outside the image boundary, only data from within the 
image boundary is used for calculating the mean velocity value.

NOTE: You can change the size of the Ellipse ROI by adjusting the 
Ellipse control. 

Freehand ROI

1. Select Freehand icon (pencil icon on the monitor display).

Use the Trackball to position the caliper on the reference 
image at the start point. Press Set to fix the start point.

2. Trace the outline of the desired ROI by moving the caliper 
with the Trackball.

3. When a suitable ROI has been drawn, release the Set key.

The caliper is then free for repositioning for another 
freehand ROI.

NOTE: You cannot go outside the image boundary when drawing a 
freehand ROI.
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Deleting a Sample Area

Sample ROIs and their corresponding traces can be deleted. 

1. Move the cursor over one of the sample area. Confirm that 
cursor is changed to hand icon.

2. Select Delete Current Sample or Delete all samples as 
necessary.

NOTE: The corresponding traces for the deleted ROIs are erased from 
the plot.

NOTE: Deleting an ROI causes the ROIs to be deleted from all frames 
in the analysis loop.
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Disabling/Enabling the frame

Frame disabling excludes the actual frame from the cineloop 
display. Frame disabling is available only with contrast data.

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to the frame maker to 
disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the trackball to move the cursor to the first frame maker 
to disable.

2. Press and hold down Set.

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.

Disabling a frame from the cineloop window

1. Use the trackball to move the cursor to the cineloop window.

2. Select Disable frame.

The current frame is disabled and the corresponding frame 
marker displays red.

To enable the frames

To re-enable all deleted frames:

1. Position the cursor on the Frame Marker line.

2. Select Enable all frames.

3. All disabled frames are re-enabled.
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Smoothing

NOTE: Smoothing is not available when entering QAnalysis from 
CF/PDI mode.

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays. Select the appropriate 
parameter.

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time 
interval over which to plot the analysis curve. 

The Horizontal Sweep control can range from TBD on the short 
side to the time interval between the user selected first and last 
frame. The default is the user selected image range. If the user 
has not yet selected a first and last frame, the first and last 
default frames from the displayed CINE loop are used.

Drift Compensation

NOTE: Drift Compensation is only available when entering QAnalysis 
from TVI mode.

Drift Compensation compensates drifting of Tissue Tracking 
curves by either resetting the curve to zero at the tracking start 
point (cycle resetting) or by linear compensation throughout the 
cycle (linear compensation).

NOTE: When Displacement is chosen by Analysis Signal, Drift 
Compensation is active.
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Statistics

Select Statistics to enable/disable display of statistics of the 
frame or loop. The statistics are shown only when the loop is 
stopped.

• Ratio: Ratio of Color (Power) Doppler pixel over total ROI 
area.

• Area (mm2): The size of ROI.

• Max Ratio/ Time of Max Ratio: Maximum Ratio of Color 
(Power) Doppler pixels in each ROI, and which frame that 
occurs in.

• Min Ratio/Time of Min Ratio: Minimum Ratio of Color 
(Power) Doppler pixels in each ROI, and which frame that 
occurs in.

Trace Measurements

Max Gradient

Displays the time and gradient that becomes the maximum 
gradient between the CINE start and end frame. 

Figure 5-14. Max Gradient
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Exporting Traces (Saving the Trace Data)

You can save the trace data to an external file.

1. Select Export Traces to save the trace data.

2. The following window displays.

Figure 5-15. Export Trace Window

• Location: Select Location which to save.

• Filename: Enter the filename. (Only Text)

3. Select OK to save the data and return to the QAnalysis 
screen.

• All displayed ROI traces are saved in the exported file.

All plot data (intensity, gradient and gradient derivative) are 
exported to a text file by “Export Trace”.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: No trace results are saved in the standard image database.

Table 5-4:  Example of exported file

Time(s): Trace 1: Trace 1 dGrad.: Trace 1 dGrad.

0.00000 -3.97995e+000 -2.15924e+001 8.05159e+001

0.03121 -5.14631e+000 -1.64719e+001 1.74256e+001

0.06242 -5.75798e+000 -1.27675e+001 -7.78004e+001

0.09362 -6.02222e+000 -1.27675e+001 -1.93426e+002

0.12483 -6.11224e+000 -1.44515e+001 -4.17252e+002
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Annotating the QAnalysis Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.

Exiting QAnalysis

There are several methods to exit QAnalysis.

• Select Exit QAnalysis on the QA Primary Menu.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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Using Easy 3D (Option)

Overview

Table 5-5:  3D Package Options

3D Type Description Sensor/No Sensor Available Tabs

Easy 3D Designed for rendering 
B Mode images, e.g., 
Fetal Face scans.

No sensor 3D Acquisition, Easy 
3D, Movie
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3D Acquisition

Acquiring a 3D Scan

To acquire a 3D scan, 

1. Optimize the B-Mode image. Ensure even gel coverage.

2. Press the User defined key assigned to 3D. Two screens 
appear. 

NOTE: Set appropriate values for Acq Mode and Scan Plane 
parameters before scanning, for example scan distance. 

3. To start acquiring the image, press L (Left key). 

4. To perform a parallel scan, scan evenly across anatomy 
keeping probe perpendicular to anatomy being scanned. To 
perform a sweep (fan) scan, plant the probe and then rock it 
across the desired anatomy. Note the distance of the scan. 

5. The 3D volume of interest (VOI) is dynamically assembled 
on the right side of the screen.

NOTE: If the image stops before you’re done scanning, start 
acquiring the 3D volume of interest again. 

6. To complete the 3D scan, press R (Right key). 

3D Notes

• Adjust the 3D data set brightness with B-Mode. 

• Use Colorize to change the color of the active data set. 

• Use Zoom to increase the zoom factor of the active dataset. 

• Vertical lines may be seen in a resliced image. This usually 
happens when you scan too fast or if the scan distance is 
set to a high value.

Scan more slowly, adjust the frame rate for a faster rate or 
adjust the scan distance.
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Manipulating the Volume of Interest

Imagine you are able to manipulate the 3D volume of interest 
(VOI) in your hand. The 3D VOI is a tangible anatomical object 
that you can see and manipulate easily using the Trackball and 
Set control panel keys. 

Practice positioning the pointer at different places within the 3D 
VOI. Highlight different colors (white, red, yellow, or green). 
Press Set to select a VOI for manipulation. Use the hand to 
manipulate the 3D VOI. 

Rotating the 3D VOI Left/Right or Forward/Backward

You can rotate it left to right or right to left. You can rotate it 
forward/backward. Press Set key when the white pointer finger 
is positioned outside the 3D VOI. This makes it a white closed 
fist. Move the fist using the trackball to manipulate the 3D VOI.

 Figure 5-16. Manipulating the 3D Volume of Interest (White Hand)
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Moving Through the 3D VOI

You can move through the 3D VOI using the red hand. Press 
Set when the red pointer finger is positioned on the red box. 
Move the closed red hand to move through the 3D VOI. 

 Figure 5-17. Moving through a 3D Volume of Interest (Red Hand)

NOTE: Any plane in the volume can be made active (highlighted with 
red box) by clicking on it. 
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Viewing Specific Portions of the Anatomy

You can move a plane of the 3D VOI by using the yellow hand. 
When the white hand becomes yellow, press Set to form a 
yellow fist. This allows the user to manipulate a plane of the 3D 
VOI, displaying a new view of specific anatomy when moving 
the trackball. 

NOTE: A yellow hand appears only when the pointer is on an edge of 
the VOI. 

 Figure 5-18. Manipulating the Edge of a 3D Volume of Interest (Yellow Hand)
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Pulling Back a Corner of the VOI to View Specific Anatomy

You can move a corner of the 3D VOI by using the green hand. 
When the white hand becomes green, press Set to form a green 
fist. This allows the user to manipulate an edge of the 3D VOI, 
displaying a new view of specific anatomy when moving the 
trackball.

NOTE: A green hand appears only when the pointer is on a corner of 
the VOI.

 Figure 5-19. Manipulating a Corner of the 3D Volume of Interest (Green Hand)
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3D Acquisition Parameter Description

Table 5-6:  3D Acquisition Description and Instructions for Use

3D Parameter Description

App (Application) 
Presets

Selections: None, OB - Baby Face, User 1, User 2, User 3

None. No application preset applied. 

OB - Baby Face. After having scanned in this mode, certain 
rendering parameters are set automatically. The gray surface 
mode is activated and the texture mode is switched off. The 
gray surface mode values for opacity and threshold are set 
automatically according to the datasets histogram. 

Delete Active User 
Preset

Select to delete a user preset (User 1, User 2, or User 3).

Acquisition Mode Selections: Sensorless Parallel, Sensorless Sweep

Sensorless Parallel. In this mode the probe must be moved 
during 3D data acquisition without angling it. You should scan 
the object you want to render in 2-4 seconds. The speed at 
which you scan should be constant. No sensor is mounted on 
the probe. 

• Since the time for rendering depends on the acquired 
number of frames, it is recommended that you check the 
frame rate. Low frame rates result in fewer acquired 
frames for the 3D dataset which results in intensive 
rendering (interpolation). Therefore, low frame rate = long 
render times. 

Sensorless Sweep. In this mode the probe must be moved 
to a position where you can clearly see a middle cut of the 
object you want to scan and render. Tilt the probe to about 30 
degrees until the object you want to scan disappears. Start 
the acquisition and tilt the probe over a distance of around 60 
degrees until the object disappears again. The entire scan 
time should be around 2-4 seconds. During the sweep, the 
probe may not be moved parallel, just tilted. No sensor is 
mounted on the probe. 

Before starting an acquisition, take care that the transmitter is 
positioned correctly during data acquisition and that the 
transmitter cannot move. 
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NOTE: The selection of user presets is effective only while 3D mode is 
active. Exiting 3D mode and activating 3D mode again resets 
the 3D presets to the default setting, regardless if Patient or 
application changes.

NOTE: When a 3D image is recalled, no 3D presets are active and 
parameters are recalled from the image file.

NOTE: Default Scan Distance, Opacity and Threshold may not be 
consistent and may change per scan. After the User Preset is 
saved and recalled, Opacity and Threshold are consistent.

Scan Plane Selections: Front to Back, Side to Side

Front to Back. After having scanned in this mode, the 
rendered dataset is shown in a frontal view. For acquiring a 
fetal face in sagittal cuts, use this mode. 

Side to Side. After having scanned in this mode, the 
rendered dataset is shown from a side view. For acquiring a 
fetal face in coronal cuts, use this mode. 

Display Format 50/50. Display in Dual Image (2D and 3D).

Only 2D. Display in Single Image.

3D Starts the rendering process. 

Scan Distance Adjusts the distance covered during the scan. Depending on 
the real width of a scan acquired during a 3D acquisition, the 
volume of interest’s width can be enlarged or reduced. You 
can adjust the shape of a fetal face if the baby’s head looks 
oval instead of round. The assumed default width of a parallel 
scan is 6 cm; or 60 degrees for a sweep scan. 

Table 5-6:  3D Acquisition Description and Instructions for Use (continued)

3D Parameter Description
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Easy 3D

Figure 5-20. Easy 3D

Descriptions and instructions for using Easy 3D follow: 

Table 5-7:  Easy 3D Description and Instructions for Use

3D Parameter Description

Reset Resets the 3D volume of interest back to its original 
orientation. 

Utilities Select Average Off, Average Light, Average Medium, or 
Average Strong. 

Undo Undoes any manipulation you have done to your 3D dataset. 

Auto Movie Initializes the calculation and display of a 3D movie. A rotation 
of 30 degrees left and right around the actual image position 
(either the default position after acquisition or the position that 
was manually defined by manipulating the 3D volume of 
interest) is shown.
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Scalpel Structures, for example a part of the placenta hiding the view 
to a fetal face, can be cut out in a rendered image. All visible 
structures can be cut out.

The option of ‘Erase In’ deletes all structures inside the 
marked region. The option of ‘Erase Outside’ deletes all 
structures outside the marked region. 

To activate the scalpel tool, select “Scalpel” in the Primary 
Menu. Next, select “Erase In” or “Erase Out” and then move 
the cursor arrow into the 3D VOI to access the scalpel tool. 
Place the scalpel tool where you wish to begin cutting away 
anatomy and press Set. As you trace using the trackball, 
press Set for each vortex until the contour is closed. Double 
click the Set key to perform the cut. As long as a contour is 
not closed, it can be traced back with the cursor key. The cut 
out process can be undone by the Undo Last function. 

As soon as the Apply button is pressed, a new dataset is 
generated. 

Gray Surface Activates the gray surface rendering mode. It leads to a 
transparent appearance of the object, generated by 
displaying only a surrounding shell of structures. 

Texture Activates the texture or photorealistic rendering mode. It 
creates a photorealistic appearance of the object. The 
shading depends on the orientation of the surface of the 
object. 

If both Texture and Gray Surface mode are switched on, the 
mixture percentage of both modes can be defined. 

Render Changes between the rendered image view and the view of a 
volume of interest. The volume of interest shows the acquired 
ultrasound images transformed into an isotropic rectangular 
coordinate system. The volume of interest can be 
manipulated as described above. 

Threshold/Opacity Threshold defines which gray values are used for rendering 
and which are considered noise. 

Opacity defines how strict Threshold is used for 
discrimination. A low opacity value creates a firmer 
appearance of the surface. A high opacity value leads to a 
transparent appearance of the rendered image.

Table 5-7:  Easy 3D Description and Instructions for Use (continued)

3D Parameter Description
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Colorize/Contrast Colorize: Colorizes the 3D render. 

Contrast: Adds contrast to the 3D rendered image. 

Orientation Marker You can now specify/define, then add the following orientation 
markers while in 3D via the Orientation Marker key:

• TRV Sup to Inf
• Ant Scan
• Prb Rt

• TRV Inf to Sup
• Ant Scan
• Prb Rt

• SAG Lt to Rt
• Ant Scan
• Prb Sup

• SAG Rt to Lft
• Ant Scan
• Prb Sup

• Defined
• Superior
• Inferior
• Left
• Right
• Anterior
• Posterior
• Cancel

• None

Table 5-7:  Easy 3D Description and Instructions for Use (continued)

3D Parameter Description
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Movie 3D

Descriptions and instructions for using Movie 3D follow

Table 5-8:  Movie 3D Descriptions and Instructions for Use

3D Parameter Description

Manual An animated rotation of the rendered image can be calculated and 
displayed by this function. Using this function, you first need to 
define the start and end position of the rotation. To define this, move 
the VOI to the start position, the press Define Start. Move the VOI to 
the end position and press Define End. 

Movie 360 
Degrees

The calculation and display of a complete rotation around the axis, 
defined by the Axis button, starts in steps of 15 degrees. 

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 
degrees left and right around the actual image position (either the 
default position after acquisition or the position that was manually 
defined by manipulating the 3D volume of interest) is shown. For this 
60 degree rotation, eleven images in steps of 6 degrees are 
calculated.

Axis All rotations (Auto Move and Movie 360) are calculated as rotations 
around the specified axis (X, or Y). 

Movie Speed You can adjust the speed of any 3D rotation. 

Pause Stops and restarts the rotation. As soon as Pause is pressed, the 
different rotation steps can be displayed by moving the Trackball. 
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Scan Assistant

Introduction

Scan Assistant provides an automated exam script that moves 
you through an exam step-by-step. This allows you to focus on 
performing the exam rather than on controlling the system and 
can help you to increase consistency while reducing keystrokes. 
The system automatically invokes the correct mode and imaging 
parameters, advances to the next step in an exam, annotates 
the image, initiates measurements, and assigns the 
measurements to the worksheet/report. 

Availability

The following additional imaging parameters and preferences 
are available for use in a Scan Assistant program: CW Doppler, 
Dual on Freeze, Depth, Color Scale, PW Doppler Scale, PW 
Sample Volume size, and Flow Model Selection.

You can initiate one or more manual Doppler measurements/
calculations. 

Body Patterns are available for use during a Scan Assistant 
program. You can turn a Body Pattern on/off, select a particular 
Body Pattern graphic, and specify the position of the probe mark 
on the Body Pattern graphic. 

The footswitch can be used with Scan Assistant. You can map 
Pause/Resume, Previous Step, and Next Step to the footswitch.

The “Always Use Doppler Cursor” preset, available on the 
Utility --> System --> General page, allows all PW Doppler steps 
to start with full screen 2D image plus mode cursor. You can 
specify the Store Order in Scan Assistant to set the Reading 
Order for the radiologist. The Learn Probe attribute can be set to 
learn and change the probe for the user in the middle of the 
exam.
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Scan Assistant Definitions

Scan Assistant definitions: 

• Scan Assistant Manager. Available via the Utility -> Scan 
Assistant page to import/export Programs created via the 
Scan Assistant Creator and to assign Programs to a user/
exam category. 

• Import. Used to load Programs created via the Scan 
Assistant Creator on to the LOGIQ V2/LOGIQ V1. 

• Export. Used to move Programs from one LOGIQ V2/
LOGIQ V1 system to another LOGIQ V2/LOGIQ V1. 

• Scan Assistant Creator. Used to create Scan Assistant 
Programs. 
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Scan Assistant Description

Figure 5-21. Scan Assistant Display Description

1. Program name, completed steps/out of total number of 
steps, and step description area. 

2. Program step status (Complete/Incomplete), step number, 
step name. A checkmark indicates that this step has been 
completed. You can also manually check the box to bypass 
this step. 

3. This column indicates the mode or when a measurement 
needs to be made. 

4. This column indicates that the action moves the Program to 
the next step. 

5. Active step: the box is green when the program is active or 
yellow when it is paused. 

6. Edit (Pencil Icon). 

7. Stop. Stop allows the program to be stopped, restarted, or a 
new program selected. 

8. Pause/Resume. 

9. Enter/Exit Reference images/Videos. 
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Setting up Scan Assistant

To set up Scan Assistant, 

1. Import the Scan Assistant Program created using the Scan 
Assistant Creator or exported from another LOGIQ V2/
LOGIQ V1 program. 

a. Insert the media with the saved Program from the Scan 
Assistant Creator or exported program from another 
LOGIQ V2/LOGIQ V1. 

b. Select Utility -> Scan Assistant. 

c. Select Import from the Scan Assistant Manager page. 

Figure 5-22. Import Programs

d. In the Source field at the top of the Import Programs 
pop-up, select the media that the Program is stored on. 
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Setting up Scan Assistant  (continued)

e. Select the Program(s) to be imported. If a folder is 
selected, all programs in the folder will be imported. 

Figure 5-23. Import Programs
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Setting up Scan Assistant  (continued)

f. Select Import. The Program(s) you selected are stored 
to the LOGIQ V2/LOGIQ V1. You can add it to the exam 
category and user. 

Figure 5-24. Add Program
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Setting up Scan Assistant  (continued)

2. Assign the imported Program to the exam category and 
user. Under Program Selections on the right-hand side of 
the Scan Assistant Manager page, specify the Exam 
Category and User for this Program. You can select All 
Users, or a specific user. If you specify All Users, all users 
will have the ability to use this Program while in the specified 
exam category, unless the user has his/her own list defined. 

3. Select the imported Program from Available Programs -> 
Custom Programs on the left-hand side of the page. Then 
press the right arrow button to move the imported Program 
to the exam category and user selected above. 

Figure 5-25. Add Program
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Setting up Scan Assistant  (continued)

4. The Program list you created in Utility ->Scan Assistant is 
visible in the Program field on the Patient menu. First press 
Patient and then set up patient data and Scan Assistant 
program, and finally, press Scan. 

Figure 5-26. Patient Scan Assistant Program

You can access the Scan Assistant Creator to edit the exam’s 
program from the imaging display via the Creator Icon located at 
the bottom, left-hand corner of the Scan Assistant Program 
monitor on the display. You can activate the Scan Assistant 
Creator from the image screen, make edits, and then run Scan 
Assistant to test your changes. 

NOTE: If you edit the program after you have already stored several 
images, and your edits change the number of program steps, 
you are prompted to Restart or Continue the Scan Assistant 
program. 

NOTE: If you edit the program after you have already completed several 
steps, checkmarked steps remain checkmarked, even if you 
insert a new step between checkmarked steps. If this is not 
correct, you can edit the checkmarks or restart the program. 
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Using Scan Assistant

After you have set up Scan Assistant, the Program is active 
when you enter the scanning page. The Program is located on 
the left-hand side of the display and as you can see in the 
example below, the annotation for the first step has been 
automatically noted on the image, ready for you to scan the 
specified anatomy. 

 Figure 5-27. Scan Assistant Display
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Using Scan Assistant  (continued)

1. Follow the steps indicated in the Program: image/measure 
the appropriate anatomy. 

2. Perform the indicated trigger (press the Store key) to move 
to the next step in the Program. 

NOTE: The footswitch can be used with Scan Assistant. You can 
map Pause/Resume, Previous Step, and Next Step to the 
footswitch.

3. To pause or unpause Scan Assistant, press the pause 
button on the display. 

4. To stop or restart a Program, press the Stop icon at the 
bottom of the Scan Assistant Program. A dialog pops up. 
This dialog lets you restart the current Program, start 
another Program, or stop Scan Assistant. 

5. To skip a step or move to a certain step, press the up/down 
arrows on the keyboard or select the step you want to move 
to using the Trackball and Set keys. 
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Exporting Scan Assistant Programs

Exporting Scan Assistant Programs allows them to be imported 
to another LOGIQ V2/LOGIQ V1 or to be edited offline with the 
Scan Assistant Creator tool. To export a Program, 

1. Insert the media to save the Program to. 

2. Press Utility -> Scan Assistant. 

3. Select Export from the Scan Assistant Manager page. 

4. In the Destination field at the top of the Export Programs 
pop-up, select the media that the Program is to be stored 
on. 

5. Specify the Program Directory using the drop-down menu if 
the desired Program Directory already exists on the media. 
If not, or if you want to export the Program to a new Program 
Directory, type a new Program Directory name in the field. 

6. Select the Program(s) to be exported. If a folder is selected, 
all programs in the folder will be exported. 

Figure 5-28. Export Programs

7. Select Export. The Program(s) you selected are stored to 
the media. You can now import it to a new LOGIQ V2/
LOGIQ V1.
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Scan Coach

Scan Coach

Before performing Scan Coach function on the system, please 
read and accept the Statement, Disclaimer and Limitation of 
liability described below:

Statement Scan Coach IS NOT MEANT TO REPLACE TRAINING, OR 
TUTORIALS/HANDS-ON. IT IS MERELY A REFRESHER 
TOOL OF ALREADY RECEIVED EDUCATION AND TRAINING.

Scan Coach IS AN ON –DEMAND REFRESHER AND 
REMINDER TOOL WHICH DISPLAYS INFORMATION IN THE 
FORM OF DICOM IMAGES AND ANIMATIONS; THE 
PROVIDED REFERENCE MATERIAL MAY HELP USER IN 
ACQUIRING ULTRASOUND IMAGES.

Scan Coach DOES NOT PROVIDE A DIAGNOSIS, BUT DOES 
PROVIDE REFERENCE MATERIAL FOR SOME TYPES OF 
ACQUISITIONS.

Scan Coach IS MEANT TO PROVIDE REFERENCE 
MATERIAL FOR ACQUISITION, BUT IT IS NOT INTENDED TO 
IDENTIFY DIAGNOSTIC IMAGE QUALITY. ACTUAL IMAGES, 
INCLUDING IMAGE QUALITY, OF THE DEVICE MAY VARY 
VERSUS THE PROVIDED REFERENCE MATERIAL.
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Scan Coach  (continued)

Disclaimer Scan Coach AND THE CONTENT AVAILABLE THROUGH IT 
ARE PROVIDED ON AN "AS IS" AND "AS AVAILABLE" BASIS. 
YOU EXPRESSLY AGREE THAT USE OF Scan Coach AND/
OR ITS CONTENT IS AT YOUR SOLE RISK. TO THE 
FULLEST EXTENT PERMISSIBLE PURSUANT TO 
APPLICABLE LAW, GE AND ITS AFFILIATES DISCLAIM ALL 
WARRANTIES OF ANY KIND, WHETHER EXPRESS OR 
IMPLIED, INCLUDING WITHOUT LIMITATION ANY 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE OR NON-INFRINGEMENT. YOU 
EXPRESSLY AGREE THAT USE OF Scan Coach, INCLUDING 
ALL CONTENT, IS AT YOUR SOLE RISK.

ANY RESPONSIBILTY FOR IMAGE ACQUISITION, IMAGE 
INTERPRETATION, IDENTIFICATION OF ANATOMICAL 
PARTS, ANATOMICAL MEASUREMENTS AND CLINICAL 
DIAGNOSIS LIES WITH YOU, THE ULTRASOUND USER.

TO THE FULLEST EXTENT PERMISSIBLE PURSUANT TO 
APPLICABLE LAW, GE AND ITS AFFILIATES DISCLAIM ALL 
LIABILTY AND RESPONSIBILITY FOR ANY DAMAGES 
SUFFERED BY A USER, OR PATIENT OF A USER 
INCLUDING, BUT NOT LIMITED TO, DAMAGES ARISING 
OUT OF LOSS OR INACCURACY OF CONTENT OF Scan 
Coach.

IT IS THE RESPONSIBILTY OF YOU, THE ULTRASOUND 
USER, TO UNDERTAKE ALL NECESSARY AND 
CUSTOMARY TRAINING, AND TO MEET ALL OTHER 
REQUIREMENTS OF APPLICABLE LAWS AND 
REGULATIONS, BEFORE USING THE ULTRASOUND 
DEVICE.

Limitation of 
Liability

UNDER NO CIRCUMSTANCES, INCLUDING, WITHOUT 
LIMITATION, NEGLIGENCE, SHALL GE OR ITS PARENTS, 
SUBSIDIARIES, AFFILIATES, OFFICERS, DIRECTORS, 
EMPLOYEES, AGENTS, OR SUPPLIERS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL DAMAGES ARISING FROM OR IN 
CONNECTION WITH THE USE OF OR THE INABILITY TO 
USE Scan Coach.
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Introduction

Scan Assistant is a series of built-in examination and workflow 
protocols, with automated exam script superimposed on them. 
The protocol steps allows you to refresh what steps should be 
performed in a given exam, while the superimposed automated 
script allows you to focus on performing the exam by reducing 
your efforts in controlling the system. Scan Assistant can help 
you to increase consistency and efficiency while reducing 
keystrokes. The system automatically invokes the correct mode 
and imaging parameters, advances to the next step in an exam, 
annotates the image, initiates measurements, and assigns the 
measurements to the worksheet/report. 

Scan Coach is an extension of the utility of Scan Assistant. Scan 
Coach leverages the built-in examination script of Scan 
Assistant and overlays it with clinical content that can be 
displayed on-demand by the user to quickly refresh herself of 
some key information. Refreshing such information about an 
exam step just before scanning may help the user to acquire the 
right scan plane. The reference image indicates how the scan 
plane image for a given step should look like. The probe/beam 
anime image shows the corresponding probe placement, or 
beam formation for getting the correct scan plane. The schema 
anime shows the key anatomical structures to be visualized in 
two dimensional mode.

Scan Coach can be used as an on-demand refresher/reminder 
tool in live scanning.
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Using Scan Coach

1. Go to Utility -> Measure -> Scan Assistant Manager, select 
the protocol from the left column, and select >> to move it to 
the Program Selections column. Then select Exit to the 
Scanning page.

Figure 5-29. Select Scan Coach Protocol

2. Press Patient key on the control panel to register a new 
patient. Then select the protocol from the pull-down menu, 
and then select Scan to navigate to the Scan Coach screen.

Figure 5-30. Scan Coach Start
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Using Scan Coach  (continued)

Figure 5-31. Scan Coach Display Description

a. Program name, completed steps/ total number of steps. 

b. Program step status (Complete/Incomplete). A 
checkmark indicates that this step has been completed. 
You can also manually check the box to bypass this 
step. 

c. Step Number, Step Name

d. Select this icon to view the reference image.

e. This column indicates the mode or when a 
measurement needs to be made. 

f. This column indicates that the action moves the 
Program to the next step. 

g. Active step. The box is green when the program is 
active or yellow when it is paused. 

h. Edit (Pencil Icon)

i. Stop

j. Pause or Resume

k. In/Out Step
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Using Scan Coach  (continued)

3. Select  or press the button   to activate the 
reference image screen for the current active step. 

4. Select   or press the button   to activate the 
probe position and schema image along with the reference 
image. It displays reference image, probe position and 
schema to guide the user to acquire the right scan plane.

 Figure 5-32. Scan Coach Reference, Probe position and Schema Images

5. Complete the scan and make the measurements if 
necessary, press Store key to store the image and go to 
next step.
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Setting up Scan Coach

Go to Utility -> Scan Assistant -> Scan Assistant Manager to 
create, import/export and manage the Scan Assistant /Scan 
Coach programs.

 Figure 5-33. Setting up Scan Coach
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Edit Scan Coach Protocol

1. To edit Scan Coach protocols, go to Utility -> Scan Assistant 
-> Scan Assistant Manager and select Creator.

 Figure 5-34. Scan Assistant Manager

2. The Scan Assistant Creator is used to build customized 
programs that can be imported onto the LOGIQ V2/LOGIQ 
V1. Select Scan Coach on the tool bar to display the Scan 
Coach edit page.

NOTE: By default Apply All Parameters checkbox is checked. This 
applies all the parameters of the reference image to the live 
image. When you uncheck the checkbox the parameters 
from the reference image will not be applied to the live 
image.
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Edit Scan Coach Protocol  (continued)

Figure 5-35. Scan Assistant Creator

3. Select the Scan Plane.

 Figure 5-36. Select Scan Plane
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Edit Scan Coach Protocol  (continued)

4. Select Browse to upload the reference image. 

Select Upload to Upload the reference image from the 
folder called “Reference Images” of the corresponding 
application. Then select Close after the upload is complete.

NOTE: The reference image only supports *.dcm file.

 Figure 5-37. Upload Reference Image
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Edit Scan Coach Protocol  (continued)

The reference image can also be uploaded from external 
USB flash drive/HDD/CD/DVD. Select the correct directory 
from the pull-down menu, and then select the appropriate 
image to upload.

 Figure 5-38. Upload Reference Image 2

5. Upload Probe Position Image and Schema Image from the 
folder called “Other Images” of the corresponding 
application, or from the external devices.
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SonoBiometry (AFB) (Option)

SonoBiometry

SonoBiometry (AFB) is an alternative to the common fetal 
biometry measurements. It provides system suggested 
measurements for AC, BPD, FL and HC which need to be 
confirmed by the user or can be changed manually. AFB is Auto 
Fetal Biometry.

Table 5-9:  List of Abbreviations

Abbreviation Full Form Definition

AC Abdominal Circumference Measure of fetal growth in pregnancy

BPD Biparietal Diameter Transverse distance between the protuberances of 
the two parietal bones of the skull

FL Femur Length The length in centimeters of the developing baby's 
femur (the femur is the long bone in the human thigh)

HC Head Circumference Head Circumference of the baby's head
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Using SonoBiometry

1. Go to Utility -> System -> System Measure.

2. Check the desired boxes under SonoBiometry Option 
Selection to enable system suggested measurements.

 Figure 5-39. SonoBiometry checkboxes

3. Select Exit to return to scanning.

4. Setup the patient with OB preset.

5. Preform the scanning

6. Press Measure.

7. Select BPD or HC or AC or FL.
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Using SonoBiometry  (continued)

There are three options to complete the SonoBiometry 
measurements:

• Accept – Press Accept if you accept the current 
measurement. The system completes the measurement.

• Edit – Press Edit to get into the edit mode and make the 
required changes.

• Manual – Press Manual to ignore the auto measurements 
completely. The system goes into the Manual measurement 
mode.

 Figure 5-40. SonoBiometry option

NOTE: If a particular scanned image does not have valid fetus data, a 
warning message appears: “No valid ‘auto measurement’ found 
- proceed with a manual measurement!”.

NOTE: If a particular image is not supported for SonoBiometry 
measurement, a warning message appears: “Not able to 
proceed on the image supplied”. 

NOTE: SonoBiometry measurements are supported on only recalled 
raw DICOM images and frozen images.
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Chapter 6

Scanning/Display Functions

Describes additional ways in which to adjust the image. 
In addition, describes additional ways to get useful 
information electronically. 
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Zooming an Image

Introduction

Zoom is used to magnify a zoom region of interest (ROI). The 
system adjusts all imaging parameters accordingly. You can also 
zoom frozen images. 

Reference Image is the small un-zoomed image displayed next 
to the zoomed image.

Bioeffect

Zooming an image changes the frame rate which tends to 
change thermal indices. The position of the focal zones may 
also change which may cause the peak intensity to occur at a 
different location in the acoustic field. As a result, the MI (TI) 
may change.

Acoustic
Output
Hazard

Observe the output display for possible effects. 
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Read vs. Write Zoom

Read Zoom

Read Zoom magnifies the display of the data without making 
any changes to the ultrasound image data that is acquired.

Available in a live, frozen, cine or recalled raw data image.

Write Zoom

With Write Zoom, the Ultrasound line density and/or sampling 
frequency increases, giving a better resolution.

Available only in pre-processing.

NOTE: Write Zoom is available only when CrossXBeam is off.

You can preset the write zoom window size (height and width) 
on Utility -> Imaging -> B-Mode.

NOTE: The difference between Read Zoom and Write Zoom can be 
described in relation to photography. With a photograph, Read 
Zoom manipulates the negative and enlarges the picture; 
whereas Write Zoom uses a telephoto lens to bring the image 
closer before taking the picture.
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Using Read/Write Zoom

When CrossXBeam is on, write zoom can not be activate: 

To activate Read Zoom, press the Depth/Zoom/Ellipse knob 
once, the zoom status is indicated on the system status bar. 

To zoom an image, rotate Depth/Zoom/Ellipse knob clockwise. 
A reference image appears in the down, left-hand section of the 
display. 

 Figure 6-1. Read Zoom

1. Zoom status

2. Reference Image

To exit zoom, press B-Mode or press the Depth/Zoom/Ellipse 
knob again or rotate Depth/Zoom/Ellipse knob 
counterclockwise until the reference zoom image is removed. 
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Using Read/Write Zoom  (continued)

When CrossXBeam is off, both read zoom and writer zoom can 
be activated: 

To activate Read Zoom, press the Depth/Zoom/Ellipse knob 
once, the zoom status is indicated on the system status bar. 

To activate write Zoom, press the Depth/Zoom/Ellipse knob 
again, the zoom status is indicated on the system status bar. 

To zoom an image, rotate Depth/Zoom/Ellipse knob clockwise. 
A reference image appears in the down, left-hand section of the 
display. 

 Figure 6-2. Write Zoom

1. Zoom status

2. Reference Image

To exit zoom, press B-Mode or press the Depth/Zoom/Ellipse 
knob the third time or rotate Depth/Zoom/Ellipse knob 
counterclockwise until the reference zoom image is removed. 

HINTS First use the Read Zoom (Press Zoom knob once) to get to the 
area of interest, then use Write Zoom (press Zoom knob again).
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Split Screen

Overview

LOGIQ V2/LOGIQ V1 supports the following multiple image 
format:

• Dual (split the window area into 2 areas)

• Wide Dual (split the window area into 2 areas, but wider 
than the normal dual)

• Quad (split the window area into 4 small areas)

This is useful, for example, when measuring AFI. 

• Simultaneous

Dual/Quad

To activate a dual split screen, press L or R. To activate a quad 
display, press and hold down L. 

When you activate Split Screen by pressing L, the single image 
is placed on the left side; when you activate Split screen by 
pressing R, the single image is placed on the right side. 

To switch between active images, press L/R.

To deactivate, press R until the screen changes.

NOTE: To put a copy of the image on the opposite side when entering 
dual split screen, use the “When Entering Dual Image...” preset 
via Utility --> Application --> Settings. 

Simultaneous mode

While using CFM or PDI, press the L and R keys simultaneously 
to display B and B+CFM, or B and B+PDI in real-time on the left 
and right side.

It is useful to observe the ROI in B-Mode.
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Freezing an Image

Introduction

Freezing a real-time image stops all movement and allows you 
to measure and print the image.

NOTE: While the image is frozen, all Power Output is suspended. 

NOTE: Selecting a new probe unfreezes the image.

Freezing an image

To freeze an image, 

1. Press Freeze. The Freeze key backlight turns green. 

If you are in a mixed mode, both images freeze immediately. 
Deactivating Freeze restarts both modes. 

To reactivate the image, 

Press Freeze again. The Freeze key backlight becomes blue 
(unfreeze). 

NOTE: Deactivating Freeze erases all measurements and calculations 
from the display (but not from the worksheet). 

 Use the Trackball to start CINE after pressing Freeze. 
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Post processing

You can use the following controls to process a frozen B-Mode 
image. 

• Revert

• Zoom

• Rejection

• SRI HD

• Dynamic Range

• Colorize

• Gray Map

• Rotation

• Biopsy Kit

• Edge Enhance

• Gain

• TGC

You can use the following controls to process a frozen Color 
Flow image.

• Threshold

• Invert

• Map

• Transparency Map

• Biopsy Kit

• Baseline

• Map Compress
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Post processing  (continued)

You can use the following controls to process a frozen Doppler 
Mode image.

• Angle Correct

• Quick Angle

• Baseline

• Invert

• Sweep Speed

• Trace Sensitivity

• Trace Direction

• Colorize

• Trace Method

• Cycles to Average

• Display Format

• Compression

• Gray Map

• Auto Angle

• Modify Auto Calcs
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Using CINE

Introduction

CINE images are constantly being stored by the system and are 
available for playback or manual review via CINE. 

You can view CINE as a continuous loop via CINE Loop or 
manually review CINE images frame by frame via the Trackball. 

Data in CINE is available until new data is acquired. CINE is 
stored on the system's memory and can be archived as well. 

CINE is useful for focusing on images during a specific part of 
the heart cycle or to view short segments of a scan session. 

Activating CINE

To activate CINE,

1. Press Freeze.

2. Move the Trackball.

Cine gauge and Monitor Display

The Cine gauge (located on the right-hand side of the monitor) 
indicates which frame you are viewing of the whole loop 
(62:123), as well as the time at which this frame occurs within 
the loop (1.6:3.2 s). 
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Using CINE

Table 6-1:  Cine Mode Menu description

Parameter Description

Select All Select all frames of the cineloop.

Sync Mode Phase synchronizes multiple CINE Loops.

First Move to the first frame of cineloop.

Last Move to the last frame of cineloop.

Run/Stop Start/Stop the cineloop review.

Loop Speed Adjust the CINE Loop playback speed.

Start Frame Select the start frame.

End Frame Select the last frame.

Frame by Frame Review the CINE image frame by frame manually.

QAnalysis Enter QAnalysis.

Cine Capture Searches through all images between the start frame and end frame and 
displays each peak or the highest velocity/tissue power.

Enhancement Execute the enhancement to the Cine capture image.
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Cine Loop Start/Stop

1. Press Freeze.

2. Rotate the Trackball horizontally to display the CINE Loop.

3. Select Run/Stop to playback the loop.

4. Select Run/Stop again to stop the CINE Loop. 

Select the start/end frame

1. Adjust Start Frame to select the start frame.

2. Adjust End Frame to select the end frame.

Storing / Recalling CINE Loops

To store a CINE Loop, press Run, then press the assigned 
Store or Print key. CINE Loops stored on the Clipboard are 
indicated with a movie strip icon.

To recall a CINE Loop, double click on the loop on the clipboard.

Synchronize CINE Loops

1. Recall stored cine loop to right side of dual screen.

2. Recall same cine loop to left side of dual screen.

3. Change visualization of left side image

4. Select Sync mode to start the synchronization.
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Cine Mode Selection

If it is in Simultaneous mode before freeze:

To scroll both B-Mode CINE loop and Time CINE loop, press 
Scan Area to select the Scroll function for trackball, then mover 
the trackball to select;

To scroll B-Mode CINE loop only, press Scan Area to select the 
Scroll B function for trackball, then mover the trackball to select.

If it is not in Simultaneous mode before freeze:

To scroll B-Mode CINE loop only, press Scan Area to select the 
Scroll B function for trackball, then mover the trackball to select.

To scroll the Timeline CINE Loop only, press Scan Area to 
select the Scroll D function for trackball, then mover the 
trackball to select.

Velocity Scale with B-Mode Only

If you review the B-Mode CINE Loop while in Doppler Mode with 
the Timeline using Scroll B, the Velocity Scale displayed with the 
Timeline is for the time phase of the currently-displayed B-Mode 
image, NOT for the time phase of the acquired Doppler 
Spectrum. 

Check the velocity value with the measurement function if you 
review the CINE Loop using Scroll B. Note that there may be a 
discrepancy between the velocity scale displayed and the 
velocity measured using the measurement function. 

Preview

Loop Preview can now be enabled independently for Time 
-Based Store. This is useful for setting preview preferences 
based on the application. 
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Annotating an Image

Introduction

The comment function provides the capability to type the 
comments of free text and/or insert the pre-defined comments 
from the comment library. It also provides the user with arrow 
markers to point to parts of the image.

Pressing the Comment key or any keys on the alphanumeric 
keyboard initiates the comment mode. This assigns the trackball 
function to controlling the cursor and displays the comment 
library.

In comment mode, text can be added by using the comment 
library or by typing from the alphanumeric keyboard.

Comments can be erased by powering down, when you press 
Clear or End Exam, or when preset via Utility -> Comments. 
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Introduction  (continued)

In addition, the display’s home position can be changed 
(preferred comment area) for each display so that all 
subsequent comments begin in the same spot.

Pressing the F7 key returns to the user specified position or 
factory default position.

A new cursor home position is established by placing the cursor 
in the desired position and pressing Shift+F7.

Comment Mode is activated by pressing the Comment key. 
Comment Mode can also be automatically activated by typing 
from the alphanumeric keyboard.

After activating the comment mode, a vertical bar type cursor 
appears on the screen. Use the Trackball to move the cursor.

The factory default color for comments is yellow. The color 
selection can be changed to any of the colors available on the 
system via Utility -> Comments -> Comments -> Text.

NOTE: The user cannot change the Font Family. 

To indicate a specific comment or text group is selected, the 
color turns to green. Once the comment is set or fixed, the color 
returns to yellow or to the user selected color.

NOTE: If selected “Automatically Set Text” in Utility -> Comment -> 
Comment, the system sets the comment at the cursor position 
automatically when text entry is complete. 

To delete comments by character, press the Backspace key.

To delete all comments, press the Clear key twice immediately 
after entering the comment mode. 

To delete all comments and arrow marks, press and hold the 
Clear key until all comments and arrow marks disappear after 
entering the comment mode. 

To exit the Comment/Library Comment function, press the next 
function you wish to do. 

To move by words or by text group, press the Tab key.
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Adding Comments to an Image

Comment Retention

Comments from the B-Mode images are retained and carried 
over when switching to multi-image format or Simultaneous 
mode.

The position of the comments is adjusted so that it is at the 
same relative position with respect to the display window in the 
new format as it was in the single image format.

NOTE: Comments may not be retained when the image is switched to 
M-Mode image format depending on the preset. 

Arrow Pointers

Arrow pointers can be used by activating the F2 (Arrow) key on 
the keyboard. When the pointer comes up, it is a GREEN color, 
indicating it is active and can be moved.

• Move the pointer using the Trackball to any place on the 
screen. The pointer head direction can be controlled by 
movement of the Trackball or Arrow Rotate control.

• To readjust the length and thickness of the pointer, use the 
Arrow Length and Arrow Width control. The default for the 
pointer size can be preset.

• Press Set to fix the place of the pointer and direction of the 
pointer head. The GREEN color turns to YELLOW (or the 
default color if changed).

• To delete the arrow marks, press the Clear key right after 
pressing the F2 (Arrow) key.

NOTE: To erase all comments as well as arrows, press and hold the 
Clear key. 

NOTE: To prevent the Trackball from changing the arrow angle, select 
the “Keep arrow angles” preset at Utility -> Comments -> 
Comments.
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Text Overlays

There are 2 layers of the text in comments, which can be 
selected by toggling the F8 (Text1/Text2) key on the keyboard. 
Text1 is the default choice.

By using this function, users can perform a HIDE TEXT/SHOW 
TEXT, allowing the users to save or print an image without 
clearing the typed text.

You can specify to display text 1, text 2, or both. This allows you 
to have some comments that do not change during the exam 
while allowing you to change the other comment. Toggle the F8 
key to cycle through the three Text 1/Text 2 states: 

1. Text 1 (Display and Edit) -- Only Text 1 displays and can be 
edited. 

2. Text 2 (Display and Edit) -- Only Text 2 displays and can be 
edited.

3. Text 1 (Display) and Text 2 (Display and Edit)-- Both 
displayed; only Text 2 comments editable. Only Text 2 
comments erased by Clear key. Word Delete only deletes 
Text 2 comment. Both Text 1 and Text 2 comments are 
erased with new patient, new exam, or probe change. 

To preset the Text Overlay Sequence, go to Utility -> 
Comment -> Comment and select either Text 1 and Both or 
Text 1 and Text 2 and Both. 

The font color for the Text1 and Text2 overlays can be set 
separately. Go to Utility -> Comment -> Comment and specify 
the text color for Text 1 Color and Text 2 Color.

NOTE: If you check “Erase when image is unfrozen” in the Utility menu, 
only the editable text plane erases when you unfreeze the 
image. 
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Annotating an image with typed words

• Press Comment and type the comments where the cursor 
is currently located (the display's home position) and use 
the Trackball to further place the comment cursor in the 
desired location.

• Press Enter to move to the next line.

NOTE: Comments wrap to the next line when they are within one 
character of the right margin if Word Wrapping is selected in the 
Text Boundary preset via Utility -> Comments -> Comments.

The word wrap starts one line below the start of that comment.

Comments appear on all prints, photos or CINE loops.

Figure 6-3. Next Line Word Wrap

If the cursor appears at the right edge of the lowest line, or a 
word cannot be completed in the lower right corner, word wrap 
cannot be executed.

NOTE: The same word wrap principles apply for library scripts as typed 
comments.

Annotating an image using the library

To reduce the amount of time spent annotating an image, store 
frequently-used comments in the Comment Library. One of the 
selected libraries is designated as the default and its entries 
shall be displayed on the menu the comment mode is activated 
for that study.

Press Comment and move the comment cursor location using 
the Trackball.

Select the desired comments or select the 

To program your system with specific comments, see 
‘Comments Libraries Presets’ on page 16-42 for more 
information.

1. Before 2. After

1 2

WORD WRAP WORD
WRAP
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Annotating an image using a Hot Key (Comments)

Before enter into comments mode, select the hot keys which are 
predefined for the frequently-used comments to enter into 
comments mode and add comments to the image.

NOTE: “Enable Alphabet Hot Key” in Utility -> System -> User 
Configurable Key should be selected before using the hot key.

There are ten alpha keys (A, S, D, F, G, H, J, K, L and ;) that are 
programmable as hot keys to store frequently-used comments. 
See ‘Comments Libraries/Libraries Preset Menu’ on page 16-42 
for more information.

Moving Texts

You have the ability to move comments already on the screen 
and place them in different locations.

• Place the cursor on the desired text or text group and press 
Set.

• The selected text color turns to green.

• Use the Trackball to move the selected text and press Set.
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Editing while annotating

Backspace over any error(s) made. Blank spaces take the place 
of the letter(s) that were there. Continue typing the comment 
after backspacing over all incorrect letters.

To delete previous character(s):

• Press Backspace as many times as necessary to make the 
deletion. 

• Once all texts within the selected text group are deleted, 
then the cursor will find another text group to delete. 

• If there is no more text to delete, the cursor will be located at 
home position.

To move through the text a word at a time:

• Press Tab or Shift + Tab.

To activate the last text group typed or selected from the Library:

1. Press F9 (Grab Word) key. The selected comment will be 
highlighted.

2. To increase/decrease the area of the highlighted selection, 
adjust HIGHLIGHT.

Once the text is highlighted, typing comments or choosing 
them from the library replaces the highlighted text. 

To select all text groups, Press Shift + F9 (Grab Word) key.

To cancel the last action:

• Select Undo.

NOTE: Undo only can restore the last deleting step.
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Body Patterns

An additional way to annotate the image display is with body 
patterns. Body patterns are a simple graphic of a portion of the 
anatomy that is frequently scanned. The body pattern and probe 
marker can serve as a reference for a patient and probe 
positioning when images are archived or scanned.

Press the Body Pattern key on the control panel to enter into 
body pattern mode.

The body pattern packages may be customized to 
accommodate user preference.

Figure 6-4. Displays of Body Pattern - example

Select the desired body pattern and the selected body pattern is 
displayed on the monitor.

• Select the Move Pattern control to reposition the body 
pattern with the Trackball and Set controls.

NOTE: Body Pattern Position is updated when the display format is 
changed.

NOTE: Body Pattern Position is reset to factory default when patient 
is changed (i.e. End Exam).
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Body Patterns  (continued)

• A probe mark is associated with the body patterns and 
illustrates the probe position on the body pattern. This 
marker can be placed with the Trackball and rotated with 
the Probe Rotate button.

• The probe mark type is selectable by adjusting the Probe 
Type menu.

• To select the active side in dual B-Mode, use the Active 
Side menu.

• To clear the body pattern, press the Body Pattern button to 
activate body patterns and then select the Clear key. 

• Press Set key on the control panel or Body Pattern key on 
the control panel to exit without erasing the body pattern.

Annotating an image using a Hot Key (Body Patterns)

After enter into Body Pattern mode, select the hot keys which 
are predefined for the frequently-used body patterns to add 
Body Pattern to the image.

NOTE: “Enable Alphabet Hot Key” in Utility -> System -> User 
Configurable Key should be selected before using the hot key.

There are 10 alpha keys (Q, W, E, R,T, Y, U, I, O and P) that are 
programmable as hot keys to store frequently-used body 
patterns. See ‘Body Pattern Libraries/Libraries Preset Menu’ on 
page 16-47 for more information.

Notes for Body pattern (Probe mark)

• Probe Type is the type of probe mark displayed on the body 
pattern. It can be saved only for each body pattern while 
body pattern is activated, but not in the Utility preset menu. 
Therefore, Probe Type cannot be saved as an Application or 
System Preset.

To save the Probe Type, 

a. Activate the Body Pattern.

b. Select a Body Pattern.

c. Select a type of probe mark with Probe Type.

d. Place the probe mark at the proper location.

e. Select Set on the control panel to save the body pattern. 

• When a Body Pattern is selected and no Probe Mark has 
been saved on it, the latest used Probe Mark is carried over 
to the Body Pattern. 
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Body Patterns  (continued)

 Figure 6-5. Body Patterns Available
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Body Patterns  (continued)

 Figure 6-6. Body Patterns Available (continued)
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Body Patterns  (continued)

1. body1
2. body2
3. body3
4. body4
5. body5
6. body6
7. body7-Lt
8. body7-Rt
9. body8-Lt
10. body8-Rt
11. body9
12. body10
13. body11-Lt
14. body11-Rt
15. liver
16. organ1
17. organ2
18. organ3
19. organ4
20. organ5
21. organ6
22. organ7
23. organ8
24. organ9
25. breast1
26. breast2
27. breast3
28. breast4-Lt
29. breast4-Rt
30. breast5-Lt
31. breast5-Rt
32. breast6-Lt
33. breast6-Rt
34. breast7-Lt
35. breast7-Rt
36. breast8-Lt
37. breast8-Rt
38. breast9-Lt
39. breast9-Rt
40. Post breast-Lt
41. Post breast-Rt
42. Post breast-bilateral
43. pelvis1
44. pelvis2
45. ob1
46. ob2
47. ob3
48. ob4
49. ob5
50. ob6

51. uterus1
52. uterus2
53. uterus3
54. fetus1
55. fetus2
56. fetus3
57. fetus4
58. fetus5
59. fetus6
60. fetus7
61. fetus8
62. fetus9
63. fetus10
64. fetus11
65. fetus12
66. fetus13
67. fetus14
68. fetus15
69. fetus16
70. twin1
71. twin2
72. twin3
73. twin4
74. twin5
75. twin6
76. twin7
77. twin8
78. hand1
79. hand2
80. hand3-Lt
81. hand3-Rt
82. hand4-Lt
83. hand4-Rt
84. hand5-Lt
85. hand5-Rt
86. hand6-Lt
87. hand6-Rt
88. head1
89. head2
90. head3
91. head4
92. head5
93. heart1
94. heart2
95. heart3
96. heart4
97. heart5
98. heart6
99. heart7
100. heart8

101. heart9
102. heart 10
103. heart 11
104. neck1
105. neck2
106. neck3
107. neck4
108. neck5
109. thyroid
110. carotid1
111. carotid2
112. New carotid2
113. carotid2-Lt
114. carotid2-Rt
115. Carotid3-Lt
116. Carotid3-Rt
117. arm1
118. arm2
119. arm3
120. arm4
121. arm5
122. arm6
123. leg1
124. leg2
125. leg3
126. leg4
127. leg5
128. leg6
129. leg7
130. leg8
131. leg 9
132. leg 10
133. leg 11
134. leg 12
135. legs13-a-Lt
136. legs13-a-Rt
137. legs13-Lt
138. legs13-Rt
139. foot1-Lt
140. foot1-Rt
141. foot2-Lt
142. foot2-Rt
143. foot3-Lt
144. foot3-Rt
145. foot4-Lt
146. foot4-Rt
147. foot5-Lt
148. foot5-Rt
149. foot6-Lt
150. foot6-Rt

151. foot7-Lt
152. foot7-Rt
153. foot8-Lt
154. foot8-Rt
155. foot9-Lt
156. foot9-Rt
157. uro1
158. uro2
159. uro3
160. uro4
161. uro5
162. uro6
163. uro7
164. uro8
165. uro9-female
166. uro9-male
167. uro10-female-Lt
168. uro10-female-Rt
169. uro10-male-Lt
170. uro10-male-Rt
171. uro11
172. uro12
173. uro13-Lt
174. uro13-Rt
175. vet-cat1
176. vet-cat2
177. vet-cat3
178. vet-cow1
179. vet-cow2
180. vet-cow3
181. vet-dog1
182. vet-dog2
183. vet-dog3
184. vet-horse1
185. vet-horse2
186. vet-horse3
187. vet-horse4
188. vet-horse5
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Using the Fast Key

Overview

A keyboard Fast Key is available to record and run a sequence 
of often-run keystrokes.

NOTE: Ensure that you have a patient selected prior to running the Fast 
Key operation. 

Create a Fast Key

1. Press the F5 key. The question dialog displays. Select OK to 
continue.

2. Select a key to assign a Fast Key to (a-z, 0-9).

If you select any key besides a-z or 0-9, a warning dialog 
displays and the procedure is cancelled.

NOTE: Assign Fast Key Function to Key 0 - 9 in Utility -> System -> 
User Configurable Key before you create a Fast Key to a 
numeric key.

NOTE: “Enable Numeric Hot key” or “Enable Alphabet Hot Key” in 
Utility -> System -> User Configurable Key should be 
selected before you create a Fast Key.

NOTE: There is no distinction between capital and small letters.

NOTE: The key code is the same in Russian and Greek (a-z, 0-9).

3. If the selected key is already assigned to a Fast Key, a 
warning dialog displays.

Select Yes to continue. The Fast Key macro file is 
overwritten.

Select No to cancel the Fast Key macro setup.

4. Input the key sequence to be assigned.

NOTE: It is impossible to save a power cycle sequence or any input 
from outside of the system.

NOTE: The warning dialog displays due to the limitations of the 
number of key sequences. Press F5 to finish and retry.

5. Press the F5 key to complete a Fast Key macro setup. The 
information dialog displays. Select OK.
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Start a Fast Key

1. Press the F6 key to start a Fast Key. The message “Select 
the key which the Fast Key is assigned to” displays on the 
status bar.

NOTE: The F6 key is ignored if another dialog displays on the 
system.

NOTE: If you press F5 after F6, the F6 function cancels and the F5 
function is enabled.

2. Press the key assigned to the Fast Key macro. The 
message “Fast Key playback is finished” displays on the 
status bar when the macro is finished.

To stop the Fast Key macro during the operation, press F6. 
The message “Fast Key playback is cancelled” displays on 
the status bar.

NOTE: Select the running speed in the Run Fast Key Speed preset 
on Utility -> System -> General.

Backup and Restore the Fast Key

You can backup/restore the Fast key via Utility -> System -> 
Backup/Restore.

To backup, select User Defined Configuration in the Backup 
section.

To restore, select User Defined Configuration in the Restore 
section.
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Using InSite ExC

InSite ExC

InSite ExC is your direct link with a GE Online Service Engineer 
or Applications Support Engineer or a Request for Service via 
the InSite ExC link at the bottom of the display screen. 

Figure 6-7. InSite ExC Icon

Types of InSite ExC Service

1. Request For Service (Contact GE). Opens a service 
dispatch with GE Service. 

2. Connect to GE. Direct contact with GE Technical Support. 

3. Configure Agent. Use to access InSite ExC Configuration 
window. 

4. Connect Clinical Lifeline. Direct contact with GE 
Applications Support. 
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Configure Agent

To access InSite ExC Service configuration window,

1. Click InSite ExC Icon at the bottom of the display screen. 
Select Configure Agent from the list.

Figure 6-8. Service Menu

2. On configuration window, do the proxy configuration if 
Proxy Configuration is required. Select Submit Changes.

Figure 6-9. InSite ExC configuration
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Initiating a Request for Service (RFS)

To initiate an RFS, 

1. Position the Windows pointer on top of the GE InSite ExC 
icon at the bottom of the display. 

2. Press Set Key, select ContactGE. This opens of the RFS 
screen which sends a service dispatch directly to GE 
Service after you fill in the following information: 

• Contact Information

• Problem type

• Problem area

• Problem description

• Send

3. After you have completed filling in all of this information, 
press Send to initiate the Request for Service. 

Figure 6-10. Request for Service Contact Information
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Initiating a Request for Service (RFS)  (continued)

After you press Send, the following pop-up appears: 

Figure 6-11. Request for Service Confirmation

All requests for service are listed on the Queue for your review. 

Figure 6-12. Request for Service Queue
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Initiating a Request for Service (RFS)  (continued)

You can monitor your RFS as well as RFS’s automatically sent 
by the system. The LOGIQ V2/LOGIQ V1 can automatically 
submit a Request for Service. These are displayed on the 
Machine Queue. 

Figure 6-13. Machine Queue
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Initiating a Request for Service (RFS)  (continued)

In addition, you can use the Users screen to identify your 
institution’s point of contact for service dispatches. 

Figure 6-14. Users
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Initiating a Technical or Clinical Support Request

To initiate Technical or Clinical Support, 

1. Position the Windows pointer on top of the GE InSite ExC 
icon at the bottom of the display. 

2. Press the Set Key. This opens the following pop-up: 

• ContactGE

• Connect to GE, 

• Configure Agent

• Connect Clinical Lifeline

• Cancel

NOTE: When you have contacted Applications or the Online 
Center/Field Engineer (OLC/FE), you may be asked to click 
on “Connect to GE”: to increase the polling rate so that the 
OLC/FE can connect more quickly. Or, you may be asked to 
“Connect to Clinical Lifeline” so applications can connect to 
the system. 

3. Select Connect to GE for Technical Support; select 
Configure Agent to fill and send ultrasound system/server 
information to GE Service; select Connect Clinical Lifeline 
for Clinical Applications Support; or press Cancel to exit. 

4. If you’ve requested GE Service to perform remote service 
on the LOGIQ V2/LOGIQ V1, answer Yes to the Insite 
Notification pop-up. 

Figure 6-15. InSite Notification

NOTE: In addition to contacting a technical/clinical support person, 
selecting this also changes the polling time from 15 minutes to 
15 seconds so that your call can be answered as quickly as 
possible, as well as allowing disruptive mode. 
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Initiating a Technical or Clinical Support Request  (continued)

InSite ExC icons appear differently, depending on their state: 

Table 6-2:  InSite ExC Icons

Online Center Non Disruptive Disruptive

Not Connected Black and White Icon - 
InSite ExC activated but 
system not open for 
Technical Support access. 

Red Icon with Clock - 
InSite ExC activated and 
open for Technical 
Support, but currently not 
active. 

Connected Yellow Icon - InSite ExC 
activated and Technical 
Support can look around 
on your system, but 
cannot perform any 
service-related functions. 

Red Icon with GE Logo - 
InSite ExC activated and 
Technical Support can 
look around on your 
system, run diagnostics, 
gather logs, and initiate 
VCO. 
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InSite ExC Definitions

Here are definitions for the different InSite ExC states: 

Virtual Console Observation (VCO). Allows Technical Support 
to control LOGIQ V2/LOGIQ V1 functionality remotely. 

Disruptive. Allows GE’s Technical Support person to connect to 
your system via VCO, to run diagnostics directly on your LOGIQ 
V2/LOGIQ V1 system, and to collect system logs. When the 
system is in Disruptive Mode, the icons are red. There are two 
disruptive states. If you see a telephone with a clock, then the 
system is in Disruptive, Not Connected Mode. If you see a 
telephone with GE, then the system is in Disruptive, Connected 
Mode. 

Non-Disruptive. Allows GE’s Technical support person to look 
around on your system, but cannot perform any service-related 
functions, depending on whether InSite has connected or not 
connected. There are two Non-Disruptive states. If you see a 
black and white icon, InSite ExC is activated, but not open for 
Technical Support access. If you see a yellow icon, InSite ExC is 
activated and the Technical Support person can look around on 
your system, but cannot perform any service-related functions. 

Connected. InSite ExC is connected.   

Not Connected. InSite ExC is not connected. 

NOTE: When Disruptive mode has been activated or a diagnostic has 
been run, the message, “Due to Service testing reboot 
required,” appears in red at the bottom of the display. It is 
recommended that you reboot the system before use. Make 
sure you disable disruptive mode before rebooting or the 
message will not be cleared.

Exiting InSite ExC

To exit InSite ExC, 

1. Position the Windows pointer on top of the GE InSite ExC 
icon at the bottom of the display. 

2. Select Connect Clinical Lifeline again to exit Disruptive 
Mode and VCO. 

3. Reboot your LOGIQ V2/LOGIQ V1 system. 
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Electronic Documentation

Documentation Distribution

Documentation is being provided via: 

• Hardcopy (Optional)

• User Guide (translated)

• Release Notes (translated)

• AIUM Acoustic Output Booklet (USA only)

• Electronic media. You can view user documentation (all 
languages) on a PC or on the Ultrasound Scanner via the 
Customer Documentation media, which includes: 

• Basic User Manual (English only)

• Advanced Reference Manual (English only)

• User Guide (translated)

• Release Notes and Workarounds (translated)

• Basic Service Manual (English only)

• Online Help (on the Ultrasound Scanner via help)
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Using Online Help Via F1

Online Help is available via the F1 key. After pressing F1, Help 
appears. The Help screen is divided into three sections: 
navigational tools on the top, left portion of the screen (Hide, 
Back, Forward), help book navigational tools on the left portion 
of the screen (Contents, Index, Search, Favorites), and the 
content portion on the right side of the screen where help topics 
are displayed. 

Figure 6-16. Opening Help Screen
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Navigating through the Help Book

Online Help is organized like a manual, with individual chapters, 
sections, and pages. Click on the plus (+) sign next to MANUAL 
to open up the book. Click on the plus sign next to the chapter 
you want to view to open up that chapter. Click on the plus sign 
next to the chapter you want to view to open up that section. 
Open up the page to view that page’s information. 

Figure 6-17. Sample Help Topic

The blue, underlined text links you to related topics. Click on the 
link to move to the new topic. 
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Links

After you click on a blue, underlined portion of text, the screen 
updates with this link’s content. To go back to the previous 
screen, press Back. To return to the link, press Forward. 

Figure 6-18. Topic Link
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Searching for a Topic

To search for a specific topic, click on the Search tab in the left 
portion of the screen. Type in the topic name in the Type in the 
keyword to find field. Topics with the word or phrase you typed 
appear in the Select Topic to display area. Either double click on 
the topic you want to view or highlight the topic and press the 
Display button to view this topics. 

Figure 6-19. Search Results

Saving Favorite Topics

You may find that there are topics you need to refer to often. In 
this case, it’s a good idea to save these topics as Favorites. To 
save a topic as a favorite, press the Favorites tab, highlight the 
topic in the Topics window, and press the Add button. You can 
now view this topic quickly by going to the Favorites help tab. 

Figure 6-20. Adding Favorites
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Using the Index

Or, you can look for topics by using the Index. Press the Index 
tab, then use the scroll bar to look up a topic. 

Figure 6-21. Index

Other Help Features

To hide the left side of the screen, press the Hide icon at the 
upper, left-hand portion of the screen. To view the left side of the 
screen again, press the Show icon at the upper, left-hand 
portion of the screen. 

To size the Help window, position and hold down the cursor at 
the corner of the screen while moving the Trackball. 

To move the Help window, position and hold down the cursor at 
the very top of the Help window while moving the Trackball on 
the control panel. 

Exiting Online Help

To exit Online Help, press the ‘X’ in the upper, right-hand corner 
of the Online Help window. 
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Electronic media

Accessing Documentation Via a PC

To view user documentation on a PC, 

1. Insert the media into the media drive. 

2. Open the media drive on your desktop. 

3. Select and open the item you want to view. 

To close the window, click on the ‘X’ in the upper, right-hand 
corner of the browser window. 

NOTE: If your PC does not have Adobe Reader, a free download is 
available on the Adobe web site at http://www.adobe.com. 
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Chapter 7

General Measurements and
Calculations

Describes how to perform general measurements and 
calculations.
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Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by system accuracy, but also by the use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

Overview

This section provides information about taking measurements 
and describes calculations available in each mode. It includes 
the following topics:

• Exam workflow

• Location of measurement controls

• Description of calipers

• List of generic measurements

• General information about taking measurements

• Mode Measurements: Step-by-step instructions for taking 
specific measurements, organized by mode

• Basic steps to view and edit worksheets

WARNING The system provides calculations (e.g. estimated fetal weight) 
and charts based on published scientific literature. The 
selection of the appropriate chart and clinical interpretation of 
calculations and charts is the sole responsibility of the user. 
The user should consider contraindications for the use of a 
calculation or chart as described in the scientific literature. The 
diagnosis, decision for further examination, and medical 
treatment must be performed by qualified personnel following 
good clinical practice.
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Exam workflow

For each patient, the system organizes information by exam 
category, study, and measurement. The definitions of these 
terms are as follows:

• Exam Category – categories include the following:

• Abdomen

• Obstetrics

• Gynecology

• Cardiology 

• Vascular

• Urology 

• Small Parts

• Pediatrics

• Study/Preset – after you choose an exam category, the 
system allows you to select a study. For example, when you 
choose the Obstetrics exam category, you can choose one 
of the following studies:

• Generic

• OB-1

• OB-2/3

• OB-General

• Fetal Heart

• OB/GYN Vessel

• Measurement – the measurements and calculations 
needed to analyze an item of anatomy. For example, a 
femur length is a measurement. A measurement can 
include several pieces of measurement data. For example, 
to calculate the area of a gestational sac, you need to 
measure width, length, and depth.

For details on how to start a new patient, see ‘Beginning an 
Exam’ on page 4-2 for more information.
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Location of Measurement Controls

Figure 7-1. Locating Measurement Controls

1. Clear. During a measurement sequence, erases the 
measuring caliper and measurement data from the display. 
When not performing a measurement sequence, clears all 
calipers and measurements from the display. 

2. Measure. Activates a measurement caliper and the 
calculation package associated with the currently selected 
preset.

3. Set/B Pause. Set fixes the caliper for measurements and 
completes the measurement sequence.

4. Trackball. Moves the measurement calipers, selects the 
measurement on the Summary Window. 

5. Depth/Zoom/Ellipse. Ellipse activates the area/ellipse 
measurement function. During the ellipse adjustment, use 
the Trackball to increase or decrease the size of the ellipse. 
Select Cursor Select to adjust the measurement calipers.
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Description of calipers

While you are making a measurement, the measurement caliper 
is either active (open plus sign) or fixed (closed plus sign). An 
active caliper is green and a fixed caliper is yellow.

The system allows you to identify measurements by number or 
by unique symbol. If you choose Number as the Cursor Type, 
after you complete a measurement, it is assigned a number. If 
you choose Symbol as the Cursor Type, after you complete a 
measurement, the caliper symbol changes to one of the nine 
shown below. The symbols are used in sequence as listed. The 
first symbol is used for the first measurement, the second 
symbol for the second measurement, and so on. The numbers 
or symbols also identify measurements in the Results Window.

Figure 7-2. Fixed Caliper Symbols

For information about how to choose Cursor Type of Number or 
Symbol, see ‘System/System Measure Preset Menu’ on 
page 16-13 for more information.

Measurement line display

While you are making a measurement, the system displays a 
dotted line to show the measurement. After you press Set to 
complete the measurement, the dotted line remains on the 
display if the Cursor Line Display, found on the System -> 
System Measure screen, is selected. If Cursor Line Display is 
not selected, the system erases the dotted line and only the 
measurement calipers with a number or symbol are displayed.
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List of general measurements

The following types of general measurements are available 
when you press Measure but do not choose a specific 
calculation. The type of measurement depends on the current 
scan mode.

After pressing Measure, rotate between various measurement 
types with the adjusting of Caliper Change menu.

B and CF Modes

• Dist (Caliper)

• Trace

• Spline

• Intensity

• Open Trace

• Open Spline

NOTE: You can preset the sequence of B and CF area measurements 
in the Measure Key Sequence (B/CF) preset in the Utility -> 
Measure -> Advanced screen. See the “M&A Advanced Preset” 
section for more information.

Doppler Mode

• Velocity

• Trace

• Slope

• Time

M-Mode

• Distance

• Time

• Slope
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General Instructions

You can take measurements in all modes and image formats, 
including real-time, frozen, CINE. After you select an exam 
category, the available calculations are displayed.

Measurement and calculation results

As you take measurements, each measurement is given a 
sequential number on the display and in the Results Window. 
The system can display nine measurements on the screen at 
one time. 

While you are taking a measurement, the value in the Results 
Window updates until you complete the measurement.

Once the Results Window has nine measurements, if you make 
any further measurements, the system erases the first 
measurement and adds the new measurement (“first in, first 
out”).

Measurement graphics are kept while in cine scroll. The 
measurement graphic is redisplayed on the frame where it is 
taken, if preset “keep graphics with cine scroll” via utility -> 
Measure ->Advanced.
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Selecting a calculation

When you take measurements, you can select the calculation 
before you take the measurement or after you take it. For 
example, in Obstetrics, if you select the calculation before you 
take the measurement, the estimated fetal age is displayed as 
you take the measurement. If you select the calculation after you 
take the measurement, the estimated fetal age is displayed after 
you complete the measurement.

NOTE: After you take a measurement, if you select a calculation and 
the measurement is not applicable for the calculation, then the 
system assumes you want to start the calculation. The system 
then uses the calculation for the next measurement.

If there is a measurement listed in the Results Window that has 
not been assigned a calculation, to assign the measurement:

1. Press Measure.

2. To select the measurement in the Results Window, move 
the Trackball to the measurement.

The measurement is highlighted.

3. Press Set.

The system displays a list of applicable calculations. For 
example, if it is a distance measurement, the list includes all 
distance calculations for the current study.

4. To select an item in the list, move the Trackball to highlight 
the item and press Set.

The system assigns the calculation to the measurement.
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Selecting a measurement in a different application

While scanning a patient, you may find that you want to measure 
an item that is not in the current application. To select a 
calculation from a different application:

1. Press Measure. 

2. Press the Second Menu button, the exam category menu is 
displayed.

3. Select the exam category that has the calculation you want 
to make.

The system displays the study of the selected exam 
category.

4. Select the study and the desired measurement.

5. After you complete the measurement, to return to the 
original application, repeat steps 1–4.

NOTE: This measurement DOES NOT appear on the original 
application worksheet. 

Post-assignment for Side/Location

1. Move the cursor to the result box (with the green frame) and 
press Set. The post-assignment menu appears.

2. Select Side and Location as needed.

Figure 7-3. Post-assignment menu

NOTE: This feature is only available in manual calcs.

Minimize/Maximize the Results Window

Move the arrow pointer by Trackball to the top-left icon in the 
Result Window and press Set. The Window is minimized and 
displays only the icons. Press Set again to maximize the display.
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Erasing measurements

The following actions erase measurements from the system's 
memory: 

The following are actions you can take while performing 
measurements.

Calculation formulas are available in the Advanced Reference 
Manual.

HINTS • If you unfreeze the image, or press Clear, the system 
erases all completed measurements and calculations on 
the display. Measurements and calculations, however, 
remain on the worksheets.

• If you select End Exam, the system erases all 
measurements and calculations on the display and clears 
the worksheets.

• If you make a new measurement that exceeds the 
maximum number of allowable measurements, the system 
erases the first (oldest) measurement and adds the new 
measurement.

• If the second caliper is active, to erase the second caliper 
and activate the first caliper, press Clear.

HINTS • Before making measurements, to stop the acquisition of 
image data, press Freeze.

• For measurements such as distance, to make fine 
adjustments before completing the measurements, adjust 
Cursor Select to toggle between active calipers.

• Before completing the measurement sequence, to erase 
the active measuring caliper and the current data 
measured, press Clear.

• After the sequence is complete, to erase all data that has 
been measured to this point, but not data entered on 
worksheet pages, press Clear.

• When there are several measurements on the display, to 
rotate through and activate previously fixed calipers, adjust 
Cursor Select. After a cursor is activated, you can change 
the measurement. 

NOTE: If you want to change a trace measurement, you 
must erase it and trace again.

• To repeat any measurement, select that measurement 
again.
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Measurement and Calculation Setup

Measurements and studies are organized for typical work flows. 
If you want, you can change this set up. You can specify which 
studies are in each exam category, and which measurements 
and calculations are in each study. You can change the 
measurements that are available. The LOGIQ V2/LOGIQ V1 
allows you to quickly and easily set up your system so that you 
can work most efficiently. 

This section describes how to:

• Change a study to include different measurements

• Add a new study or measurement

• Remove a study from an exam category

• Change measurement parameters

• Create a measurement formula to correctly handle unit 
conversions

• Edit user-defined calculations

• Define application-specific measurement parameters

• Specify the default manual calc measurements for a 
selected study or folder
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Starting Study and Measurement SetUp 

You can make changes to studies and measurements in the 
Measurement & Analysis screen. To open the screen:

1. Enter Utility-> Measure.

2. On the monitor display, select M&A tab.

The system displays the Measurement & Analysis screen 
on the monitor display.

 Figure 7-4. Measurement & Analysis screen

NOTE: In the Measure menu, the navigational tabs across the top may 
differ from system to system but the functionality is the same.

1. Selection menu: select exam category, study, 
or measurement.

3. Folder or measurement: define studies and 
measurements. This section changes between 
Folder and Measurement, depending on what 
you select in the Selection menu.2. Measurement menu: add and delete studies 

(folders) and measurements; select mode.
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Selecting an exam category

When you open the Measurement & Analysis screen, it displays 
the exam category that was last used on the system. To select 
the exam category you want to work with:

1. Move the Trackball to highlight the exam category at the 
top of the Selection menu. 

2. Press Set.

The system displays a list of exam categories. 

3. Move the Trackball to highlight the exam category you 
want.

4. Press Set.

The Selection menu lists studies and measurements for the 
selected exam category.

Figure 7-5. Select Exam Category

Selecting the measurement mode

In the Measurement menu section of the Measurement & 
Analysis screen, select one of the following:

• 2D (B-Mode)

• MM (M-Mode)

• Dop. (Doppler Mode)

• Plot (Plot Mode—The measurement on the plot graph of the 
QAnalysis)

The Selection menu lists studies and measurements for the 
selected mode.

Figure 7-6. Select Mode
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Selecting a study or measurement

To work with a folder or measurement, you must first select it in 
the Selection menu. The Selection menu lists the studies and 
measurements for an exam category. The studies and 
measurements are organized in a hierarchy. The following 
example shows the highest level of the Obstetrics exam 
category, with the OB studies listed.

 Figure 7-7. Selection Menu: Exam Studies
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Selecting a study or measurement  (continued)

After you select a study, the Selection menu shows all folders 
and measurements in the study. The Folder section of the 
Measurement & Analysis screen changes, and lists the 
measurements. The Selection menu shows all measurements 
for the OB-1 exam category. 

 Figure 7-8. Selection Menu: OB-1 Exam Category
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Selecting a study or measurement  (continued)

The following example shows the Selection menu after the BPD 
measurement is selected. The Measurement section is now 
displayed, with information about the BPD measurement. 

 Figure 7-9. Selection Menu: BPD Measurement
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Selecting a study or measurement  (continued)

To select a folder or measurement: 

1. Move the Trackball to the Selection menu and highlight the 
folder or measurement. 

2. Press Set.

• If you selected a folder, the system displays the folder in 
the Folder section of the Measurement & Analysis 
screen.

• If you selected a measurement, the system displays the 
measurement in the Measurement section of the 
Measurement & Analysis screen.

NOTE: Items must be selected in the Available folders and 
measurements list to be in the Selection menu. To move or 
change an item that is in the Available folders and 
measurements list but not in the Selection menu, move the 
Trackball to the check box for the item, and press Set. The item 
is now listed in the Selection menu.

 Figure 7-10. Available folders and measurements check boxes
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Defining Hot Keys

There are 10 alphanumeric keys that are programmable as hot 
keys to store frequently-used measurements. 

1. In the Hot Key field, select the desired hot key (Z, X, C, V, B, 
N, M, , , . or / ) for the appropriate Measure Study by 
pressing the up/down arrow key on the monitor display.

2. Ensure that the “Enable Alphabet Hot Key” preset has been 
selected in the Keyboard Key portion of the Utility -> System 
-> User Configurable Key page.

NOTE: Defined hot keys are listed on the Measurement Window.

Figure 7-11. Hot keys for measurements
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Using folders

When you select a folder in the Selection menu, the system 
displays all folders and measurements that are in the folder. A 
folder can indicate a study, or can indicate a measurement 
group that contains related measurements. For example, a 
calculation such as OB Amniotic Fluid Index (AFI) requires four 
measurements, one of each quadrant. The AFI folder contains 
four measurements. 

 Figure 7-12. AFI Folder
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Specifying Which Measurements Go in a Study or Folder

The Folder section of the Measurement & Analysis screen has 
two lists of folders and measurements. This is where you specify 
which items go in a study or folder.

• Available folders and measurements. The left list contains 
all possible folders and measurements for the selected 
study or folder. 

• Measure & Study. The right list has all folders and 
measurements currently selected for the study or folder. 
These are selected from the Available folders and 
measurements list. These are the folders and 
measurements you see when you are scanning and choose 
an exam category. This also defines the order of the folder 
or measurement is located, based on the number in this list. 

To add an item to the Measure & Study list:

1. In the Measure & Study list, move the Trackball to highlight 
which folder you want to put the item in, and press Set.

Figure 7-13. Measure & Study list: Selecting item and position

2. Move the Trackball to highlight an item in the Available 
folders and measurements list, and press Set.
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Specifying Which Measurements Go in a Study or Folder  

(continued)

3. Select the arrow between the lists. The item is copied to the 
Measure & Study list.

Figure 7-14. Measure & Study list: New item added

The selected item is now displayed in the Measurement 
Summary Window.

NOTE: If an item is already in the Measure & Study list, the system does 
not allow you to add it again. To move an item within the 
Measure & Study list, see ‘Moving items in the Measurement 
Summary Window’ on page 7-22 for more information.

Measurement Summary Window

The figure below shows the OB menu area and a portion of the 
Measurement and Analysis screen for OB.

Figure 7-15. Measurement Summary Window
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Moving items in the Measurement Summary Window

To move items that are displayed in the system menu, you move 
them in the Measure & Study list in Utility -> Measure - > 
Measure.

1. Move the Trackball to highlight an item in the Measure & 
Study list.

2. Select the up or down arrow.

The item is displayed at the selected position in the system 
menu.

Removing items from the System Menu

To remove an item from the Selection menu:

1. Move the Trackball to the item in the Available folders and 
measurements list.

2. To clear the check box for the item, move the Trackball to 
the check box and press Set.

The system removes the item from the Selection menu, the 
Measure & Study list, and from the System Menu. It is also 
not listed in the Summary Window.
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Setting up an automatic measurement flow

In some cases, related measurements are put in a 
measurement folder. This allows you to logically organize 
measurements. It also allows you to specify that the system 
automatically start each measurement in a folder, one after the 
other. This is the automatic sequence feature. To use this 
feature:

1. In the Selection menu, select the folder that contains the 
measurements you want.

The system displays the folder and lists the measurements.

2. In the Folder section of the Measurement & Analysis screen, 
select Auto sequence. For OB-1 measurements, Uterine 
Volume measurements are put in the Uterine folder.

 Figure 7-16. Measurement & Analysis screen: Auto sequence

1. Selection Menu 2. Auto Sequence
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Changing Measurements

You can make changes to some of the measurements. For 
example, Head Circumference can be measured with an ellipse, 
a trace, or two distances. You can specify which measurement 
type you want the system to use as the default. You specify the 
measurement type by selecting the tool to use to make the 
measurement.

• To change the tool used to make a measurement:

In the Measurement section of the Measurement & Analysis 
screen, select the desired tool from the Tool list. Select the 
arrow to display the drop-down list.

NOTE: If the Tool field is gray, it cannot be changed.

After you choose the tool, this is what the system expects 
when you scan and choose this measurement.

NOTE: The diagram to the right of the Tool list shows the measurement 
type. In the following example, ellipse is selected and the 
diagram shows an ellipse.

Figure 7-17. Measurement & Analysis screen: Change 
measurements
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Adding Folders and Measurements

Adding a folder

When you add a folder, it can be a study, or a measurement 
folder that includes related measurements. 

1. In the Selection menu, select the study or folder where you 
want to add the folder.

2. In the Measurement menu section, select Add folder.

• If you select Blank, the system adds a folder with a 
name such as USERDEFS1. It is listed in the Selection 
menu.

• If you want to use an existing folder, select Insert, and 
then select a folder from the list. The list includes all 
folders defined for the current exam category and 
selected mode. You cannot edit this folder.

Figure 7-18. Add folder Window

3. Select the user-defined folder in the Selection menu.

The system displays the new folder in the Folder section of 
the Measurement & Analysis screen.

4. To name the folder, move the Trackball to highlight the 
Name field, press Set twice, and type the name.

NOTE: DO NOT use “single quotes” for a parameter name, a 
measurement name, a folder name or an author name.

5. To add measurements to the folder, see ‘Adding a 
user-defined measurement’ on page 7-27 for more 
information.
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Adding a folder  (continued)

 Figure 7-19. Measurement & Analysis: Add folder
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Adding a user-defined measurement

You can create a user-defined measurement in a 
system-defined folder or in a folder you created.

NOTE: DO NOT use “single quotes” for a parameter name, a 
measurement name, a folder name or an author name.

1. In the Selection menu, select the study or folder where you 
want to add the measurement.

2. In the Measurement menu section, select Add 
Measurement.

The system displays the Add Measurement window. 

Figure 7-20. Add Measurement window

3. Do one of the following: 

• If you want to create this measurement from a copy of 
an existing measurement, select Use copy of, and then 
select a measurement from the list. The list includes all 
measurements defined for the current exam category 
and selected mode.

NOTE: This only applies to OB and Cardiac. 

• If you want to use an existing formula, select Insert, and 
then select a measurement from the list. The list 
includes all measurements defined for the current exam 
category and selected mode. You cannot edit this 
formula.

• If you want to create a blank new measurement, select 
Blank.

WARNING Please remember that you are responsible for confirming the 
correctness and accuracy of the user input formula that you 
add.
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Adding a user-defined measurement  (continued)

4. Select OK.

• If you created a blank measurement, the system adds a 
measurement with a name such as USERDEFM3. 

• If you created a measurement from a copy of an existing 
measurement, the system lists the measurement and its 
parameters in the Measurement section.

5. When you create a new measurement, the measurement 
name is automatically highlighted. Type a name for the new 
measurement. You can change the name of a measurement 
you created from a copy.

 Figure 7-21. Measurement & Analysis: Add measurement

NOTE: 2D Dual Caliper, 2D Dual Area, 2D Dual Ellipse, and 2D Dual 
Spline Trace are not available through the factory default. To 
enable these measurements, add a new measurement using 
“2D Dual Caliper”, “2D Dual Area”, “2D Dual Ellipse”, or “2D 
Dual Spline Trace” tool.
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Defining measurement parameters

After you add a measurement, you can add parameters. You 
may also want to change parameters if you copied an existing 
measurement. See ‘Changing or adding measurement 
parameters’ on page 7-29 for more information.

Changing or adding measurement parameters

You can make changes to measurement parameters and you 
can add measurement parameters.

Changing measurement parameters

To change a measurement parameter:

1. In the Selection menu, select the measurement.

2. To change the name of the Parameter, move the Trackball 
to the parameter name and press Set twice. Type a name 
for the parameter.

For a description of other measurement changes, see ‘Changing 
Measurements’ on page 7-24 for more information.
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Adding measurement parameters

To add a measurement parameter:

1. In the Selection menu, select the measurement.

2. To change the tool used to make a measurement:

In the Measurement section of the Measurement & Analysis 
screen, select the desired tool from the Tool list. Select the 
arrow to display the drop-down list.

NOTE: If the Tool field is gray, it cannot be changed.

3. If necessary, check Fetus (OB only), Location (Loc), or Side:

• Fetus: If this is an OB measurement, check this box. 
(Default ON).

• Location: If this measurement includes a Prox, Mid, or 
Dist location, check this box.

• Side: If this measurement includes a Left or Right side, 
check this box.

4. In the Measurement section, move the Trackball to an 
empty line at the bottom of the Parameter list. Press Set.

The system adds a parameter with a name of (Name).

Figure 7-22. Adding a Parameter
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Editing Calculations

To modify user-defined calculations:

1. Select Add Measurement from the Measurement menu. 
The system displays the Add Measurement window. 

2. Select Blank and OK.

3. Type the appropriate name and select “Calculation” from the 
Tool pull-down menu.

Figure 7-23. Measurement window

4. Type the parameter name.

5. Select OK.

6. In the Measurement menu section, select Edit calc.

Figure 7-24. Edit Calc

The Modify User CALC window displays.
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Editing Calculations  (continued)

7. In the User Defined list, select the calculation that you want 
modified, then select OK.

Figure 7-25. Modify User CALC window

8. The Measure tab for user-defined calculations displays. 
Double click on the equals sign symbol under Tool Result for 
the desired parameter. 

Figure 7-26. Measurement & Analysis M&A tab

9. Edit the formula as needed and select OK.
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Deleting a Folder or Measurement

NOTE: You can only delete user-defined folders or measurements. You 
cannot delete default system folders or measurements.

1. Select the folder or measurement in the Selection menu.

2. In the Measurement menu section, select the X next to 
Delete measure and study.

M&A Advanced Preset

The system allows you to specify application-specific values for 
certain parameters. You specify the parameter values on the 
Advanced tab of the Measurement & Analysis screen.

1. Enter Utility->Measure. 

2. On the monitor display, select the Advanced tab. 

Figure 7-27. M&A Advanced Preset Menu

M&A Category: Display and select current exam category. 

Parameter: Lists application specific parameters.

Value: Select the value for a parameter.

3. To select an exam category, select it from the M&A category 
list.

The Parameters list displays parameters for the selected 
category.
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M&A Advanced Preset  (continued)

4. To select a value for a parameter, select it from the Value 
list.

NOTE: The parameters that appear are category dependent.

Table 7-1:  M&A Advanced 

Preset Parameter Description

Absolute Value Displays the absolute value of the Doppler Velocity measurement (On 
or Off)

Display Angle Correct Value On or Off

Display Summary Window On or Minimize

Doppler Default Method Avg, Max, Min or Last

Heart Rate Cycle 1, 2, 3, 4, 5, 6, 7, 8, 9, or 10
NOTE: For Cardiac, you can select only “1”.

Keep Graphics with Cine Scroll If you select “On”, the measurement graphics remain while in CINE 
scroll. The measurement graphic redisplays on the frame where the 
measurement was taken in B-Mode.

Start M&A on a Freeze (B) Off: Select measurement manually on Freeze
On: Measurement menu appears automatically on Freeze.
Caliper: Measurement menu and caliper appear automatically on 
Freeze.

Start M&A on a Freeze (M)

Start M&A on a Freeze (D)

Measure Key Sequence (B/CF) 2 Sequences: Dist, Trace; Dist, Spline
2 Sequences: Dist, Open Trace: Dist, Open Spline
3 Sequences: Dist, Trace, Spline; Dist, Spline, Trace; Dist, Spline, 
Intensity; Dist, Trace, Intensity; Dist, Trace, Open Trace; Dist, Spline, 
Open Trace
4 Sequences: Dist, Trace, Spline, Intensity; Dist, Spline, Trace, 
Intensity; Dist, Spline, Trace, Open Trace; Dist, Trace, Open Trace, 
Spline

Show Result Parameters Preview or After Set cursor:
Preview: Displays while taking the measurement.
After Set Cursor: Displays after completing the measurement.

Default Location Off, Prox, Mid or Dist

Default Side Left or Right

RI Calc Bidirectional Flow On or Off

RI Calc Method MD or ED

Show Location Select Button Both on B and Doppler, Doppler only or No Display
NOTE1: Only Abdominal, Vascular, Obstetrics and Gynecology have 
this preset. 
NOTE2: For Obstetrics and Gynecology, you can select only Doppler 
only or No Display.



Measurement and Calculation Setup

LOGIQ V2/LOGIQ V1 – Basic User Manual 7-35
Direction 5610735-100 English Rev. 2

Show BM Folder Name on 
Worksheet

On or Off

Show Measure Name on 
Worksheet

On or Off

Show Point Velocity On or Off

Show Tissue Depth On or Off

Keep Result Window Auto, On or Off

Trace Auto or manual

Vol Flow Method TAMEAN or TAMAX

Vol Flow Compensation with 
TAMAX

If you select TAMAX as the volume flow method, then you MUST 
specify the coefficient to use. Select from 0.5 to 1.0. 

Worksheet Default Display Mode/Expand (Abdominal, Small Parts, Obstetrics, Gynecology, 
Urology and Pediatrics) or Worksheet Summary (Vascular)

Doppler AutoCalc Velocity Unit Velocity, Hz, Both or Auto

WMS Freeze Loop at ES On or Off

WMS Segment Model 16 segments or 18 segments

WMS Initial Scoring Undefined or Normal

WMS Scoring Legend ASE, European or Asian

Show area value while tracing On or Off

Table 7-1:  M&A Advanced  (continued)

Preset Parameter Description
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Manual Calcs Presets

The system allows you to preset the parameters for manual 
calculations. You specify the parameter values on the Doppler 
tab of the Measurement & Analysis screen.

1. On the keyboard, select Utility.

2. On the touch panel, select Measure.

3. On the monitor display, select the Doppler tab. 

 Figure 7-28. M&A Doppler Preset Menu

M&A Category: Display and select current exam category. 

4. To select an exam category, select it from the M&A category 
list.

The system displays a hierarchical view of the exam 
category and the studies and folders in the category.

5. In the hierarchical view, select a study or folder.

6. In the Modify Calcs column, select the measurements that 
you want to the system to show for manual calcs for the 
selected study or folder.

7. To save the changes, select the Save button.
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Application Measurement Preset

The Application Measurement presets allow different calculation 
packages to be available under different application presets.

The presets allow you to configure the Measurement Categories 
and Measurement Exam Calcs. These presets are found on the 
Utility -> Application -> Measurements screen. 

Figure 7-29. Application Measurement
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Mode Measurements

B-Mode Measurements

Two basic measurements can be made in B-Mode.

• Distance

• Circumference and Area

• Ellipse Method

• Trace Method

• Spline Method

• Intensity (Echo level) Method

NOTE: The following instructions assume that you first scan the 
patient and then press Freeze.
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Distance measurement

To make a distance measurement:

1. Press Measure key to enter into measure mode, if 
necessary.

2. Adjust Caliper Change in the Primary Menu to Distance.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

3. To position the active caliper at the start point, move the 
Trackball.

4. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

5. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points, if preset 
accordingly.

6. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window.

HINTS • Before you complete a measurement:

• To toggle between active calipers, adjust Cursor 
Select.

• To erase the second caliper and the current data 
measured and start the measurement again, press 
Clear once.

• After you complete the measurement:

• To rotate through and activate previously fixed calipers, 
adjust Cursor Select.

• To erase all data that has been measured to this point, 
but not data entered onto worksheets, press Clear.
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Circumference and area (ellipse) measurement

You can use an ellipse to measure circumference and area. To 
measure with an ellipse:

1. Press Measure key to enter into measure mode, if 
necessary.

2. Adjust Caliper Change in the Primary Menu to Distance.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset.

3. To position the active caliper, move the Trackball.

4. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

5. To position the second caliper, move the Trackball.

6. Rotate Ellipse control on the control panel; an ellipse with 
an initial circle shape displays.

7. To position the ellipse and to size the measured axes (move 
the calipers), move the Trackball.

8. To increase or decrease the Ellipse, rotate the ellipse 
control.

9. To toggle between active calipers, adjust Cursor Select.

10. To complete the measurement, press Set. The system 
displays the circumference and area in the Results Window.

HINTS Before you complete the ellipse measurement:

• To erase the ellipse and the current data measured, press 
Clear once. The original caliper is displayed to restart the 
measurement.

• To exit the measurement function without completing the 
measurement, press Clear a second time.
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Circumference and area (trace) measurement

Trace To trace the circumference of a portion of the anatomy and 
calculate its area: 

1. Press Measure key to enter into measure mode, if 
necessary.

2. Adjust Caliper Change in the Primary Menu to Trace.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

3. To position the caliper at the start point, move the Trackball.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. To trace the measurement area, move the Trackball around 
the anatomy. A dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the circumference and the area in the Results 
Window.

Open Trace To trace the circumference of a portion of the anatomy and 
calculate its length: 

1. Press Measure key to enter into measure mode, if 
necessary.

2. Adjust Caliper Change in the Primary Menu to Open Trace.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

3. To position the caliper at the start point, move the Trackball.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. To trace the measurement area, move the Trackball around 
the anatomy. A dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the circumference in the Results Window.

HINTS Before you complete the trace measurement:

• To erase the line (bit by bit) back from its current point, move 
the Trackball or adjust the Ellipse control counterclockwise.

• To erase the dotted line but not the caliper, press Clear once.

• To clear the caliper and the current data measured, press 
Clear twice.
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Circumference and area (spline trace) measurement

To trace the circumference of a portion of the anatomy and 
calculate its area: 

1. Press Measure key to enter into measure mode, if 
necessary.

NOTE: Adjust Caliper Change in the Primary Menu to Spline.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

2. To position the first caliper at the start point, move the 
Trackball.

3. To fix the trace start point, press Set. The first caliper turns 
yellow. The second caliper appears at the same position as 
the first caliper and is green. 

NOTE: When pressing the Clear key once, the second caliper 
disappears and the first caliper is activated. 

If Clear is pressed again, the first caliper disappears and the 
Spline trace is cancelled.

4. To position the second caliper, move the Trackball and 
press Set. The third caliper appears at the same position.

NOTE: The Clear key functionality is the same as noted in the 
previous step.

The spline trace requires at least three points to draw the 
trace. Continue setting the points of the trace until the 
desired points are set.

5. Press Set again after the last caliper is fixed to finalize the 
spline trace. All points are removed from the line and the 
spline trace turns yellow.

NOTE: Pressing Set twice finishes the trace measurement.

If Clear is pressed twice when more than 3 points exist on 
the trace, all points are removed and the first caliper again 
displays.
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Circumference and area (spline trace) measurement  (continued)

Edit the spline trace

1. Select Cursor Select. The spline trace changes to green 
and all points appear on the trace as yellow. 

A pick-caliper appears on the center of the image and the 
message “Edit spline trace” displays at the bottom of the 
screen.

NOTE: The pick-caliper is used to select and move the trace points.

Figure 7-30.  Edit spline trace

Select Cursor Select again. The trace is deactivated 
(changes to yellow) and all points, including the pick-caliper, 
are removed. 

If the previous/next fixed caliper exists on the image, it is 
activated.

NOTE: Pressing Clear at this time removes all points and the trace 
graphic.

2. Move the pick-caliper to the desired point and press Set. 
The point is activated and turns green.

3. Move the point to the desired position and press Set. The 
point is fixed and turns yellow. The pick-caliper appears on 
the center of the image.

NOTE: The spline trace is updated at run time.

NOTE: To remove a point, press Clear while moving the point. The 
trace turns green and the remaining points continue to be 
shown as yellow. If there are less than three points, the 
spline trace is removed.

4. Press Set again. All points are removed from the trace and 
the trace is shown as yellow.
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Intensity (Echo level) measurement

To make an echo level measurement:

1. Press Measure key to enter into measure mode, if 
necessary.

2. Adjust Caliper Change in the Primary Menu to Intensity.

NOTE: The available values for Caliper Change menu can be set 
in Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

3. To position the first caliper at the start point, move the 
Trackball.

4. To fix the trace start point, press Set. The caliper changes to 
an active caliper. 

5. To trace the measurement area, move the Trackball around 
the anatomy. A dotted line shows the traced area.

6. To complete the measurement, press Set. The system 
displays the echo level, as EL __ dB, in the Results Window.

NOTE: The echo level measurement is only available on a frozen 
image, not on a B-paused image.
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2D Dual caliper

NOTE: 2D dual caliper / 2D dual area / 2D dual ellipse / 2D dual spline 
trace / 2D dual circle are not available through the factory 
default. To enable these measurements, add new measurement 
using “2D dual caliper”, “2D dual area”, “2D dual ellipse”, “2D 
dual splinetrace” or “2D dual circle” tool in the Utility -> 
Measure -> M&A preset menu.

You can take a measurement on dual images with B and B 
mode, on dual images with B and CF mode, with simultaneous 
mode or on dual images with live image with 2D dual 
measurements. 

1. Select an added measurement from the menu area to 
enable the appropriate measurement. A caliper displays.

NOTE: When the measurement is selected without dual B images 
or with different probe images, warning message is 
displayed on the status bar, and the selected measurement 
is canceled.

2. To position the caliper at the start point, move the Trackball.

You can use both images as an original image.

NOTE: If the first point of the original graphic is out of the shadow 
image area, then the warning message displays on the 
status bar and the shadow graphic is not drawn.

3. To fix the start point, press Set. The caliper changes to an 
active caliper. 

NOTE: Only original graphic has graphic numbering to distinguish 
between original image and shadow image.

NOTE: The trackball move area is limited to the narrow area of both 
images.

NOTE: Only the original graphic can be edited. When the original 
graphic is edited, the shadow graphic is also updated

4. To complete the measurement, press Set. The system 
displays the measurement result in the Results Window.

NOTE: It's impossible to take a measurement across dual images.

NOTE: 2D Dual measurement tool can not be copied.

NOTE: When one of them (original and shadow) is deleted, then both 
graphic are deleted.
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Doppler Mode Measurements

Basic measurements can be made in Doppler Mode.

• Velocity

• TAMAX and TAMEAN (Manual or Auto Trace)

• Two Velocities with the Time Interval and Acceleration 
between them

• Time Interval

• Volume Flow

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Go to the Doppler Mode part of the display.

3. Press Freeze.

Velocity

To measure velocity: 

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to Velocity.

An active caliper with a vertical and horizontal dotted line 
displays.

2. To position the caliper at the desired measurement point, 
move the Trackball.

3. To complete the measurement, press Set. The system 
displays the velocity measurement in the Results Window.
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Slope (Velocity, Time Interval and Acceleration)

To measure two velocity values, the time interval (ms), and 
acceleration (m/s2):

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to S/D Slope.

An active caliper with a vertical and horizontal dotted line 
displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the two peak end point velocities, the time interval, 
and the acceleration in the Results Window.

Time interval

To measure a horizontal time interval: 

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to S/D Time.

An active caliper with a vertical and horizontal dotted line 
displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the time interval between the two calipers in the 
Results Window.
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TAMAX and TAMEAN

Manual Trace

The value measured depends upon the Vol Flow Method preset. 
The two selections available are: Peak (TAMAX) and Mean 
(TAMEAN). 

To do a manual trace of TAMAX or TAMEAN: 

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to S/D Trace.

In the Utility -> Measure - Advanced preset menu set Trace 
preset to Manual.

2. To position the caliper at the trace start point, move the 
Trackball.

3. To fix the start point, press Set.

4. To trace the maximum values of the desired portion of the 
spectrum, move the Trackball.

NOTE: To edit the trace line, move the Trackball.

5. To complete the measurement, press Set. The system 
displays the measurement values in the Results Window. 

Auto Trace

The value measured depends upon the Vol Flow Method preset. 
The two selections available are: Peak (TAMAX) and Mean 
(TAMEAN). 

To auto trace TAMAX:

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to S/D Trace.

In the Utility -> Measure - Advanced preset menu set Trace 
preset to Auto.

2. To position the caliper at the trace start point in the Doppler 
spectrum, move the Trackball.

3. To fix the start point, press Set.

4. To position the vertical caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
automatically fixes both calipers and traces the maximum 
value between the two points. The system displays this 
value in the Results Window. 
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Edit Trace

Auto Trace can be edited after taking an Auto Trace 
measurement.

1. After taking an Auto Trace measurement, select the 
measurement result on the result window. The Edit Trace 
(Edit Peak or Edit Mean) menu window appears.

NOTE: If the system cannot take the trace data correctly from the 
image, Edit Trace does not work.

2. Select Edit Trace. The first caliper (manual trace caliper) 
appears on the center of the image. Use the Trackball to 
move the caliper on the trace line to the start point.

NOTE: To cancel Edit Trace at this time, press Clear, Scan, or 
Freeze.

3. Press Set to fix the first caliper. The second caliper appears. 
Edit the trace manually using the second caliper. 

The Ellipse control is used to edit the trace.

NOTE: When pressing the Clear key once at this time, the second 
caliper disappears and the first caliper appears in the center 
of the image.

NOTE: If you press Scan or Freeze at this time, the caliper is 
automatically fixed and the result window updates.

4. Press Set to fix the second caliper. The trace and the result 
window update. The trace data (TAMAX and TAMEAN) are 
updated, though the other points (e.g. PS, ED) are not 
updated by trace. The points can be edited with Cursor 
Select.

NOTE: While in Edit Trace, Cursor Select is disabled.

5. Repeat Edit Trace as needed.
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Doppler Auto Calc Average Cycle

When using Auto Calc, a selection is available to average a 
number of cycles automatically. There is also a preset selection 
in the Utility Imaging PW page for this feature. When using 
average cycle:

• Selected cardiac cycle lines display on the image. Point 
calipers are not displayed.

• When changing the number of cycles from 1 to >1, all the 
data is reacquired from the image, recalculated and 
updated.

• When multiple cycles are selected in AutoCalc, the average 
values calculate and display automatically.

• When selecting Peak Value (PV), average cycle is not 
available.

NOTE: You cannot edit the lines while in Average Cycle. Cursor Select 
is not available at that time.

NOTE: Average Cycle data is acquired from the display image area 
only, for both live and frozen. The average cycle data fails if the 
setting for the number of cycles is larger than the number of 
image cycles.
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Volume Flow - Manual Calc

You perform a manual Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation. 

1. To perform the Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation, in 
Utility-->Measure-->Advanced, select the following:

• Trace = Manual

• Vol Flow Method = TAMAX [you MUST also select a 
Volume Flow coefficient for use with TAMAX.] 

• Vol Flow Compensation with TAMAX = [select value 
from 0.5 to 1.0]

2. Set Auto Calcs to Off via Doppler Mode-->Modify Auto 
Calcs-->Off. 

3. Select a folder in Doppler Mode-->select a calculation 
folder-->select Show All. 

4. Select Volume Flow. You’ll notice that TAMAX is 
automatically selected. 

NOTE: Ensure that you have placed the caliper in the spectral 
window when selecting the Volume Flow measurement. 

5. Trace the TAMAX. The system prompts you to “Mark the 
first point on the spectral doppler.” Press Set. 

6. The system prompts you to “Trace the velocity spectrum 
boundary.” Press Set. 

NOTE: You can back up while tracing the TAMAX by using the 
Trackball. 

7. Trace the vessel diameter. The system prompts you to 
“Mark first point of vessel diameter for volume flow 
calculation.” Press Set. 

8. The system prompts you to “Mark last point of vessel 
diameter for volume flow calculation.” Press Set. 

9. The Volume Flow is calculated in ml/min. 
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Volume Flow - Auto Calc

You can perform an automatic Volume Flow measurement using 
TAMEAN or using the TAMAX and a Volume Flow coefficient. 

1. To perform the Volume Flow measurement using the 
TAMEAN, in Utility-->Measure-->Advanced, select the 
following: 

• Trace = Auto

• Vol Flow Method = TAMEAN

OR, to perform the Volume Flow measurement using the 
TAMAX plus a Volume Flow coefficient compensation, 
select the following: 

• Trace = Auto

• Vol Flow Method = TAMAX [if you use TAMAX, you 
MUST also select a Volume Flow coefficient for use with 
TAMAX.] 

• Vol Flow Compensation with TAMAX = [select value 
from 0.5 to 1.0]

2. Set Auto Calcs to Live via Doppler Mode-->Modify Auto 
Calcs-->Live. 

3. Perform the scan. 

4. Select Volume Flow via Doppler Mode-->Modify Auto 
Calcs-->VOLUME FLOW. The system prompts you through 
the measurement. 

5. Take vessel diameter for volume flow calculation. Set the 
first cursor. 

6. Mark last point of vessel diameter for volume flow 
calculation. Press Set. 

7. The calculation automatically completes the Volume Flow 
measurements as ml/min. 

NOTE: If you change the TAMAX coefficient, the Volume Flow is 
automatically adjusted when in Auto Calcs (but not in 
Manual Calcs). 
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M-Mode Measurements

Basic measurements that can be taken in the M-Mode portion of 
the display are:

• Tissue Depth (Distance)

• Time Interval

• Time Interval and Velocity

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Activate M-Mode.

3. Press Freeze.

Tissue depth

Tissue depth measurement in M-Mode functions the same as 
distance measurement in B-Mode. It measures the vertical 
distance between calipers.

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to MM 
Distance.

An active caliper with a vertical and horizontal dotted line 
displays.

2. To position the active caliper at the most anterior point you 
want to measure, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the most posterior point 
you want to measure, move the Trackball.

5. To complete the measurement, press Set.

The system displays the vertical distance between the two 
points in the Results Window.
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Time interval

To measure a horizontal time interval and velocity: 

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to MM Time.

An active caliper with vertical and horizontal dotted lines 
displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the first caliper, press Set. The system fixes the first 
caliper and displays a second active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set. The system 
displays the time interval between the two calipers in the 
Results Window.

Slope (Time interval and Velocity)

To measure time and velocity between two points: 

1. Press Measure key to enter into measure mode, if 
necessary.

Adjust Caliper Change in the Primary Menu to MM Slope.

An active caliper with vertical and horizontal dotted lines 
displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

5. To complete the measurement, press Set.

The system displays time(s) and slope between the two 
points in the Results Window.
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Viewing and Editing Worksheets

NOTE: Worksheets are not saved if the system crashes.

As you complete measurements, the system puts measurement 
data in the appropriate worksheets. 

To view a worksheet

To view a worksheet, select Worksheet .

The system displays the worksheet for the current study. 

 Figure 7-31. Worksheet Display Primary Menu

To return to scanning, do one of the following:

• Select Worksheet again. 

• Press Esc.

• Select the Exit.
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To view a worksheet  (continued)

To view a different worksheet, select the worksheet key for the 
desired worksheet. 

To view worksheet data for a particular mode, select that mode. 
To view a worksheet with data for more than one mode, select 
Expand. When Expand is selected, it defaults to view all 
measurements, noted by mode, on the worksheet.

If a worksheet has more data on a second page, to view the next 
page, adjust the Page Change control.
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To edit a worksheet

To change data on a worksheet:

1. To position the cursor at the field you want to change, move 
the Trackball. The field is highlighted.

2. Press Set.

3. Type the new data in the field. The new data is displayed in 
blue to indicate that it was manually entered.

To delete or exclude data on a worksheet:

1. To position the cursor at the field you want to delete or 
exclude, move the Trackball. The field is highlighted.

2. Do one of the following:

• To delete the field, select Delete Value.

• To exclude the field, select Exclude Value.

The data in the field is not visible and is not included in 
worksheet calculations.

• To include a value that you previously excluded, select 
Exclude Value.

To type a comment on a worksheet:

1. Select Examiner’s Comments. The Examiner’s Comments 
window opens.

2. Type comments about the exam.

3. To close the Examiner’s Comments window, select 
Examiner’s Comments again.

To turn the volume measurement value off:

• Select the method type Off.

HINTS Some fields on the worksheet are view only, and others you can 
change or select. To easily see which fields you can change or 
select, move the Trackball. As the cursor moves over a field that 
you can change or select, the field is highlighted.
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Delete All Worksheet Values

You can delete all worksheet values on a worksheet.

1. When the Worksheet is displayed on the monitor, press the 
Clear key; the following warning message appears:

Figure 7-32. Delete All Warning Message

2. Select OK to delete all.

Select Cancel to cancel the deletion.



Generic Measurements

LOGIQ V2/LOGIQ V1 – Basic User Manual 7-59
Direction 5610735-100 English Rev. 2

Generic Measurements

Overview

Each exam category has a Generic study. The Generic studies 
provide you quick access to measurements such as volume, 
angle, A/B ratio, and % stenosis. The particular measurements 
available in each Generic study vary, depending on the exam 
category and the mode. This section describes generic 
measurements, organized by mode.

To access Generic studies:

1. On the Control Panel, press Measure.

2. Select the Second Menu, the exam category menu is 
displayed.

3. Select the Generic folder.

Calculation formulas are available in the Advanced Reference 
Manual.
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Assign a name to the generic measurement

NOTE: Available for any linear and circumference measurement.

1. Move the cursor over the measurement result window and 
press Set.

Figure 7-33. User Name

2. Select User Name from the menu. The dialogue window 
displays.

Figure 7-34. Enter new parameter

3. Enter the appropriate name and select OK.
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B-Mode Measurements

In B-Mode, the Generic study includes the following 
measurements:

• % Stenosis

• Volume

• Angle

• A/B Ratio

Figure 7-35. B-Mode Generic Study

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

% Stenosis

You can calculate % Stenosis by diameter or by area, depending 
on the mode.

NOTE: The LOGIQ V2/LOGIQ V1 automatically activates the % 
Stenosis with the default selection. If another method is 
preferred, select it from the screen.
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Diameter

NOTE: When you use diameter to calculate the % stenosis, always take 
the measurement from a cross-sectional view of the vessel.

To calculate percent stenosis by diameter:

1. From Generic, select % Stenosis. 

2. Select %sten(Diam).

The system displays an active caliper.

3. Make a distance measurement of the inner area of the blood 
vessel. 

The system displays an active caliper for the second 
distance measurement.

4. Make a distance measurement of the outer area of the blood 
vessel. 

The system displays each distance measurement and the% 
Stenosis in the Results Window.

For details on how to make a distance measurement, see 
‘Distance measurement’ on page 7-39 for more information.

NOTE: For the diameter calculation, do NOT take a distance 
measurement from a longitudinal view. This may lead to an 
inaccurate assessment of % stenosis.

Area

To calculate percent stenosis by area:

1. From Generic, select % Stenosis. 

2. Select %sten(Area).

The system displays a caliper.

3. Make a trace measurement of the inner area of the blood 
vessel.

NOTE: To erase an open trace, move the Trackball.

4. Press Set.

The system displays a second caliper. 

5. Make a trace measurement of the outer area of the blood 
vessel.

The system displays the two area measurements and 
percent stenosis in the Results Window.

See ‘Circumference and area (trace) measurement’ on 
page 7-41 for more information.
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Volume

The volume calculation can be made from any of the following 
measurements: 

• One distance

• Two distances

• Three distances

• One ellipse

• One distance and one ellipse

For details on how to make a distance measurement, see 
‘Distance measurement’ on page 7-39 for more information.

For details on how to make an ellipse measurement, see 
‘Circumference and area (ellipse) measurement’ on page 7-40 
for more information.

NOTE: IMPORTANT!! If you want to make a volume calculation using 
one or two distances, you must select Volume BEFORE you 
make the measurements.

NOTE: If you select Fix Caliper by Print Key on the Utility --> System --> 
System Measure, the print key does not function like the Set 
key, but instead ends the measurement sequence and initiates 
the volume calculation based on the number of measurements 
taken so far.

To make a volume calculation using one or two distances: 

1. Select Volume.

2. Make one or two distance measurements.

3. Select Volume.

The system displays the distances and the volume in the 
Results Window.

NOTE: Use the Clear key to erase the green caliper.

To make a volume calculation using three distances:

1. Make three distance measurements.

NOTE: Three distances can be done in the dual format mode (side 
by side images). One measurement is usually made in the 
sagittal plane and two measurements in the axial plane. To 
use the dual format mode, press the L or R key on front 
panel.

2. Select Volume.

The system displays the distances and the volume in the 
Results Window.
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Volume  (continued)

To make a volume calculation using one ellipse: 

1. Make one ellipse measurement.

2. Select Volume.

The system displays the ellipse measurement and the 
volume in the Results Window.

To make a volume calculation using one ellipse and one 
distance: 

1. Make one distance measurement and one ellipse 
measurement.

2. Select Volume.

The system displays the distance and ellipse measurement 
and the volume in the Results Window.

NOTE: If you change the parameters or category during the volume 
measurement, please follow the procedure below before you 
restart the measurement. 

1. Check the number of each measurement in the summary 
window.    

2. If the numbers are not all the same, it shows that you have 
the calculation which is not completed. Open the Worksheet 
and clear that calculation.   

HINTS • Volumes are most accurate when measurements are taken 
in the sagittal and axial scan planes.

• To display sagittal and axial plane images simultaneously, 
use the side-by-side dual format option.
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Volume  (continued)

Figure 7-36. Volume Calculation Examples

1. One distance

2. Two distances

3. Three distances

4. One ellipse

5. One distance and one ellipse

Calculation formulas are available in the Advanced Reference 
Manual.

Table 7-2:  Volume Calculations

Calc Name Input Measurements

Volume (spherical) One distance

Volume (prolate spheroidal) Two distances, d1>d2

Volume (spheroidal) Three distances

Volume (prolate spheroidal) One ellipse: (d1 major axis, d2 minor axis)

Volume (spheroidal) One distance d1, and one ellipse (d2 major axis, d3 minor axis)

1 2 3

4 5
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Volume  (continued)

Post-assignment for General Volume

You can input a unique name for the general volume 
measurement. You can group the general volume 
measurements for each application.

1. Complete the volume measurement.

2. Move the caliper to the measurement result box (with green 
frame) and select Set.

3. The volume name menu appears. Select Name Volume.

Figure 7-37. Volume Name menu

4. The dialog box displays. Enter a new name or choose the 
existing name.

Figure 7-38. Volume Name Dialog box

NOTE: The factory default volume name cannot be changed (for 
example, Renal Volume).
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Angle

This function measures the angle between two intersecting 
planes.

1. From the Generic, select Angle. 

The system displays an active caliper. 

2. To position the caliper, move the Trackball.

3. To fix the position of the first caliper, press Set.

The system displays a second active caliper.

4. To position the second caliper at the apex of the angle, 
move the Trackball.

5. To fix the position of the second caliper, press Set.

The system displays a third active caliper. 

6. To position the third caliper, move the Trackball. 

7. To complete the angle measurement, press Set.

The system displays the angle in the Results Window.

NOTE: To rotate through and activate previously fixed calipers, adjust 
the Cursor Select control.
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A/B Ratio

In B-Mode, you can calculate A/B ratio by diameter or by area.

NOTE: The LOGIQ V2/LOGIQ V1 automatically activates the A/B Ratio 
with the default selection. If another method is preferred, select 
it from the screen.

Diameter

To calculate A/B ratio by diameter:

1. From Generic, select A/B Ratio. 

2. Select Ratio(Diam). 

The system displays an active caliper.

3. Make a distance measurement of the first diameter. 

The system displays an active caliper for the second 
distance measurement.

4. Make a distance measurement of the second diameter. 

The system displays each distance measurement and the A/
B ratio in the Results Window.

NOTE: The first distance is the A diameter. The second distance is the 
B diameter.

For details on how to make a distance measurement, see 
‘Distance measurement’ on page 7-39 for more information.

Area

To calculate A/B ratio by area:

1. From Generic, select A/B Ratio. 

2. Select Ratio(Area). 

The system displays a caliper.

3. Make a trace measurement of the A area.

NOTE: To erase an open trace, move the Trackball.

The system displays a second caliper. 

4. Make a trace measurement of the B area.

The system displays the two area measurements and the A/
B ratio in the Results Window.

For details on how to make a trace measurement, see 
‘Circumference and area (trace) measurement’ on page 7-41 for 
more information.
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M-Mode Measurements

In M-Mode, the Generic study includes the following 
measurements:

• % Stenosis

• A/B Ratio

• HR (Heart Rate)

Figure 7-39. M-Mode Generic Study

% Stenosis

See ‘% Stenosis’ on page 7-61 for more information.
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A/B Ratio

In M-Mode you can measure A/B ratio by diameter, time, or 
velocity. 

NOTE: The LOGIQ V2/LOGIQ V1 automatically activates the A/B Ratio 
with the default selection. If another method is preferred, select 
it from the screen.

Diameter

See ‘Diameter’ on page 7-68 for more information.

Time

To calculate A/B ratio by time:

1. Select A/B. 

2. Select Ratio(Time). 

The system displays an active caliper.

3. Make the first time interval measurement. 

The system displays an active caliper for the second time 
interval measurement.

4. Make the second time interval measurement. 

The system displays the two time measurements and A/B 
ratio in the Results Window. 

Velocity

To calculate AB ratio by velocity:

1. Select A/B. 

2. Select Ratio(Velocity). 

The system displays an active caliper with vertical and 
horizontal dotted lines.

3. To position the caliper at the A velocity, move the Trackball.

4. To fix the measure point, press Set.

The system displays a second active caliper.

5. To position the second caliper at the B velocity, move the 
Trackball.

6. To complete the measurement, press Set.

The system displays the two velocity measurements and the 
A/B ratio in the Results Window. 
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Heart Rate

To calculate the heart rate from M-Mode:

1. Obtain an image and press Measure. Select HR. 

The system displays an active caliper. 

2. To position the caliper at a recognizable point in the first 
cycle, move the Trackball.

3. To fix the first caliper, press Set.

The system displays a second active caliper.

4. To position the caliper at the identical point in the next cycle 
(depending on preset), you need to move the Trackball.

NOTE: In the message bar at the bottom of the display, the system 
indicates the number of cycles you should measure. 

Figure 7-40. Two Heart Beat Reference (example in Doppler 
mode)

5. To complete the measurement and transfer the calculation 
to the worksheet, press Set.
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Doppler Mode Measurements

In Doppler Mode, the Generic study includes the following 
measurements:

• PI (Pulsatility Index)

• RI (Resistive Index)

• PS/ED Ratio or ED/PS Ratio

• A/B Ratio

• FV-D (Mean)/FV-D (Max)

• FV-A (Mean)/FV-A (Max)

• HR (Heart Rate)

NOTE: Only when presetting in Utility -> Measure ->M&A will FV-D and 
FV-A display on the screen.

Figure 7-41. Doppler Mode Generic Study

NOTE: The following instructions assume that you do the following:

1. In the B-Mode part of the display, scan the anatomy you 
want to measure.

2. Go to the Doppler Mode part of the display.

3. Press Freeze.
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Pulsatility Index (PI)

For auto trace:

1. From the Doppler Generic, select PI. 

The system displays a caliper and a vertical dotted line.

2. Position the caliper at the beginning of the waveform.

3. To fix the start point, press Set.

The system displays a second active caliper.

4. Position the caliper at the end of the waveform.

5. To complete the measurement, press Set.

The system displays Vmax (peak systole), Vmin (minimum 
diastole), Vd (end diastole), TAMAX, PI, RI, S/D and D/S in 
the Results Window. 

For manual trace:

1. Select PI. 

The system displays a caliper and a vertical dotted line.

2. Position the caliper at the beginning of the waveform.

3. To fix the start point, press Set.

The system displays a second active caliper.

4. Manually trace the entire waveform.

5. To complete the measurement, press Set.

The system displays Vmax (peak systole), Vmin (minimum 
diastole), Vd (end diastole), TAMAX, PI, RI, S/D and D/S in 
the Results Window. 

Resistive Index (RI)

1. From the Doppler Generic, select RI. 

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at the peak systolic velocity, move the 
Trackball.

3. To fix the measure point, press Set.

The system displays a second active caliper.

4. To position the second caliper at the end diastolic velocity, 
move the Trackball.

5. To complete the measurement, press Set.

The system displays Vs (PS), Vd (ED), RI, S/D and D/S in 
the Results Window. 
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PS/ED or ED/PS Ratio

To calculate the Peak Systole/End Diastole ratio or End 
Diastole/Peak Systole ratio:

1. Select S/D Ratio or D/S Ratio

The system displays an active caliper with vertical and 
horizontal dotted lines.

2. To position the caliper at peak systole (PS) or end diastole 
(ED), move the Trackball.

3. To fix the measure point, press Set.

The system displays a second active caliper.

4. To position the second caliper at end diastole (ED) or peak 
systole (PS), move the Trackball.

5. To complete the measurement, press Set.

The system displays the peak systole, end diastole, and PS/
ED or ED/PS ratio in the Results Window. 

Heart Rate

To measure heart rate, see ‘Heart Rate’ on page 7-71 for more 
information. or select any of the following measurements.
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A/B Ratio

In Doppler Mode you can measure A/B ratio by velocity, time, or 
acceleration.

NOTE: The LOGIQ V2/LOGIQ V1 automatically activates the A/B Ratio 
with the default selection. If another method is preferred, select 
it from the touch panel.

Velocity

See ‘Velocity’ on page 7-70 for more information. 

Time

See ‘Time’ on page 7-70 for more information.

Acceleration

To measure A/B ratio by acceleration:

1. Select A/B Ratio. 

2. Select Ratio(Acc). 

The system displays an active caliper.

3. Make a distance measurement of the A acceleration point. 

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window and displays an active caliper for the second 
distance measurement.

4. To make a distance measurement of the B acceleration 
point, repeat steps a–d. 

The system displays the two acceleration measurements 
and the A/B ratio in the Results Window. 
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Flow Volume (FV)

Flow Volume estimates the volume of blood that flows through a 
vessel per unit time. It is derived from a vessel's cross-sectional 
diameter obtained from the B-Mode portion of the image and the 
mean velocity of flow in the vessel obtained from the Doppler 
portion of the image. It is measured in milliliters. When the FV 
measurement is made, FVO is automatically calculated.

To measure flow volume:

1. Select FV-D or FV-A. 

2. Place the dotted horizontal line caliper at each of the time 
base on the Doppler spectrum.

• If Trace Auto is selected, the waveform is automatically 
traced.

• If Trace Auto is not selected, manually trace the desired 
portion of the waveform.

The caliper moves to the B-Mode area.

3. If Select FV-D, measure the diameter of the vessel.

If select FV-A, use the Ellipse or Trace method to measure 
the circumference and area of the vessel.

The FV Diameter/FV Area, TAMAX [if FV-D(Max) or 
FV-A(Max) selected], Volume and Volume Flow (FV) are 
calculated and displayed in the result window.
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Modify Auto Calcs

When you select Second Menu, the Modify Calculation menu is 
displayed as below. In this menu, you select parameters to 
display in the Auto Vascular Calculation window. Only 
parameters that can be used by the calculation are displayed.

Select Save as Default to save the selected parameters as the 
default calculations for this application.

Select Return to return to the previous scan screen.

If you select PV, all selected parameters are turned off. When 
you deselect PV, the system returns to the previously selected 
calculation.

Figure 7-42. Modify Auto Calculation Menu
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Auto vs. Manual Calculations

The same calculations can be performed using either manual or 
auto calcs.

Manual Calcs

To perform manual calcs:

1. To turn Auto Calcs off and perform manual measurements, 
choose Auto Calcs -> OFF in the second menu.

2. After obtaining a waveform, press Measure. Choose the 
appropriate vessel folder or calculation. The system walks 
you through the measurement.

NOTE: To program which calculations are done under manual calcs 
when using measurement folders for measuring specific 
vessels, press the Utility key. Select Measure -> Doppler and 
program your manual calcs (Auto Calcs OFF). Each vessel must 
be programmed individually and saved after each change.

Auto Calcs To perform auto calcs:

1. Ensure that the auto calcs function is on by choosing Auto 
Calcs -> Frozen or Live in the Second Menu.

• Live: Auto calculation activates when the system in alive 
state.

• Freeze: Auto calculation activates when you press 
Freeze.

• Off

2. After obtaining a waveform, press Measure. Choose the 
appropriate vessel folder, side and location. The 
measurements that are pre-programmed are performed 
automatically and entered in the worksheet.

To modify auto calcs:

1. Choose the measurements to be performed with this preset 
in the Second Menu -> Modify Calcs. 

2. To save these measurements:

• If this is a temporary change, press Return.

• If this is a permanent change, select Save as default.

The measurements are saved and can be performed with 
the auto calcs function.
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Auto vs. Manual Calculations  (continued)

Edit Auto Calcs

Auto Calcs can be edited after taking an Auto Trace 
measurement.

1. After taking an Auto Calc with a trace, select the 
measurement result on the result window. The Edit Trace 
menu window appears.

NOTE: If the system cannot take the trace data correctly from the 
image, Edit Trace does not work.

2. Select Edit Trace. The first caliper (manual trace caliper) 
appears on the center of the image. Use the Trackball to 
move the caliper on the trace line to the start point.

NOTE: To cancel Edit Trace at this time, press Clear.

3. Press Set to fix the first caliper. The second caliper appears. 
Edit the trace manually using the second caliper. 

The Ellipse control is used to edit the trace.

NOTE: When pressing the Clear key once at this time, the second 
caliper disappears and the first caliper appears in the center 
of the image.

NOTE: If you press Scan or Freeze at this time, the caliper is 
automatically fixed and the result window updates.

4. Press Set to fix the second caliper. The trace and the result 
window are updated. The data is retaken from the trace and 
updated.

NOTE: While in Edit Trace, Cursor Select is disabled.

The trace data (TAMAX and TAMEAN) is updated, but the 
other selections (e.g. PS, ED) are not updated by trace. The 
points can be edited using Cursor Select if needed.

5. Repeat Edit Trace as needed.
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Performing Measurements on Saved Images

You can perform measurements on recalled images. Select the 
image, then perform the measurement. If the image was not 
saved as a raw DICOM image, you need to calibrate the image 
prior to performing the measurement. 

To calibrate the image,

1. Recall the image.

2. Press Measure. The Measurement Calibration second 
menu appears.

3. Select the mode you need to be in to perform the 
measurement.

4. Select the Second Menu and select the appropriate mode 
key, 2D calib for B-Mode, M calib for M-Mode, or Dopper 
calib for Doppler mode. The specified mode calibration 
pop-up appears. 

5. The system prompts you, depending on the mode.

B-Mode:

a. Place the first point of the caliper on the ruler. Press 
Set.

b. Position the cursor at the 5 cm point on the ruler. Press 
Set.

c. Type “5” into the 2D-Mode Calibration pop-up window. 
Press OK.

Figure 7-43. 2D-Mode Calibration
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Performing Measurements on Saved Images  (continued)

M-Mode or Doppler Mode:

a. Place the cross on zero depth and minimum or zero 
time. 

b. Place the cross on maximum depth and time. 

c. Type the time (in seconds) and velocity (cm/sec) in the 
M-Mode/Doppler Mode calibration pop-up window.

Figure 7-44. M-Mode Calibration

Figure 7-45. Doppler Mode Calibration
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Helpful hints

HINTS The following hints can help when making a measurement

• Prior to making measurements, use the Cine function, if 
necessary, to display the best image.

• As you take measurements, each measurement is given a 
sequential number on the display and in the Results 
Window. Nine measurements can be displayed in the 
Results Window at one time.

• Once the Results Window has nine measurements, if you 
make any further measurements, the system erases the 
top (first) measurement and adds the new measurement 
last (“first in, first out”).

• While you are taking a measurement, the value in the 
Results Window updates until you complete the 
measurement.
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Chapter 8

Abdomen and Small Parts

Describes how to perform Abdomen and Small Parts 
measurements and calculations.
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Abdomen/Small Parts Exam

Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

Calculation formulas are available in the Advanced Reference 
Manual.

General Guidelines

New Patient information must be entered before beginning an 
exam. See ‘Beginning an Exam’ on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again from the Screen.
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Abdomen

Overview

Abdominal measurements offer a few different types of 
measurement studies:

Figure 8-1. Abdomen Exam Category 

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-59 for more information.

• Abdomen

• Renal

• BPG

• Aorta Iliac

• Vascular Renal

• Mesenteric

• Abdomen Vein

To change a study:

1. Press Measure.

2. Rotate the Second Menu button, the exam category menu 
is displayed.

3. To choose another study, select that desired study.
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Small Parts

Overview

The Small Parts exam category includes the following two 
folders:

• Generic - Common to all applications. See ‘Generic 
Measurements’ on page 7-59 for more information.

• Small Parts, which includes the thyroid and scrotal 
measurements described in this section

Figure 8-2. Small Parts Exam Category 
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Thyroid

 Thyroid Left/Right

Each of these is a standard distance measurement. Length and 
height are typically measured in the sagittal plane. Width is 
measured in the transverse/axial plane.

To measure thyroid length, width, or height:

1. On the second menu, select Small Parts and then select 
Thyroid.

2. Select Lt or Rt Thyroid. Change the orientation (side), if 
necessary.

3. Select Thyroid L, Thyroid W, or Thyroid H.

An active caliper displays.

4. Perform a standard distance measurement:

The system displays the distance value in the Results 
Window.

5. The system automatically prompts to make the second and 
third distance measurements. 

6. Perform another 2 standard distance measurements for the 
second and third distance measurements.

After you complete the third distance measurement, the 
system displays the thyroid volume in the Results Window.

Isthmus AP

To measure the anterior/posterior isthmus tissue, perform a 
distance measurement.
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Scrotal

Testicle Left/Right

Each of these is a standard distance measurement. Length and 
height are typically measured in the sagittal plane. Width is 
measured in the transverse/axial plane.

To measure scrotal length, width, or height:

1. On the second menu, select Small Parts and then select 
Scrotal.

2. Select Lt or Rt Testicle. Change the orientation (side), if 
necessary.

3. Select Testicle L, Testicle W, or Testicle H.

4. An active caliper displays.

5. Perform a standard distance measurement:

The system displays the distance value in the Results 
Window.

6. The system automatically prompts to make the second and 
third distance measurements. 

7. Perform another 2 standard distance measurements for the 
second and third distance measurements.

After you complete the third distance measurement, the 
system displays the thyroid volume in the Results Window.

Epididymis

To measure the epididymis structure, perform a distance 
measurement. 
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Chapter 9

OB/GYN

Describes how to perform obstetric and gynecology 
measurements and calculations, and how to use OB 
graphs and worksheets.
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OB Exam

Exam Preparation
Prior to an ultrasound examination, the patient should be 
informed of the clinical indication, specific benefits, potential 
risks, and alternatives, if any. In addition, if the patient requests 
information about the exposure time and intensity, it should be 
provided. Patient access to educational materials regarding 
ultrasound is strongly encouraged to supplement the information 
communicated directly to the patient. Furthermore, these 
examinations should be conducted in a manner and take place 
in a setting which assures patient dignity and privacy.

• Prior material knowledge and approval of the presence of 
nonessential personnel with the number of such personnel 
kept to a minimum.

• An intent to share with the parents per the physician’s 
judgement, either during the examination or shortly 
thereafter, the information derived. 

Acoustic Output Considerations

General warning

The LOGIQ V2/LOGIQ V1 system is a multi-use device which is 
capable of exceeding FDA Pre-enactment acoustic output 
(spatial peak-temporal average) intensity limits for fetal 
applications.

Concerns surrounding fetal exposure

Always be aware of the acoustic output level by observing the 
Acoustic Output Display. In addition, become thoroughly familiar 
with the Acoustic Output Display and equipment controls 
affecting output.

Training It is recommended that all users receive proper training in fetal 
Doppler applications before performing them in a clinical setting. 
Please contact a local sales representative for training 
assistance.

CAUTION It is prudent to conduct an exam with the minimum amount and 
duration of acoustic output necessary to optimize the image's 
diagnostic value.
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To Start an Obstetrics Exam
NOTE: Calculation formulas are listed in the Advanced Reference 

Manual.

To begin an Obstetrics exam, you enter patient data by pressing 
Patient on the control panel or, if the patient data from a 
previous exam is saved in the system, find the patient 
information in Archive Screen. 

If the patient data is not stored in the system, enter the data. To 
enter data in a field, move the Trackball to highlight the field 
and then press Set. Use the Tab key to move between fields. 
Obstetric patient fields are listed in the following table. 

After you complete the patient information, select OB category 
and related exam, then you can begin the scan. 

1. To change from the Patient Data Entry screen to the Scan 
screen, do one of the following:

• Select Scan on the Patient screen.

• On the Control Panel, select Freeze.

• On the Control Panel, press the B-Mode key.

The system displays the scan screen.

2. Scan the patient.

3. On the Control Panel, press Measure.

The default Obstetrics study is displayed. 

OB Type change
The LOGIQ V2/LOGIQ V1 system includes measurements for 
the following studies: USA, Europe, Osaka, Tokyo, and ASUM. 
Select OB Type in Utility -> System -> System Measure. 

NOTE: ASUM studies include the following measurements:

• ASUM: AC, BPD, CRL and AFI

• ASUM 2001: AC, BPD, CRL, FL, HC, HL, OFD and AFI

Table 9-1:  Obstetric fields

Field Description

LMP Last Menstrual Period; enter the date that the patient started her last menstrual period. 
You must enter 4 digits for the year. When you type the month and day, the system fills 
in the /. The Date Format preset chosen in Utility -> System -> General determines the 
required format. 

BBT Basal Body Temperature.

EDD by LMP Estimated Delivery Date by LMP; the system fills in the date after you enter the LMP. 

GA by LMP Gestational Age by LMP; the system fills in the age after you enter the LMP. 

Fetus # Number of fetuses; default is 1. Can be 1-4.
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OB Measurements and Calculations

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

When you make measurements, you can select the calculation 
before you make the measurement or after you make it. If you 
select the calculation before you make the measurement, the 
Results Window shows the estimated fetal age as you make the 
measurement. If you select the calculation after you make the 
measurement, the estimated fetal age is displayed after you 
complete the measurement. The measurements steps in this 
section tell you to select the calculation before you make the 
measurement.

The following pages describe how to make OB measurements 
and calculations. The measurements are organized by mode, 
and within mode are listed in alphabetical order.

Out of Range – If the system indicates that a measurement is 
out of range (OOR), it means one of the following:

• The measurement is out of the normal range based on the 
gestational age that is calculated from the LMP. The system 
determines OOR from the ultrasound age compared to the 
gestational age. The gestational age is calculated from the 
last menstrual period or the estimated delivery date.

• The measurement is outside of the range for the data used 
in the calculation. That means that the measurement is 
either less than or more than the range of measurements 
used to determine fetal age based on the measurement.

NOTE: Calculation formulas are listed in the Advanced Reference 
Manual.
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B-Mode Measurements

This section describes all B-Mode measurements that you 
typically find in OB studies. Additional OB measurements follow 
the typical ones.

Abdominal Circumference (AC)

To calculate abdominal circumference, you make an ellipse, 
trace, spline trace or two distance measurements.

Ellipse 
1. Select AC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make an ellipse measurement.

The system displays the circumference in the Results 
Window. 

Trace
1. Select AC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Trace.

3. Make a trace measurement.

The system displays the circumference in the Results 
Window.

Spline Trace
1. Select AC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Spline.

3. Make a spline trace measurement.

The system displays the circumference in the Results 
Window.

Two distances
1. Select AC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make 2 distance measurement.

The system displays the abdominal circumference in the 
Results Window. 

NOTE: The available values for Caliper Change menu can be set in 
Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

USA
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Biparietal Diameter

To measure biparietal diameter, make one distance 
measurement:

1. Select BPD; an active caliper displays.

2. Make one distance measurement.

The system displays the biparietal diameter in the Results 
Window.

Crown Rump Length

To measure crown rump length, make one distance 
measurement:

1. Select CRL; an active caliper displays.

2. Make one distance measurement.

The system displays the crown rump length in the Results 
Window.

Femur Length

To measure femur length, make one distance measurement:

1. Select FL; an active caliper displays.

2. Make one distance measurement.

The system displays the femur length in the Results 
Window.

Gestational Sac

To calculate the gestational sac, you make three distance 
measurements in two scan planes. To display two scan planes, 
press the L or R key. Get an image in each scan plane and 
press Freeze. 

1. Select GS; an active caliper displays. 

2. Make three distance measurements. 

After you complete the third distance measurement, the 
system displays the gestational sac measurement in the 
Results Window.

You can calculate the gestational sac by one distance 
measurement.

1. Select GS; an active caliper displays. 

2. Make one distance measurement. 

After you complete the measurement, the system displays 
the gestational sac measurement in the Results Window.
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Head Circumference (HC)

To calculate head circumference, you make an ellipse, trace, 
spline trace or two distance measurements.

Ellipse 
1. Select HC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make an ellipse measurement.

The system displays the circumference in the Results 
Window. 

Trace
1. Select HC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Trace.

3. Make a trace measurement.

The system displays the circumference in the Results 
Window.

Spline Trace
1. Select HC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Spline.

3. Make a spline trace measurement.

The system displays the circumference in the Results 
Window.

Two distances
1. Select HC; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make 2 distance measurement:

The system displays the abdominal circumference in the 
Results Window. 

NOTE: The available values for Caliper Change menu can be set in 
Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.

USA
Euro

pe

To
ky

o
Osa

ka
ASUM



OB/GYN

9-8 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Amniotic Fluid Index (AFI)

To calculate the amniotic fluid index, you make measurements 
of the four quadrants of the uterine cavity. The system adds 
these four measurements together to calculate the Amniotic 
Fluid Index.

NOTE: The four quadrants can be measured with distance (caliper) or 
circumference (circle) measurements. Select the appropriate 
AFI quadrant to show the popup menu to select caliper or circle.

1. Select AFI. 

The first distance measurement, AFI-Q1, is already 
selected.

2. Make a standard distance measurement for the first 
quadrant:

3. When the measurement of the first quadrant is completed, 
unfreeze and move to the second quadrant. 

4. After you obtain the image, press Freeze and then 
Measure. 

The system prompts you to continue with the AFI 
measurements. Make sure that the next quadrant has been 
selected.

5. Perform a standard distance measurement for the second, 
third, and fourth quadrants.

When all four quadrants have been measured, the system 
calculates the AFI total and displays it in the Results 
Window.
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HINTS • If you unfreeze the image after doing an AFI measurement, 
the system does not delete the previous measurements. 
Unfreeze and change scan planes as necessary.

• To specify that an unassigned distance measurement be 
used for an AFI measurement:

• Select AFI.

• Move the Trackball to highlight the unassigned 
distance measurement in the Results Window, press 
Set and select the AFI measurement from the pop-up 
menu.

• If the fluid in a pocket is zero, set the second caliper on top 
of the first one to give it a zero value.

• You can measure an AFI quadrant that is zero (0) by 
pressing Set twice.
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A/B Ratio

In B-Mode you can calculate A/B ratio by diameter or by area. 
See ‘A/B Ratio’ on page 7-68 for more information.

Angle

See ‘Angle’ on page 7-67 for more information.

Antero-Postero Trunk Diameter & Transverse Trunk Diameter (APTD-TTD)

Make two distance measurements, one of the antero-postero 
trunk diameter and one of the transverse trunk diameter. 

1. Select APTD_TTD; an active caliper displays.

2. Make a distance measurement of the antero-postero trunk 
diameter.

3. To make a distance measurement of the transverse trunk 
diameter.

The system displays the antero-postero trunk diameter and 
the transverse trunk diameter in the Results Window.

Antero-Postero Trunk Diameter by Transverse Trunk Diameter (AxT)

Make two distance measurements, one of the antero-postero 
trunk diameter and one of the transverse trunk diameter. 

1. Select AxT; an active caliper displays.

2. Make a distance measurement of the antero-postero trunk 
diameter.

3. To make a distance measurement of the transverse trunk 
diameter.

The system displays the antero-postero trunk diameter, the 
transverse trunk diameter, and AxT in the Results Window.

Cardio-Thoracic Area Ratio (CTAR)

To calculate cardio-thoracic area ratio, you make two ellipse 
measurements.

1. Select CTAR; an active caliper displays.

2. Make an ellipse measurement of the cardiac area.

3. Make an ellipse measurement of the thoracic area.

The system displays the cardio-thoracic area ratio in the 
Results Window.
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Estimated Fetal Weight (EFW)

To measure estimated fetal weight, you make several OB 
measurements. These measurements can vary, based on how 
your system is set up. Measurements can include biparietal 
diameter, fetal trunk area, femur length, antero-postero trunk 
diameter and transverse trunk diameter, abdominal 
circumference, head circumference and spinal length.

1. Select EFW.

The system displays the required measurements.

2. Make each measurement.

The system displays each measurement in the Results 
Window. The estimated fetal weight is displayed in the 
Results Window only with Tokyo or Osaka OB type.

NOTE: For a description of any of the required measurements, refer to 
that measurement. 
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Fetal Trunk Area (FTA)

To measure fetal trunk area, you make an ellipse, trace, spline 
trace or two distance measurements.

Ellipse 

1. Select FTA; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make an ellipse measurement.

The system displays the circumference in the Results 
Window. 

Trace
1. Select FTA; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Trace.

3. Make a trace measurement.

The system displays the circumference in the Results 
Window.

Spline Trace
1. Select FTA; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Spline.

3. Make a spline trace measurement.

The system displays the circumference in the Results 
Window.

Two distances
1. Select FTA; an active caliper displays.

2. Adjust Caliper Change in the Primary Menu to Distance.

3. Make 2 distance measurements.

The system displays the abdominal circumference in the 
Results Window. 

NOTE: The available values for Caliper Change menu can be set in 
Utility -> Measure -> Advanced preset -> Measure Key 
Sequence.
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Foot Length 

To measure foot length, make one distance measurement:

1. Select Ft; an active caliper displays.

2. Make one distance measurement.

The system displays the foot length in the Results Window.

Humerus Length

To measure humerus length, make one distance measurement:

1. Select HL; an active caliper displays.

2. Make one distance measurement.

The system displays the humerus length in the Results 
Window.

Nuchal Translucency (NT)

To measure nuchal translucency, make one distance 
measurement:

1. Select NT; an active caliper displays.

2. Make one distance measurement.

The system displays the nuchal translucency in the Results 
Window.

NOTE: Nuchal Translucency is not available through the factory default. 
To enable Nuchal Translucency, add NT to the measurement 
folder in Utility -> Measure -> M&A -> Add measurement 
(Insert).

Occipitofrontal Diameter

To measure occipitofrontal diameter, make one distance 
measurement:

1. Select OFD; an active caliper displays.

2. Make one distance measurement.

The system displays the occipitofrontal diameter in the 
Results Window.

% Stenosis 

In B-Mode, you can calculate % Stenosis by diameter or by 
area. See ‘% Stenosis’ on page 7-61 for more information.
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Spinal Length (SL)

To measure spinal length, make one distance measurement:

1. Select SL; an active caliper displays.

2. Make one distance measurement.

The system displays the spinal length in the Results 
Window.

Transverse Abdominal Diameter

To measure transverse abdominal diameter, make one distance 
measurement:

1. Select TAD; an active caliper displays.

2. Make one distance measurement.

The system displays the transverse abdominal diameter in 
the Results Window.

Transverse Cerebellar Diameter

To measure transverse cerebellar diameter, make one distance 
measurement:

1. Select TCD; an active caliper displays.

2. Make one distance measurement.

The system displays the transverse cerebellar diameter in 
the Results Window.

Thorax Transverse Diameter

To measure thorax transverse diameter, make one distance 
measurement:

1. Select ThD; an active caliper displays.

2. Make one distance measurement.

The system displays the thorax transverse diameter in the 
Results Window.
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Tibia Length

To measure tibia length, make one distance measurement:

1. Select Tibia; an active caliper displays.

2. Make one distance measurement.

The system displays the tibia length in the Results Window.

Ulna Length

To measure ulna length, make one distance measurement:

1. Select Ulna; an active caliper displays.

2. Make one distance measurement.

The system displays the ulna length in the Results Window.

Volume

See ‘Volume’ on page 7-63 for more information.

USA
Euro

pe

To
ky

o
Osa

ka
ASUM

USA
Euro

pe

To
ky

o
Osa

ka
ASUM



OB Measurements and Calculations

LOGIQ V2/LOGIQ V1 – Basic User Manual 9-15
Direction 5610735-100 English Rev. 2

M-Mode Measurements

In M-Mode you can measure % stenosis, A/B ratio, and heart 
rate.

% Stenosis 

In M-Mode, you measure % Stenosis by diameter. See ‘% 
Stenosis’ on page 7-69 for more information.

A/B Ratio

In M-Mode you can measure A/B ratio by diameter, time, or 
velocity. See ‘A/B Ratio’ on page 7-70 for more information.

Heart Rate

See ‘Heart Rate’ on page 7-71 for more information.
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Doppler Mode Measurements

You can use Doppler mode to study fetal blood flow in the heart, 
umbilical cord, placenta, and middle cerebral arteries. OB/GYN 
Doppler mode also allows you to study uterine and ovarian 
blood flow. 

The OB/GYN vessel study includes the following vessels:

• Aorta (Ao)

• Desc. Aorta

• Middle Cerebral Artery (MCA) (right and left)

• Ovarian (right and left)

• Placenta

• Umbilical

• Uterine (right and left)

Figure 9-1. OB/GYN Vessels
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Doppler Mode Measurements  (continued)

For each of these studies, you can make any of the following 
measurements. See ‘Doppler Mode Measurements’ on 
page 7-72 for more information.:

• Peak Systole (PS)

• End Diastole (ED)

• Minimum Diastole (MD)

• Heart Rate

• TAMAX

• Pulsatility Index (PI)

• Resistive Index (RI)

• PS/ED Ratio

• ED/PS Ratio

• Acceleration

• AT

• TAMEAN

• Volume Flow

• PV



OB/GYN

9-18 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

To select OB/GYN vessel measurements

OB/GYN Vessel measurements use the auto sequence feature. 
With this feature, when you select a folder for the vessel you 
want to measure, the system automatically starts the first 
measurement. It then continues with each of the other 
measurements in that study.

1. Select the folder for the vessel you want to measure.

The system shows all the measurements for that vessel. 
The caliper for the first measurement is automatically 
displayed.

2. Make the measurement.

After you complete each measurement, the system starts 
the next measurement. After the last measurement is 
complete, the system returns to the OB/GYN Vessel.

Your system is set up to show the measurements that you 
usually make for each vessel. To make a measurement that is 
not shown for the selected vessel:

1. Go to Utility -> Measure -> Measure -> Doppler tab

2. Select Obstetrics in M&A Categories.

3. Click on the plus sign (+) before OB/GYN Vessel to show all 
the folders.

4. Select the folder for the vessel you want to show the 
measurement.

5. Select the desired measurement.

6. Select Exit to exit the Utility screen

When you do the measurements and select the folder, the 
system displays all selected measurements.
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OB Worksheet

The OB Worksheet lists patient information, and all 
measurement and calculation data.

To view the OB Worksheet:

1. Press Measure.

2. Select Worksheet. 

 Figure 9-2. OB Worksheet

The OB Worksheet has three sections of information:

1. Patient data

2. Measurement information

3. Calculation information
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Patient data

The Patient data section, at the top of the worksheet, lists 
information from the Patient Data Entry screen. 

You can select the following fields:

• FetusNo – if this is a multi-gestational patient, you can 
select the fetus in this field. You can also adjust the Fetus 
selection to change the fetus.

• CUA/AUA – select the ultrasound age calculation method

• Composite Ultrasound Age (CUA) – regression 
calculation

• Average Ultrasound Age (AUA) – an arithmetic average

You can select the method in this field, or adjust the Select 
CUA/AUA control.

NOTE: CUA/AUA is only available when you select USA OB Type in 
Utility -> System -> System Measure menu.

You can enter information in the following fields:

• FetusPos – type information about the fetus position.

• PLAC – type information about the placenta.
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Measurement information

This section lists the results of all measurements. 

• CUA or AUA – If this field is checked, the system uses the 
measurement to calculate the ultrasound age. 

• Value – The measured value. If more than one 
measurement was made for an item, the system uses the 
specified method (average, maximum, minimum, or last) to 
determine this value.

• m1–m3 – Up to three measurement values for each item. If 
you make more than three measurements, the worksheet 
uses the last three.

• Method – When there is more than one measurement for an 
item, this specifies the method used to calculate the 
measurement value listed in the Value column. Choices are 
average, maximum, minimum, last, or off. To change the 
method: 

a. Move the Trackball to the Method field. 

b. Press Set.

c. Move the Trackball to select from the list.

d. Press Set.

• AGE – The fetal age for this measurement.

• Range – The typical range of fetal age for this 
measurement.
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Calculation information

This section of the worksheet provides calculation choices and 
lists calculation results.

• EFW – lists the parameters used to calculate EFW. This is 
followed by the calculation result. 

To change which parameters are used:

a. Select this field or press Select EFW.

b. Select the desired parameters.

• EFW GP – lists the source used to calculate EFW–GP 
(growth percentile). This is followed by the growth 
percentile.

To change the source:

a. Select this field or press Select GP.

b. Select the desired source.

The remaining calculation information shows ratios for several 
measurements, and the Cephalic Index (CI). 

The worksheet shows if any of the ratios are out of range 
(OOR). Out of range indicates one of the following:

• The measurement is out of the normal range based on the 
gestational age that is calculated from the LMP. The system 
determines OOR from the ultrasound age compared to the 
gestational age. The gestational age is calculated from the 
last menstrual period or the estimated delivery date.

• The measurement is outside of the range for the data used 
in the calculation. That means that the measurement is 
either less than or more than the range of measurements 
used to determine fetal age based on the measurement.

For more information about how to use the worksheet, see 
‘Viewing and Editing Worksheets’ on page 7-55 for more 
information.
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Anatomical Survey

Overview

The Anatomical Survey page provides a checklist that indicates 
which anatomy was imaged and its appearance.

Figure 9-3. Anatomical Survey
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Editing

• To activate the Anatomical Survey, select Anatomy on the 
OB Worksheet screen.

• Fill the required field.

Select Exit to return to the Scan screen.

Select Worksheet to return to the Worksheet or Graph to enter 
the OB Graph screen.

NOTE: The patient specific contents input on the Anatomical Survey 
page are returned to the factory default settings after starting a 
new patient. 

Table 9-2:  Anatomical Survey

Field Description

Fetus Pos Indicate the fetal position within the uterus.

PLAC Identify the location of the placenta.

ANATOMY Enter the following information for each part of the anatomy imaged:

1. Imaged?: Check the box that you did image this part of the anatomy.

2. Appearance: If you checked the Imaged? box, indicate whether the 
appearance was normal or abnormal.

You can add the required anatomy up to 9 additional anatomy.

Move the Trackball to the blank field.

Enter the anatomy name.

BIOPHYSICAL The score is _ of 10 possible total points, depending upon the number of 
parameters entered. Enter the following information to assess the fetus’s 
biophysical well-being.

Movement Type 0, 1 or 2

Tone Type 0, 1 or 2

Breathing Type 0, 1 or 2

Fluid Type 0, 1 or 2

Reactive NST (Reactive 
non-stress test)

Type 0, 1 or 2

COMMENTS Free text
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OB Graphs

Overview

OB Graphs allow you to assess fetal growth compared to a 
normal growth curve. When a patient has completed two or 
more ultrasound exams, you can also use the graphs to look at 
fetal trending. For multi-gestational patients you can plot all 
fetuses and compare the growth on the graphs. 

The LOGIQ V2/LOGIQ V1 provides the following two basic 
types of graphs:

• Fetal Growth Curve graphs – show one measurement per 
graph. These graphs show the normal growth curve, 
positive and negative standard deviations or applicable 
percentiles, and ultrasound age of the fetus using the 
current measurement. For multi-gestational pregnancies, 
you can view all fetuses. If previous exam data is available, 
the graph can show fetal trending.

• Fetal Growth Bar graph – shows the ultrasound age and 
the gestational age based on patient data. Plots all 
measurements on one graph. 

To View OB Graphs

To view OB graphs:

1. Press Measure.

2. Select Worksheet.

3. Select Graph. 

After you select Graph, the system displays the OB Graph keys. 
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Fetal Growth Curve Graph

Figure 9-4. Fetal Growth Curve Graph

The horizontal axis shows the fetal age in weeks. The system 
determines this age from the data on the Patient Data Entry 
screen. The vertical axis shows one of the following:

• For measurements, mm or cm

• For ratios, percent

• For fetal weight, grams

The Fetal Growth Curve Graph shows the following information 
for the selected measurement:

• The normal growth curve

• The standard deviations or relevant percentiles

• The gestational age of the fetus, using patient data (vertical 
dotted line)

• Using the current ultrasound measurement data, where the 
fetus is on the growth curve 

The legend at the bottom of the graph shows the symbols and 
colors that indicate data for fetal trending (Past and Present) 
and multiple gestation (Fetus).



OB Graphs

LOGIQ V2/LOGIQ V1 – Basic User Manual 9-27
Direction 5610735-100 English Rev. 2

Fetal Growth Curve Graph  (continued)

To select the measurement

To select which measurement you want to display on the Fetal 
Growth Curve Graph, do one of the following:

• To select a specific measurement:

a. On the graph display, move the Trackball to the 
Measurement Type field and press Set. 

The system displays a list of measurements.

b. Move the Trackball to select the desired measurement 
and press Set.

The system displays the Fetal Growth Curve Graph for 
the selected measurement.

• To scroll through all Fetal Growth Curve Graphs, adjust the 
Graph Change control.

To select the age to use

To plot the fetus age, the system allows you to use the 
gestational age (GA) from the LMP, or to use the composite 
ultrasound age (CUA). To select, adjust the Select GA control. 
The information in the left column changes between CUA and 
GA(EDD), and the data may change. 

To view a single or four graphs
You can view either a single Fetal Growth Curve Graph or you 
can view four graphs at the same time. To select each view, 
press Single or Quad. 

Figure 9-5. Fetal Growth Curve Graph: Quad View

The measurement values are displayed at the bottom of the 
graph. 
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Fetal Growth Curve Graph  (continued)

To change measurements in quad view 

When you view four graphs simultaneously, you can select 
which four you want to see. To change each graph in quad view:

1. On the graph display, use the Trackball to move the cursor 
to the small box that is upper left of each graph, then press 
Set.

The system displays a list of measurements.

2. Move the Trackball to select the desired measurement and 
press Set.

The system displays the Fetal Growth Curve Graph for the 
selected measurement.

To scroll through all Fetal Growth Curve Graphs, adjust the 
Graph Change control. 

The order of a quad graph view can be saved by selecting Save. 

Fetal Trending When you have ultrasound data for more than one exam for a 
patient, you can use the data to look at fetal trending on the 
Fetal Growth Curve Graphs.

1. Select Graph and select the desired Fetal Growth Curve 
Graph.

2. Select Plot Both. 

The system automatically finds the data from previous 
ultrasound exams, and displays it on the graph with the 
present data.

Figure 9-6. Fetal Trending on Fetal Growth Curve Graph: FL

The legend at the bottom of the graph shows the symbols and 
colors that indicate Past and Present data.
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To edit patient data

When you are working with graphs, you can change or enter the 
following patient data.

• GA(LMP) – this field is computed using the LMP date on the 
Patient Data Entry screen. To change this field:

NOTE: You can only change this field on the Fetal Growth Curve 
Graph in single view.

a. Move the Trackball to the field, which is left of the 
graph. To select the field, press Set.

The system displays a window with the GA weeks and 
days.

b. To select each field, move the Trackball to move to the 
field and press Set.

c. Type the correct weeks or days.

d. Select OK.

The system makes the following changes:

• GA (LMP) is now GA (GA) and shows the age you 
entered.

• In the Patient Data section, the GA changes.

• In the Patient Data section, The EDD (LMP) changes to 
EDD(GA) and shows an updated date, using the GA 
you entered.

• FetusPos – type information about the fetus position.

• PLAC – type information about the placenta.

To return from a graph to the scan display

After viewing graphs, to return to the scan display, do one of the 
following:

• On the graph display, select Exit.

• Select Graph on the graph display.
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Fetal Growth Bar Graph

The fetal growth bar graph shows current exam measurements 
and the normal growth range based on the gestational age. It 
shows all measurements on one graph.

To view the Fetal Growth Bar Graph: 

1. Press Measure.

2. Select Worksheet.

3. Select Graph.

4. Select Bar.

Figure 9-7. Fetal Growth Bar Graph

• The horizontal axis shows the gestational weeks. 

• The red vertical line shows the gestational age using the 
patient data. 

• The blue dotted vertical line shows the ultrasound age using 
the current measurements. 

• The yellow x shows the ultrasound age for each 
measurement.

• The green rectangle shows the normal age range for the 
measurement.

You cannot do fetal trending or view multiple gestation data on 
the bar graph.
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OB-Multigestational

Multiple Fetus
LOGIQ V2/LOGIQ V1 allows you to measure and report multiple 
fetus development. The system can report a maximum of four 
fetuses.

To enter the number of fetuses 
If more than one fetus is imaged during the exam, enter the 
number of fetuses in the Patient Data Entry Menu.

Figure 9-8. Fetus Number

When you start an OB exam, the system automatically fills in the 
Fetus # field with 1. To change the number:

1. Move the cursor to the fetus number and press Set twice.

The number is highlighted.

2. Type the correct number and press Set.

The system displays a message to confirm that you want to 
change the fetus number.

3. Select Yes.

To identify each fetus
For measurements, calculations, and worksheet displays, the 
system labels each fetus A, B, C, or D. Each fetus is identified 
by a letter and the total number of fetuses. For example, fetus A/
3 is fetus A from a total of 3.

When scanning, you can enter information about the fetus 
position and placenta location. You can enter the information in 
the Patient Data section of the worksheets and the graphs. You 
can type up to 18 characters in the FetusPos field and 12 
characters in the PLAC fields. 

 Figure 9-9. Patient Data section of the OB Worksheet
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To select a fetus

During measurements and calculations, to change between 
fetuses, do one of the following: 

• Adjust the Fetus selection.

• Move the Trackball to move to the Summary Window and 
select the fetus.

Figure 9-10. Summary Window: Multiple fetus

 You can change between fetuses at any time during the exam.

NOTE: After you change to the next fetus, any measurements you 
make are recorded and reported to that fetus. If you have any 
active measurement or calculation that is not completed when 
you change the fetus, the system cancels the measurement or 
calculation.
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To view multiple fetuses data on graphs

You can view multiple gestation data on fetal growth curve 
graphs. After you have made measurements for each fetus, 
select Graph. 

1. To view the graph for each fetus, do one of the following:

• Adjust the Fetus selection.

• In the Patient Data section, move the Trackball to 
highlight the FetusNo field. In the list of fetuses, move 
the Trackball to select the fetus you want, and press 
Set.

2. To display data for multiple fetuses on the same graph, 
select Fetus Compare.

Figure 9-11. Fetal Growth Curve Graph: Fetus Compare

The legend at the bottom of the graph shows the symbols and 
colors that represent each fetus.
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To compare multiple fetus data on a worksheet

With multiple fetuses, you can list and compare measurements 
of the fetuses on the worksheet. 

Select Worksheet, then select Fetus Compare. 

Figure 9-12. OB Worksheet Display

When you select Fetus Compare, the system lists the 
measurement results for each fetus on the Worksheet.

Figure 9-13. Worksheet Display with Fetus Compare
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To Show Fetal Trending for Multiple Fetuses 

When you have data for more than one exam, you can show 
fetal trending and compare fetuses on one graph. 

To view fetal trending for multiple fetuses: 

1. Select Graph.

2. Select Fetus Compare. 

3. Select Plot Both.

NOTE: You can only view fetal trending for multiple fetuses in single 
graph display.

The symbol key for fetal trending and multiple fetuses is shown 
at the bottom of the graph.
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OB Table Editor

You can add user programmable OB tables to the system.

OB Table Settings Menu

You add OB Tables in the Measurement & Analysis menu. To 
open the menu:

1. Enter Utility -> Measure, then select M&A.

2. Check the Exam Category on the far left of the monitor 
screen. Make sure that Obstetrics is selected.

If it is not selected, select Obstetrics and continue selecting 
the folders until the appropriate area is selected as to where 
this new OB Table will be entered. For example, select 
Obstetrics, then select OB-2/3. If there are further folders 
within OB-2/3, select that appropriate folder.

3. On the monitor display, select the OB Table tab.

The system displays the OB Table settings menu. 

Figure 9-14. OB Table settings
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OB Table Settings Menu  (continued)

4. The OB Table settings menu lists OB Table parameters. 
Specify the following parameter values as appropriate:

• Study: Shows the study to which this measurement 
table belongs.

• New/Edit: To create a new OB table, select New Table. 
To edit an existing user-programmable OB table, select 
Edit Table.

NOTE: You cannot edit the system’s OB Tables.

• OB Table Template: To create a new OB table, select 
the Template (1 - 7) which you want to use as the basis 
of the user programmable OB Table. See ‘OB Table 
Templates’ on page 9-38 for more information.

To edit an existing user OB table, select the desired OB 
table to edit.

• Tool Type: Select the type of measurement: Distance, 
Circumference or weight.

• Measure Name: Type the name of measurement that 
will display on the menu.

• Author Name: Type the author’s name.

• Table Type: If necessary, select the Table Type: Fetal 
Age or Fetal Growth.

• Measure Type: Select a measurement type that can be 
used to calculate EFW, for example BPD. 

NOTE: Measure Type is used only when calculating EFW.

NOTE: The following items are display only: Table Format, Table 
Unit, SD/GP Range, and Graph Range. The system 
determines these values automatically, based on the type of 
OB table you are creating.

5. After specifying all parameter values, move the Trackball to 
Edit Table and press Set.

The system displays the Edit Menu.

NOTE: If any of the OB table parameters are not correct, the Edit 
Menu is not displayed.
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OB Table Templates

Tool Type:

• Distance: 2D Caliper

• Circumference: 2D Ellipse, 2D Trace, 2D Caliper

• Weight

Template 1

Table 9-3:  Template 1 (based on Hadlock)

Template 1: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Week Week

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

Min [#w#d]

Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Week mm Week

Others are same as above
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Template 2

Table 9-4:  Template 2 (based on Tokyo)

Template 2: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day Day

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: day(+/-)

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm Day

Others are same as above
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Template 3

Table 9-5:  Template 3 (based on Osaka)

Template 3: SD Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm Day mm

Table Range 1SD

Graph Range 1SD

Measurement Result Value [cm]

GA [#w#d]

SD: sd=(mv-pv)/sd

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit Day mm mm

Others are same as above
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Template 4

Table 9-6:  Template 4 (based on several European tables)

Template 4: 5%-95% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 5%:95%

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit 
Growth Table, GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 5%:95%

Graph Range 5%:95%
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Template 5

Table 9-7:  Template 5 (based on several European tables)

Template 5: 5% - 95% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 5%:95%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 
GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 5%:95%
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Template 6

Table 9-8:  Template 6 (based on several European tables)

Template 6: 10% - 90% Table

Fetal Age Table Table Format MEAS MIN MEAN MAX

Table Unit mm WeekDay WeekDay WeekDay

Table Range 10%-90%

Graph Range 10%-90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]
GP is calculated by Fetal Growth Table. If you did not edit Growth Table, GP is 
not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MIN MEAN MAX

Table Unit WeekDay mm mm mm

Table Range 10%-90%

Graph Range 10%-90%
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Template 7

Table 9-9:  Template 7 (Based on several european tables)

Template 7: 10% - 90% Table

Fetal Age Table Table Format MEAS MEAN SD

Table Unit mm WeekDay mm

Table Range 1SD

Graph Range 10%:90%

Measurement Result Value [cm]

GA [#w#d]

GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table, 
GP is not calculated by the system,

EDD (Date)

GA-Min [#w#d]

GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD

Table Unit WeekDay mm mm

Table Range 1SD

Graph Range 10%:90%
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OB Table Edit Menu

The data you enter in the OB Table Edit Menu depends on 
whether the table type is Fetal Age or Fetal Growth.

Fetal Age Table

If you are creating or editing a Fetal Age table, the OB Table Edit 
Menu is as follows:

Figure 9-15. OB Table Edit Menu: Fetal Age Table

Complete the field

1. Input value to Min, Max and Interval of the Parameters field. 

The system automatically fills in the MEAS column.

Input value to the columns of MEAN and SD.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want cancel this table, move the 
Trackball to move to Cancel and press Set.
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Fetal Growth Table

If you are creating or editing a Fetal Growth table, the OB Table 
Edit Menu is as follows:

Figure 9-16. OB Table Edit Menu: Fetal Growth Table 

Complete the field

1. Input value to the required columns.

NOTE: To move between the fields in the table, use the up, down, 
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines 
with a blank cell are not saved. 

2. To save the Table Data, move the Trackball to Exit to Save 
and press Set. If you want to cancel this table, move the 
Trackball to Cancel and press Set.

After you complete the OB table, it is now available for the 
selected study. To use the measurement, you must assign it to a 
menu.   See ‘Measurement and Calculation Setup’ on page 7-11 
for more information.
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EFW for OB User Table/Formula Editor

EFW Table Editor

You can edit an EFW Formula at the OB Table Editor. 

1. Select Utility -> Measure -> OB Table.

2. Select the appropriate parameters and press Edit Table.

• New/Edit: Select “New Table”

• OB Table Template: Select appropriate template.

• Tool Type: Select “Weight”

• Measure Name: Enter measurement name.

• Author Name: Enter author’s name.

• Table Type: Select “Fetal Age”

Figure 9-17. OB Table Tab Screen
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EFW Table Editor  (continued)

3. Edit the table data and press Exit To Save.

Figure 9-18. OB Table Editor Screen
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EFW Formula Editor

1. Select the M&A tab and select Edit Calc. The Modify User 
CALC window displays.

Select the user table previously added from the User 
Defined pull-down menu and press OK.

Figure 9-19. Modify User CALC window

2. Double click the Calculated button for the EFW parameter.

Figure 9-20. M&A Tab Screen
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EFW Formula Editor  (continued)

3. The EDIT FORMULA window displays. Edit the formula and 
select OK.

Figure 9-21. EDIT FORMULA window

NOTE: When you edit a formula, be careful of the following points.

• If you want to calculate EFW by centimeter, add “*100” to 
the {parameter}.

• If EFW is calculated in grams, add “/1000“ to the formula.

or example,

10^(1.56{AC[Hadlock]}*100+0.08*{FL[Hadlock]}*100)/1000
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GYN Measurements

Introduction

The Gynecology exam category includes the following three 
studies:

• Generic. This study is common to all exam categories. See 
‘Generic Measurements’ on page 7-59 for more information. 

• General Gynecology. This study includes uterine, ovarian, 
ovarian follicle, and endometrium measurements.

• OB/GYN Vessel. This study includes the following vessels: 
uterine, ovarian, umbilical, middle cerebral artery, aorta, 
placenta, and descending aorta.

NOTE: The calculation formulas are listed in the Advanced Reference 
Manual.
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To Start a Gynecology Exam

To begin a gynecology exam, you enter patient data or, if the 
patient data from a previous exam is saved in the system, find 
the patient information. 

For details about how to start an exam, See ‘Beginning an 
Exam’ on page 4-2 for more information.

After you complete the patient information, select GYN category 
and related exam, you can begin the scan. 

1. To change from the Patient screen to the Scan screen, do 
one of the following:

• Select Scan.

• On the Control Panel, select Freeze.

• On the Control Panel, press the B-Mode key.

The system displays the Scan screen.

2. On the Control Panel, press Measure.

The default Gynecology study is displayed on the menu. 

Table 9-10:  Obstetric fields

Field Description

LMP Last Menstrual Period; enter the date that the patient started her last menstrual 
period. 
You must enter 4 digits for the year. When you type the month and day, the 
system fills in the /. The Date Format preset chosen in Utilty -> System -> 
General determines the required format.  

Gravida Number of pregnancies.

Para Number of births.

AB Number of abortions.

Ectopic Number of ectopic pregnancies.
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B-Mode Measurements

In B-Mode, you make the measurements in the General 
Gynecology study. These measurements include: 

• Uterine length, width, and height 

• Ovarian length, width, and height

• Ovarian follicle

• Cervix

• Endometrium thickness

Figure 9-22. General Gynecology study
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Follicle measurements

You can make left and right ovary follicle measurements from 
one, two, or three distances. 

One distance

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. Make one distance measurement.

The system displays the ovary follicle measurement in the 
Results Window.

Two distances

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. Make two distance measurements.

The system displays the ovary follicle measurement in the 
Results Window.

Three distances

1. To select the left or right, adjust the Side selection.

2. Select Follicle; an active caliper displays.

3. Make three distance measurements.

After the third measurement, the system displays the ovary 
follicle measurement in the Results Window.

Endometrium thickness

To measure the endometrium thickness, make one distance 
measurement.

1. Select Endometrium; an active caliper displays.

2. Make one distance measurement.

The system displays the endometrium thickness in the 
Results Window.
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Ovary length, width, and height 

You can measure the length, width, and height of the left and 
right ovaries. Each measurement is a typical distance 
measurement made in the appropriate scan plane. 

Typically, length and height are measured on the sagittal plane 
while the width is measured on the axial/transverse plane.

To measure ovarian length, width, or height:

1. Scan the patient's right or left ovary in the appropriate plane.

2. To select left or right, adjust the Side selection.

3. Select the OV folder, then select OV L, OV W, or OV H. 

4. Perform a standard distance measurement: 

5. Make the second and third distance measurements. 

After you complete the length, width, and height 
measurements, the system displays the ovarian volume in 
the Results Window.

Uterus length, width, and height

Each of these is a standard distance measurement. Typically, 
length and height are measured on the sagittal plane while the 
width is measured on the axial/transverse plane.

To measure uterus length, width, or height:

1. Scan the patient in the appropriate scan plane. 

2. Select the UT folder, then select UT L, UT W, or UT H. 

An active caliper displays.

3. Perform a standard distance measurement: 

4. Make the second and third distance measurements. 

After you complete the third distance measurement, the 
system displays the uterine volume in the Results Window.

Cervix measurements

You can make cervix measurements from one distance or spline 
trace. 

One Distance 1. Select CX; an active caliper displays.

2. Make one distance measurement.

3. The system displays the cervix measurement in the Result 
Window.

Spline Trace 1. Select CX Trace; an active caliper displays.

2. Make a spline trace measurement.

3. The system displays the cervix measurement in the Result 
Window.
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M-Mode Measurements

M-Mode measurements for the Gynecology exam are identical 
to M-Mode measurements for the Obstetrics exam. These 
measurements include % stenosis, A/B ratio, and heart rate.

For details regarding these measurements, See ‘M-Mode 
Measurements’ on page 9-15 for more information.

Figure 9-23. M-Mode Generic study
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Doppler Mode Measurements

Doppler measurements for the Gynecology exam are identical 
to Doppler measurements for the Obstetrics exam. These 
measurements include the following vessels: uterine, ovarian, 
umbilical, middle cerebral artery, aorta, placenta, and 
descending aorta. For each vessel, you can make any of the 
following measurements: peak systole, minimum diastole, end 
diastole, heart rate, TAMAX, pulsatility index, resistive index, 
acceleration, PS/ED, ED/PS, and acceleration time.

For details regarding these measurements, See ‘Doppler Mode 
Measurements’ on page 9-16 for more information.

Figure 9-24. Doppler Mode General Gynecology study
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Chapter 10

Cardiology

Describes how to perform cardiac measurements and 
calculations.
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Cardiology Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See ‘Scanning a New Patient’ on page 4-9 for more 
information.

Any measurement can be repeated by selecting that 
measurement again from the menu.
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Cardiology Measurements

Overview

Cardiology measurements offer two different types of 
measurement studies, Generic and Cardiac. 

Figure 10-1. Cardiac Exam Calc

• Generic – Each exam category has a Generic study. The 
Generic studies provide you quick access to measurements.

• Cardiac – This study includes all cardiac measurements. 
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Naming Format for Cardiac Measurements

When you make a measurement, you select the abbreviation for 
the measurement on the menu. Most abbreviations are made 
using acronyms. The following table lists acronyms used for 
naming cardiac measurements. 

Table 10-1:  Cardiology Abbreviations

Acronym Name

% STIVS % Interventricular Shortening

A Area

Acc Acceleration

AccT Flow Acceleration Time

ALS Aortic Leaflet Separation

Ann Annulus

Ao Aorta

AR Aortic Regurg

Asc Ascending

ASD Atrial Septal Defect

AV Aortic Valve

AV Cusp Aortic Valve Cusp Separation

AVA Aortic Valve Area

AV-A Aortic Valve Area by Continuity Equation

BSA Body Surface Area 

CI Cardiac Index

CO Cardiac Output

d Diastolic

D Diameter

Dec Deceleration

DecT Deceleration Time

Desc Descending

Dur Duration

EdV End Diastolic Volume

EF Ejection Fraction

EPSS E-Point-to-Septum Separation
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EsV End Systolic Volume 

ET Ejection Time

FS Fractional Shortening

FV Flow Volume

FVI Flow Velocity Integral

HR Heart Rate

IVRT IsoVolumetric Relaxation Time

IVS Interventricular Septum

L Length

LA Left Atrium

LAA Left Atrium Area

LAD Left Atrium Diameter

LPA Left Pulmonary Artery

LV Left Ventricle

LVA Left Ventricular Area

LVID Left Ventricle Internal Diameter

LVL Left Ventricle Length

LVM Left Ventricular Mass

LVPW Left Ventricle Posterior Wall

ML Medial to Lateral

MPA Main Pulmonary Artery

MR Mitral Regurgitation

MV Mitral Valve

MVcf Mean Velocity Circumferential Fiber Shortening

MVO Mitral Valve Orifice

OT Outflow Tract

P Papillary Muscles

PA Pulmonary Artery

PAP Pulmonary Artery Pressure

PDA Patent Ductus Arterosis

Table 10-1:  Cardiology Abbreviations

Acronym Name
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PEP Pre-Ejection Period

PFO Patent Foramen Ovale

PG Pressure Gradient 

PHT Pressure Half Time

PI Pulmonary Insufficiency

PISA Proximal Isovelocity Surface Area

PR Pulmonic Regurgitation

PV Pulmonic Valve

PV-A Pulmonic Valve Area by Continuity Equation

PVein Pulmonary Vein

PW Posterior Wall

Qp Pulmonic Flow or CO

Qs Systemic Flow or CO

RA Right Atrium

RAA Right Atrium Area

Rad Radius

RAD Right Atrium Diameter

RPA Right Pulmonary Artery

RV Right Ventricle

RVA Right Ventricle Area

RVAW RIght Ventricle Anterior Wall

RVD Right Ventricle Diameter

RVID Right Ventricle Internal Diameter

RVL Right Ventricle LEngth

RVOT Right Ventricle Outflow Tract

s Systolic

SI Stroke Index

ST Shortening

SV Stroke Volume

SVI Stroke Volume Index

Table 10-1:  Cardiology Abbreviations

Acronym Name
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In this manual, the abbreviation for each measurement is listed 
in parenthesis after the measurement, as follows:

• Aortic Root Diameter (Ao Diam)

• Left Ventricle Posterior Wall Thickness, Diastolic (LVPWd)

For example, to measure the Aortic Root Diameter, you select 
Ao Diam.

T Time

TA Tricuspid Annulus

TAML Tricuspid Annulus Medial to Lateral

TR Tricuspid Regurgitation

TV Tricuspid Valve

TVA Tricuspid Valve Area

Vcf Velocity Circumferential Fiber Shortening

Vel Velocity

VET Valve Ejection Time

Vmax Maximum Velocity

Vmean Mean Velocity

VSD Ventricular Septal Defect

VTI Velocity Time Integral

Table 10-1:  Cardiology Abbreviations

Acronym Name
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Cardiac Measurements

This section lists cardiac measurements and the steps to 
perform them. The measurement information in this section is 
organized by mode, then by region of interest, and then by type 
of measurement. The organization is as follows:

• Mode; there is a section for B-Mode, M-Mode, Color Flow 
Mode, and Doppler Mode. There is also a Combination 
Mode section, which includes calculations that are a result 
of measurements made in more than one mode.

• Within each mode section, there are sections for region of 
interest, such as aorta or mitral valve.

• Within each region of interest section, there are sections for 
type of measurement, such a one distance, two distance, 
trace, or velocity flow trace. Each measurement type section 
lists all cardiac measurements that are that type, and then 
describes the steps to perform that type of measurement.

Some measurements, such as Aortic Root Diameter or Aortic 
Valve Cusp Separation, can be made in B-Mode or M-Mode. 
The information for these measurements is included in both 
B-Mode and M-Mode sections.

NOTE: You can select the diastole frame/systole frame (ED/ES or ES/
ED) with the assigned control.
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Steps to perform a measurement

Making a one distance measurement

1. Select the measurement; an active caliper displays.

2. To position the active caliper at the start point, move the 
Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second active caliper at the end point, move 
the Trackball.

A dotted line connects the measurement points.

5. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.

Making two distance measurements

1. Select the measurement; an active caliper displays.

2. Make the first distance measurement:

a. To position the active caliper at the start point, move the 
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

c. To position the second active caliper at the end point, 
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.

The system displays the distance value in the Results 
Window. After the first measurement, the system 
displays an active caliper.

3. To make the second distance measurement, repeat steps 
a–d above.

The system displays the measurements and ratio in the 
Results Window.
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Steps to perform a measurement  (continued)

Making a trace measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the trace start point, press Set.

The system displays a vertical dotted line.

4. To trace the measurement area, move the Trackball.

A line shows the traced area.

5. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.

Making a slope measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

A dotted line shows the slope.

5. To complete the measurement, press Set. 

The system displays the slope measurement in the Results 
Window.

Making a time interval measurement

1. Select the measurement.

The system displays an active caliper and a vertical dotted 
line. 

2. To position the caliper at the start point, move the Trackball.

3. To fix the first caliper, press Set.

The system displays a second active caliper.

4. To position the caliper at the end point, move the Trackball.

5. To complete the measurement, press Set.

The system displays the time interval in the Results 
Window.
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Steps to perform a measurement  (continued)

Making a velocity flow trace measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the trace start point, press Set.

The system displays a vertical dotted line.

4. To trace the envelope, move the Trackball.

A line shows the traced area.

5. To complete the trace, press Set.

The system displays a second vertical dotted line.

6. To position the second dotted line at the start of the next 
envelope, move the Trackball.

7. To complete the measurement, press Set.

The system displays the measurement in the Results 
Window.

Making a peak velocity measurement

1. Select the measurement; an active caliper with a vertical 
dotted line displays.

2. To position the caliper at the desired measurement point, 
move the Trackball.

3. To complete the measurement, press Set. 

The system displays the velocity measurement in the 
Results Window.

Making a time interval/slope measurement

1. Select the measurement; an active caliper displays.

2. To position the caliper at the start point, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second 
active caliper.

4. To position the second caliper at the end point, move the 
Trackball.

A dotted line shows the slope.

5. To complete the measurement, press Set. 

The system displays the time interval and slope 
measurements in the Results Window.
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B-Mode Measurements
Aorta

One distance measurement

• Aortic Root Diameter (AO Diam)

• Aortic Arch Diameter (AO Arch Diam)

• Ascending Aortic Diameter (Ao Asc Diam)

• Ascending Aortic Diameter (Ao Asc Diam)

• Aorta Annulus Diameter (Ao Annulus Diam)

• Aorta Isthmus (Ao Isthmus)

• Aorta ST Junction (Ao st junct)

Aortic Valve

One distance measurement

• Aortic Diameter (Ao Diam)

• Aortic Valve Cusp Separation (AV Cusp)

• Aortic Valve Diameter (AV Diam)

One trace measurement

• Aortic Valve Area Planimetry (AVA Planimetry)

• Transverse Aortic Valve Area (Trans AVA (d), Trans AVA 
(s)) 

Left Atrium

Two distance measurements

• Left Atrium Diameter to AO Root Diameter Ratio (LA/AO 
Ratio)

One distance measurement

• Left Atrium Diameter (LA Diam)

• Left Atrium Length (LA Major)

• Left Atrium Width (LA Minor)

One trace measurement

• Left Atrium Area

• Diastolic (LAA (d)) 

• Systolic (LAA (s))

One trace measurement and one distance measurement

• Left Atrium Volume, Single Plane, Method of Disk 

• Diastolic (LAEDV A2C) (LAEDV A4C)

• Systolic (LAESV A2C) (LAESV A4C)
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Left Ventricle

NOTE: The user can select the Straight/Line (polygonal line) with the LV 
study tool. Adjust the appropriate control on the touch panel to 
make the selection.

One distance measurements

• Left Ventricle Mass Index 

• Diastolic (LVPWd)

• Systolic (LVPWs)

• Left Ventricle Volume, Teichholz

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Volume, Cubic

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Internal Diameter

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Length

• Diastolic (LVLd)

• Systolic (LVLs)

• Left Ventricle Outflow Tract Diameter (LVOT Diam)

• Left Ventricle Posterior Wall Thickness

• Diastolic (LVPWd)

• Systolic (LVPWs)

• Left Ventricle Length (LV Major)

• Left Ventricle Width (LV Minor)
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Left Ventricle  (continued)

One trace measurements

• Left Ventricle Outflow Tract Area (LVOT Diam)

• Left Ventricle Area, Two Chamber

• Diastolic (LVA (d))

• Systolic (LVA (s))

• Left Ventricle Area, Four Chamber

• Diastolic (LVA (d))

• Systolic (LVA (s))

• Left Ventricle Area, Short Axis

• Diastolic (LVA (d))

• Systolic (LVA (s))

• Left Ventricle Endocardial Area, Width (LVA (d))

• Left Ventricle Epicardial Area, Length 

• Diastolic (LVAepi (d))

• Systolic (LVAepi (s))

One time interval measurements

• Heart Rate, Teichholz 

• Heart Rate for Two Chamber study

• Heart Rate for Four Chamber study

• Heart Rate for Two Chamber Area-Length study

• Heart Rate for Two Chamber Method of Disk study

• Heart Rate for Four Chamber Area-Length study

• Heart Rate for Four Chamber Method of Disk study

• Heart Rate for Bi-Plane Method of Disk study
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Left Ventricle  (continued)

Two distance measurements 

• Ejection Fraction, Teichholz (LVIDs)

• Ejection Fraction, Cubic (LVIDs)

• Left Ventricle Posterior Wall Fractional Shortening (LVPWs)

• Left Ventricle Stroke Index, Teichholz (LVIDs, and Body 
Surface Area)

• Left Ventricle Fractional Shortening (LVIDs)

• Left Ventricle Stroke Volume, Teichholz (LVIDs)

• Left Ventricle Stroke Volume, Cubic (LVIDs)

Body surface area and stroke volume measurements

• Left Ventricle Stroke Index, Single Plane, Two Chamber, 
Method of Disk (LVIDd, LVIDs)

• Left Ventricle Stroke Index, Single Plane, Four Chamber, 
Method of Disk (LVIDd, LVIDs)

• Left Ventricle Stroke Index, Bi-Plane, Bullet 

• Left Ventricle Stroke Index, Bi-Plane, Method of Disk (LVAd, 
LVAs)

The system calculates body surface area from the patient’s 
height and weight.

Left Ventricle Study

• Diastolic (LVd)

• Systolic (LVs)

The Left Ventricle study automatically sequences the 
following measurements:

• Interventricular Septum (IVSd, IVSs) 

• Left Ventricle Internal Diameter (LVIDs, LVIDd)

• Left Ventricle Posterior Wall Thickness (LVPWs, 
LVPWd)
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Mitral Valve

One distance measurements

• Mitral Valve Annulus Diameter (MV Ann Diam)

• E-Point-to-Septum Separation (EPSS)

One trace measurement

• Mitral Valve Area by Pressure Half Time (MVA By PHT)

• Mitral Valve Area Planimetry (MVA Planimetry)

Pulmonic Valve

One distance measurement

• Pulmonic Valve Annulus Diameter (PV Ann Diam)

• Pulmonic Diameter (Pulmonic Diam)

Right Atrium

One distance measurement

• Right Atrium Diameter, Length (RA Major)

• Right Atrium Diameter, Width (RA Minor)

One trace measurements

• Right Atrium Area (RA Area)

• Right Atrium Volume, SIngle Plane, Method of Disk (RAAd)

• Right Atrium Volume, Systolic, SIngle Plane, Method of Disk 
(RAAs)
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Right Ventricle

One trace measurement

• Left Pulmonary Artery Area (LPA Area)

• Right Pulmonary Artery Area (RPA Area)

One distance measurements
• Right Ventricle Internal Diameter

• Diastolic (RVIDd)

• Systolic (RVIDs)

• Right Ventricle Diameter, Length (RV Major)

• Right Ventricle Diameter, Width (RV Minor)

• Right Ventricle Wall Thickness

• Diastolic (RVAWd)

• Systolic (RVAWs)

• Right Ventricle Outflow Tract Diameter (RVOT Diam)

• Left Pulmonary Artery (LPA)

• Main Pulmonary Artery (MPA)

• Right Pulmonary Artery (RPA)

System
One distance measurements

• Interventricular Septum Thickness

• Diastolic (IVSd)

• Systolic (IVSs)

• Inferior Vena Cava (IVC)

• Main Pulmonary Artery Diameter (MPA Diam)

• Systemic Vein Diameter (Systemic Diam)

• Patent Ductus Arterosis Diameter (PDA Diam)

• Patent Foramen Ovale Diameter (PFO Diam) 

• Pericardial Effusion Diastole (PEd)

• Ventricular Septal Defect Diameter (VSD Diam)

• Atrial Septal Defect Diameter (ASD Diam)

Body surface area and stroke volume measurements

• Interventricular Septum (IVS) Fractional Shortening (IVSs)

The system calculates body surface area from the patient’s 
height and weight.

Tricuspid Valve

One distance measurements

• Tricuspid Valve Annulus Diameter (TV Ann Diam)

• Tricuspid Valve Area (TV Area)



Cardiology

10-18 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

M-Mode Measurements
Aorta

One distance measurement

• Aortic Root Diameter (AO Root Diam)

Aortic Valve

One distance measurements

• Aortic Valve Cusp Separation (AV Cusp)

Left Atrium

One distance measurement

• Left Atrium Diameter (LA Diam)

Two distance measurement (ratio)

• Left Atrium Diameter to AO Root Diameter Ratio (LA/AO)
Left Ventricle

One distance measurements

• Left Ventricle Volume, Teichholz 

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Volume, Cubic

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Internal Diameter

• Diastolic (LVIDd)

• Systolic (LVIDs)

• Left Ventricle Posterior Wall Thickness

• Diastolic (LVPWd)

• Systolic (LVPWs)

One time interval measurement

• Heart Rate, (R-R)

• Left Ventricle Ejection Time (LVET)

• Left Ventricle Pre-Ejection Period (LVPEP)

• Velocity Circumferential Fiber Shortening (Vcf)

Left Ventricle Study

The Left Ventricle study (LV Study) automatically sequences 
the following measurements:

• Interventricular Septum (IVSd, IVSs) 

• Left Ventricle Internal Diameter (LVIDd, LVIDs)

• Left Ventricle Posterior Wall Thickness (LVPWd, LVPWs)
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Mitral Valve

One distance measurements

• E-Point-to-Septum Separation (EPSS)

One slope measurements

• Mitral Valve Anterior Leaflet Excursion (D-E Excursion)

• Mitral Valve D-E Slope (D-E Slope)

• Mitral Valve E-F Slope (E-F Slope)

Right Ventricle

One distance measurements

• Right Ventricle Internal Diameter

• Diastolic (RVIDd)

• Systolic (RVIDs)

• Right Ventricle Wall Thickness

• Diastolic (RVAWd)

• Systolic (RVAWs)

One time interval measurements

• Right Ventricle Ejection Time (RVET)

• Right Ventricle Pre-Ejection Period (RVPEP)

Right Ventricle Study

The Right Ventricle study (RV study) automatically sequences 
the following measurements:

• Right Ventricle Internal Diameter (RVIDd, RVIDs))
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Pulmonic Valve

One time interval measurements

• QRS complex to end of envelope (Q-to-PV close)

System

One distance measurements

• Interventricular Septum

• Diastolic (IVSd)

• Systolic (IVSs)

Two distance measurement:

• Interventricular Septum (IVS) Fractional Shortening (LVD - 
LVS / LVD x 100)

Tricuspid Valve

One time interval measurements

• QRS complex to end of envelope (Q-to-TV close)
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Doppler Mode Measurements

Aortic Valve

Velocity flow trace measurements

• Aortic Insufficiency Mean Pressure Gradient (AI Trace)

• Aortic Insufficiency Peak Pressure Gradient (AI Vmax)

• Aortic Insufficiency Mean Velocity (AI Trace)

• Aortic Insufficiency Mean Square Root Velocity (AI Trace)

• Aortic Insufficiency Velocity Time Integral (AI Trace)

• Aortic Valve Mean Velocity (AV Trace)

• Aortic Valve Mean Square Root Velocity (AV Trace)

• Aortic Valve Velocity Time Integral (AV Trace)

• Aortic Valve Mean Pressure Gradient (AV Trace)

One peak velocity measurements

• Aortic Valve Peak Pressure Gradient (AR Vmax)

• Aortic Insufficiency Peak Velocity (AR Vmax/AI Vmax)

• Aortic Insufficiency End-Diastolic Velocity (ARend Vmax/ 
AIend Vmax)

• Aortic Valve Peak Velocity (AV Vmax)

• Aortic Valve Peak Velocity at Point E (AV Vmax)

• Aorta Proximal Coarctation (Coarc Pre-Duct)

• Aorta Distal Coarctation (Coarc Post-Duct)

One slope measurements

• Aortic Valve Insufficiency Pressure Half Time (AR PHT)

• Aortic Valve Flow Acceleration (AV Trace)

• Aortic Valve Pressure Half Time (AV Trace)
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Aortic Valve  (continued)

One time interval measurements

• Aortic Valve Acceleration Time (AV AccT)

• Aortic Valve Deceleration TIme (AI PHT)

• Aortic Valve Ejection Time (AVET)

• Aortic Valve Heart Rate 

• Time

Two time interval measurement

Slope through aortic valve trace:

• Aortic Valve Acceleration to Ejection Time Ratio (AVET)

• Aortic Valve Area according to PHT 
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Left Ventricle

One peak velocity measurements

• Left Ventricle Outflow Tract Peak Pressure Gradient (LVOT 
maxPG)

• Left Ventricle Outflow Tract Peak Velocity (LVOT Vmax)

One velocity flow trace measurements

• Left Ventricle Outflow Tract Mean Pressure Gradient (LVOT 
Trace)

• Left Ventricle Outflow Tract Mean Velocity (LVOT Trace)

• Left Ventricle Outflow Tract Mean Square Root Velocity 
(LVOT Trace)

• Left Ventricle Outflow Tract Velocity Time Integral (LVOT 
Trace)

One time interval measurements

• Left Ventricle Heart Rate (LVOT Trace)

• Left Ventricle Ejection Time (LVET)
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Mitral Valve
NOTE: When measuring the MV E/A velocity, Auto/Manual trace can be 

modified with the appropriate touch panel control.

One velocity flow trace measurements

• Mitral Valve Regurgitant Flow Acceleration (MV Trace)
• Mitral Valve Regurgitant Mean Velocity (MV Trace)
• Mitral Regurgitant Mean Square Root Velocity (MR Trace)
• Mitral Regurgitant Mean Pressure Gradient (MR Trace)
• Mitral Regurgitant Velocity Time Integral (MR Trace)
• Mitral Valve Mean Velocity (MV Trace)
• Mitral Valve Mean Square Root Velocity (MV Trace)
• Mitral Valve Velocity Time Integral (MV Trace)
• Mitral Valve Mean Pressure Gradient (MV Trace)

One peak velocity measurements

• Mitral Regurgitant Peak Pressure Gradient (MR Vmax)
• Mitral Valve Peak Pressure Gradient (MV Vmax)
• Mitral Regurgitant Peak Velocity (MR Vmax)
• Mitral Valve Peak Velocity (MV Vmax)
• Mitral Valve Velocity Peak A (MV A Velocity)
• Mitral Valve Velocity Peak E (MV E Velocity)

One slope measurements

• Mitral Valve Area according to PHT (MV PHT)
• Mitral Valve Flow Deceleration (MV DecT)
• Mitral Valve Pressure Half Time (MV PHT)
• Mitral Valve Flow Acceleration (MV AccT)

Two distance measurement

• Mitral Valve E-Peak to A-Peak Ratio (A-C and D-E) (MV E/A 
Ratio)

One time interval/slope measurements

• Mitral Valve Acceleration Time (MV AccT)

• Mitral Valve Deceleration Time (MV DecT)

One time interval measurement

• Mitral Valve Ejection Time (M VET)
• Mitral Valve A-Wave Duration (MV A Dur)
• Mitral Valve Time to Peak (MV TTP)
• Time

Two time interval measurement

Body surface area and stroke volume measurements:

• Stroke Volume Index by Mitral Flow (MV Trace)

The system calculates body surface area from the patient’s 
height and weight.

One distance and two velocity measurement:

• Mitral Valve Area from Continuity Equation (MV Vmax)
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Pulmonic Valve

One peak velocity measurements

• Pulmonic Insufficiency Peak Pressure Gradient (PI Vmax)

• Pulmonic Insufficiency End-Diastolic Pressure Gradient (PR 
Trace)

• Pulmonic Valve Peak Pressure Gradient (PV Vmax)

• Pulmonic End-Diastolic Pressure Gradient (PR Trace)

• Pulmonic Insufficiency Peak Velocity (PR Vmax)

• Pulmonic Insufficiency End-Diastolic Velocity (PRend 
Vmax)

• Pulmonic Valve Peak Velocity (PV Vmax)

• Pulmonic End-Diastolic Velocity (PV Trace)

One velocity flow trace measurements

• Pulmonary Artery Diastolic Pressure (PV Trace)

• Pulmonic Insufficiency Mean Pressure Gradient (PR Trace)

• Pulmonic Valve Mean Pressure Gradient (PV Trace)

• Pulmonic Insufficiency Mean Velocity (PR Trace)

• Pulmonic Insufficiency Mean Square Root Velocity (PR 
Trace)

• Pulmonic Insufficiency Velocity Time Integral (PR Trace)

• Pulmonic Valve Mean Velocity (PV Trace)

• Pulmonic Valve Mean Square Root Velocity (PV Trace)

• Pulmonic Valve Velocity Time Integral (PV Trace)

One slope measurements

• Pulmonic Insufficiency Pressure Half Time (PR PHT)

• Pulmonic Valve Flow Acceleration (PV AccT)

One time interval measurements

• Pulmonic Valve Acceleration Time (PV AccT)

• Pulmonic Valve Ejection Time (PVET)

• Pulmonic Valve Pre-Ejection Period (PVPEP)

• QRS complex to end of envelope (Q-to-PV close)

• Time

Two time intervals measurements

• Pulmonic Valve Acceleration to Ejection TIme Ratio (PV 
AccT, PVET)

• Pulmonic Valve Pre-Ejection to Ejection Time Ratio 
(PVPEP, PVET)
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Right Ventricle

One peak velocity measurements

• Right Ventricle Outflow Tract Peak Pressure Gradient 
(RVOT Vmax)

• Right Ventricle Systolic Pressure (RVOT Vmax)

• Right Ventricle Outflow Tract Peak Velocity (RVOT Vmax)

One velocity flow trace measurement

• Right Ventricle Diastolic Pressure (RVOT Trace)

• Right Ventricle Outflow Tract Velocity Time Integral (RVOT 
Trace)

One time interval measurement

• Right Ventricle Ejection Time (PVET)
System

One peak velocity measurements

• Pulmonary Artery Peak Velocity (PV Vmax)

• Pulmonary Vein Velocity Peak A (reverse) (P Vein A)

• Pulmonary Vein Peak Velocity 

• End-Diastolic (P Vein D)

• Systolic (P Vein S)

• Systemic Vein Peak Velocity 

• End-Diastolic (PDA Diastolic)

• Systolic (PDA Systolic)

• Ventricular Septal Defect Peak Velocity (VSD Vmax)

• Atrial Septal Defect Peak Velocity (ASD Vmax)

One velocity flow trace measurements

• Pulmonary Artery Velocity Time Integral (Pulmonic VTI)

• Systemic Vein Velocity Time Integral (Systemic VTI)

One time interval measurements

• Pulmonary Vein A-Wave Duration (P Vein A Dur)

• Time

• IsoVolumetric Relaxation Time (IVRT)

• IsoVolumetric Contraction Time (IVCT)

Two peak velocity measurements

• Pulmonary Vein S/D Ratio (P Vein D, P Vein S)

• Ventricular Septal Defect Peak Pressure Gradient (VSD 
maxPG)

Two velocity flow trace measurements:

• Pulmonic-to-Systemic Flow Ratio (Qp/Qs)



Cardiology Measurements

LOGIQ V2/LOGIQ V1 – Basic User Manual 10-27
Direction 5610735-100 English Rev. 2

Tricuspid Valve

One peak velocity measurements

• Tricuspid Regurgitant Peak Pressure Gradient (TR Vmax)

• Tricuspid Valve Peak Pressure Gradient (TV Vmax)

• Tricuspid Regurgitant Peak Velocity (TR Vmax)

• Tricuspid Valve Peak Velocity (TV Vmax)

• Tricuspid Valve Velocity Peak A (TV A Velocity)

• Tricuspid Valve Velocity Peak E (TV E Velocity)

One velocity flow trace measurements

• Tricuspid Regurgitant Mean Pressure Gradient (TR Trace)

• Tricuspid Regurgitant Mean Velocity (TR Trace)

• Tricuspid Regurgitant Mean Square Root Velocity (TR 
Trace)

• Tricuspid Regurgitant Velocity Time Integral (TR Trace)

• Tricuspid Valve Mean Pressure Gradient (TV Trace)

• Tricuspid Valve Mean Velocity (TV Trace)

• Tricuspid Valve Mean Square Root Velocity (TV Trace)

• Tricuspid Valve Velocity Time Integral (TV Trace)

One time interval measurements

• Tricuspid Valve Time to Peak (TV TTP)

• Tricuspid Valve Closure to Opening (TCO)

• Tricuspid Valve A-Wave Duration (TV A Dur)

• QRS complex to end of envelope (Q-to-TV close)

One slope measurements

• Tricuspid Valve Pressure Half Time (TV PHT)

One velocity flow trace and one area measurement

• Stroke Volume by Tricuspid Flow (TV SV)

Two peak velocity measurement

• Tricuspid Valve E-Peak to A-Peak Ratio (TV E/A Velocity)
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Color Flow Mode

Aortic Valve

One distance measurements

• Proximal Isovelocity Surface Area: Regurgitant Orifice Area 
(PISA AR)

• Proximal Isovelocity Surface Area: Radius of Aliased Point 
(PISA AR)

One velocity flow trace measurements

• Proximal Isovelocity Surface Area: Regurgitant Flow (PISA 
AR)

• Proximal Isovelocity Surface Area: Regurgitant Volume Flow 
(PISA AR)

One peak velocity measurement

• Proximal Isovelocity Surface Area: Aliased Velocity (PISA 
AR)

Mitral Valve

One distance measurements

• Proximal Isovelocity Surface Area: Regurgitant Orifice Area 
(PISA MR)

• Proximal Isovelocity Surface Area: Radius of Aliased Point 
(PISA MR)

One velocity flow trace measurements

• Proximal Isovelocity Surface Area: Regurgitant Flow (PISA 
MR)

One peak velocity measurement

• Proximal Isovelocity Surface Area: Aliased Velocity (PISA 
MR)
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Cardiac Worksheet

After you make cardiac measurements, you can review all the 
data on the cardiac worksheet. To view the worksheet, select the 
Worksheet on the control panel.

The cardiac worksheet has a heading for each mode, and for 
each folder.

Figure 10-2. Cardiac Worksheet: Page 1

If a worksheet has more data on a second page, to view the next 
page, select Page Change.

To return to scanning, select the Worksheet or select Exit or 
press Esc on the keyboard.
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Worksheet information

The information on the cardiac worksheet is as follows:

• Parameter – This column lists the mode, the measurement 
folder, and the specific measurement.

• Value – The measured value. If more than one 
measurement was made for an item, the system uses the 
specified method (average, maximum, minimum, or last) to 
determine this value.

• m1-mN - All measurement values for each item. If you make 
more than six measurements, the worksheet has a scroll bar 
to show all values (cardiac worksheet only).

• Method – When there is more than one measurement for an 
item, this specifies the method used to calculate the 
measurement value listed in the Value column. Choices are 
average, maximum, minimum, or last. To change the 
method: 

a. Move the Trackball to the Method field. 

b. Press Set.

c. Move the Trackball to select from the list.

d. Press Set.

For more information about working with worksheets, see 
‘Viewing and Editing Worksheets’ on page 7-55 for more 
information.

Setting up and Organizing Measurements and Calculations

When you receive your LOGIQ V2/LOGIQ V1 system, the 
studies and measurements are organized for typical work flows. 
If you want, you can change this set up. You can change 
studies, create studies, and specify which measurements and 
calculations are in each study. You can change the 
measurements that are available on the measurement summary 
window. The LOGIQ V2/LOGIQ V1 allows you to quickly and 
easily set up your system so that you can work most efficiently. 

For information about how to customize studies and 
measurements, see ‘Measurement and Calculation Setup’ on 
page 7-11 for more information.

When you make cardiac measurements, the results you see in 
the Results Window and the Worksheet can vary, depending on 
what you have set up in the Utility screens. 
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Generic Study

The Cardiology B Mode Generic exam category includes the 
following measurements:

• Area (Trace)

• Volume

• Volume (d)

• Volume (s)

• Dist (Distance) Ratio

• Area Ratio

• R-R

The Cardiology M Mode Generic exam category includes the 
following measurements:

• LV Study

• LA/Ao

• RV Study

• D-E Excursion

• Slope Caliper

• Caliper

• Time

• HR

• Dd/Ds Study

The Cardiology Doppler Mode Generic exam category includes 
the following measurements: 

• Point

• Manual Trace

• MV E/A Ratio

• PHT

• Time

• HR

• Tei Index
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Cardiac Doppler Measurements

Cardiac Output (CO)

To measure CO (Cardiac Output), make a velocity measurement 
in the Doppler Spectrum. A FCA (Flow Cross-Sectional Area) is 
measured on the vessel in B-Mode. These two measurements 
are used to calculate SV (Stroke Volume). Finally, a HR (Heart 
Rate) measurement is taken in the Doppler Spectrum. SV and 
HR are then used to calculate cardiac output. Below take LVOT 
CO measurement for example.

1. Measure LVOT Diam in B Mode.

2. Measure LVOT Trace and the Heart Rate in doppler mode.

CO (Cardiac Output) is computed from the SV and HR 
values and is displayed.

E/e’ Ratio

The ratio of early transmitral velocity to early diastolic velocity of 
the mitral annulus (E/e’) is measured in Doppler Mode and TVD 
mode.

1. First, measure MV E/A Velocity to get “E”.

2. Measure e’.

NOTE: The system displays “e” in place of “e’” on the menu.

3. The system calculates E/e’ ratio automatically.

Tei Index

The Tei Index, (ICT+ IRT)/ET, is calculated as (A-B)/B.

To calculate the Tei Index:

1. Select Tei Index on measurement summary window when 
Generic study is select in Second Menu

2. Measure A, A= ICT + IRT + ET

3. Measure B, B = ET

4. The system calculates Tei Index automatically.

The system displays A, B and Tei Index in the Result 
Window.
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Chapter 11

Vascular

Describes how to perform Vascular measurements and 
calculations.
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Vascular Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

Patient information must be entered before beginning an exam. 
See ‘Scanning a New Patient’ on page 4-9 for more information.

Any measurement can be repeated by selecting that 
measurement again from the menu.
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Vascular Measurements

Introduction
Vascular measurements offer several different types of 
measurement studies:

Figure 11-1. Vascular Exam Category

• Generic – Common to all applications. See ‘Generic 
Measurements’ on page 7-59 for more information.

• Carotid

• LEA (Lower Extremity Artery)

• LEV (Lower Extremity Vein)

• TCD (Trans Cranial Doppler)

• UEA (Upper Extremity Artery)

• UEV (Upper Extremity Vein)

• Renal

• BPG (Bypass Graft)

• UEV (Upper Extremity Vein) Map

• LEV (Lower Extremity Vein) Map
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Introduction  (continued)

To change an exam calc:

1. Select the Second Menu button, the exam category menu 
is displayed.

2. To select another exam study, select the desired exam study 
folder.

A vascular study is a group of particular vessels. You can 
customize the vessel exam calcs in the configuration menu. See 
‘Measurement and Calculation Setup’ on page 7-11 for more 
information.

When you use Auto Vascular calculation, you use the vessel 
keys to post-assign vascular calculations. When you are not 
using Auto Vascular calculation, the vessel key is used for 
manual measurement.
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Naming format for vessels

When you want to measure a vessel, on the measurement 
window, you select the folder for the vessel. Many vessel folders 
are labeled with an abbreviation. The following table lists 
abbreviations used for naming vascular vessels. 

Table 11-1:  Vascular Vessel Abbreviations

Acronym Name

ACA Anterior Cerebral Artery

Acc RA Accessory Renal Artery

AComA Anterior Communicating Artery

Anast Anastomosis

ArcA Arcuate Artery

ATA Anterior Tibial Artery

ATV Anterior Tibial Vein

AVF Arteriovenous Fistula

Axill Axillary Artery

Axill V Axillary Vein

BA Basilar Artery or Brachial Artery

Bas V Basilic Vein

BasV Antecub Basilic Vein Antecubital Fossa

BIF IMT F/N Bifurcation Intima Media Thickness Far/Near

Brac V Brachial Vein

CA Celiac Artery

CCA Common Carotid Artery

Ceph V Cephalic Vein

Ceph V Antecub Cephalic Vein Antecubital

CFA Common Femoral Artery

CFV Common Femoral Vein

CHA Common Hepatic Artery

Com Femoral Common Femoral Artery

CIA Common Iliac Artery

CIV Common Iliac Vein
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Com Iliac A Common Iliac Artery

DFA Deep Femoral Artery

DFV Deep Femoral Vein

Dors Pedis Dorsalis Pedis

DPA Dorsalis Pedis Artery

ECA External Carotid Artery

EIA External Iliac Artery

EIV External Iliac Vein

Fr. Branch Frontal Branch

FV Femoral Vein

GBWall Gall Bladder Wall

GDA Gastro duodenal Artery

GR Graft

GSV Greater Saphenous Vein

HA Hepatic Artery

Hilar A Hilar Artery

HV Hepatic Vein

IIA Internal Iliac Artery

IIV Internal Iliac Vein

ICA Internal Carotid Artery (Transcranial Doppler)

ICA Interior Carotid Artery (Carotid Artery)

IJV Internal Jugular Vein

IMA Inferior Mesenteric Artery

IMT Intima Media Thickness

IMV Inferior Mesenteric Vein

Inn Innominate

Int. Lobular A Interlobular Artery

IVC Inferior Vena Cava

LSV Lesser Saphenous Vein

MCA Middle Cerebral Artery

Table 11-1:  Vascular Vessel Abbreviations (continued)

Acronym Name
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Mcub V Median Cubital Vein

Mid Hep V Middle Hepatic Vein

MPV Main Portal Vein

MRA Main Renal Artery

Par. Branch Parietal Branch

PCA Posterior Cerebral Artery

PComA Posterior Communicating Artery

Peron Peroneal

POP Popliteal

Pseudo False Artery (aneurysm)

PTA Posterior Tibial Artery

PTV Posterior Tibial Vein

PV Portal Vein

RA Renal or Radial Artery

RV Renal or Radial Vein

SA Splenic Artery

Sap Fem Junc Sapheno-Femoral Junction

Seg. A Segmental Artery

SFA Superficial-Femoral Artery

SFJV Sapheno-Femoral Junction Vein

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

SSV Small Saphenous Vein

STA Superficial Temporal Artery

SUBC Subclavian Artery

SUBC V Subclavian Vein

SV Splenic Vein

SV Pop Junc Small Saphenopopliteal Junction

TCD Transcranial Doppler

TIPS Transjugular Intrahepatic PortalSystemic Shunt

Table 11-1:  Vascular Vessel Abbreviations (continued)

Acronym Name
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UA Ulnar Artery

UV Ulnar Vein

VERT Vertebral Artery

VES Vessel

Table 11-1:  Vascular Vessel Abbreviations (continued)

Acronym Name
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B-Mode Measurements

Figure 11-2. B-Mode generic measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

% Stenosis

See ‘% Stenosis’ on page 7-61 for more information. 

Volume

See ‘Volume’ on page 7-63 for more information.

A/B Ratio

See ‘A/B Ratio’ on page 7-68 for more information.

Angle

See ‘Angle’ on page 7-67 for more information.
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IMT Measurement

You can measure the average of the intima media thickness for 
use as the index of arterial sclerosis. 

IMT can be measured both on the posterior and the anterior 
walls of the vessel.

NOTE: Due to the physical properties of ultrasound imaging, the 
posterior IMT measurement is generally more accurate than the 
anterior IMT measurement.

NOTE: Auto IMT is optional in LOGIQ V2/LOGIQ V1.

IMT Measurement - Auto 

Auto IMT automatically measures the thickness of the Intima 
Media on the far and near vessel walls. Near Wall IMT is the 
distance between the trailing edges of the adventitia and intima; 
the Far Wall IMT is the distance between the leading edges of 
the adventitia and intima. 

Set up the parameters you want to record on the worksheet on 
the Utility -> Measure -> M&A page while are in the Carotid 
application. Select Carotid -> CCA/ICA/BIF -> AutoIMT Far/
Near -> Parameter (Average, Max, Min, Standard Deviation 
(SD), Points, or Distance) or select Carotid -> AutoIMT Far/
Near -> Parameter (Average, Max, Min, Standard Deviation 
(SD), Points, or Distance). 

 Figure 11-3. Configuring Auto IMT
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IMT Measurement - Auto  (continued)

In the Vascular Carotid application, the Auto IMT measurement 
is available. 

Figure 11-4. Auto IMT menu

The following controls are available. 

Table 11-2:  Auto IMT description

Parameter Description

Worksheet Select to view the Worksheet

IMT Far Select to begin the Far Field IMT measurement. 

IMT Near Select to begin the Near Field IMT measurement. 

Length/Offset Menu Push to save Length/Offset as a preset. 

IMT Overall / IMT 
Intima

Adjusts (re-measures) the IMT automatically measured by the system. 

Rt / Lt Side Select Left / Right Side. 

Cursor Select Allows you to update cursor placement. 
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IMT Measurement - Auto  (continued)

To measure the IMT,

1. In the Carotid application, press Freeze, press Measure. 

2. Select the appropriate IMT measurement. For example, If 
measuring the IMT of the far wall of the right common 
carotid artery, select Rt CCA folder, and then AutoIMT Far. 

3. Use the Trackball to set the length. Or use the IMT Length 
/ IMT Offset control to set the length and offset distance. 
The Offset key controls how far away from the vertical line 
the measurement starts. Length is the length of the tool 
itself. If set to zero, you can adjust it anywhere on the image. 

4. Press Set. 

You can either adjust the trace prior to pressing the Store 
key or press the Store key to store the image which also 
saves the measurement to the Worksheet.

To adjust the trace, use the IMT Overall/IMT Intima control.

Figure 11-5. Example of Auto IMT Far Measurement
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IMT Measurement - Auto  (continued)

5. Position the cursor, then select AutoIMT Near. 

6. Use the Trackball to set the length. Or use the IMT Length 
/ IMT Offset menu to set the length and offset distance.

7. Press Set. “Store image to accept IMT measurement” 
displays in the message area. If the traces fit both layers of 
the wall, approve the measurement by press the Store 
button to store the image. 

To adjust the trace prior to pressing the Store key, use the 
IMT Overall/IMT Intima menu. The measurement is saved 
to the Worksheet. 

NOTE: Since the IMT measurements are done semi-automatically, 
the operator has to approve the detection by visual 
inspection before storing the results in worksheet and 
report.
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M-Mode Measurements

Figure 11-6. M-Mode generic measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

% Stenosis 

See ‘% Stenosis’ on page 7-69 for more information.

A/B Ratio

See ‘A/B Ratio’ on page 7-70 for more information.

Heart Rate

See ‘Heart Rate’ on page 7-71 for more information.



Vascular Measurements

LOGIQ V2/LOGIQ V1 – Basic User Manual 11-15
Direction 5610735-100 English Rev. 2

Doppler Mode Measurements

Figure 11-7. Doppler Mode generic measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

PI

See ‘Pulsatility Index (PI)’ on page 7-73 for more information.

RI

See ‘Resistive Index (RI)’ on page 7-73 for more information.

S/D Ratio or D/S Ratio

See ‘PS/ED or ED/PS Ratio’ on page 7-74 for more information.

A/B Ratio

See ‘A/B Ratio’ on page 7-75 for more information.

Heart Rate

See ‘Heart Rate’ on page 7-74 for more information.
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Auto Vascular Calculation

Auto Vascular Calculation Overview

Auto Vascular Calculation enables the LOGIQ V2/LOGIQ V1 to 
detect and identify a cardiac cycle. It allows you to assign 
measurements and calculations during live timeline imaging, 
while the image is frozen, or in CINE. Peak values are detected 
for venous flow.

During cardiac cycle detection, the system identifies the cardiac 
cycle using calipers, vertical bars, and/or highlighting of timeline 
data. Use of identifiers is based on measurements and 
calculations selected by an operator for the current application. 
The system may place calipers at early systolic peak, peak 
systole, minimum diastole and end diastole. Vertical bars may 
also be placed to indicate the beginning and end of the cardiac 
cycle. The peak and/or mean trace may be highlighted. You can 
edit the cardiac cycle identified by the system or select a 
different cardiac cycle.

You can select the calculations to be displayed in the M&A 
Result window during live scanning or on a frozen image. These 
calculations are displayed at the top of M&A Result Window 
located adjacent to the image. These calculations are 
presettable by application which means you can set up the 
default calculations to be displayed for each application.
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Auto Vascular Calculation

Activating Auto Vascular Calculation

To activate Auto Vascular Calculation, select Live (calculations 
displayed on the real-time image) or Freeze (calculations 
displayed on the frozen image) under Auto Calc in Second 
Menu.

To deactivate Auto Vascular calculation, select Off.

Setting up Auto Vascular Calculation Parameters

• Selecting Auto Trace

You can select to have a continuous auto trace of the max or 
mean velocities.

• Select Max or Mean from Trace Method on the menu 
area.

• Selecting Trace Detection

Trace Detection lets you use peak timeline data above, 
below, or composite (above and below) the baseline. 

• Select Above, Below, or Both to set the peak timeline 
data.

• Modify Calculation

a. Select Second Menu in measurement screen. 

The Modify Calculation menu is displayed. 

b. Select which measurements and calculations are to be 
displayed in the Auto Vascular calculation window.

You can select the following parameter: PS, ED, MD, 
HR, TAMAX, TAMEAN, PI, RI, Accel, PS/ED, ED/PS, 
AT, Volume Flow, PV.



Vascular

11-18 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Auto Vascular Calculation  (continued)

Auto Vascular Calculation Exam

1. Preset the system.

2. Perform the scan and press Freeze.

3. Activate Auto Vascular Calculation.

The system performs a calculation automatically.

 Figure 11-8. Auto Vascular Calculation
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Auto Vascular Calculation Exam  (continued)

The Auto Vascular calculation is assigned to particular vessel 
measurements.

1. Press Measure to display the Measurement menu.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel name from the menu. 

Selected vessel measurements are automatically assigned 
with the Auto Vascular calculation. The results are then 
displayed in the Results Window.

 Figure 11-9. Assigned Vessel

NOTE: When you want to cancel the assignment, you can use the 
Cancel Transfer. 
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Auto Vascular Calculation  (continued)

During the course of an exam, the cardiac cycle may be 
indicated between two yellow bars; the peak trace and the mean 
trace may appear in green; calculation indicators appear on the 
spectral trace as a caliper identifier (these vary, depending on 
the selected calculation in the Results Window). 

The right-most, most complete cycle is typically chosen to be the 
selected cardiac cycle. You can select a different cardiac cycle. 

To select a different cardiac cycle:

• Move through CINE memory with the Trackball until the 
desired cardiac cycle is selected by the system.

NOTE: You need several good cycles in front of the new cardiac 
cycle for this to be successful. Oftentimes, this is 
problematic near a freeze bar.

NOTE: You need several good cycles in front of the new cardiac cycle 
for this to be successful. Oftentimes, this is problematic near a 
freeze bar.

To move the systole or diastole position:

• Use the Cursor Select control to move the start systole 
position or the end diastole position.
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Manual Vascular Calculation

You can perform the following calculations manually when Auto 
Doppler Calculation is not activated.

1. Press Measure.

If necessary, you can select another Exam Calc and then 
select parameters from Modify Calculation.

2. Select the location of the vessel (Prox, Mid, or Dist) and 
Side (Right or Left).

3. Select the desired vessel folder.

The Measurement menu is displayed.

4. Make the required measurements according to the system, 
or select your preferred measurements.

For each vessel in Doppler mode, you can make any of the 
following measurements. See ‘Doppler Mode Measurements’ on 
page 7-72 for more information.:

• Peak Systole (PS)

• End Diastole (ED)

• Minimum Diastole (MD)

• Heart Rate

• TAMAX

• TAMEAN

• Pulsatility Index (PI)

• Resistive Index (RI)

• S/D Ratio

• D/S Ratio

• Acceleration (Accel)

• Acceleration Time (AT)

• Volume Flow

• Peak Value (PV)
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Vascular Worksheet

The vascular worksheet is structured to automatically display 
vascular measurements made at specific anatomical sites. The 
worksheet can also display an average, last, maximum, or 
minimum value of the latest three measurements. Calculated 
ratios are automatically summarized and displayed.

To view the Vascular Worksheet

1. Press Measure.

2. Select Worksheet.

The system displays the worksheet.

Figure 11-10. Vascular Worksheet - Example

Only measured parameters are displayed. Location information 
is labeled with vessel name first. Measured parameters of the 
vessel are grouped under the vessel label.

Selected value by method is highlighted, however, when the 
average method is selected, the highlighted cursor is removed.

When an entire vessel measurement does not have sides (left or 
right), the side label is not displayed in that vessel study 
worksheet.

HINTS Some fields on the worksheet are view only, and others you can 
change or select. To easily see which fields you can change or 
select, move the Trackball. As the cursor moves over a field that 
you can change or select, the field is highlighted.
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Worksheet Display

1. Vessel Worksheet: Select this key to display the Vessel 
Worksheet when the Vessel Summary is displayed.

2. Vessel Summary: Select this key to display the Vessel 
Summary when the Vessel Worksheet is displayed.

3. Examiner’s Comment: Select this key to display the 
Examiner’s comment window. See ‘To edit a worksheet’ on 
page 7-57 for more information.

4. Generic: Select this key to display the Generic Worksheet. 
Generic study measurements/calculations, such as volume 
and velocity, are displayed on this worksheet.

5. Delete Value: Use to delete a value (each measurement 
value). See ‘To edit a worksheet’ on page 11-24 for more 
information.

6. Exclude Value: Use to exclude a value from the result line. 
See ‘To edit a worksheet’ on page 11-24 for more 
information.

7. Intravessel Ratio: Select this key to display the Intravessel 
Ratio Calculation window. See ‘Intravessel ratio’ on 
page 11-28 for more information.

8. Page Change: If a worksheet has more data, to view the 
next page, adjust the Page Change.
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To edit a worksheet

To change data on a worksheet:

1. Select Worksheet from any page of the Vascular 
Calculation.

2. To position the cursor at the field you want to change, move 
the Trackball.

The field is highlighted. Press Set.

3. Type the new data in the field and move the cursor to 
another place. Press Set. The new data is displayed in blue 
and asterisk are appended to value and resultant value to 
indicate that it was manually entered. 

The average measurements, calculations and ratios are 
automatically updated to reflect the edited values.

Figure 11-11. Display of the edited value

NOTE: If the user moves the cursor to the edited value and presses the 
Set key once, the value returns to the original value before the 
edit.
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To edit a worksheet  (continued)

To delete data: 

1. Select Worksheet from any page of the Vascular 
Calculation menu.

2. To position the cursor at the field you want to delete, move 
the Trackball.

The field is highlighted.

3. Select Delete Value.

For Example:

1. If the user measured RI 4 times, however, latest 3 sets of 
measurements were displayed in the worksheet.

1. Then, the user deleted PS value of #3 from the worksheet.

2. The whole set of #3 measurements is deleted from the 
worksheet and #1 set of measurements is shifted and 
displayed as below.

Table 11-3:  Example of Latest Measurements in Worksheet

Result Number #2 #3 #4

PS 0.500 0.600 0.700

ED 0.100 0.200 0.300

RI 0.800 0.667 0.571

Table 11-4:  Example of Worksheet after Value Deleted

Result Number #1 #2 #4

PS 0.400 0.500 0.700

ED 0.000 0.100 0.300

RI 1.000 0.800 0.571
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To edit a worksheet  (continued)
To exclude data: 

When the user selects a particular value on the Worksheet and 
selects Exclude Value, this value is excluded from result line 
and resultant value is re-calculated without this value and also 
calculation values using this value is ‘blank’.

1. Select Worksheet from any page of the Vascular 
Calculation menu.

2. To position the cursor at the field you want to exclude, move 
the Trackball.

The field is highlighted.

3. Select Exclude Value.

4. The data in the field is not visible and is not included in 
worksheet calculations as below.

5. To include a value that you previously excluded, select 
Exclude Value again.

Figure 11-12. Display of the excluded value

The user can select the method for calculating the cumulative 
value.

This value is only calculated by using displaying values. If the 
user takes parameters more than 3 times, the last 3 values are 
used for this calculation.

To select the method:

1. Move cursor to method column and press Set. 

2. The pull-down menu is displayed. Move to cursor any one of 
methods and press Set. The selected method is displayed 
in the column.

Figure 11-13. Pop-up menu of methods
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Examiner’s Comments

To type a comment on a worksheet:

1. Select Exam’s Comments.

The Examiner’s Comments window opens.

2. Type comments about the exam.

3. To close the Examiner’s Comments window, select Exam’s 
Comments. The comments appear on the report.

Figure 11-14. Examiner’s comments field
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Intravessel ratio

To calculate Intravessel ratio, you need a measurement of 
assessing pressure and stenotic velocities.

1. Select Intrav. Ratio to display the pop-up window in the 
header section of the worksheet.

Figure 11-15. Intravessel Pop-up Window

2. Select the first velocity. 

The value is displayed in the window.

Figure 11-16. Intravessel ratio one

3. Select the second velocity.

The second value and Result value are displayed in the 
window.

Figure 11-17. Intravessel ratio two

• To save the Intravessel ratio to the Vessel Summary, 
move the cursor to Save and press Set.

• To clear values, move the cursor to Clear and press 
Set.

• To cancel and exit Intravessel ratio, move the cursor to 
Cancel and press Set.

NOTE: Intravessel Ratio is only displayed and saved in the Vessel 
Summary as Intra-Ratio.
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Vessel Summary

The Vessel Summary is designed to automatically display 
measurements made at specific anatomical sites. Calculated 
ratios are automatically summarized and displayed.

The Vessel Summary can be displayed at any time during the 
exam by selecting Vessel Summary from the Vascular 
Worksheet menu.

Figure 11-18. Vessel Summary - Example
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Vessel Summary  (continued)

1. The first row, indicating Right or Left, is not displayed when 
the side is not defined in the vessel. In the third column on 
the second line, you select the calculations. Move the cursor 
to the third column, and the pop-up menu is displayed. The 
selected parameter is displayed in every third column.

Figure 11-19. Pop-up menu

2. Vessel Name with location information.

3. Check Box. Use to select the vessel velocity for calculating 
the vessel ratio (ex. ICA/CCA). You can only select one 
location (position) in a vessel.

4. Result value column. This value cannot be changed or 
excluded from this page.

5. Calculation name and result. ICA/CCA: The ICA/CCA ratio 
selects the highest systolic ICA and CCA velocities when 
calculating this ratio, and displays the velocities.
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Carotid Study

In the configuration page for ICA/CCA ratio, you can specify 
which portion of the CCA vessel (Prox, mid, distal) is chosen. 
You can override the selections on the Vessel summary.

The ICA/CCA ratio is able to be configured for either systole or 
diastole.

The vertebral vessel also has systole and diastole selections. In 
the summary page, there is a box to select flow reversal for 
vertebral flows. The choices are Ante (Antegrade), Retr 
(Retrograde), and Abs (Absent).

To select the method: 

Move cursor to the box and press Set. After the pop-up menu 
(Blank, Ante, Retr, Abs) is displayed, select from a menu of 
choices. The selected choice is displayed in the column.

The box is independent of Left and Right.

Renal Artery Study

For renal arteries, you can calculate RENAL/AORTIC ratio 
(RAR) based on peak systolic velocities. 

You can combine the two renal summary pages, and have a 
heading to separate the different measurements (main renal, 
intra renal). You can scroll between the measurements. The 
most commonly used, the main renal artery, is the default.

Lower Extremity Artery Study

For the lower extremity artery, you need an intra vessel ratio 
(assessing pre vs. stenotic velocities). You can specify which 
(ratio is stenotic/pre).

The intra-vessel ratio needs to be available for all vascular 
measurements. This appears on the worksheet only if used.

Recording Worksheet

The worksheet can be saved as you would any ultrasound 
image. Once it is displayed on the screen, it can be recorded on 
the DVR, printed on the B/W printer, stored on media with the 
Image Archive option.
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Chapter 12

Urology

Describes how to perform Urology measurements and 
calculations.
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Urology Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See ‘Beginning an Exam’ on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again.

The system retains all measurements, but the worksheet retains 
only the last six measurements of each type.
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Urology Calculations

Introduction

Urology measurements offer three different types of 
measurement studies:

• Generic–Common to all applications. See ‘Generic 
Measurements’ on page 7-59 for more information.

• Urology

• This chapter describes Urology B-Mode measurements.

• The Urology M-Mode measurements are common to 
other applications. See ‘M-Mode Measurements’ on 
page 7-69 for more information. 

• The Urology Doppler measurements are common to 
other applications. See ‘Doppler Mode Measurements’ 
on page 7-72 for more information.

• Pelvic Floor. See ‘Pelvic Floor Measurements’ on 
page 12-10 for more information.

To change a study:

1. Select the Second Menu, the Urology exam category menu 
is displayed.

2. To select another study, select the desired study.
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Urology B-Mode Measurements

In B-Mode, the Generic Exam Calcs for Urology includes the 
following measurements:

• % Stenosis

• Volume

• Angle

• A/B Ratio

See ‘B-Mode Measurements’ on page 7-61 for more 
information.

The following measurements are located specifically in the 
Urology Exam Calcs. Those specific measurements (Bladder 
Volume, Prostate Volume and Renal Volume) are listed on the 
following pages.

Select Second Menu. The following category is displayed.

Figure 12-1. Urology Exam Calcs B-Mode 

NOTE: Bladder(0.7) Vol, Bladder Vol, Post Void Vol, Prostate Vol, Renal 
Vol, Renal (0.49) Vol and Volume can be displayed if preset at 
the Utility -> Measure screen.
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Bladder Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-2. Bladder Volume

To measure Bladder Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select the Bladder folder, an active caliper displays.

3. Perform a standard distance measurement. 

The system displays the distance value in the Results 
Window.

4. Perform the second and third distance measurements. 

After you complete the third distance measurement, the 
system displays the bladder volume in the Results Window.



Urology

12-6 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Prostate Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-3. Prostate Volume

To measure Prostate Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select the Prostate folder, an active caliper displays.

3. Perform a standard distance measurement. 

The system displays the distance value in the Results 
Window.

4. Perform the second and third distance measurements. 

After you complete the third distance measurement, the 
system displays the prostate volume in the Results Window.
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Prostate Volume  (continued)

PSA Measurement

If you enter the value of PSA (Prostatic Specific Antigen) and 
PPSA Coefficient at the Urology Patient screen, PSAD and 
PPSA are automatically calculated.

The values are displayed on the Worksheet and Report (if set 
appropriately on the Report Designer page).

Figure 12-4. Urology Patient Screen

Figure 12-5. Measurement result window

PSAD: Prostatic Specific Antigen (PSA) Density – defined as: 
PSAD = PSA/Volume

PPSA: Predicted Prostate Specific Antigen – defined as: PPSA 
= Volume x PPSA Coefficient 
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Prostate Volume  (continued)

Worksheet

• For the prostate volume calculation, you can select the 
method “m1, m2...” in addition to Avg., Max., Min. and Last.

• The value of PSA and PPSA are displayed.

Figure 12-6. Urology Worksheet
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Renal Volume

This calculation uses a standard distance measurement. Length 
is typically measured in the sagittal plane. Width and height are 
measured in the axial plane.

Figure 12-7. Renal Volume

To measure Renal Volume:

1. Scan the patient in the appropriate scan plane. 

2. Select Side.

3. Select the Renal folder, an active caliper displays.

4. Perform a standard distance measurement: 

The system displays the distance value in the Results 
Window.

5. Perform the second and third distance measurements. 

After you complete the third distance measurement, the 
system displays the renal volume in the Results Window.
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Pelvic Floor Measurements

Pelvic floor measurements can be performed in the Pelvic Floor 
study. The measurements are located in the Exam Calc folder in 
the Urology preset. 

Figure 12-8. Pelvic Floor Measurements

BN (Bladder Neck) Rest

Obtain an image with the patient at rest (relaxed).

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. A 
positive number displays since the caliper is placed below 
the baseline.

3. A distance is calculated in millimeters.
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Pelvic Floor Measurements  (continued)

BN (Bladder Neck) Stress

Obtain an image after the patient performs the Valsalva 
maneuver.

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position 
the caliper at the anterior margin of the bladder neck. 

If the bladder neck is below the baseline, the Bladder Neck 
Stress is a positive number. If the bladder neck is above the 
baseline (closer to the transducer face), the number is 
negative.

Bladder Neck Descent (BND)

The Bladder Neck Descent is a calculation that should be 
calculated after measuring the Bladder Neck Rest and Bladder 
Neck Stress. 

BND = Bladder Neck Rest - Bladder Neck Stress

NOTE: If the Bladder Neck Stress is a negative number, it becomes 
positive and is added to the bladder neck rest measurement.

DWT (Detrusor Wall Thickening)

Three distance measurements of the bladder wall dome are 
calculated into a mean dimension and displayed in millimeters.

UT (Uterine) Descent Max

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the uterus in a stress image and display in millimeters
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Pelvic Floor Measurements  (continued)

Rect Amp Des Max (Rectal Ampulla Descent Max)

1. Create a straight line (zero or baseline) to line up with the 
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position 
of the rectal ampulla in a stress image and displayed in 
millimeters

Rectocele (Depth and Width)

Two 2-caliper diameter measurements to measure depth and 
width of the rectocele. Displayed in millimeters.

Lev Hiat Stress (Levator Hiatus Stress)

Two 2-caliper diameter measurements and calculate an area 
displayed as cm squared.

Residual Urine

Two 2-caliper diameter measurements calculate as:

(x) times (y) times 5.9 minus 14.9 equals Residual Volume 
displayed in ml.



LOGIQ V2/LOGIQ V1 – Basic User Manual 13-1
Direction 5610735-100 English Rev. 2

Chapter 13

Pediatrics

Describes how to perform Pediatrics measurements 
and calculations.
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Pediatrics Exam Preparation

Introduction

Measurements and calculations derived from ultrasound images 
are intended to supplement other clinical procedures available 
to the attending physician. The accuracy of measurements is not 
only determined by the system accuracy, but also by use of 
proper medical protocols by the user. When appropriate, be sure 
to note any protocols associated with a particular measurement 
or calculation. Formulas and databases used within the system 
software that are associated with specific investigators are so 
noted. Be sure to refer to the original article describing the 
investigator's recommended clinical procedures.

General Guidelines

New Patient information must be entered before beginning an 
exam. See ‘Beginning an Exam’ on page 4-2 for more 
information.

Any measurement can be repeated by selecting that 
measurement again.

The system retains all measurements, but the worksheet retains 
only the last six measurements of each type.

The six worksheet measurements can be averaged and the 
average used in other calculations.
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Pediatrics Calculations

Overview

Pediatrics measurements offer two different types of 
measurement studies:

• Generic. The Generic Calculations study is common to all 
applications. See ‘Generic Measurements’ on page 7-59 for 
more information.

• Pediatric Hip (PedHip). 

• This chapter describes Pediatrics B-Mode 
measurements.

• The Pediatrics M-Mode measurements are common to 
other applications. See ‘M-Mode Measurements’ on 
page 7-69 for more information. 

• The Pediatrics Doppler measurements are common to 
other applications. See ‘Doppler Mode Measurements’ 
on page 7-72 for more information.

Figure 13-1.  Pediatrics Exam Category
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Ped Hip

B-Mode Measurements

Figure 13-2. Pediatrics B-Mode Measurement 

The following generic measurements are common to other 
exam applications:

• %Stenosis

• Volume

• Angle

• A/B Ratio

See ‘B-Mode Measurements’ on page 7-61 for more 
information.
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Hip Dysplasia Measurement

The HIP calculation assists in assessing the development of the 
infant hip. In this calculation, three straight lines are 
superimposed on the image and aligned with the anatomical 
features. The two angles are computed, displayed, and can be 
used by the physician in making a diagnosis.

The three lines are:1

1. The baseline connects the osseous acetabulum convexity to 
the point where the joint capsule and the perichondrium 
unite with the iliac bone.

2. The inclination line connects the osseous convexity to 
labrum acetabulare.

3. The Acetabulum roof line connects the lower edge of the 
osilium to the osseous convexity.

The α (Alpha) angle is the supplement of the angle between 1 
and 3. It characterizes the osseous convexity. The β (Beta) 
angle is the angle between lines 1 and 2. It characterizes the 
bone supplementing additional roofing by the cartilaginous 
convexity.

Figure 13-3. Hip Dysplasia 

1Source: R GRAF, journal of Pediatric Orthopedics, 4: 
735-740(1984)

Anatomical Landmarks

a. Ilium d. Bony Roof

b. Iliac Bone e. Cartilaginous acetabular roof

c. Labrum f. Femoral Head
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HIP (BA)

To make a Hip Dysplasia measurement: 

1. Select either the right or left side (orientation) and then 
select HIP (BA). 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control. 

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle.

5. To place the line along the inclination line of the osseous 
convexity to labrum acetabulare, move the Trackball. 

6. To rotate or change inclination, adjust the Ellipse control. 

7. To fix the second measurement line, press Set.

The system displays a third dotted line at an angle.

8. To place the caliper along the acetabular roof line, move the 
Trackball. 

9. To rotate or change inclination, adjust the Ellipse control. 

10. To fix the third measurement line and complete 
measurement, press Set. 

The system displays the hip measurements (α and β) in the 
Results Window.

HIP (A) (Alpha HIP)

The Alpha HIP measurement measures the angle between the 
iliac baseline and the bony roof line. To make an Alpha HIP 
measurement: 

1. Select either the right or left side (orientation) and then 
select HIP (A). 

A horizontal dotted line displays. 

2. To place the baseline, move the Trackball. Position the 
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control.

4. To fix the baseline, press Set. 

The system displays a second dotted line at an angle. 

5. To place the caliper along the acetabular roof line, move the 
Trackball.

6. To rotate or change inclination, adjust the Ellipse control. 

7. To fix the second measurement line, press Set. 

The system displays the alpha hip measurement (α) in the 
Results Window.
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d:D Ratio Measurement

The d:D Ratio measurement measures the percentage of the 
femoral head coverage under the bony roof. To make this 
measurement:

1. Select either the right or left side (orientation) and then 
select d:D Ratio. 

A horizontal dotted line displays. 

2. Use the Trackball to place the baseline along the ilium. 
Position the crosshairs edge at the osseous convexity of the 
ilium.

3. Use the Ellipse control to adjust or change inclination. 

4. Press Set to fix the baseline. 

5. The system displays a circle representing the femoral head. 
Use the Trackball to position the circle.

6. Use the Ellipse control to size the femoral head 
circumference.

7. Press Set to fix the femoral head circumference. 

The system displays the d:D ratio for the femoral head in the 
Results Window.
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Chapter 14

ReportWriter

Describes how to generate reports.
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Standard Report Pages

Introduction

The LOGIQ V2/LOGIQ V1 enables the generation of patient 
reports based on the examination performed and the analyses 
that were made during the exam. The reports are generated 
using the data stored in the system with pre-selected templates.

You may edit a report while performing the exam; customize, 
delete, or add measurements; and save changes until you use 
the Store command. Once Stored, the reports are read-only.

It is recommended that the data be saved often, and then 
carefully reviewed before the report is Stored. Use the 
worksheet to facilitate the review and adjust data before storing 
a report. The final report can be printed on a standard printer.

Creating a report

Reports summarize the data obtained in the examination. They 
can contain data, images, and cine loops.

Once generated, the report can be viewed, images can be 
added, and the patient’s personal data can be modified. The 
examination data itself CANNOT be changed.
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Activating the Report

1. Select Report on the keyboard. 

2. The system displays the default report for the current 
application on the monitor. 

The information entered during the examination is 
automatically filled in the appropriate fields (e.g. 
demographic, diagnosis, comments).

The preview image appears when the cursor is over the 
clipboard image.

NOTE: The template is the skeleton of your report. It is composed 
of different objects that can be customized by the user.

3. Adjust the Page Change control to move down the page.

 Figure 14-1. Report Page Example
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Activating the Report  (continued)

Table 14-1:  Report Button Controls

Button Description

Save As Exports the report page to storage media as CHM or PDF format. 

Designer Accesses template editor screen.

Template Selects template from the list of selected applications. 

Store Stores the report page into Archive as CHM* file.

Retrieve Retrieves the report page from Archive.

Stored Date/Time is appended to the name of stored report.

Print Prints out the report to the default printer.

Delete Deletes the report page from Archive.

Worksheet Accesses Worksheet Page.

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

*CHM is a compressed HTML help file.
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Selecting another template

You can select another template for the current patient:

1. Select TEMPLATE at the bottom of the monitor display.

2. A list of available templates and exam categories displays.

Figure 14-2. Application List Example
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Selecting another template  (continued)

3. Select the desired template using the Trackball and press 
Set.

The selected template displays on the monitor.

NOTE: If you select another exam category, the template list of the 
selected category displays. Select the desired template.

Figure 14-3. Available Template list

4. Select the desired template name and press Set.

5. The report changes to the selected template.
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Factory Templates

The system has factory templates for each application. You can 
modify these templates or create user-defined templates. You 
need to save revised/new templates with unique names. 

A template may include one or more of the following:

• Measurements

• Worksheet or Vessel Summary Images

• Anatomical Surveys or Biophysical Profiles

• Anatomical Graphics

• Graphs

• Images areas

• Score Boxes

NOTE: Additional factory templates can be added from the 
Utility-->Reports menu (OB for multiple gestation, Renal, etc.). 
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Editing a Report

Entering the hospital address

When using a factory template, the area for the hospital 
information is usually placed in the upper portion of the report.

To make a new area, See ‘Fixed Text’ on page 14-45 for more 
information.

To modify the factory template:

1. Select Report on the keyboard.

2. Select Designer.

3. Double-click on the area for the hospital information in the 
template. The Fixed Text dialogue box displays.

Figure 14-4. Fixed Text Dialogue Box

4. Make changes as necessary.

a. Enter the hospital address in the text area.

b. Modify Box Properties (box width, box border line width, 
text align, box height, box left margin, and font).

5. Select OK.
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Entering the hospital address  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
appends “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and appends “[user]”. 
For example, NewReport[user].

7. Exit the Report Designer. The report with the hospital 
address displays.
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Inserting the hospital logo

When using a factory template, the area for the logo is usually 
placed in the upper left portion of the report.

To make a new area, See ‘Fixed Text’ on page 14-45 for more 
information. 

To modify the factory template:

1. Save the preferred hospital logo in either a jpeg or bmp 
format on the removable media.

NOTE: Label the logo with a unique name (e.g. 
HospitalNameLogo.bmp). If the different logo is printed on 
the report, rename the logo image you want to use and 
insert it into the report template again.

2. Insert the removable media.

3. Select Report on the keyboard.

4. Select Designer.

5. Double-click logo box at the left top so that the frame is 
highlighted. The logo box displays.

Figure 14-5. Logo Box



Standard Report Pages

LOGIQ V2/LOGIQ V1 – Basic User Manual 14-11
Direction 5610735-100 English Rev. 2

Inserting the hospital logo  (continued)

6. Select Import Logo (1). Select the removable media first and 
then the hospital logo.

7. Select OK. The hospital logo displays in the logo list (2). 
Click the logo to select.

NOTE: Scroll the logo list using the left/right arrow key (3).

8. Modify Appearance (4).

9. Select OK.

10. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

11. Exit the Report Designer. The template with the hospital 
logo displays.

NOTE: If a different logo prints on the report, rename the logo image 
which you want on the report and insert it into the report 
template again.
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Changing the Archive Information

When using a factory template, the Archive Information is 
usually placed below the hospital name and logo. 

The contents of the Archive Information is inserted through the 
related page automatically. If you want to change the 
description, such as Information or Comments that was entered 
in the patient menu:

1. Double-click the yellow text to be changed, e.g. Information 
or Comments.

The area where the description was entered (e.g. Patient 
menu) displays.

2. Change the existing data as necessary.

3. Select Scan then select Report to return to the report.

Figure 14-6. Patient Information Area (Example)
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Modifying the displayed objects of Archive Information

1. Select Designer.

2. Double click on the area for the Archive Information in the 
template. The Archive Information Box displays.

Figure 14-7. Archive Information Box

3. Click the checkboxes to select and deselect the objects. 
Objects with checkmarks will appear in the report template.

4. Select Box Properties to change the font, font size, font 
color, or box size, and select OK.

5. Select OK to return to the Report Designer.

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

7. Select File -> Exit to leave the Report Designer.
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Entering free text

You can enter free text to the report using the alphanumeric 
keyboard.

The factory template terms their text area as “Summary or 
Comments”. 

1. Move the cursor to the text field and press Set.

NOTE: You can enter the text only to the field set as free text in the 
Report Designer.

NOTE: DO NOT enter “%s” in a free text field and then try to edit/
save the template in the Report Designer. 

2. Type the text.
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Inserting Text

1. Select Designer.

2. Move the cursor where the text is to be inserted and press 
Set.

3. Select the Text Field from the Insert menu. The Text Field 
dialog box displays.

Figure 14-8. Text Field Dialogue Box

4. Select the appropriate display items:

• Ref. Reasons: Retrieves this information from the Direct 
Report

• Comments: Retrieves this information from the 
Comment field of the patient screen and the Exam 
Comment field of the worksheet.

• Diagnosis: Retrieves this information from the Direct 
Report

• Free Text 1 - 8
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Inserting Text  (continued)

5. Type the heading Text.

6. Modify box properties, the heading text and font, and data.

7. Select OK or Cancel. 

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].
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Inserting an image to the report

Some factory templates include an image area. If you want to 
insert or modify the image area, See ‘Insert Image’ on 
page 14-37 for more information.

To insert images from clipboard into the image field of the report:

1. Move the cursor to the desired image on the clipboard.

NOTE: The preview image appears when the cursor is over a 
clipboard image.

2. Press and hold down the Set key and drag the selected 
image to the report by using the Trackball or double click 
the Set key on the desired image. 

3. To move images between image areas, press and hold 
down the Set key and using the Trackball, drag the 
selected image to the new location.

To remove an image from the report, press and hold down 
the Set key and using the Trackball, drag the select image 
back to the clipboard.
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Measurement result section

Measurement results for the current patient display 
automatically if you have the measurement section in the report 
template.

The factory template has an appropriate measurement result 
area. If you want to insert or modify the measurement area, See 
‘Measurements’ on page 14-43 for more information.

Figure 14-9. Measurement section
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Inserting the worksheet

You can insert the worksheet (like you can insert an image) to 
the image display field. To set a image display field in the report 
template, See ‘Insert Image’ on page 14-37 for more 
information.

1. Display the worksheet on the monitor display.

2. Save the worksheet using the Store key.

3. Select Report on the keyboard.

4. Drag the worksheet into the report.

a. Move the cursor to the desired worksheet on the 
clipboard.

b. Press and hold down the Set key. Use the Trackball to 
drag the selected worksheet into the Image Display 
Field.

c. Release Set.

NOTE: You can also move the cursor to the desired worksheet on 
the clipboard, double-click the worksheet.

5. The worksheet displays on the report.

NOTE: You can double-click the worksheet in the report to change 
the background color to white to save ink during printing. 
Double-click the worksheet again to return the worksheet to 
the original color.
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Placing objects side-by-side

If you want to place images, the image and comment, 
anatomical graphic and comment, etc. side-by-side, you must 
first place a table, which has two (or more) columns, into the 
report template.

1. Press Report on the keyboard

2. Select Designer to display the Report Designer.

3. Place the cursor where you want to insert the object.

4. Select Table from the Insert menu. Insert Table box 
displays.

 Figure 14-10. Insert Table Box

5. Set the number of columns to 2 (or more, as required) and 
change the table parameters, if needed. Select OK.

NOTE: If you do not need a table border, set the Border to 0. Add 
additional rows if required.

6. Place the cursor in the column and select the desired items 
from the Insert menu (e.g. logo, image, free text). Specify 
those items.

7. Repeat step 6 for each column as required.

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

You can insert the images in the order preferred, by row or 
column, on the factory templates. See ‘Inserting the Table’ on 
page 14-30 for more information.
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Accessing Worksheet, OB Graph and Anatomical Survey Pages

If the Worksheet, OB Graph, and/or Anatomical Survey pages 
have been saved for the current patient, you can access these 
pages from the report page.

NOTE: OB Graph and Anatomical Survey pages apply only to OB.

1. Select either Worksheet, Graph or Anatomical Page.

There is also Fixed Text set up as hyper links for these 
pages. Cursor to the fixed text and press Set.

2. The system displays the appropriate page (Worksheet, OB 
Graph or Anatomical Survey).

3. Select Report to return to the Report page.

Storing the Report

1. Select Store.

The Report is saved as a CHM file to Archive. 

NOTE: The archived report cannot be edited; therefore, it is 
recommended that the data is carefully reviewed before the 
report is saved.

Retrieving an Archived Report 

1. Select Retrieve. The Retrieve menu displays.

Figure 14-11. Retrieve Menu (Prefix “User1\” may not appear)

2. Select the desired report and press Set.

NOTE: The retrieved report cannot be edited.
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Deleting a Report from Archive

1. Select Delete. The Retrieve menu appears on the screen.

Figure 14-12. Delete Reports Menu (Prefix “User1\” may not 
appear)

2. Select the report to delete and press Set.

Printing the Report

1. Select Print to print out the report.

The Report is printed on the default printer.

NOTE: To preview the Print Layout before printing, See ‘Preview the 
Print Layout’ on page 14-28 for more information.

NOTE: Double-click the worksheet and/or image in the report to change 
the background color to white A white background will save ink 
during printing. Double-click the worksheet or image again to 
return to the original color.
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Exporting the Report to Media

Reports can also be saved in a user-defined locations in the 
following formats:

• Compiled HTML (.CHM) files: readable from any web 
browser.

• Portable Document Format (.PDF) files: readable with 
Adobe Acrobat reader.

1. Select Save As.

The Save As dialog box appears on the screen.

Figure 14-13. Save as dialog box

2. Enter the Report title in the File Name field.

3. Select the media to export the Report.The system supplies 
a name (numeric DICOM UID, unique identifier). 

4. Select PDF or CHM from the Save as type pull down menu.

5. Select Save.

Exiting the report

1. Select Store to save the report.

NOTE: If the user is working on a report and leaves the report 
screen for any reason, all information added to the report is 
automatically saved without loss of data.

2. Select Esc key or Report key to exit the report page.
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Designing Your Own Template

Template Designer

You can design and create your own customized template from 
a blank template page, or you can use an existing template 
(factory or user-defined) and save the changes.

Display the desired template and select Designer to open the 
Template Designer page.

Figure 14-14. Report Designer
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File Menu

Create a new template

To design a new template without using a pre-existing factory 
template:

1. Select Designer to open the Report Designer.

2. Select New from the File menu, and press Set. 

The blank template displays.

3. Create the report template as needed.

4. Select Save from the File menu, and press Set.

The Save Template As dialogue box displays.

5. Enter a template name and click OK.

6. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

Table 14-2:  File Menu

Description

New Creates a new template. A blank template appears. 

Save Overwrites the existing template.

Save As Saves as a new name.

Page Setup Enters Print Layout screen.

Print Preview Executes print preview.

Exit Exits Report Designer page.
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Create a new template and save as a factory template name 

To design a new template by modifying an existing factory 
template and keeping the same name of the factory template:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. To save changes, select Save from the File menu, and 
press Set.

The Save Template dialog box displays.

• Yes: Saves changes.

• No: Does not save changes.

• Cancel: Returns to Report Designer.

NOTE: The template name displays in the template list, retains the 
same name, and adds “[user]”. For example, 
“OB23-Basic[user]”. You do not lose the original factory 
template.

5. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

Create a new template and save with a new name

To design a new template by modifying or copying an existing 
factory template and saving it with a new name:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. Select Save as from File menu and press Set.

 The Save Template As dialog box displays.

5. Type the new template name and click OK.

6. Select Exit from the File menu and Set.

7. The Report Designer closes and returns to the Report Page.

NOTE: The template receives the new name and adds “[user]”. For 
example, NewReport[user].

HINTS Save changes frequently as you modify your template. Saving 
often reduces the risk of losing all your changes.
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Page Setup

1. Modify the factory template as necessary in Designer.

2. Select Page Setup from File menu and press Set.

3. Change the paper size or orientation to fit the print layout, as 
necessary.

To define the header and footer for the printed report, type 
text and enter the required variables listed in the table 
below. Select “Different for first page” and enter a specific 
header/footer for that page.

Figure 14-15. Page Setup Dialog

NOTE: Default is left aligned. Report will appear as black ink on 
white background.

4. Select OK or Cancel.

Table 14-3:  Variable and Definition

Variable Definition Variable Definition

{pid} Patient ID {prt} Current time (printing time)

{pnm} Patient name {cp} Current page

{pbd} Patient date of birth {tp} Page count

{exd} Examination date {c} Subsequent text is centered

{prd} Current date (printing date) {r} Subsequent text is right aligned.

{inm} Institution name
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Preview the Print Layout

1. Select Template to choose the Report Template.

2. Select Designer.

3. Select Print Preview from File menu, and press Set.

4. The Print Preview screen displays.

If changes need to be made, select Close to exit the 
Preview page. Modify the template or return to the Report 
and modify the contents.

Edit Menu

Deleting a template object

1. Select the object to be deleted.

2. Select Delete from the Edit menu, and press Set. The 
object is deleted from the template.

Undoing the operation

1. Select Undo from the Edit menu, and press Set.

2. Repeat as required.

Table 14-4:  Edit Menu

Description

Delete Deletes the selected object from the report template.

Undo Restores the previous state(s) of the report template.
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Insert Menu

Inserting the Page Break

1. Place the cursor where the Page Break is to be inserted and 
press Set.

2. Select Page Break from the Insert menu and press Set. The 
page break line displays on the template.

Table 14-5:  Insert Menu

Description

Page Break Inserts a Page Break.

Table Inserts a Table.

Logo Inserts a Logo Bitmap File.

Archive Info Inserts Archive Information.

Anatomical Graphics Selects anatomical graphics by category to be inserted into a 
field.

Image Inserts the image display field to the template.

Wall Motion Analysis Selects Cut Planes, Bull’s Eye, or Score Table Box.

OB/GYN Selects OB Graph, Bar Graph or Anatomy.

Measurements Inserts the measurement display field in the template.

Text Field Edits text field.

Fixed Text Enters any comments as Fixed Text.

Dropdown Text Insert a Dropdown text
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Inserting the Table 

1. Place the cursor where the table is to be inserted and press 
Set.

2. Select Table from the Insert menu and press Set. The Insert 
Table dialog box displays.

Figure 14-16. Insert Table Dialog

3. Specify each parameter as required.

NOTE: To set the table border as not visible, set “Border” parameter 
to 0 (zero)

4. Select OK to insert the table or Cancel. 

NOTE: To insert/delete a row/column from the table or access table 
properties, double click the Set key in any empty area inside 
the table. A table menu appears with those options.
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Inserting Images in a Table

You can choose the order in which images are inserted into 
tables: by row (default) or by column.

Image Order by Row

The system default inserts images in the cells of the first row, 
then to the next row. 

Figure 14-17. Image Order—Row Preference 
(System Default)

1. Follow the instruction for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, insert an image box in each cell of 
the table. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the table.

After the template is saved and you are working in the Report 
Writer, when you select images to be inserted in the table, they 
are placed in the default order.
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Inserting Images in a Table  (continued)

Image Order by Column

If you prefer to have the image placement by column, images 
are inserted in each cell of the first column, then the next 
column.

Figure 14-18. Image Order—Column preference

In order to achieve the column preference, you need to create a 
table with 2 columns and 1 row. In each cell of this table, you 
need to insert another table.

1. Follow the instructions for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, create a table inside each of the 
existing table’s cells. 

a. Move the cursor to the left column’s cell and press Set.

b. Select Table from the Insert menu and press Set.

c. When specifying parameters, specify:

No. of Columns=1; No. of Rows=2; Width=290 pixels, 
height=500 pixels.

Select OK. 

d. Repeat steps a-c for the next column.

3. Insert an image box to each table cell. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the 2 tables.

After the template is saved and you are working in the Report 
Writer, when you select images to be inserted in the table, they 
are placed with your column preference.
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Inserting Logos

1. Place the cursor where you want to insert the logo and 
press Set.

2. Select Logo from the Insert menu and press Set. The Logo 
Box displays.

3. Select a logo that you want to insert (1) or import a bmp or 
jpg file from the removable media (2). Scroll the images 
using the arrow key (3). Specify the appearance (4).

Figure 14-19. Logo box

4. Select OK to insert the logo or Cancel.

Changing a logo:

1. Place the cursor on the logo to be changed and press Set 
twice. The Logo Box displays.

2. Select a different logo. If the desired logo is not shown, 
select Import Logo to import a different logo.

3. Specify the appearance.

4. Select OK or Cancel.
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Inserting Archive Information

Archive information contains all the objects from the different 
information menus (Patient, Exam, and Site Information). This 
box accumulates different information menu selections that can 
be grouped together and displayed in one table.

1. Place the cursor where you want to enter the archive 
information and press Set.

If you use a factory template, double click on the current 
archive information area to display the Archive Information 
Box.

2. Select Archive Info from the Insert menu and press Set. 
The Archive Info Box displays.

Figure 14-20. Archive Information Box

3. Type the Heading, select a heading link from the pull-down 
menu, and select the parameters you want to display in the 
report.
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Inserting Archive Information  (continued)

4. Select Box Properties to change the Font, Alignment, 
Appearance, etc.

NOTE: To set the same font to all fields, select Set All fields. 

Figure 14-21. Table Properties

5. Select OK or Cancel. The contents of the Archive 
Information is inserted to the related page automatically.

Editing displayed Archive Information:

1. Select Designer.

2. Move the cursor to Archive Information field to be edited.

3. Press Set twice. The Archive Information Box displays.

4. Edit the heading, the Heading Link and Information 
parameters, as necessary.

5. Select OK to save or Cancel.



ReportWriter

14-36 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Anatomical graphics

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the Anatomical 
Graphics and press Set.

4. Select Anatomical Graphics from the Insert menu.

Figure 14-22. Anatomical Graphics Menu Example

5. Select the desired category and press Set. The graphic box 
displays.

Figure 14-23. Anatomical Graphics Box Example

6. Select the graphic to be inserted to the template or import a 
bmp or jpg file from the removable media. Scroll the images 
using the arrow key. 

7. Select Appearance.

8. Select OK or Cancel.



Designing Your Own Template

LOGIQ V2/LOGIQ V1 – Basic User Manual 14-37
Direction 5610735-100 English Rev. 2

Insert Image

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the image.

4. Select image from the Insert menu and press Set. The 
Ultrasound Image Box displays.

Figure 14-24. Ultrasound Image Box

5. Type the Heading text, modify the box properties, and 
change the heading text font, as necessary.

NOTE: For no heading, type a Space in the Heading text.

To keep the monitor image appearance, the ratio of width to 
height (W:H) should be 4:3. So, basically 640:480 for large 
images and 300:225 for two side-by-side images.

6. Select OK or Cancel.
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Cardiac Studies Wall Motion Analysis

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the wall motion 
analysis and press Set.

4. Select Wall Motion Analysis from the Insert menu.

5. Select and set up the desired parameter.

• Bull’s Eye

Figure 14-25. Bull’s Eye Dialog Box

Figure 14-26. Bull’s Eye Report Example
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Cardiac Studies Wall Motion Analysis  (continued)

• Cut Planes

NOTE: The Cut Planes dialog box parameters are similar to the 
Bull’s Eye Dialog Box shown previously.

Figure 14-27. Cut Planes Report Example

• Score Table Box

Figure 14-28. Score Table Box Dialog Box

6. After you finish the setup, select OK or Cancel.
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OB/GYN (OB and GYN Only)

The OB Graph, Bar Graph and Anatomy can be entered into the 
Report.

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the graph or 
anatomy and press Set.

4. From the Insert menu, select OB/GYN. The selection menu 
displays.

5. Select the appropriate item as necessary. A dialog box 
displays.

Figure 14-29. Selection Menu

• OB Graph

Figure 14-30. OB Graph Dialog Box

a. Select the Measurement and Fetus Number.

b. Check Fetus Trending and Fetus Compare, if 
appropriate.

c. Modify the Layout, if necessary.

d. Select OK.
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OB/GYN (OB and GYN Only)  (continued)

• Bar Graph

Figure 14-31. Bar Graph Dialog Box

a. Select the exam and fetus number.

b. Modify the Layout, if necessary.

c. Select OK.

NOTE: The Bar Graph already contains default application 
measurements.



ReportWriter

14-42 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

OB/GYN (OB and GYN Only)  (continued)

• Anatomy

Figure 14-32. Anatomy Dialog Box

a. Type the Heading.

b. Select qualifiers from the pull-down menu.

c. Select “Add all” to copy all measurements to the right 
column

d. Check the box in front of the measurement you need in 
the left column and select “Add”. The select 
measurements copy to the right column.

e. To remove measurements you do not need, check the 
boxes in front of those measurements in the right 
column, and select “Remove” or “Remove all”.

f. If you want to modify the properties, select Box 
Properties and set required parameters.
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Measurements 

Insert a field to display the measurements. The measured 
parameters displayed in the measurement display field are 
configured.

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the measurement 
and press Set.

4. Select Measurements from the Insert menu and press Set. 
The Measurements Box displays.

Figure 14-33. Measurement Box

5. Type the Heading text, select the Filter Criteria and 
measurements from the tree, as necessary.

6. Select OK or Cancel.
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Text Fields 1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the text and press 
Set.

4. Select Text Field from the Insert menu and press Set. The 
Text Field dialog box displays.

Figure 14-34. Text Field Dialog Box

5. Type the Heading Text. If you do not need the heading, type 
a space.

6. Select Display item.

• Ref.Reason: Reason for Referral.

• Comments: Gets information from the Comment field of 
the Patient screen and the Exam Comment field of the 
Worksheet.

• Diagnosis.

• Free Text: 1 - 8

7. Specify the border of the Text Field and Font as necessary.

8. Select OK or Cancel. 

The text is saved automatically into the corresponding area 
selected on this dialog box.

Editing an existing text field:

1. Move the cursor to the Text Field to be edited.

2. Press Set twice. The Text Field dialog box displays.

3. Edit the heading, the settings, or font, as necessary.

4. Select OK or Cancel.
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Fixed Text

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the fixed text and 
press Set.

4. Select Text Field from the Insert menu and press Set. The 
Fixed Text dialog box displays.

Figure 14-35. Fixed Text Dialog Box

5. Type the text (e.g. hospital information, report title, or table 
title) and specify the border and font.

6. Select OK or Cancel.

Editing existing Fixed Text:

1. Move the cursor to the Fixed Text to be edited.

2. Press Set twice. The Fixed Text dialog box displays.

3. Edit the text, the border or font, as necessary.

4. Select OK or Cancel.
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Dropdown Text

1. Select Template to choose the Report Template.

2. Select Designer.

3. Place the cursor where you want to insert the Dropdown text 
and press Set.

4. Select Dropdown text from the Insert menu and press Set. 
The Dropdown Text dialog box displays.

Figure 14-36. Fixed Text Dialog Box

5. Type the Heading Text. If you do not need the heading, type 
a space.

6. Select Display item and input the dropdown list: input one 
item, select Add, then input another item. 

7. Specify the border of the Text Field and Font as necessary.

8. Select OK or Cancel. 

Editing existing Dropdown Text:

1. Move the cursor to the Dropdown text to be edited.

2. Press Set twice. The dropdown text dialog box displays.

3. Edit the heading, dropdown list, the border or font, as 
necessary.

4. Select OK or Cancel.
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Customize Menu

Page Color

1. To change the page color, select Page Color from the 
Customize Menu and press Set. The Color dialog box 
displays.

Figure 14-37. Color Dialog

2. Choose the desired color or create a new color.

3. Select OK or Cancel.

Table 14-6:  Customize Menu

Description

Page Color Changes the template color.

Preference The Preference menu for Archive Information field displays.
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Setting Preferences

To set preferences for the Archive Information:

1. Select Preferences from the Customize menu and press 
Set. The Preference Box displays. 

Figure 14-38. Preferences Box

2. Select the information to be modified and set the desired 
preferences.

3. Select OK or Cancel.

4. Save the template.
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Direct Report

Direct Report

You can use Direct Report to enter Comments, Diagnosis, and 
Referral Reasons at any time during the examination that will be 
part of the final report. The comments are reflected on the 
Report if the Report is configured for those parameters. 

1. Select Direct Rep. on the measurement Summary window. 

Figure 14-39. Measurement Window
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Direct Report  (continued)

2. The Direct Report displays on the left side of the screen.

Figure 14-40. Direct Report

a. Select the type of information

NOTE: Comments entered under Diagnosis appear in the 
Clinical Diagnosis section of the final report.    
Comments entered under Referral Reasons appear in 
the Referral Diagnosis section of the final report.

b. Create/insert pre-defined text

c. Text field

d. List of measurements completed 

The measurement results display on the Measurement 
Overview field.

Double Click: inserts value only for selected line, 
e.g. 1.66 cm

Shift + Double Click: inserts whole line for selected line, 
e.g. Renal L 1.66 cm 

e. Exits the Direct report
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Direct Report  (continued)

3. Select the appropriate parameter and type the free text with 
the alphanumeric keyboard or use Insert Text.

NOTE: You can configure the pre-defined text at the Utility Report 
screen.

a. Select Insert Text to display the Insert Text Window.

b. Use the Trackball and press Set to select the text to be 
inserted.

c. Double click the Set key. The selected text displays on 
the Direct Report.

Figure 14-41. Full Insert Text Window

• New: Enters the new text

• Edit: Edits the existing text

• Delete: Deletes the existing text

• More: Displays the Full Insert Text Window

• Close: Closes the insert text window

4. Move the cursor over the measurement result displayed in 
the overview window, and double click the Set key or Shift + 
Double Click Set key to insert the measurement. 

5. Select Done at the bottom of Direct Report to exit.

If you configure the field of comment, diagnosis, referral 
reasons or Measurement on the Report, the text and/or 
measurement results entered in the Direct Report are 
automatically displayed on the Report.
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Report Presets

Utility Report Page

You can edit the report template and text on the Utility Reports 
page.

Templates

Left Column: The list of all templates (Factory Default, User 
defined, etc.) 

Right Column: The list of templates displayed on the template 
list.

Figure 14-42. Report Template Tab
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Templates  (continued)

• To insert the template on the template list:

a. Select the application which you want to insert into the 
template from the pull-down menu above the right 
column.

b. Select the category (categories) and/or the template(s) 
in the left column by the check the box.

c. Select the right arrow to copy the template to the right 
column.

• To remove the template from the template list but not from 
the system):

a. Select the template in the right column.

b. Use the left arrow to remove the template from the right 
column.

• To edit the template or to make a new template:

a. Enter Utility -> Reports -> Templates tab.

b. Select the appropriate template in the left column.

c. Select Edit Template. The Template Designer page 
displays.

d. Edit the template and save or save as with a new name.

If you use Save As with a new name, the new template 
is added to the left column. See ‘Designing Your Own 
Template’ on page 14-24 for more information.

• To delete the template:

a. Select the template to be deleted.

b. Press Delete.

NOTE: The Predefined templates can not be deleted.
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Templates  (continued)

• To export the template:

a. Insert the removable media in the drive.

b. Move the cursor to “Export Templates” and press Set. 
The available user-defined templates display in the 
Export Templates window.

Figure 14-43. Export Templates

c. Select the template(s) to be exported.

NOTE: To select multiple templates, use the Ctrl or Shift keys.

d. Select the desired removable media under the Select 
Target Device field.

e. Select OK.

f. Press F3 to eject the media.

HINTS Export templates to removable media (CDs, DVDs, USBs) 
so, at a later time, you can import those templates to a 
system. Export only works on templates, not data.
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Templates  (continued)

• To import the template:

NOTE: Import only works on templates, not data.

a. Insert the removable media with the report template(s) 
to be imported.

b. Select Import Template. The Import Template window 
displays.

Figure 14-44. Import Templates

c. Select the Source Device from the pull-down menu. 
Select OK.

d. Press F3 to eject the media.

NOTE: Imported templates are stored in the User defined 
templates\General directory. 

• To move the template from the left column to the right, or 
from the right to the left:

a. Select the template to be moved.

b. Select the Right Arrow or Left Arrow button.

• To move the template up or down in the right column:

a. Select the template to be moved.

b. Press the Up Arrow or Down Arrow button.
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Comment Texts

You can edit the comment text on the Comment Texts tab.

Figure 14-45. Comment Texts Tab

• New: Enters the new comment.

• Edit: Edits the existing comment.

• Delete: Deletes the existing comment.

• Move up/Move down: Moves the comment up or down.
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Backup/Restore Report Templates

NOTE: Only backup and restore User defined templates. For system 
predefined templates, import /export templates via Utility --> 
Reports.

Backup moves user defined templates to removable media 
(CDs, DVDs, USBs).

Restore moves user defined templates, that were backed up 
onto media, to the LOGIQ V2/LOGIQ V1 with the same software 
version.

NOTE: To move reports with patient data, use Backup/Restore Report 
Archive and Patient Archive.

To backup the report template:

1. Insert the media.

2. Select Utility on the keyboard.

3. Select System and select the Backup/Restore tab.

4. Select the media.

5. Check User Defined configuration box of the Backup field.

6. Select Backup.

7. After Backup complete, press F3 to eject the media.

To restore the report template:

1. Insert the media.

2. Select Utility on the keyboard.

3. Select System and select Backup/Restore tab.

4. Check Report Template box of the Detailed Restore of User 
Defined.

5. Select Restore.

6. After the system reboot, select Utility and Reports.

7. Select the Template tab.

8. Select the appropriate template (See ‘Templates’ on 
page 14-52 for more information.)

For preset specifics, see Chapter 16.
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Chapter 15

Recording Images

Describes how to record images. 
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Introduction

Overview

A typical workflow for connectivity might be as follows (this setup 
varies by each user setup): 

1. Select the dataflow, worklist for example. 

2. Start a new exam. Select the patient. 

3. Perform the patient scan.

4. Store images as single image or multi-frame CINE Loops 
and Raw DICOM data via the assigned key. 

5. Check the DICOM Job Spooler via F4 to verify delivery. 

6. End the exam. 

7. Permanently store images via the Patient menu. 
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Overview  (continued)

During an examination, the operator stores data, images and 
cineloops for immediate purposes. The LOGIQ V2/LOGIQ V1 
includes an integrated patient archiving system for data and 
image storage.

The LOGIQ V2/LOGIQ V1 enables also storing of data and 
images to external databases (Network Server, removable 
media).

Dataflow combines archive, data, DICOM, and onboard records 
into one coherent workflow. Destination devices are configured 
and assigned to the print keys. You select the appropriate 
dataflow (Portable, etc.) according to your requirements. You 
manage the patient database (local, shared, or via a worklist 
broker). 

• DO NOT use the internal hard drive for long-term image 
storage. Daily backup is recommended. External storage 
media is recommended for image archive.

NOTE: DICOM images are stored to external media storage 
devices separately from patient data, which also needs to be 
backed up to a dedicated database-formatted external 
storage media. 

• If working off-line with a dataflow pointing to a DICOM 
server, the images stored during the examination may have 
to be manually resent in the DICOM spooler when 
reconnecting the unit. Resend all jobs that failed or are on 
hold.

In addition, stored images and cineloops can be saved to a 
removable media in the standard formats JPEG, MPEG, AVI 
and DICOM.

• You need to set up a protocol for locating images stored to 
external storage media for easy recall.

• GE IS NOT responsible for lost data if you do not follow 
suggested back-up procedures. GE WILL NOT aid in the 
recovery of lost data. 

Refer to Customizing your system chapters for instructions on 
setting up your system’s connectivity. 
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Adding Devices

To add a destination device (printer, worklist server, etc.) to this 
system, see ‘Device’ on page 16-71. 

To verify a DICOM device, see ‘Device’ on page 16-71.

Adding a Dataflow

To add a new dataflow to this system, see ‘Dataflow’ on 
page 16-89.

Adding Devices to a Print Button

To add devices/dataflows to a print button, see ‘Button’ on 
page 16-90.

Formatting Removable Media

To format removable media, see ‘Formatting removable media’ 
on page 16-92.
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Image/Data Management

Reviewing Patient Images

Please refer to Chapter 4 for the detailed information on the 
following:

• Retrieving and editing archived information

• Searching for a patient

• Reviewing a patient exam

• Reviewing an image

• Deleting a patient, exam, or image

Backup/Restore Images

Please refer to ‘Backup and Restore’ on page 16-21 and 
‘EZBackup and EZMove’ on page 16-24 for detailed information.
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Clipboard

The clipboard displays thumbnail images of the acquired data 
for the current exam. Images from other exams are not 
displayed on the current patient’s clipboard. 

All of the images can be viewed in the Active Images screen, 
available from the display or from the Archive menu. 

 Figure 15-1. Clipboard

Saving the image /cine to the Clipboard

The active image/cine is stored and placed on the clipboard 
when you press the Store key (this assumes that you have 
already set up the Store key to do this). The clipboard contains 
preview images with enough resolution to clearly indicate the 
contents of the image. CINE Loops are indicated by a movie clip 
icon. 

The clipboard fills from left to right, starting in the left-hand 
corner. Once the row is full, the next image stored starts to fill a 
‘second’ row (the first row disappears from the clipboard display, 
with the second row now becoming the first row). 

Previewing Clipboard Images

1. Select the Cursor key to obtain a cursor arrow.

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. An enlarged preview of the image is displayed on the 
left-hand side of the monitor. 

Recalling Images from the Clipboard

To recall images from the clipboard, 

1. Select the Cursor key to obtain a cursor arrow. 

2. Move the Trackball to position the pointer over the 
clipboard image you want to recall. 

3. Press Set to recall the image. 
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To delete an image from the clipboard

1. Select the Cursor key to obtain a cursor arrow.

2. Place the cursor on the clipboard image you want to delete, 
then press Set to select the image.

3. Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm 
the action to perform.

4. Select Yes.

Storing Images and Cineloops

Images and cineloops that are stored during a current 
examination are displayed as thumbnails on the clipboard.

When an image is stored, all the additional information that is 
displayed is saved with it (i.e. probe and application selected, 
image setting, annotations or measurements).

See ‘Print Control’ on page 16-55 for detailed settings related 
storing image/Cine.

The image archive is set by the dataflow selected (See 
‘Dataflow’ on page 16-89 for more information.)

Storing an image

To store an image, 

1. While scanning, press Freeze. 

2. Scroll through the CINE Loop and select the desired image. 

3. Press the Store key. 

The selected image is stored (per your preset instructions) 
and a thumbnail is displayed on the clipboard. 

Storing a CINE Loop

A CINE Loop is a sequence of images recorded over a certain 
time frame. The stored CINE Loops are displayed 
chronologically on the clipboard. 

CINE Loops can be stored at any time during scanning. You can 
choose to preview the CINE Loop before storage and save the 
CINE Loop directly, as described below. 

Refer to ‘Print Control’ on page 16-55 about the setting.
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Previewing and Storing a CINE Loop

1. While scanning, press Freeze. 

2. Determine the best CINE Loop to store. 

3. Play the CINE Loop to review it. 

4. Press the Store key. 

Depending on whether the system has been configured to 
enable or disable “Preview Loop before store” (see ‘Print 
Control’ on page 16-55), the following procedures enable the 
CINE Loop to be stored directly. 

Storing a CINE Loop Without Preview

If “Preview clip before store” is disabled, 

1. While scanning, press the Store key. 

2. The last valid CINE Loop is stored in the archive and a 
thumbnail is displayed on the clipboard. 

3. Scanning resumes immediately.

Storing a CINE Loop With Preview

If “Preview clip before store” is enabled, 

1. While scanning, press the Store key. 

2. The last valid CINE Loop is previewed. 

3. Adjust the CINE Loop, as necessary. 

4. Press the Store key. 

The movie clip thumbnail is displayed on the clipboard. 
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Save As

Images and cineloops can be saved to a removable media or 
Network storage to View on a Windows PC in the following 
standard formats:

• Still images: JPEG, DICOM and RawDICOM (Raw data + 
DICOM)

• Cineloops: WMV, AVI, DICOM and RawDICOM (Raw data + 
DICOM)

Images can also be stored as MPEG format as described on 
‘MPEGvue’ on page 15-22

To save images:

1. Insert the media into the drive or connect the USB drive to 
the system.

NOTE: If you have not formatted the media, the media will be 
formatted when you select Save As.

2. On the scan screen, press the Cursor key. The arrow cursor 
displays. 

3. Place the cursor on the image or CINE Loop in the clipboard 
to be saved and press Set/ B Pause. The image displays on 
the screen. 
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Save As  (continued)
4. Select save as icon in the lower, right-hand corner of the 

screen. The SAVE AS menu appears.

NOTE: If you save the image as an .avi file or .wmv file, run the 
CINE Loop before you select Menu. 

NOTE: You can not save 2D cineloop image as a .jpeg file.

Figure 15-2. Save As Menu

5. Select the media from the Save in archive pull-down menu.

6. Folder name: You can create the folder for the saved file. 

• Default is blank (The folder is not created)

NOTE: You can not edit the folder name when the folder is opened.

7. File name: The name of the file is automatically filled in, but 
you can change the file name in the File name field. 

NOTE: DO NOT use the following special characters when saving 
images: !, @, #, $, %, ^, &, *, (, ), |, :, ;, <, >, ?, /, ~, [, ], {, }. 

8. Store: Select Image only or Secondary capture. 

• Image only: Saves only the ultrasound image area.

• Secondary capture: Saves the ultrasound image area, 
title bar, and scan information area. Not available for 
DICOM or RawDICOM images. 

NOTE: If you select “WMV” for Save as type, Secondary capture is 
disabled.
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Save As  (continued)

9. Compression: Specify Compression. 

• None

• Rle

• Jpeg

• Jpeg2000

NOTE: If you select “WMV” for Save as type, Compression is 
disabled.

10. Quality: Specify image quality (between 10-100). A high 
quality setting gives a lower compression. 

NOTE: If you select “WMV” for Save as type, Quality is disabled.

11. Save as type: Select one of the following. 

• RawDICOM: saves the still image or CINE Loop in both 
GE raw format and DICOM format. 

• DICOM: saves the still image or CINE Loop in pure 
DICOM format. 

• AVI: Saves the CINE Loop in avi format. 

NOTE: Store “Image Only” is available if you select AVI for 
Type.

• JPEG: Saves the still image in jpeg format. 

• JPEG2000: Saves the still image in JPEG2000 format.

• WMV: Saves the CINE Loop in wmv format

NOTE: WMV type is only available with CINE loop image.

If you want to see all data saved onto the HDD, select 
“AllFiles(.*)”. All the data names display in the window.

NOTE: The Save button is disabled when you select “AllFiles”. 
Select each Save as type when you want to save data.

12. Press Save. 

The images are saved directly to the media whenever you 
press Save.

If you select “Transfer to CD/DVD”, the images are saved to 
the HDD buffer.

• If free space of the destination is not enough to save all 
selected images, then warning dialog appears.

• If the same file name is existed in the destination, the 
warning dialog displays.

OK: Overwrite file and continue to save selected 
images.

Cancel: Do not save images.
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Save As  (continued)

13. Repeat this step for as many images/clips to be saved.

14. After you have added all of the images/loops you want to 
save and are ready to write to the CD/DVD, transfer all the 
images at the same time. Press Save As --> Transfer To 
CD/DVD. 

A progress bar lets you know that the “Media transfer is in 
progress.” 

If total transfer size is bigger than CD/DVD free space size, 
then only the files that can be copied to CD/DVD are 
transferred. After the copy is finished, the warning dialog 
displays. Warning dialog shows total required file size and 
transferred file size. Press OK and you need to change CD/
DVD and press Transfer to CD/DVD again.

15. If you do not want to save the image to CD/DVD, select 
“Delete Files for Transfer” All images are deleted.

16. Press F3 to eject the media. Select CD/DVD Recordable or 
USB drive. 

NOTE: The Report Save As feature is somewhat different. As soon as 
you select to save a report, the report is saved. (CD/DVD) 

NOTE: Verify the saved image works correctly on the Windows PC. If 
the image does not work, please save it again on the LOGIQ V2/
LOGIQ V1. 

Table 15-1:  Save As Formats

.avi format .wmv format MPEGvue in Data Transfer

B, B+CF Multi frames Multi frames Multi frames

B+Dopploer Single frame Multi frames Single frame

B+M Single frame Multi frames Single frame

3D Multi frames N/A Single frame
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’SaveAs’ Images

You can select the images at one time which you want store by 
SaveAs in the Active Image screen.

Features are almost same as usual SaveAs. See ‘Save As’ on 
page 15-9 for more information.

NOTE: We suggest that you save the images page by page with 
“SaveAs” Images in Active Images. It takes time if you have 
many images or raw data.

NOTE: If the image has a filmstrip icon, this indicates a CINE Loop, 
which gets saved as a .wmv file; single images are saved as a 
jpeg file.

NOTE: ’SaveAs’ Images function doesn't support images which are 
query/retrieved.

1. In the Active Image screen, place the cursor on the image or 
CINE Loop to be saved and press Set. You can select multi 
images with multi pages.

 Figure 15-3. Active Screen
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’SaveAs’ Images  (continued)

2. Press ’SaveAs’ Images on the monitor display. The SaveAs 
menu appears.

Figure 15-4. ’SaveAs’ Images Menu

3. Ensure that Jpeg&WMV is selected, then press Save. 

If you are saving to USB, images are transferred as soon as 
you press Save; if you are saving via Transfer to CD/DVD, 
you need to save images to the hard drive, then images are 
transferred when you select Transfer to CD/DVD.
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Storing Images with More Resolution

To store images with more resolution than is available with the 
JPEG selection, select Save As and select AVI as the Save As 
Type. You can save single images as .avi files. 

Table 15-2:  Store Options

Image Type Store as Image Only Store as Secondary Capture

CINE Loop Gives you a loop of just the image (no 
title bar and scan information).

Gives you a single image of the video 
area. DO NOT DO THIS BECAUSE 
YOU DO NOT KNOW WHICH IMAGE 
FROM THE LOOP THAT YOU ARE 
GETTING. 

Still Image Gives you a single image (no title bar 
and scan information). 

Gives you a single image of the video 
area. 
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Data Transfer

The user can select and access the Exam Transfer services 
from the Exam Data Transfer screen.

• Import

• Export

• Worklist

• MPEGvue

• Q/R (Query/Retrieve)

NOTE: Ensure that all patients are exported or backed up BEFORE 
deleting them.

Figure 15-5. Exam Data Transfer Screen
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Export/Import 

To move exams from one Ultrasound system to another system 
or to back up/retrieve exam information, you need to export/
import exam information. 

NOTE: Both database information and images are exported. No data is 
deleted from the local archive when exporting data. 

NOTE: Export/Import patient records may take more than ten (10) 
minutes. Please allow sufficient time to export/import patients. 

NOTE: You MUST verify the media you use BEFORE performing 
Export/Import. You must do this once each session. If you 
encounter problems, eject the media and then re-insert the 
media; then try the Export/Import again. 

NOTE: We STRONGLY recommend that you verify files on Eject when 
using Export.

Exporting Data

To export an exam(s) to a compatible Ultrasound system:

1. Format and label the removable media. Answer Yes/OK to 
the messages. 

NOTE: The system formats the unformatted CD-R/DVD-R 
automatically when you select Export on the data transfer 
screen. 

2. Press Archive and select Data Transfer.

3. The Data Transfer screen is displayed. Select Export.

4. “Local Archive-Int.HD” displays on the Transfer From 
pull-down menu and the patient list included in the Local 
Archive displays.
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Exporting Data  (continued)

5. Select the destination at the Transfer To pull-down menu.

6. Select the patient(s) to export by using the Transfer From 
search field (the upper field). 

You can use Windows commands to select more than one 
patient. 

To select a consecutive list of patients, click the cursor on 
the first name, move the cursor to the last name, then press 
and hold down the Shift + Set key to select all the names.

To select a non-consecutive list of patients, click the cursor 
at the first name, move the cursor to the next name, then 
press and hold down the Ctrl + Set key, move the cursor to 
the next name, then press and hold down the Ctrl + Set key 
again, etc. 

You can also search for patients via the Search key and 
string. 

Or, use Select All to select all patient.

NOTE: You need to use your best judgment when moving patients’ 
images. If there are lots of images or loops, then only move 
a few patients at a time. 

7. Press Transfer. The progress bar displays during the 
transfer.

8. Once the transfer is complete, press F3 to eject the media. 
Specify that you want to finalize the media. 

After performing an Export, the system reflects that this 
operation was successfully completed; however, it is ALWAYS a 
good idea to verify that there was no corruption to the backup/
export media during this process. 

To verify that the data was successfully transferred to the media, 
press F3, then select “Finalize” --> “Yes and Verify Files.” If there 
was any corruption to the media during an operation, the 
message, “An error occurred on the last disk. Please discard it 
and start over.” appears. In this case, please redo the operation 
with new media. 

NOTE: To display exported DICOM or Raw DICOM images on a PC, 
you need the dedicated viewer.
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Importing Data

To import an exam(s) to another Ultrasound system:

1. At the other Ultrasound system, insert the media. 

2. Press Archive and select Data Transfer.

3. The Data Transfer screen displays. Select Import.

4. Select the media from the Transfer From pull-down menu.

5. The Transfer From search field shows the patients available 
for import from the removable media you just loaded onto 
the system. 

6. Select the patient(s) or the exam(s) from the list to be 
imported.

7. Press Transfer. The progress bar displays during the 
transfer.

8. Please wait for the patient information to be copied to this 
Ultrasound system. Informational messages appear while 
the import is taking place. 

9. Press F3 to eject the media.

NOTE: Use Import to restore EZBacked up and/or EZ Moved images. 

NOTE: You can retrieve from the media to the Local HDD, playback, or 
process exam information on the system as Raw Data.
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Query/Retrieve (Search and retrieve the data from DICOM device)

NOTE: For Query/Retrieve to find a patient, the patient MUST have a 
Patient ID. 

NOTE: Before you retrieve data from the Worklist server, make sure 
that default IP address is input in the Default Gateway field in 
Utility -> Connectivity -> TCP/IP. 

Query

1. Press Archive and select Data Transfer. The Data Transfer 
screen displays.

2. Select Q/R. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only “Local Archive - Int.HD” is enabled for Transfer To.

3. Select the Query/Retrieve server from the Transfer From 
pull-down menu.

NOTE: The server is configured in the Utility screen. Multiple 
servers are able to be configured.

4. Press Query in the Transfer From section. The Query is 
performed.

5. The server’s patient list displays.

NOTE: Press Query again to refresh the list.

Retrieve

1. Select the patient(s) or the exam(s) to be retrieved from the 
patient list.

2. Select Transfer. Retrieve the data from the Query/Retrieve 
Server. The progress bar displays during the transfer.
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Worklist (Search and retrieve the Patient/Exam information)

NOTE: Before you retrieve data from the Worklist server, make sure 
that default IP address is input in the Default Gateway field in 
Utility -> Connectivity -> TCP/IP. 

1. Press Archive and select Data Transfer. The Data Transfer 
screen displays.

2. Select Worklist. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only “Local Archive - Int.HD” is enabled for Transfer To.

3. The Worklist used last time is displayed on the monitor 
display. Select refresh to refresh the list or select another 
Worklist server from the Transfer From pull-down menu.

NOTE: The worklist server is configured in the Utility screen. 
Multiple servers are able to be configured.

NOTE: You can configure whether the auto-refresh worklist has 
been enabled/disabled in the Utility screen. The system 
automatically refreshes the list when the exam data transfer 
accesses the Worklist server or changes the Worklist 
server.

4. Select the patient(s) or the exam(s) from the list.

5. Press Transfer. The progress bar displays during the 
transfer.
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MPEGvue

You can see the exam data on the Windows PC by using 
MPEGvue.

NOTE: If you want to label the removable media, format it before use. 
The system formats the unformatted CD-R/DVD-R automatically 
when you select MPEGvue on the data transfer screen. 

1. Insert the removable media.

2. Select Archive and select Data Transfer. The Data 
Transfer screen displays.

3. Select MPEGvue. The Patient list, which has images in the 
Local Archive, displays in the Transfer From section.

Start the media formatting automatically except USB HDD. 
Label the media with “YYYYMMDD_#”.

NOTE: Only “Local Archive - Int.HD” is enabled for the Transfer 
From.

4. Select the media from the Transfer To pull-down menu.

NOTE: Select Removable CD Archive if you use CD-R or DVD-R.

CAUTION DO NOT transfer more than 50 patients at one time.

CAUTION DO NOT use lossy compression images, such as JPG or 
MPEG images, for diagnosis.

CAUTION MPEGvue function is NOT compatible with other LOGIQ series 
products. Do NOT share the same USB Drive for MPEGvue 
between LOGIQ V2/LOGIQ V1 and other LOGIQ series 
products.
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MPEGvue  (continued)

5. Select the patient(s) or the exam(s) from the list.

NOTE: If you press Clear in the Transfer From and Transfer To 
section, all the search criteria clears and the list is refreshed 
accordingly.

NOTE: Trying to save 3D loops using MPEGvue, the 3D loops are 
saved as still images. Use “Save As” to save 3D loops. 

6. Press Transfer. The progress bar displays during the 
transfer.

Displays the check mark in the Copied field of the 
completed patient.

Figure 15-6. Completed patient

When the message “Not enough free space” displays during 
MPEGvue, 

• CD-R/DVD-R: Please change to a new media. 

• USB HDD/USB Flash Drive: Backup the current data in 
the USB device to the other media and clear the USB 
device. 
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MPEGvue  (continued)

If the following dialogue and message displays during 
MPEGvue, reduce the number of exams to gain space, and 
perform MPEGVue once again to a new media (CD-R/
DVD-R) or the USB device.

Figure 15-7. Error Dialogue

7. When the transfer is completed, select Exit to return to the 
scan screen and then eject the media.

NOTE: The capacity of media (number of patients) and the writing 
time depends on the data size of each patient. If you try to 
save an image larger than 1GB using MPEGvue, it may take 
a few hours to save the image. 

NOTE: Before you read the media on the PC, finalize the media on the 
LOGIQ V2/LOGIQ V1.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

CAUTION DO NOT use “Verify” when ejecting the CD/DVD if you 
transferred multiple patients to the media using MPEGVue.
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MPEGvue  (continued)

On your PC with Windows 2000/XP

An MPEG exam can be read from any computer with 
Windows 2000/XP, provided that DirectX 8.1 or later and 
Windows Media Player 7.1 or later are installed. 

NOTE: Verify the saved image works correctly on the Windows PC. If 
the image does not work, please save it again on the LOGIQ V2/
LOGIQ V1.

If a warning message displays, press OK to continue.

• Windows PC with Windows XP + SP2

All media is readable.

• Windows PC with Windows XP + SP1

All media is readable. 

But DVD-R with data greater than 4GB are not readable. An 
issue report from Microsoft states that SP2 fixes this 
problem. Please refer http://support.microsoft.com/kb/
329112/EN-US/.

• Windows PC with Windows 2000 + SP4

Only CD-Rs are readable. DO NOT perform MPEGvue 
using a DVD-R/-RAM.

• “Active-X” security block on Windows XP + SP2

When attempting to view an MPEGVue exam on a PC which 
is running on WindowsXP with Service-Pack 2, the image 
remains blank if you click on a thumbnail.

If this occurs, do the following steps:

• When running MPEGVue and you click on one of the 
clipboard thumbnail images, the following message 
appears:

“To help protect your security, Internet Explorer has 
restricted this file from showing active content that could 
access your computer. Click here for options”

• Place the mouse over the message “To help protect 
your security...” and click over it.

• Select “Allow Blocked Content...” in pop-up menu.

• A security warning message appears. Select “YES”.

The Exam should start to display normally at this point.

NOTE: Every time you attempt to view another exam you will 
need to repeat the procedure described above.
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MPEGvue  (continued)

On your PC with Windows Vista

When you try reviewing MPEGvue on a Windows Vista-based 
computer, the dialog, “An important update for MPEGVue Player 
Software Component (vX.X.XX) is available for this computer...” 
displays. Press No on the dialog and eject the medium.

Then do the following steps to install the MPEGVue Player 
Software Component with administrative rights.

1. Click Start, and then click Control Panel.

2. In the Control Panel, click User Accounts And Family 
Safety.

3. Click User Accounts.

4. Click Turn User Account Control On of Off.

5. The message, “Windows needs your permission to 
continue” displays. Press “Continue.”

6. Uncheck the checkbox for User Account Control ((UAC) 
To Help Project Your Computer, and then click OK.

7. When prompted, restart your computer.

8. Insert the medium with MPEGVue data. The dialog “An 
important update for MPEGVue Player Software Component 
(vX.X.XX) is available for this computer...” displays. Press 
Yes.

9. The MPEGVue Player Software Component will be 
installed. When the install is done, check the checkbox for 
User Account Control (UAC) To Help Protect Your 
Computer according to the steps 1 - 6 above.

10.  You can now review MPEGVue on your computer.
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MPEGvue  (continued)

On your PC with Windows 7

When you try reviewing MPEGvue on a Windows 7-based 
computer, the dialog, “An important update for MPEGVue Player 
Software Component (vX.X.XX) is available for this computer...” 
displays. Press No on the dialog and eject the medium.

Then do the following steps to install the MPEGVue Player 
Software Component with administrative rights.

1. Click Start, and then click Control Panel.

2. In the Control Panel, click User Accounts And Family 
Safety.

3. Click User Accounts.

4. Click Turn User Account Control On of Off.

5. Note the original notify level and change notify level to 
“Never Notify”.

6. The message about confirmation, press Yes.

7. Press OK.

8. Restart your computer.

9. Insert the medium with MPEGVue data. The dialog “An 
important update for MPEGVue Player Software Component 
(vX.X.XX) is available for this computer...” displays. Press 
Yes.

10. The MPEGVue Player Software Component will be 
installed. When the install is done, change notify level 
according to the step 1 - 5 of the above.

11.  You can now review MPEGVue on your computer.
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MPEGvue  (continued)

NOTE: Select “MPEG4 Windows Media Format (*.wmv)” when you 
save the Cine image from CD/DVD to the HDD while reviewing it 
on your PC.

NOTE: Measurement graphics from the exam performed on the system 
are maintained with the MPEG exam.

1. To read MPEG exams stored on a CD-R/DVD-R:

• Insert the MPEGVue CD-R/DVD-R in the computer 
DVD drive. The MPEGVue Patient list is displayed.

To read MPEGVue exams stored on other media:

• Insert the media containing the MPEG exams and 
double-click on the file Start_MPEGvue.bat. The 
MPEGVue Patient list is displayed.

Figure 15-8. Patient list

CAUTION DO NOT modify the folder name and the folder configuration of 
MPEGvue which is created in the media.
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MPEGvue  (continued)

2. Select the desired examination date to display the images. 
The MPEGVue screen is displayed.

 Figure 15-9. MPEGvue screen

1. Clipboard: select the image to display

2. Selected image

3. Cineloop

4. Single frame image

5. Freeze/run cineloop

6. Scrolling tool when in Freeze

7. Display full screen

8. Save image as .wmv, .bmp, jpeg or .avi

9. E-mail support

10. Display previous/next image

11. Display the MPEGVue patient list

12. Exit
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MPEGvue  (continued)

E-mail support

Sending images or examinations by e-mail.

NOTE: E-mail support and a desktop icon cannot be used on a 
non-English PC.

The selected image or the entire examination can be sent by 
e-mail as an attachment, providing the computer has a mail 
client application (e.g. MS Outlook, MS Outlook Express).

To send an image

1. Select the image to send on the clipboard and select the 
e-mail button. The e-mail dialogue window displays.

2. Check Send current image. The e-mail address window 
displays.

3. Select an existing address or enter a new address. Up to 10 
addresses can be stored.

4. Select Send. 

5. The e-mail with the image is sent and a Confirmation 
window displays. Select OK.

The person receiving the e-mail can open the image in Windows 
Media Player.
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E-mail support  (continued)

To send an examination

Examinations sent by e-mail as attachments are 
zip-compressed, encrypted and password protected. If the size 
of the exam is too large to be sent as a single attachment, it is 
divided into several zip file attachments and sent in several 
e-mails.

1. Open the examination to send in MPEG viewer and select 
the e-mail button. The e-mail dialogue window displays.

2. Check Send current exam. The e-mail address window 
displays.

3. Select an existing address or enter a new address.

4. Select Send. The Password window displays.

5. Enter a password and select OK. The exam is sent and a 
confirmation window displays. Select OK.

To open an MPEGvue exam from an e-mail

1. In the MPEG viewer press the E-mail button. The E-mail 
dialogue window is displayed.

2. Check Receive exam. The Password window is displayed.

3. Enter the password and select OK. The exam is 
uncompressed and opened in the viewer and the E-mail(s) 
containing the MPEG examination is deleted.



Recording Images

15-32 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Send To (Send the image to the DICOM Device)

“Send To” sends the selected exam for a patient and to 
interactively Send-To the exam to a destination DICOM device 
configured on the system. An exam in this case includes its 
images and any corresponding Structured Report.

1. Search and select the patient and select Folder View. The 
Exam View screen displays. 

2. Select the exam which has the images and press Send to.

Figure 15-10. Send To

NOTE: You can only select “Local Archive - Int.HD” for Workflow.

3. The “Send To“ Dialogue box displays. 

Select the destination device and press OK.

Figure 15-11. Send To Dialogue Box

NOTE: The destination device is configured in the Utility screen. 
Multiple devices are able to be configured.

The successful/unsuccessful message is displayed at the 
bottom of the screen.



Image/Data Management

LOGIQ V2/LOGIQ V1 – Basic User Manual 15-33
Direction 5610735-100 English Rev. 2

Selectable Send To

“Selectable Send To” sends the selected images for an exam 
and to interactively Send-To the exam from Local Archive or 
DICOM Read to a destination DICOM device configured on the 
system.

1. Select a patient or an exam in the Archive menu.

2. Go to Active Images.

3. Select an image (images) and press Send To. Send To 
Dialogue displays

NOTE: If the image is not selected, warning dialog is displayed and 
no image is sent. 

4. Select a destination from pull-down menu and press OK.

“Selected image(s) is (are) send to” message displays on 
the status bar.

Figure 15-12. Selectable Send To Dialogue Box
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Using the DICOM Spooler

To monitor/control DICOM jobs, press F4. You can view, resend, 
redirect, and delete images from the DICOM spooler by 
selecting a job, then specifying the action to be performed on 
this job. 

NOTE: If you find a failed job(s) in the Spooler, please remove the failed 
job(s) from the Spooler. 

Table 15-3:  Spooler status description

Status Description

Hold Waiting for user activity. Select Resend or Send-To to 
complete the job. 

Pending Waiting for the previous job(s) to finish (a previous job may be 
Active or Pending).

No user interaction required.

Append Not completed. 

Example 1: Direct Storing job. Waiting for more images or the 
end of the exam (by selecting New Patient or End Current 
Patient). 

Example 2: Print job with 3x3 images has only 8 images. 
Waiting for one more image or the end of the exam (by 
selecting New Patient or End Current Patient).

Active Signifies network activity (or connection attempt).

Success Sent successfully.

Failed Unsuccessful job attempt. Job stays in spooler. Select Retry 
or Delete to complete the job.

Done Finished successfully.
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External drives 

Removable media

Removable media can be used for the following purposes:

• Long-term image storage: the final destination of the 
images, after they are moved out of the system hard disk by 
using the EZBackup/EZMove (see ‘EZBackup and EZMove’ 
on page 16-24).

• Backup of patient database and system configuration 
presets (see ‘Backup procedure’ on page 16-21)

• Export to copy a set of patient records to a third party 
DICOM review station.

• MPEGVue: review exported images on a Windows 
computer (see ‘MPEGvue’ on page 15-22).

• Copy of system configuration presets between to units using 
the Backup/Restore feature (see ‘Preset synchronization’ on 
page 16-23).

• SaveAs: Save images as JPEG, WMV, AVI, DICOM and 
RawDICOM for review on a standard Windows computer.

About removable media and long-term image storage

If CD/DVD is used, it is recommended to use Archive Grade or 
Medical Grade CD/DVD.

No matter which media is used, it is always highly 
recommended to make a backup of the media, which is the 
responsibility of the customer.

HINTS Keeping your media disc in an original media case or caddy all 
the time will prevent it from becoming dirty or damaged.
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DVD Drive

The DVD drive (Standard) is an option and can be connected via 
USB ports. 

You can use these to perform software upgrades, image 
archiving and service diagnostics.

You can use the following media for the multi-drive:

• CD-R

• DVD-R

Recommendation concerning CD and DVD handling

To avoid data loss, never touch the recordable surface of a disk. 
Handle the disk only by the outer edge. Do not place it face 
down on a hard surface. Fingerprints or scratches will make the 
disk unusable. Before usage, verify that the disk surface has no 
visible scratches. If there are any scratches, do NOT use the 
disk.

Insert a media

Insert a media with the eject button on the DVD drive. 

CAUTION DO NOT use or attempt to format CD-RW, DVD+R, DVD+RW 
or DVD-RW on the LOGIQ V2/LOGIQ V1 DVD Multi-Drive.

CAUTION Due to the variety of disk types, we cannot guarantee that 
every media is available.

CAUTION When you put a media into the DVD drive, please make sure 
the media is placed in the right position. If the media is not 
placed in the right position, the media may be damaged.

CAUTION Make sure that the Disk tray is securely placed in each device 
during system operation. Mechanical damage may occur if 
other objects hit the tray.
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Eject a media

1. To eject a media, always press F3. DO NOT use the eject 
button on the drive. 

2. The Eject device menu is displayed. Select CD/DVD 
Recordable.

3. When ejecting a media, you are prompted if you wish to 
finalize the disk. If you do not finalize the disk, you can add 
files to the media at a later time. However, you may not be 
able to view the files stored on this disk with a standard PC. 
Finalizing a media, allows you to view these files using most 
standard PCs.

To verify that the data was successfully transferred to the 
media, Press F3, then select “Finalize” --> “Yes and Verify 
Files.” If there was a corruption to the media during an 
operation, the message, “An error occurred on the last disk. 
Please discard it and start over.” appears. In this case, 
please redo the operation with new media.

NOTE: When you press F3 with a blank media inside the DVD 
drive, the finalization menu displays. You can select “Yes” or 
“Yes and Verify Files”, but the system ejects the media 
without doing anything. 
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USB Hard Disk Drive/USB Flash Drive/SD card

USB Ports and SD card port

You can use the 2 general external USB ports and 1 SD card 
port on the left side for USB flash drives and SD card.

Figure 15-13. USB ports on the left side

1. 2 general external USB ports

2. 1 SD Card port

Cautions and Warnings

WARNING DO NOT use the USB Hard Disk Drive for patient storage. The 
USB HDD is not considered a permanent storage device.

If you connect the USB HDD to a virus-infected computer, the 
USB HDD may also be infected with a computer virus.

CAUTION Before removing the USB drive from the USB port, press Eject 
(F3) and select USB Drive from the pull-down menu. 
Disconnect the USB drive after the success dialogue is 
displayed. If the unsuccessful dialogue is displayed, retry after 
a while.

CAUTION DO NOT plug in TWO Bus-powered USB Drives at the same 
time.

CAUTION When exporting a large quantity of patient data to the 
USB-HDD, the system may crash. If this occurs, the export is 
not completed properly. First, delete the data remaining in the 
USB-HDD, and then try again with a smaller number of 
patients.
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Cautions and Warnings  (continued)

NOTE: Do not insert USB Memory devices (hard drives or flash drives) 
that contain multiple partitions into the scanner. Use single 
partitioned USB Drives.

NOTE: Some USB memory device manufacturers allow for executable 
partitions or ship pre-formatted new USB memory devices with 
multiple partitions pre-configured. BEFORE inserting any 
memory device into the scanner, insert it into a PC or MAC to 
verify that there is only a single partition. If multiple partitions 
exist, contact the USB manufacturer for the steps in reformatting 
the memory to a single partition.

Formatting the USB Flash Drive

NOTE: Before using the USB flash drive, format it in Utility -> 
Connectivity -> Removable media.

To format the USB Flash Drive

1. Insert the USB Flash Drive into the front USB port. 

2. Select Utility--> Connectivity--> Removable Media. 

3. Select USB Drive from the Removable Media pull-down 
menu. 

4. Type the USB Flash Drive label. 

5. Press Format. 

CAUTION If a problem occurs while exporting to the USB-HDD, such as a 
crash, the export may not have completed. Try again with a 
smaller number of patients.

CAUTION DO NOT Disconnect the USB HDD when performing EZMove 
on the system.

CAUTION DO NOT use “Select All” when you export the patient data to 
the USB-HDD.
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Eject a USB Flash Drive/USB HDD

1. To eject a removable media, always press F3. DO NOT use 
the eject button on the drive. 

2. The Eject device menu is displayed. Select the relevant 
media.

3. Select USB Drive from the pull-down menu to disconnect 
the USB Drive. Disconnect the USB drive after the success 
dialogue is displayed. 

Remove the USB Drive from the USB port. 

NOTE: If the unsuccessful dialogue is displayed, retry after a while.

NOTE: Verify is NOT available on Flash Drives or Hard Disk Drive 
media.

MPEGvue (Data Transfer)

To transfer a patient/exam to the USB Flash Drive or USB HDD, 

1. Insert the USB Flash Drive into the USB port. 

2. On the Archive menu, select Data Transfer, then 
MPEGvue. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When the transfer has been completed, press Eject (F3) . 
Select the USB Drive from the pull-down menu to 
disconnect the USB Drive. 

4. Remove the USB Drive from the USB port. 

Backup/Restore

To Backup/Restore to/from a USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the USB port. 

2. Press Utility--> System --> Backup/Restore. Select the USB 
Drive as the media. 

3. Follow instructions for Backup/Restore. See ‘Backup and 
Restore’ on page 16-21 for more information. 

4. When the Backup has been completed, press Eject (F3). 
Select the USB Drive from the pull-down menu to 
disconnect the USB Drive.

5. Remove the USB Drive from the USB port. 

CAUTION After transferring images to a USB Drive using MPEGVue, 
verify that the images have actually transferred to the USB 
drive.
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SaveAs

NOTE: See ‘Save As’ on page 15-9 for more information.

To save images to the USB Flash Drive or USB HDD, 

1. Insert the USB Drive into the USB port. 

2. Select the image(s) to be saved. 

3. Select Save As menu in the lower, right-hand corner of the 
screen. Select the USB Drive as the archive media. 

4. Specify: Image only or Secondary Capture, type of 
compression, quality, and image save format (Raw DICOM, 
DICOM, Avi, Jpeg, or WMV). 

5. Press Save. When the images have been saved, press 
Eject (F3). Select USB Drive from the pull-down menu to 
disconnect the USB Drive.

6. Remove the USB Drive from the USB port. 

NOTE: If you perform the SaveAs function to the USB drive ([drive 
letter]\Export) in RawDICOM format and review the data on your 
PC, the title of the data appears as “I[drive 
letter]\GEMS_IMG\2013_Oct\08(date)\FL073749(First Letter of 
First Name and Last Name + time)”, for example.

Direct SaveAs

You can save the image directly to the USB Drive just by 
pressing a Print or Store key. 

NOTE: “Direct SaveAs” doesn't supports WMV type.

1. Insert the USB Drive into the USB port. 

2. Select Save As from the pull-down menu in Utility -> 
Connectivity -> Service. Press Add. 

3. Select Save As in the list. Rename it in the Name field if 
needed. 

4. Select USB Drive in the Destination field.

5. Verify the service. 

6. Press Save.

7. Assign Save As to the appropriate print/store key in Button 
tab. 

8. Display the image on the monitor and press the assigned 
print/store key. 
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Export/Import 

To export/import exams using the USB Flash Drive or USB 
HDD, 

NOTE: Before you export exams to the USB HDD, check “Export to 
USB HDD: Create DICOMDIR” in Utility -> Connectivity -> 
Miscellaneous. If you uncheck this parameter, you must import 
the data to review.

1. Insert the USB Drive into the USB port. 

2. On the Patient menu, select Data Transfer, then Export/
Import. Specify USB Drive in the transfer To: pull-down 
menu. Select the patient/exam you want to transfer. Press 
Transfer. 

3. When Export/Import has completed, press F3. Select USB 
Drive from the pull-down menu.

4. Remove the USB Drive from the USB port after the success 
dialogue displays.

EZBackup (USB HDD only)

1. Select “USB Drive” on the Utility -> Backup/Restore -> 
EZBackup/Move -> Media.

2. Follow instructions for EZBackup. See ‘EZBackup and 
EZMove’ on page 16-24 for more information.

3. When EZBackup has completed, press F3. Select USB 
Drive from the pull-down menu.

4. Remove the USB Hard Disk from the USB port after the 
success dialogue displays.

NOTE: “Media capacity for estimate (MB)” in Utility -> System -> 
Backup/Restore -> EZBackup and EZMove are not effective 
when the Media is “USB HDD”. It only applies to the CD and 
DVD. 

SD card

You can use SD card for data management, which is the same 
as USB Flash Drive, to perform the MPEGvue (Data Transfer), 
Back up/Restore, Save As, Export/Import, EZBackup. For how 
to use SD card, you can refer to the information about USB 
Flash Drive in this Chapter.
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Network Storage Service

You can save patient data/images to the PC directly with the 
following functions, if you select Network Storage service.

• Save As

• Export/Import

• MPEGvue

• DICOM Read

NOTE: DO NOT share the folder used for Export/Import with other 
ultrasound systems. It causes loss of data if two or more 
systems access to the same folder. Please create the unique 
folder for each system.

NOTE: Before you export patient data/images using Network Storage, 
check “Export to Network Storage: Create DICOMDIR” in 
Utility -> Connectivity -> Miscellaneous. If you uncheck this 
parameter, you must import the data to review.

Potential risk

• Patient/Image data might not be sent at all with inaccurate 
network configuration.

• Patient/Image data might be lost by disconnecting the 
network.

• Patient/Image data might be damaged by unstable network/
data coupling.

• Patient/Image data might be mixed up by network/data 
coupling.

• Patient/Image data might be sent to wrong destination if 
network configuration is not inaccurate.

• The system might be attacked by a virus and vulnerable 
infection.

• Network is not connected by IP address conflict.

CAUTION After MPEGVue to Network Storage, the MPEGVue patient 
may not be listed in the To list. Make sure to confirm on the 
destination to storage whether the copy of data succeeded. 
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LOGIQ V2/LOGIQ V1 Setup

NOTE: Create a Share folder on your PC on the network before 
continuing with this setup.

1. Select Utility -> Connectivity -> Device. 

2. Select Add.

3. Type the computer name in the Name field and Static IP 
address in the IP Address field. 

NOTE: Only use alphanumeric characters for the name.

NOTE: If you change Static IP Address after export, you cannot 
import patient data/image. In this case, type previous IP 
address again before import. 

Figure 15-14. Network Storage Service setup - Device
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Network Storage Service  (continued)

4. Select Ping to verify the icon changes (smiley face 
appears). 

5. Select Service.

Select the Network Storage from the pull-down menu. 
Select Add. 

Specify the properties for this service.

• Name: Enter unique name that identifies this service.

NOTE: Do not use the same name for any other Service or 
device.

• Password: Enter the password used for logging onto the 
PC.

• User name: Enter the user name used for logging onto 
the PC.

• Shared Dir: Enter the Share name of the folder.

NOTE: Only use alphameric characters for the Shared Dir.

6. Select Save and select Verify to verify the icon changes 
(smiley face appears).

It takes a long time to access Network Storage Service by 
the condition of the network. 

Setup on your PC

Check with your network administrator about the LAN 
connection and setting method of the shared folder.
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Printing Options

Setting up the Off-Line Paper Printer
You can connect an off-line paper printer via the Isolated USB 
port. 

Following printers can be connected to the power outlet supplied 
by the system.

• BW Printer: Sony UP-D897, Sony UP-D898MD

• Color Printer: Sony UP-D25MD

• HP Officejet 100 Printer

• HP Officejet Pro 8100 Printer

Figure 15-15. Patient Environment

CAUTION ONLY plug in devices to the USB ports of the system WHILE 
the LOGIQ V2/LOGIQ V1 is NOT powered up. If you plug in a 
device while the LOGIQ V2/LOGIQ V1 is powered on, your 
system may become unusable.

CAUTION DO NOT place an off-line paper printer inside the patient 
environment. This assures compliance to leakage current. 

CAUTION DO NOT place an off-line paper printer inside the patient environment 
(within the dotted line area noted by “1” in Figure 15-15). Refer to the 
off-board printer’s manufacture manual for details. 
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Setting up the off-line paper printer

NOTE: The printer driver is customized for the LOGIQ V2/LOGIQ V1 at 
the factory; you do not need to change the settings. 

1. Connect the printer to the USB port. 

2. Select Utility--> Connectivity--> Service. Add the 
Standard Print service. 

Figure 15-16. Connectivity -> Service Screen

3. Select the printer from the Printer pull-down Properties 
menu. 

NOTE: After selecting the printer, the field turns white. 

4. Set the parameters in Properties. 

5. Type the printer name in the Name field. 

NOTE: This name is used on the Button screen. 
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Setting up the off-line paper printer  (continued)

6. Press Save, then select the Button tab. 

7. Select the appropriate print key (Print or Print3 or Store) 
from the Physical Print Buttons section. 

8. Select printer from the MyComputer column and press “>>” 
to move it to the Printflow View column. 

Figure 15-17. Connectivity -> Button Screen

9. If you want to assign this printer to the Standard Print Button 
on the Active Image Screen, select this printer at the Active 
Image Printer section. 

10. Press Save. 

NOTE: If you want settings other than 1 image per sheet, or 2x3 sheet, 
or to improve the image quality, refer to the manual that came 
with the printer. 
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Setting up Digital Peripherals

You set up digital peripherals from the Utility --> System --> 
Peripherals menu. 

NOTE: Printing using a standard printing service overrides the 
orientation and N-up feature of the printer preferences. Printer 
preferences are set up in the printer folder (via Utility-->System 
-->Peripherals. Select Properties under Standard Printer 
Properties). 

Digital Printer Setup

There are two steps to do when setting up a digital printer: 
1) follow the procedure below for each printer, then 2) set up 
specific properties for each printer if you need. 

Follow this procedure for each printer:

1. Select Utility--> Connectivity--> Service. Select or add the 
Standard Print. Highlight Standard Print in the Service list. 
Select the printer from the Printer pull-down Properties 
menu. 

2. Type the printer name in the Name field. This name is used 
on the Button screen. After you select the printer from the 
Printer pull-down Properties menu again, it turns white. 
Press Save. 

3. Select Button. Select the appropriate print key (Store, Print, 
Print3) from the Physical Print Buttons section. Select the 
printer from the MyComputer column and press >> to move 
it to the Printflow View column. Press Save. 

In Active Images screen, you can select Standard Print to print 
image in additional to pressing the Print key which is assigned 
for Printing control.
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Setting up specific Properties for each digital printers Instructions

Follow these steps to set up specific properties: 

1. Press Utility-->System-->Peripherals. Select the printers 
from the pull-down menu under Standard Printer Properties. 
Click Properties.

Figure 15-18. Properties

2. Select Printing Properties from Printer pull-down menu.

Figure 15-19. Properties setting up

3. Change the settings as necessary. Press Apply. Press OK.

4. Press Save, then Exit.
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Setting up the Printer to Print Reports

To set up the Off-Line Printer to print reports, 

1. Enter Utility--> System--> Peripherals. 

2. Select the printer from Default Printer pull-down menu. 

Figure 15-20. Report Printer Setup

3. Press Save. 

4. Press Print on the Report screen to print the report. 

Setting up specific Properties for report printers Instructions

Follow these steps to set up specific properties: 

1. Press Utility-->System-->Peripherals. Select the printers 
from the pull-down menu under Standard Printer Properties. 
Click Properties.

Figure 15-21. Properties

2. Select Printing Properties from Printer pull-down menu.

Figure 15-22. Properties setting up

3. Change the settings as necessary. Press Apply. Press OK.

4. Press Save, then Exit.
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Setting Up a Network Printer

The LOGIQ V2/LOGIQ V1 supports the HP printers which use 
HP Universal Printing PCL6 driver as network printer. 

To set up the network printer on the LOGIQ V2/LOGIQ V1, first 
set up the network printer properties, then assign the print key 
for network printer.

Setting up the Network Printer Properties

1. Go to Utility-->System-->Peripherals. Select the HP 
Universal Printing PCL6 from the pull-down menu under 
Standard Printer Properties. Click Properties.

Figure 15-23. Properties

2. Click Printing Preferences in the Printer pull-down menu.

Figure 15-24. HP Network Printers Properties
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Setting up the Network Printer Properties  (continued)

3. Select Enter the Printer Address, enter the Printer Address.

NOTE: Contact your network administrator for local network 
information.

Figure 15-25. Printing Preferences

4. Select the printer, select Check Status to see if the printer is 
ready for use.

If the printer is ready for use, select OK; if not, please 
contact your network and office administrator.

Figure 15-26. Check printer status
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Setting up the Network Printer Properties  (continued)

5. Change other settings as necessary. Select Apply, then 
Select OK.

Figure 15-27. Setting Up Other Settings

Assigning the Print key for network printer

1. Go to Utility-->Connectivity -> Service, select or add 
Standard Printer in Service preset menu. Select HP 
Universal Printing PCL6 in the Printer drop down menu in 
the Properties column. 

2. Press Save, then select the Button tab. 

3. In Button tab, configure the print key (Print or Print3 or 
Store) as standard print, select Save and Exit. 

4. Press the print or store key which is configured as Standard 
Print.
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Chapter 16

Customizing Your System

Describes how to create system, user, and exam 
presets. 
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Presets

Overview

Preset Menus provides the following functionality: 

• System presets. View and update general system 
configuration settings, measurement and analysis settings, 
and peripheral settings; backup and restore data and 
configuration files. 

• Imaging presets. View and update exam and imaging 
parameters. 

• Comment presets. Set up comment libraries by 
application. 

• Body Pattern presets. Set up body pattern libraries by 
application. 

• Application presets. Configure application- and 
user-specific settings. 

• Test Patterns Presets. Helps configure system settings. 

• Connectivity Setup. Define connection and communication 
setup, including exam dataflow information. 

• Measurement presets. Customize exam studies, create 
measurements, set up manual sequencing, and create OB 
Tables. 

• Reports Presets. Allows you to edit the report template, 
diagnosis codes, and report comments. 

• Admin presets. Perform system administrator activities 
such as setting up user IDs and logon formats. 

• Service. Activates the Service Browser. 

• Scan Assistant. Create, import/export, and manage Scan 
Assistant programs. 

• Search. You can search for a parameter on the Utility pages 
(Measure, Reports, and Service pages cannot be 
searched.) 

To access these functions, select the Utility on the keyboard, 
then select the appropriate menu key. 
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System Presets

Overview

System presets allows you to view or change the following 
parameters

• General – Location, Date/Time, General User Interface, 
Title bar, Key Usage, Trackball, Utility, Scan Assistant and 
Audio and LCD configuration

• System Imaging – Biopsy Guides, Automatic Wide Screen, 
QAnalysis Statistics Value Display, Image Control and 
Display configuration

• System Measure – Measurement, Cursor and Results 
Window and SonoBiometry configuration

• Backup/Restore – Backup, Media, EZBackup/EZMove, 
Restore, Detailed Restore of User Defined.

• Peripherals – Print and Store Options, Standard Printer 
properties, Default Printer and Setup configuration

• User Configurable Key – User Defined keys, Keyboard 
keys

• About – System software, patent, and image information

Changing system parameters

To change system parameters:

1. Select Utility on the keyboard.

2. Then select System.

The System screen is displayed.

3. On the monitor display, move the Trackball to select the tab 
that has the information you want to change. 

4. Select values for the parameters you want to change.

5. To save the changes, select the Save button. Select Exit to 
return to scanning. In some cases, you may need to reboot 
the system for the change to take effect. 
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System/General Preset Menu

Figure 16-1. System/General Preset Menu

Table 16-1:  Location

Preset Parameter Description

Hospital Type the institution’s name.

Department Type the institution’s department name.

Preset Region (restart needed) Select region.

Language (restart needed) Select the appropriate language from the drop-down list.
Note: If you select Japanese (JPN), only the warning and status 
messages are displayed in Japanese. You can not type in Japanese. 

Units Select metric or US units of measurement.

Regional Options Select to set up the keyboard. 

Table 16-2:  Date and Time

Preset Parameter Description

Time Format Select the time format.

Date Format Select the date format.

Default Century Select the default century for the system to use.

Date/Time Select to display the Date/Time Properties window, to specify the system 
date, time, time zone, and to auto adjust for daylight savings time. 

Table 16-3:  General User Interface

Preset Parameter Description

Color Level (restart needed) Select System Color according to the condition of the room.
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System/General Preset Menu  (continued)

Table 16-4:  Title Bar

Preset Parameter Description

Hide Patient Data When set to Always, patient information is removed from the scanning screen 
Title bar and when storing images; or you can set this to remove patient 
information only when storing the image (On Store); or Never. 
Note: Upon recall of images with measurements, Dual image, the DICOM 
image is recalled. In this case, there is no patient data burned into the 
DICOM image. If you DO NOT want this to occur, set this to Never. 

Font Size (restart needed) Select to display patient information in the title bar. You need to reboot the 
system for this change to take effect. 

Table 16-5:  Trackball

Preset Parameter Description

Speed Set how fast you want the Trackball to move while performing actions such 
as tracing the anatomy. 0=Slow; 20=Very Fast 

Acceleration Set how fast you want to trackball to move across the display. 0, 1, and 2 with 
0 being the slowest acceleration. 

Table 16-6:  Key Usage

Preset Parameter Description

Run Fast Key speed Select the maximum value of the key interval when running Fast Key.

Cursor key mapping Define the Cursor key function.

Table 16-7:  Utility

Preset Parameter Description

Prompt for Save on Exit If selected, the system prompts you to save data when you select exit without 
saving.

Utility Font Size Select the font size you want to use to view the Utility menus. 

Table 16-8:  Scan Assistant

Preset Parameter Description

Always Use Doppler Cursor Use the Doppler Cursor when you activate Scan Assistant. 

Table 16-9:  Audio and LCD

Preset Parameter Description

Reset Audio Volume Resets audio volume to default configuration.

Reset LCD Brightness Resets LCD brightness to default configuration.
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Foreign Language and Keyboard Setup

NOTE: You must apply the changes on each setup page before moving 
to the next page. 

1. In Utility--> System--> General -> Location, select Regional 
Options. 

Figure 16-2. Regional Options

2. The Regional and Language Options Screen displays. In 
the Regional Options tab, under Standards and Formats 
select desired language, under Location select desired 
location. 

Figure 16-3. Regional Options
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Foreign Language and Keyboard Setup  (continued)

3. Select the Advanced tab, then select the language in the 
Language for non-Unicode programs pull-down menu. 

Figure 16-4. Set Language



Customizing Your System

16-8 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Foreign Language and Keyboard Setup  (continued)

4. To set Foreign keyboard, perform the steps below:

a. Select the Language tab, select Details.

b. Select desired language under Default input language.

c. Under Installed Services, select input method.

If necessary, select Add or Remove to add or remove 
input method.

Figure 16-5. Selecting the International Keyboard

d. Press Apply, press OK.

5. In the Regional and Language Options screen, select 
Apply, select Yes in the following pop-up message.

 Figure 16-6. Copy and use existing files
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Foreign Language and Keyboard Setup  (continued)

6. In the Regional and Language Options screen, select OK, 
select No in the following pop-up message.

Figure 16-7. Restart Message

7. In Utility--> System--> General -> Location -> Language, set 
the Language as desired. 

Figure 16-8. Location

8. Press Save, select OK in the pop-up message. 

Figure 16-9. Restart Message

9. After the system restarts, the system appears in the 
selected language. 

NOTE: Press Ctrl+Shift to change the input method, press Alt+Shift to 
change the input language.

NOTE: To have the settings take effect, you MUST turn off the system 
and turn it back on. 

NOTE: Service password does not work for Greek and Russian 
language settings. Change the setting to English. 
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System/System Imaging Preset Menu

The System/System Imaging screen allows you to specify 
parameters for key usage, and image control and display.

Figure 16-10. System/System Imaging Preset Menu 

Table 16-10:  Biopsy Guides

Preset Parameter Description

Show Center Line Displays center biopsy guideline. 

Show Outer Lines Displays outer biopsy guidelines. 

Enable 0.5cm markers Activates biopsy depth markers every 0.5cm. 

Show Biopsy Mark on CFM 
Simultaneous Mode

Displays the Biopsy Guideline on the image while in Simultaneous Mode. 
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System/System Imaging Preset Menu  (continued)

Table 16-11:  Automatic Wide Screen...

Preset Parameter Description

Dual Screen Automatically switch to Wide Screen when in Dual Screen. 

DualView (Simultaneous) Automatically switch to Wide Screen when in Simultaneous DualView 
Screen.

LOGIQ View Automatically switch to Wide Screen when in LOGIQ View.

QAnalysis Automatically switch to Wide Screen when in QAnalysis.

Table 16-12:  QAnalysis Statistic Value Display

Preset Parameter Description

Max Ratio Select to display the Max Ratio value in QAnalysis.

Time of Max Ratio Select to display the Time of Max Ratio value in QAnalysis.

Min Ratio Select to display the Min Ratio value in QAnalysis.

Time of Min Ratio Select to display the Time of Min Ratio value in QAnalysis

Table 16-13:  Controls

Preset Parameter Description

Auto Invert on Linear Steer When selected, for auto calcs, automatically inverts the timeline if needed 
when using ASO.

Auto Invert on ASO Automatically inverts the spectrum with ASO. 

Link Color/Doppler Invert When selected, the Doppler timeline scale inverts along with the color ROI.

Audio Volume Adjusts the Audio Volume.

Auto Freeze Automatically freezes the system after few minutes of inactivity.

Turn Off CrossXBeam for 
LOGIQ View (non-linear 
probe)

Deactivates CrossXBeam when you activate LOGIQ View. 

Doppler Scroll Priority Set to 2D, Doppler, or Last Live Mode.

Table 16-14:  Display

Preset Parameter Description

Horizontal Scale Select to display width markers. 

TGC Display Select to display TGC curve.

PW Velocity Units in cm/s Select to change scale on timeline from centimeters per second to meters 
per second.
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Display image size Select image display size. 

Image Parameter Size 
(restart needed)

Choose image parameter size. Must reboot the system.

Highlight Image Parameter 
Changes

Select if you want the display to indicate which controls you adjusted by 
highlighting the new value on the display. 

Show Clipboard Deselect to hide the clipboard. 

Overlay Color (single 
visible dataset)

Select the overlay color.

Hide Multiple Dataset 
Menu When Storing

Select to hide the Multiple Dataset Menu when storing.

Table 16-15:  Auto Zoom Linear Probe Images at Shallow Depth...

Preset Parameter Description

Single Screen Automatically zoom linear probe images at a shallow depth on a single 
screen. 

Dual Screen and DualView Automatically zoom linear probe images at a shallow depth on the dual and 
DualView screen. 

Table 16-14:  Display (continued)

Preset Parameter Description
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System/System Measure Preset Menu

The System/System Measure screen allows you to specify 
measurement parameters such as the type of default OB 
measurements and calculations. You can also define cursor and 
Results Window default functionality.

 Figure 16-11. System/System Measure Preset Menu 
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System/System Measure Preset Menu  (continued)
Table 16-16:  Measurement

Preset Parameter Description

Repeat Measurement Select No, Repeat, DefaultMeas

OB Type Select which OB measurements and calculations studies to use.

EFW GP Select the source used to calculate EFW-GP Estimated Fetal Weight-Growth 
Percentile)

CUA/AUA for Hadlock Select to use CUA (Composite Ultrasound Age) or AUA (Average Ultrasound 
Age) as the default

Hadlock Table Type Select Hadlock 82 or Hadlock 84 tables

EFW Formula (Europe) Select the source used to calculate EFW (Europe) (Estimated Fetal Weight).

EFW Formula (Tokyo) Select the source used to calculate EFW (Tokyo) (Estimated Fetal Weight)

Add 1 week to EDD Select to add additional week to estimated date of delivery

OB Graph Display Select Single or Quad for displaying OB Graphs. 

OB Graph Single Display Select Last Meas or EFW Single OB Graph displayed by default.

Fix Caliper by Print key Select to use the Print key like the Set key. 
NOTE: If you select this during a generic volume measurement, the print key 
does not function like the Set key, but instead ends the measurement 
sequence and initiates the volume calculation based on the number of 
measurements taken so far. 

LV Study using straight line Sets straight line as the default for 2D LV studies. 

Side selections of Rt, Lt 
and Off

Select to use “Rt, Lt and Off” for Side Selection. When not selected, displays 
only “Rt and Lt”.

SonoBiometry Option 
Selection

Select checkboxes to choose SonoBiometry options
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System/System Measure Preset Menu  (continued)

Table 16-17:  Cursor 

Preset Parameter Description

Cursor Type Select whether to mark measurements with numbers or symbols.

Cursor Size Specify 12x12 or 9x9. 

Cursor Line Display If selected, after you press Set to complete a measurement, the cursor line is 
displayed. If not selected, after you press Set to complete a measurement, 
only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line 
Display

Check box to display the cross line in Ellipse. 

D Manual Trace Cross 
Line Display

Check box to display the cross line with the caliper. 

Cursor Position Select 1st Cursor, 2nd Cursor, or Image Center. 

Color When Set 
(restart needed)

Select the color. 

Table 16-18:  Results Window

Preset Parameter Description

Result Window Mode 
Depend

Select this if you want the measurement result window to be repositioned, 
depending on the mode. 

Result Window Position 
X[0-800]

You can set the coordinates for the measurement result window when you do 
not have the result window set to be mode dependent. This is the X 
coordinate (left/right) 

Result Window Position 
Y[0-600]

You can set the coordinates for the measurement result window when you do 
not have the result window set to be mode dependent. This is the Y 
coordinate (up/down) 

Result Window 
Location-2D

Select the Result Window location on the Monitor Display for 2D mode.

Result Window 
Location-Timeline

Select the Result Window location for the images with timeline.

Result Window Format Select Wide or Narrow. 

Font Color (restart needed) Select the color (reboots the system)

Font Size (restart needed) Select the font size (reboots the system)
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System/Backup and Restore Preset Menu

The backup and restore procedures described in this section are 
divided into two parts. The first part describes procedures to 
backup and restore patient data. The second part describes 
procedures to backup and restore system and user-defined 
configurations.

The Backup/Restore function enables the user to:

• Copy/Restore the patient archive.

• Copy/Restore the system configuration. The Copy/Restore 
system configuration feature enables the user to configure 
several units with identical presets, providing that the units 
have the same software version.

Depending on the system, you can use either a CD-R, DVD-R, 
USB Flash Drive, or USB Hard Disk for system backup/restore. 
For the sake of simplicity, we have used the CD-R in the 
following examples. 

NOTE: The system ONLY supports CD-R / DVD-R and DOES NOT 
support CD+R / DVD+R. 

WARNING GE is not responsible for lost data if the suggested backup 
procedures are not followed and will not aid in the recovery of 
lost data.

WARNING The LOGIQ V2/LOGIQ V1 is not intended to be used as a 
storage device; backup of the Patient and Image Database is 
your institution’s responsibility. GE is NOT responsible for any 
lost patient information or for lost images.

WARNING The system crash can cause the HDD corruption.The HDD is 
not considered a permanent storage device. Backup data on a 
regular basis. 
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System/Backup and Restore Preset Menu  (continued)

CAUTION To minimize accidental loss of data, perform EZBackup and 
Backup on a regular basis.   

1. First, perform EZBackup to save the images.

2. Next, perform Backup at Utility -> System -> Backup/
Restore. Enable the following checkboxes under Backup: 

• Patient Archive 

• Report Archive

• User defined configuration

• Service

CAUTION Archived data is managed at the individual sites. Performing 
data backup (to any device) is recommended.

CAUTION Make sure to verify the media after writing of data, such as 
EZBackup, SaveAs or Export.     

Verifying media requires additional time, which varies 
depending on the amount of data backed up or exported.

CAUTION Before deleting a patient or image from the patient screen, 
make sure you have saved the data by EZBackup/Backup or 
Export and verify that the media transfer of data was 
successful. 
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System/Backup and Restore Preset Menu  (continued)

Figure 16-12. System/Backup/Restore Preset Menu

Table 16-19:  Backup

Preset Parameter Description

Patient Archive Select to back up patient data.

Report Archive Select to back up report data. 

User Defined Configuration Select to back up the user-defined configuration settings.

Service Select to back up Service settings.

Backup Select to begin the backup.

Table 16-20:  Media

Preset Parameter Description

Media Select media type to use for backup and restore. 
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System/Backup and Restore Preset Menu  (continued)

Table 16-21:  EZMove

Preset Parameter Description

Move Files Older Than in 
Days

The system will move images older than the number of days specified here. If 
you enter a zero (0), then all of the images from today on will be moved.

Media Select media type.

Media capacity for 
estimate (MB)

Specify the capacity of the backup media. 

Table 16-22:  EZBackup

Preset Parameter Description

Reminder Dialog Interval 
days

Specify the number of days after the last backup that you want the system to 
prompt you to perform an EZBackup procedure (only for moving images). 

Enable Reminder Dialog Select to activate the EZBackup reminder pop-up dialog. 

Media Select media type.

Media capacity for 
estimate (MB)

Specify the capacity of the backup media. 

Table 16-23:  Restore 

Preset Parameter Description

Patient Archive Select to restore patient data.

Report Archive Select to restore report data. 

User Defined Configuration Select to restore the user-defined configuration settings.

Service Select to restore service settings. 
CAUTION: DO NOT restore service presets on to a different LOGIQ V2/
LOGIQ V1 system. Only restore service presets to the same system. 

Restore Select to begin the restore process for the selected configuration files.
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System/Backup and Restore Preset Menu  (continued)

The detailed section of this menu allows you to restore one area 
at a time from the user defined configuration. This allows you to 
selectively restore what you want to restore across multiple 
machines. Check the box(es) you want to restore, insert the 
appropriate media, and press Restore. 

NOTE: When you restore backup data from the Utility menu, the LOGIQ 
V2/LOGIQ V1 application usually restarts automatically when 
the restoring is complete.

Table 16-24:  Detailed Restore

Preset Parameter Description

Imaging Presets Select to restore imaging presets.

Connectivity Configuration Select to restore connectivity configurations.

Measurement 
Configuration

Select to restore measurement configurations.

Comment/Body Pattern 
Libraries

Select to restore comment and body pattern configurations.

Report Templates (Same 
software version only)

Select to restore Report templates. 

Fast Key Select to restore Fast Key. 

Utility-->Application 
Presets

Select to restore Utility--> Application presets. 

Custom Programs Select to restore Scan Assistant programs. 

All Others Select to restore all other configurations not listed in the Detailed Restore 
section. This includes parameters defined on the System preset menus.

Restore Select to begin the restore process for the selected configuration files.
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Backup and Restore

To minimize accidental loss of data, perform backup of the 
patient archives stored on the local hard drive DAILY as 
described in this section. Use a formatted Backup/Restore disk 
to back up patient archives from the hard drive, using the 
backup procedure described in this section. Data from the 
Backup/Restore disk may be restored to the local hard drive 
using the restore procedure.

NOTE: To perform backup and restore procedures, you must login with 
administrator privileges.

Backup procedure

Back up patient data AFTER you’ve archived (via EZBackup/
EZMove) images so that the pointers to the patient’s images 
reflect that the images have been moved to removable media 
and are no longer on the hard drive. 

1. Insert a media into the drive or USB device into a USB port.

2. On the Archive screen under dataflow, select Local Archive - 
Int. HD.

3. Go to Utility --> System --> Backup/Restore.

4. In the Backup list,

• Select Patient Archive and Report Archive to backup 
the patient records.

• Select User Defined Configuration to copy system 
settings and user presets.

• Select Service to backup service presets.

NOTE: The detailed section of this menu decouples the user 
defined configuration above. This allows you to selectively 
restore what you want to restore across multiple machines. 

5. Specify where to save data in the media field.

6. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

7. At the end of the process, the Backup completed message 
is displayed on the monitor.

Select Eject (F3) to eject media/disconnect the USB device.

8. Make sure to physically label the media. An identification of 
the system should also be noted on the media and a backup 
log should be kept.

File the media in a safe place.
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Restore procedure

1. Go to Utility --> System --> Backup/Restore.

2. In the Restore list,

• Select Patient Archive and Report Archive to restore 
the patient archive.

• Select User Defined Configuration to restore all 
system settings and user presets.

or

One or several system configuration items to restore 
parts of the Detailed Restore of User Defined.

• Select Service to restore Service Settings.

3. In the Media field, select the appropriate Source device.

4. Select Restore.

The system performs the restore. As it proceeds, status 
information is displayed on the Backup/Restore screen.

5. The LOGIQ V2/LOGIQ V1 restarts automatically when 
Restore is done. 

CAUTION The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct media.

You cannot restore the data between systems with different 
software versions.

CAUTION To avoid the risk of overwriting the local patient and report 
archives, DO NOT check Patient Archive when restoring 
user-defined configurations.
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Backup and restore strategy: user-defined configurations

In addition to generating a safety copy, the backup/restore 
function of the user-defined configuration (presets) can be used 
to configure several LOGIQ V2/LOGIQ V1 systems with 
identical presets (preset synchronization).

Preset synchronization

The procedure for preset synchronization of several scanners is 
as follow:

1. Make a backup of the user-defined configurations on a 
removable media from a fully configured LOGIQ V2/LOGIQ 
V1 system.

2. Restore user-defined configurations from the removable 
media to another LOGIQ V2/LOGIQ V1 system (you can 
restore all the user-defined presets or select specific presets 
to restore via Detailed Restore).
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EZBackup and EZMove

EZBackup or EZMove allows you to manage hard disk space 
(move images off the hard drive) while maintaining the patient 
database on the scanner, as well as to back up the patient 
database and images. 

• EZBackup: Copy the data from the local HDD to the 
removable media.

• EZMove: Copy the data from the local HDD to the 
removable media. After copying the image file to the media, 
EZMove deletes the image file from the Local HD.

HINTS PLEASE READ THIS

Ensure that you have established a data management protocol 
for your office/institution. You MUST manage the backup media 
by keeping a log and by creating a media filing system. 

For example, if you need to back up 500 MB/day, or 2.5 GB/
week, then you need to back up 5 CDs/s/week, or ~250CDs/
year. 

Generally speaking, you should back up the system when you 
have 10 GB of images to back up. 

You should assign the person who is in charge of performing 
the backups. Backups will vary by the volume of your work. You 
need to track how long it takes your office/institution to get to 
10 GB, and set the back-up parameters accordingly. 

Your office/institution needs to determine your backup strategy, 
for instance, backup weekly and move monthly. It should be an 
easy strategy to perform and to remember. And follow this 
same strategy/schedule consistently. 

It’s also useful to keep your more recent information on the 
hard drive since it’s easier to recall that way. 
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EZBackup and EZMove  (continued)

CAUTION You can still do a backup/move daily; but ALWAYS do a patient 
archive backup after each move. 

CAUTION Only cancel the backup/move in case of an emergency. The 
system completes backing up the current media and then 
cancels the operation.

CAUTION When EZBackup requires more than one disk (CD-R or 
DVD-R) for backup, a message appears when the first disk is 
full. If you select “Cancel” to stop the backup procedure and 
later try EZBackup again, all the data may not be backed up.

Select “Full Backup” on the first EZBackup wizard screen if the 
last time you were performing EZBackup you selected 
“Cancel”.

CAUTION If you use EZBackup or EZMove as a “true” patient archive, 
you must maintain a separate backup of the patient database 
(Patient Archive and Report Archive). If for any reason the 
Local Archive - Int HD gets corrupted or the base system 
software has to be reloaded, then the patient archive is the 
ONLY way to rebuild the EZBackup and EZMove patient 
archive. 

CAUTION DO NOT turn off the power while EZBackup is running. The 
data may be lost. It may take several hours for EZBackup to 
finish, depending on the amount of data being backed up.

The following may give the impression of a lockup, but 
EZBackup is continuing in the background.

• The progress bar does not move.

• The screen may become white.

• The hourglass icon keep turning.
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EZBackup and EZMove  (continued)

NOTE: EZBackup/EZMove are saved data as RAW data. If you import 
data to the system, you can modify the image data. 

NOTE: To display exported Raw DICOM images on a PC, you need the 
dedicated viewer.

NOTE: When backing up or moving reports using EZBackup and 
EZMove, use the USB HDD. DVDs and CDs are not supported 
for backing up or moving reports using EZBackup or EZMove.

NOTE: “Archived” information is saved to each exam during EZBackup. 
When you perform EZBackup, the system backs up the exams 
except for the archived exam.

NOTE: EZBackup/EZMove cannot span a single image across two (2) 
or more media. Therefore, if EZBackup/EZMove encounters an 
image that is greater than the capacity of the media, it skips the 
oversized image. 

NOTE: EZBackup/EZMove does not store images to media in 
sequential order. Instead it maximizes the most amount of 
images per media. 

NOTE: If the system locks up during the media auto format process, 
shutdown the system by holding down the power button and 
boot it up again. After the system is up, replace the media to a 
new one and execute EZBackup or EZMove again. To avoid a 
trouble such as data loss, do not reuse the failed media for any 
other function.

NOTE: If you try exporting a previously backed-up exam, the message 
“Can’t Find Source file” displays. The image data had already 
been removed from the hard disk drive with EZBackup/EZMove. 

CAUTION NEVER restore the patient archive from media made previous 
to the last move. 
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EZBackup and EZMove  (continued)

Basically, when you perform the EZBackup or EZMove 
procedure, you insert the media (or connect USB HDD if 
applicable), the system backs up/moves the images, and 
creates a reference between the patient database and the 
media’s volume. 

EZBackup/EZMove can take up to 20 minutes (or longer, 
depending on the size of the backup). Make sure to schedule 
this at the same time daily, when no patients are scheduled. 

1. Prepare unformatted media or the USB HDD before starting 
EZBackup/EZMove.

2. Specify the EZBackup/EZMove setup on the Utility --> 
System --> Backup/Restore page. 

3. To start the EZBackup/EZMove procedure, go to the 
Archive Screen and select EZBackup/EZMove. The 
EZBackup/EZMove Wizard starts. 

NOTE: If you use the USB HDD, some wizards and the pop-up 
messages DO NOT appear. 
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EZBackup and EZMove  (continued)

4. Verify the information on the first page of the EZBackup/
EZMove Wizard, then press Next. 

Full backup options display on the first page of the 
EZBackup wizard. If you want to backup all of the exams in 
the range (even if the exam was previously backed up, 
check this option). If you uncheck this option, the system 
only backs up exams which have not yet been backed up. 

NOTE: You can set the range for EZMove in Utility --> System --> 
Backup/Restore --> Move files older than in days. 

NOTE: If you update an exam which is already backed up, the 
exam is also backed up. 

Figure 16-13. EZBackup Wizard, Page 1
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EZBackup and EZMove  (continued)

5. Verify the information on the EZBackup/EZMove Wizard, 
Page 2. The backup may span multiple media. This page 
tells you how many media you need to do this backup. After 
you have gathered the media (allow for one extra media, 
just in case), you are ready to begin the backup. Press Next. 

If the storage capacity of the USB HD is insufficient, you will 
see the message, “Selected Location does not have enough 
free space.”

NOTE: The calculation for the number of backup CD is only an 
estimate. Allow for one additional CD when performing an 
EZBackup/EZMove.

NOTE: This message appears if you press Next without inserting 
the backup media: “Please insert a blank media...”. Insert 
the media and continue. 

Figure 16-14. EZBackup/EZMove Wizard, Page 2
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EZBackup and EZMove  (continued)

6. A pop-up message appears that provides you with the 
media label. Label the media, then insert the media. Press 
OK. 

Figure 16-15. Insert Media Message

a. Ensure that you label the media with not only the 
volume name indicated on the Insert Media Message, 
but with the name of the LOGIQ V2/LOGIQ V1 system 
where this backup/move procedure was done. 

b. Update the EZBackup/EZMove log with this information 
the volume information and the location of the media. 

c. After the backup/move has been completed, file the 
media. 

Table 16-25:  Typical EZBackup/EZMove Log

Date
Scanner ID 

Name
Backup 

Images Y/N
Older than 

__ Days
Move 

Images Y/N

Media Label 
(and 

Scanner ID)
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EZBackup and EZMove  (continued)

7. The status menu appears. When the backup/move has 
been completed, press Next. 

Figure 16-16. EZBackup Wizard Page 3

NOTE: When/if you need to insert the next media, a message 
appears providing you with the media label. Label the 
media, then insert the next media and press OK.
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EZBackup and EZMove  (continued)

8. When the backup is complete, the completed wizard page 
appears. Press Finish. 

Figure 16-17. EZBackup/EZMove Wizard, Page 4

9. Do a patient archive after each EZBackup/EZMove (move). 

We recommend attaching the patient list to the EZBackup/
EZMove media.

NOTE: Use Import to restore EZBackup images.
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To Review EZBackup/EZMove and Export Images

You can review backed up media via the Archive Menu, Import, 
and the DICOM Read dataflow. 

If you review EZMoved image,

1. Select the patient on the Patient Menu (on the same system 
where the EZMove was performed). 

2. Insert the media volume indicated on the Patient Menu. 

3. View the exam from the media. 

NOTE: You may need to insert a media volume prior to or after the 
recommended media. 

NOTE: If the patient is split over multiple media, images on the previous 
or next media are displayed as triangles. 

NOTE: To view the whole patient on the system, use Import, from as 
many media as you have for that patient. However, take care not 
to import studies over existing studies; duplicate or missing 
images may result. Delete the existing exam first. 
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System/Peripherals Menu

The System/Peripherals screen allows you to specify 
parameters for the printers.

 Figure 16-18. System/Peripherals Preset Menu

Print and Store Options: select Print and Store Options to go 
to the Utility --> Connectivity --> Miscellaneous setup page. 

Removable Media: select Removable Media to go to the Utility 
--> Connectivity --> Removable Media page. 

Table 16-26:  Setup 

Preset Parameter Description

Standard Printer 
Properties: [Printer] and 
Properties, and 
Default Printer

Select to add an additional standard printer via the USB serial port and to 
configure digital printers. This activates the Windows Add Printer wizard. 
NOTE: Most printer drivers are available via Windows; however, newer 
printers may require you to load the manufacturer-supplied print driver. 
Note: The displayed Sony UP-D898MD/X898MD is just the printer driver for 
UP-D898MD. Sony UP-X898MD is NOT supported on LOGIQ V2/LOGIQ V1.

Print Full Screen Select for the standard printer to print the full screen.

Enable Video Invert Select for the standard printer to print black on white rather than white on 
black.

Video Output Format Select the video format, PAL or NTSC.
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System/User Configurable Key

 Figure 16-19. User Configurable Key Preset Menu

User Defined and Keyboard keys

User Defined and Keyboards Keys can be programmed as one of the 
functions in the list. After programmed, the functions can be activated 
by selecting the User Defined and Keyboard Keys.

To program the numeric hot key on the keyboard:

1. Select the function from the drop-down list for the numeric 
hot key.

2. Select Enable Numeric Hot Key.

3. Pre Save and Exit to save the settings and exit the utility 
screen.

4. Select the programmed numeric hot key to activate the 
assigned function. 

To program the user defined key on the control panel:

1. Select the function from the drop-down list for the User 
defined key.

2. Pre Save and Exit to save the settings and exit the utility 
screen.

3. Select the programmed user defined key to activate the 
assigned function. 

Table 16-27:  Keyboard Key and User Defined Key

Preset Parameter Description

Enable Numeric Hot Key Select to enable the Numeric hot keys. Only when this is selected, selecting 
the Numeric hot key on the keyboard can activate the assigned functions.

Enable Alphabet Hot Key Select to enable the Alphabet hot keys. Only when this is selected, selecting 
the alphabet hot key on the keyboard can activate the assigned functions 
(Comments, Body Pattern and Measure).
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System/About Preset Menu

 Figure 16-20. System/About screen

The System/About screen lists information about the system 
software.

Additional About Information

Click and open Additional About Information for hardware 
information: Module Name, Revision and Part Number.

Table 16-28:  Software

Preset Parameter Description

Software Version The current software version on this system.

Software Part Number The software part number.

Build View The software build view.

Build Date The software build date.

Table 16-29:  Patents

Preset Parameter Description

Patents Lists system patents.

Table 16-30:  System Image

Preset Parameter Description

Image Part Number The image part number (ghost part number).

Image Date The image date (ghost date).
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Imaging Presets

Overview

Imaging screens allow you to specify parameters for the 
following:

• B-Mode (B)

• Color Flow Mode (CF)

• Power Doppler Imaging (PDI)

• M-Mode (M)

• Anatomical M-Mode (AMM)

• Pulse Wave Mode (PW)

• Continuous Wave Mode (CW)

• Harmonics (HAR)

• Tissue Velocity Imaging (TVI)

• Tissue Velocity Doppler (TVD)

• General
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Overview  (continued)

 Figure 16-21. Imaging - Example

1. Model/application dependent setup parameters

2. Probe dependent setup parameters

3. Select to reload factory defaults
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Changing imaging presets

To change imaging presets:

1. Select Utility on the keyboard.

2. Select Imaging. 

The system displays the Imaging screens.

 Figure 16-22. Example: B-Mode Preset

3. In the row across the top of the screen, select the mode.

The system displays two sets of parameters and settings. 
The left column lists all settings for the exam (for example, 
OB-1). The right column lists settings that apply only to the 
exam and probe combination.

4. In the Preset list, select the exam.

5. In the Probe list, select the probe.

6. To change a parameter, do one of the following:

• Select the value from a list.

• Select one value from a choice of two or more buttons.

• Select or clear a check box.
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Changing imaging presets  (continued)

7. After changing the parameters, to save the changes, select 
the Save button.

NOTE: When you Save changes to imaging parameters, the system 
saves changes to all modes, not just the mode currently 
displayed.

NOTE: If you have problems with imaging, you can return parameters 
back to the original settings. Select the exam, probe, and mode, 
and then select Reload Factory Defaults. The system returns the 
selected parameters to the original settings.

For information about the specific parameters, refer to Chapter 5 
Optimizing the Image.



Imaging Presets

LOGIQ V2/LOGIQ V1 – Basic User Manual 16-41
Direction 5610735-100 English Rev. 2

General

Figure 16-23. General Presets

You can specify a default probe per application and a default 
application per probe.

Default probe per application

1. To specify a default probe per application, select Utility --> 
Imaging --> General -> Configuration for Selected 
Application Only.

2. Select the default probe from the pull-down menu.

Default mode and application per probe

1. To specify a default application per probe, select Utility --> 
Imaging --> General.

2. Under Probe, specify the desired mode and application from 
the pull-down menu.

Selected Probe application Category 

1. To specify the application category for the selected probe, 
select Utility --> Imaging --> General.

2. Select the appropriate applications for the selected probe.

Other setting

Checkmark the following field when you want the system to 
activate a certain display: 

• Simultaneous



Customizing Your System

16-42 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Comments Libraries Presets

Overview

Comment screens allow you to specify comment text and 
pointer options, to define comment libraries, and assign 
comment libraries to applications.

Comments Libraries/Libraries Preset Menu

On the comments Libraries tab, you can change and create 
comment libraries. A comment library is a list of comments that 
are associated with a specific application. The comments are 
listed in the library in the order in which they display on the 
Comment Menu on the screen.

Figure 16-24. Comment Libraries Preset Menu 

Table 16-31:  Libraries

Preset Parameter Description

Library The name of the comment library.

Left and Right Columns The list of comments for the selected library separated by side.

User Defined Library The name of a new comment library that you want to create/delete.

Copy from Existing You can add to or delete from the selection of comments.

Hot Key Assign frequently-used comments to specific alphanumeric keys 
(programmed as hot keys)
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Defining Comments

1. In the Library field, select the library you want. 

The system displays all comments for the library. The 
comments are listed in the order that they are shown when 
you use comments.

2. To change or add an comment, select the comment or blank 
location and press Set, then do one of the following:

• Type the comment.

• Select the comment in the Copy from Existing list, and 
press Set. 

3. To save the changes, select the Save button.

Creating a new comments library

1. In the User Defined Library field, type a name for the library, 
then select Create.

The system creates a new library.

2. Enter comments as described in step 2 above section 
(Defining Comments).

3. To save the changes, select the Save button.

Deleting a user defined library

1. Select the library name which you want to delete from the 
pull-down menu. 

2. Press Delete. 

3. Press Save to save the changes. 

Defining Hot Keys

There are ten alphanumeric keys that are programmable as hot 
keys to store frequently-used annotations. 

1. In the Hot Key field, select the desired hot key (A, S, D, F, G, 
H, J, K, L or ;).

2. Press Set.

3. Type the comment or Select the comment in the Copy from 
Existing list, and press Set.

4. Press Save to save the changes.

5. Ensure that the “Enable Alphabet Hot Key” preset has been 
selected in the Keyboard key portion in the Utility -> System 
-> User Configurable key preset screen.

6. When scanning, if a comment is required, select the 
programmed alphabet hot key to add the corresponding 
comments.
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Comments Libraries/Comments Preset Menu

On the Comments tab, you specify text and pointer options.

Figure 16-25. Comment/Comments Preset Menu

Table 16-32:  Text

Preset Parameter Description

Text Font Size Specify the font size. The font size increases as the number increases. 

Text1 Color / Text 2 Color Select the color for comment Text1 and Text2.

Text Boundary Select Group Move or Word Wrapping.

Enable Type Over Mode Select to type over existing comments. Position the cursor over the text to be 
changed, then start typing. 

Automatically Set Text If selected, the system sets the comment at the cursor position automatically 
when text entry is complete. 

Table 16-33:  Arrow

Preset Parameter Description

Arrow Length Select the default pointer length.

Arrow Size Select the default pointer size.

Keep Arrow Angle Keep the angle of arrow pointer head until next change. 
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Comments Libraries/Comments Preset Menu  (continued)

After you change comment options, select Save to save the 
changes.

Comments Libraries/Applications Preset Menu

The Comments Libraries/Applications tab is a link to the 
Applications preset menu. The Applications preset screen 
allows you to specify which libraries belong to an application. 
You also specify which is the default library that displays when 
you use comments. 

Figure 16-26. Applications/Comments Link

The Applications/Comments screen can be accessed through 
either the Comments Libraries or Applications key.

 Figure 16-27. Applications/Comments Preset Menu

Table 16-34:  General

Preset Parameter Description

Retain while entering or 
leaving timeline mode

If selected, the system keeps the comment(s) on the monitor display when you 
enter or leave timeline mode. 

TextOverlay in Multiple 
Image

When selected, and you select the F8 key to hide or show comments, if you 
are in multiple image, the system hides the text in both images. When cleared, 
the system only hides the text for the active image.

TextOverlay sequence You can specify to display Text1, Text2, or both. This allows you to have some 
comments that do not change during the exam while allowing you to change 
other comments. Toggle the F8 key to cycle through the 3 Text1/Text12 states.

Erase When the image is 
unfrozen

Deletes comments when you unfreeze the image. If you check this parameter, 
Text2 automatically erase when you unfreeze the image.

Show ToolTip If selected, shows tool tip when comments are typed on the screen.

Erase When the probe or 
application is changed

Deletes annotations when you change the application or probe.
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Specifying which libraries belong to an application

1. On the Comments tab, in the Preset field, select the 
application.

2. In the Library Group Tabs fields, select the libraries for this 
application. 

3. To save the changes, select the Save button.

Using comments from a library

To use comments, press the Comment key on the Control 
Panel. Comments are then displayed on the screen.

Select the appropriate comments.

Table 16-35:  Applications

Preset Parameter Description

Preset The name of the application preset.

Select Library Select the library from the drop-down list for the application. 
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Body Patterns Presets

Overview

Body patterns screens allow you to specify body pattern options, 
to define body pattern libraries, and assign body pattern 
libraries.

Body Pattern Libraries/Libraries Preset Menu

On the Body Patterns Libraries tab, you can change and create 
body pattern libraries. A body pattern library is a list of body 
patterns that are associated with a specific application. The 
body patterns are listed in the library in the order in which they 
display on the control panel.

Figure 16-28. Body Patterns Libraries Preset Menu
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Body Pattern Libraries/Libraries Preset Menu  (continued)

Defining body patterns

1. In the Library field, select the application library you want.

The system displays all body patterns for the library. The 
body patterns are listed in the order that they are shown on 
the menu.

2. To change or add a body pattern, select the body pattern or 
blank location and press Set, then do one of the following:

• Type the body pattern name.

• Select the body pattern in the Copy from Existing list, 
and press Set. 

NOTE: When you select a body pattern name on the menu or in 
the Copy from Existing list, the system displays the 
pattern in the lower left corner of the screen.

3. To save the changes, select the Save button.

Creating a new body pattern library

1. In the User Defined Libraries field, type a name for the 
library, then select Create.

The system creates a new library.

2. Enter body patterns as described in step 2 above section 
(Defining body patterns).

3. To save the changes, select the Save button.

Table 16-36:  Body Patterns Libraries

Preset Parameter Description

Library The name of the body pattern application library.

Left, Middle and Right Columns The list of body patterns for the selected library.

Body Pattern Image Displays the image of the currently selected body pattern.

User Defined Libraries-Create The name of a new body pattern application library that you want to create.

User Defined Libraries-Delete Allows the selection of the user defined library to be deleted.

Copy from Existing A list of body patterns you can use to create an application library.

Hot key The list of body patterns for the selected library can be assigned to the 
designated alphanumeric keys as hot keys.
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Defining Hot Keys

There are ten alphanumeric keys that are programmable as hot 
keys to store frequently-used body patterns. 

1. In the Hot Key field, select the desired hot key (Q, W, E, R, 
T, Y, U, I, O or P).

2. Press Set.

3. Type the body pattern name or select the body pattern in the 
Copy from Existing list, and press Set.

4. Press Save to save the changes.

5. Ensure that the “Enable Alphabet Hot Key” preset has been 
selected in the Keyboard key portion in the Utility -> System 
-> User Configurable key preset screen.

6. When scanning, if a body pattern is required, select the 
programmed alphabet hot key to add the corresponding 
body pattern.



Customizing Your System

16-50 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Body Pattern Libraries/Body Patterns Preset Menu

On the Body Patterns tab, you specify body pattern options.

Figure 16-29. Body Patterns General Preset Menu

After you change body pattern options, select Save to save the 
changes.

Table 16-37:  Body Patterns

Preset Parameter Description

Erase When the probe or 
application is changed

If checked, when you change probes or applications, the system erases the 
body pattern.

Erase When the image is 
unfrozen

If checked, when you unfreeze the image, the system erases the body 
pattern.

Copy to active side in 
multiple image

If checked, when you use dual B-Mode, the system copies the body pattern 
to the active side of the dual image.

Body pattern background Select whether you want the body pattern background to be Transparent or 
Opaque.

Use Zoom Rotary knob to 
select Body pattern

If selected, you can scroll through the body patterns with the Zoom control.

Bump Body Pattern 
Control for easy entry

If checked, allows you to quickly add a body pattern by nudging the control. 
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Body Pattern Libraries/Applications Preset Menu

The Body Patterns Library/Applications tab is a link to the 
Applications preset menu. The Body Patterns Applications tab 
allows you to select body pattern application libraries. You also 
specify which is the default library that displays when you use 
body patterns.

Figure 16-30. Applications/Body Patterns Link

The Applications/Body Patterns screen can be accessed 
through either the Body Pattern Libraries or Applications keys.

Figure 16-31. Body Patterns Applications Preset Menu

Selecting body pattern application libraries

1. On the Body Patterns tab, in the Preset field, select the body 
pattern.

2. In the Library Group Tabs fields, select the application 
libraries for Body Patterns. 

3. To save the changes, select the Save button.

NOTE: When you use body patterns, the default library is displayed.

Table 16-38:  Applications

Preset Parameter Description

Preset Defines the Body Pattern option.

Select Library Select the library from the drop-down list for the application. 
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Using body pattern application libraries

See the following Body Patterns Small Parts. 

Figure 16-32. Body Patterns Small Parts

To select a body pattern library, select the more to select the 
designed library. 

To select body patterns, use the Trackball and Set key or the hot 
key.

NOTE: If use hot keys, ensure that the “Enable Alphabet Hot Key” 
preset has been selected in the Keyboard key portion in the 
Utility -> System -> User Configurable key preset screen.
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Application Presets

Overview

Application Settings presets allow you to configure the 
application-specific settings (presets). 

Settings

Figure 16-33. Application Settings Preset Menu

Table 16-39:  Preset

Preset Parameter Description

Preset Select the application that you want to specify the presets. 

Table 16-40:  Image Control and Display

Preset Parameter Description

Show kHz scale When selected, displays the kHz scale on the left side of the Doppler 
spectrum.

Show Doppler Rate When selected, displays the Doppler rate (mm/s) below the Doppler 
spectrum. 

Anatomical Angle 
Correction

Select to keep the angle constant with regard to the anatomy. 
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Join Dual Image for Linear Select to place linear probe dual images directly next to each other. 

Hide Mode Cursor Key Select to unmap (hide) the Mode Cursor key, which normally appears on the 
left Trackball key during live scanning in B-Mode or Color Flow Modes.

Table 16-41:  When Entering Dual Image...

Preset Parameter Description

Duplicate Frozen Image to 
Opposite Side

When entering Dual Image, duplicate the frozen image to the opposite side. 

Duplicate Live Image to 
Opposite Side

When entering Dual Image, duplicate the live image to the opposite side. 

Table 16-42:  Patient Info

Preset Parameter Description

Titlebar Line 1 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 2 Select the patient information to display on the scanning screen Title bar.

Titlebar Line 3 Select the patient information to display on the scanning screen Title bar.

Table 16-43:  Comments

Preset Parameter Description

Active function at Freeze Select None, Body Pattern, or Comments. If Body Pattern or Comment is 
selected, the Body Pattern or Comment is activated automatically when 
freezing the system.

Table 16-44:  Footswitch

Function Description

Left, Middle, Right Specify footswitch functionality.

Table 16-40:  Image Control and Display

Preset Parameter Description
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Print Control

You have to set parameters with each application.

Figure 16-34. Print Control

Table 16-45:  Preset 

Preset Parameter Description

Preset Select Application from pull-down menu. You can set Time span for each 
application. 

Table 16-46:  Live Store 

Preset Parameter Description

Store/Print/P3 Select the behavior of Print key during live scan from Retrospective Clip, 
Single image only or None for each print key. 
None: Store a still image when you press Store or print key during Freeze. 
Retrospective clip: The system stores cine predetermined time before you 
press the Store or Print key, based on the Time Span setting. 
Single image only: Store a still image during live scan each time you press 
Store or print Key.   

Table 16-47:  Time-Based Store

Preset Parameter Description

Time span [s] Select the number of seconds of CINE Loop storage. The default is 3 
seconds. 

Preview loop before store When selected, allows you to review cine loops before storage.
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Imaging Controls

For B, M, CF, PDI, PW, CW, CM, Cine and Report mode, you 
can select which controls you want to be available on the 
Primary Menu for the selected application.

 Figure 16-35. Imaging Controls
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Comments and Body Patterns

Comments and Body Patterns were described earlier in this 
chapter.

Measurements

You can set the exam category measurement and calculation 
package you want to appear when you select the exam category 
Preset. 

Figure 16-36. Application Measurements Menu
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Test Patterns

Overview

There are different test patterns available: Gray Bars, Color 
Bars, Resolution, Text, Brightness Calibration, White, Gray, Red, 
Green and Blue.

WARNING Test Pattern function is NOT for Customer Use, for Engineering 
and Service Only.
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Configuring Connectivity

Overview

You use Connectivity functionality to set up the connection and 
communication protocols for the ultrasound system. This page 
gives an overview of each of the Connectivity functions. 

Structured Reporting

DICOM Structured Reporting provides the results of a procedure 
as structured data elements (well-defined fields) as opposed to 
unstructured data (large amounts of text undifferentiated by 
individual fields). This greatly improves query capability. DICOM 
Structured Reporting creates coded clinical data that can be 
used for clinical research, outcomes analysis, and disease 
management.

Supported parameters

The DICOM supported parameters are listed in the DICOM 
Conformance Statement at the following web site under DICOM 
- Ultrasound:

http://www.gehealthcare.com/usen/interoperability/dicom/
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Connectivity Functions

To set up your institution’s connectivity, you must login with 
administrator privileges. 

1. TCPIP: allows you to configure the Internet Protocol and 
wireless Network.

2. Device. allows you to set up devices. 

3. Service: allows you to configure a service (for example, 
DICOM services such as printers, worklist, and other 
services such as standard print) from the list of supported 
services. This means that the user can configure a device 
with the DICOM service(s) that particular device supports.

4. Dataflow: allows you to adjust the settings of the selected 
dataflow and associated services. Selecting a dataflow 
customizes the ultrasound system to work according to the 
services associated with the selected dataflow. 

5. Button: allows you to assign a pre-configured output 
service (or a set of output services) to the Print keys on the 
control panel. 

6. Removable Media: enables formatting (DICOM, database, 
or blank formatting) and DICOM verification of removable 
media.

7. Miscellaneous: allows you to set up the patient exam menu 
options, print and store options, patient/exam Message 
options, Other ID Options. 

Configure these screens from left to right, starting with the Tcpip 
tab first. 

NOTE: The ultrasound system is pre-configured for many services, with 
default settings selected. You can change these services and 
settings as needed.

CAUTION You must restart the LOGIQ V2/LOGIQ V1 after making any 
changes to connectivity settings in the Utility menus. This 
includes any changes on the TCPIP or dataflow setup screens.
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TCPIP

This configuration category enables users with administrative 
rights to set the TCPIP for the system and connected remote 
archive.

 Figure 16-37. Connectivity TCPIP Preset Menu 

1. Type the name of the Ultrasound system in the Computer 
Name field. 

2. In the IP settings section, identify the ultrasound system to 
the rest of the network by one of the following:

• Dynamic Host Configuration Protocol (DHCP) can be 
used provided your network supports the DHCP 
protocol.

• Type the IP-Address. In this case, uncheck the “Enable 
DHCP” box and enter the IP address, Subnet Mask, and 
Default Gateway. Contact your network administrator if 
you are unsure what values to enter. 

NOTE: If no Default Gateway is required, re-enter the IP 
address into the Default Gateway.

3. Select the Network Speed.

4. Select Save settings. 

5. Re-boot the ultrasound system. 

NOTE: TCPIP settings do not get restored when restoring backups. 
This is per system design. The LOGIQ V2/LOGIQ V1 IP address 
MUST BE unique.
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TCPIP  (continued)

NOTE: Restart the system to activate any changes saved from this 
page. 

Table 16-48:  Computer Name

Preset Parameter Description

Computer Name Type the unique name for the Ultrasound system (no spaces in name).

Table 16-49:  IP settings

Preset Parameter Description

Enable DHCP Select this box to enable dynamic IP Address selection.
NOTE: The system shall disable IP-Address, Subnet Mask, and Default 
Gateway when the user chooses to use DHCP.

IP-Address Type the IP Address of the Ultrasound system. NOTE: IP stands for Internet 
Protocol. Every device on the network has a unique IP address. 

Subnet Mask Type the subnet mask address. NOTE: The Subnet Mask is an IP address 
filter that eliminates communication/messages from network devices of no 
interest to your system. 

Default Gateway Type the default gateway address.

Network Speed Select the network speed.

Table 16-50:  Wireless Network

Preset Parameter Description

Configuration Press to configure the Wireless Network -- see instructions below.

IP-Address Type the IP Address of the Ultrasound system. NOTE: IP stands for Internet 
Protocol. Every device on the network has a unique IP address. 

Subnet Mask Type the subnet mask address. NOTE: The Subnet Mask is an IP address 
filter that eliminates communication/messages from network devices of no 
interest to your system. 

Default Gateway Type the default gateway address.
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Configuring the Wireless Network (Option)

A Wireless Network (WLAN) is available on the LOGIQ V2/
LOGIQ V1. When the WLAN is active, an icon appears in the 
status bar to indicate whether the WLAN is installed or 
disconnected. 

Connecting to the WLAN

To connect the LOGIQ V2/LOGIQ V1 to the WLAN, 

1. Connect the wireless adapter card to the system.

2. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

 Figure 16-38. Available Wireless Networks
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Connecting to the WLAN  (continued)

3. If necessary, check the box for “Enable Wireless 
Connection”.

4. Select the wireless network you want to use or setup, select 
Connect. If prompted, enter the correct settings for this 
wireless network, for example: Network key.

5. If the connection is successfully, the status bar Active 
Wireless LAN indicator will no longer have a red “X”. 

Figure 16-39. Active Wireless LAN Indicator

NOTE: If the WLAN fails to connect, review and/or recreate the 
Wireless connection on the Security Tab. 

Adding a Wireless Network

To add a WLAN profile (even for a network which is not yet 
available), 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Security tab. 

3. Select Add...

4. Add the following information to the Wireless Network 
Properties page: 

• Network Name (SSID)

• Network Authentication (Open, Shared Key, WPA, WPA 
PSK, WPA2, or WPA2 PSK). 

• Data Encryption

• Network Key

• Key Index

5. After you have filled in all the required information, select 
OK. To cancel adding this profile, select Cancel. 
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Removing a WLAN

To remove a WLAN profile (even for a network which is not 
available), 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Security tab. 

3. Select Wireless Network that need to be removed, select 
Remove. 

Customizing Wireless Network Settings

To customize an existing WLAN profile, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Security tab. 

3. Select Customize...

4. Edit the following information: 

a. Network Name (SSID)

b. Network Authentication (Open, Shared Key, WPA PSK, 
or WPA2 PSK). 

c. Data Encryption

d. Network Key

e. Key Index

5. After you have edited all the information that you want to 
edit, select OK. To cancel the edit, select Cancel. 

Refreshing a WLAN

Refreshes the list of available Wireless Networks. To refresh the 
Wireless Network, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the wireless network you want to refresh. 

3. Select Refresh from the bottom of the Configuration tool. 
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Setting a WLAN as Non-Preferable

When you make a WLAN non-preferable, you disconnect the 
network from the system and delete all connection settings from 
the system. Afterwards, the system WILL NOT try to reconnect 
to this WLAN automatically. And if you want to reconnect, you 
will need to re-add this WLAN. 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the wireless network you want to set as 
non-preferred. 

3. Select Make Non-Preferable from the bottom of the 
Configuration tool. You will receive the following message to 
confirm this decision: “Are you sure you wish to make 
network _______ non-preferable? Network will be 
disconnected and system will not reconnect to this network 
automatically. Network connection settings will be deleted 
from the system.” 

4. Confirm your decision to repair (Yes), or cancel (No).

Monitoring the WLAN

If there are wireless network communication problems, you can 
monitor the wireless network events.

To monitor Wireless Networking events, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Monitor Tab.

 Figure 16-40. Monitor Tab
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WLAN Diagnostics

If the wireless network is connected, you can run diagnostics to 
determine how well, or poorly, the network itself is working. The 
diagnostic information displayed can help pinpoint causes of 
networking problems. Tests which pass are shown in green; 
tests which fail are shown in red.

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Diagnostics Tab. 

3. Select Run Diagnostics. 

 Figure 16-41. Diagnostic Results
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Repairing the WLAN

Occasionally you may need to repair a WLAN that has lost its 
connection to the LOGIQ V2/LOGIQ V1. To repair the Wireless 
Network, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Diagnostics Tab. 

3. Select Repair. 

NOTE: DO NOT cancel the Repair operation after you have 
selected to repair the Wireless LAN connection. 

If the WLAN is functioning properly, the following message 
appears. Confirm your decision to repair (Yes), or cancel (No). 

Figure 16-42. Repair Message
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Available WLAN Channels

The available WLAN channels show availability of wireless 
connect points that the scanner can talk to. Each channel 
supports a finite number of users and has limited signal 
strength. This may effect the ability to connect, the throughput 
and the connection dropping out.

To check the available WLAN channels, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear. 

2. Select the Properties Tab. 

 Figure 16-43. Properties Tab

3. Select Available Channels.... 

Figure 16-44. Available Channels
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Disconnecting from the WLAN

To disconnect from the Wireless Network, 

1. Select Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears.   

2. Select the WLAN you are connected to. 

3. Select Disconnect. 

Viewing WLAN Online Help

To view the WLAN Online Help, press Help (F1 Key). 
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Device

To add a new device, 

1. Press Add. 

2. Type the device name in the Name field. 

3. Type the device’s IP address in the IP Address field. 

Figure 16-45. Connectivity Device Preset Menu

To ping a device, 

1. Select the device. 

2. Press Ping. If the smiley face smiles, then the connection 
has been confirmed. If the smiley face frowns, then the 
connection has not been made. Check the device name and 
IP address. 

Table 16-51:  Device

Preset Parameter Description

Add/Remove Press Add to add a new device; press Remove to delete a device. 

Ping Press Ping to confirm that a device is connected. 

Properties: Name Type the name of the device. 

Properties: IP Address Type the device’s IP address. 

Properties: AE Title AE Title of the LOGIQ V2/LOGIQ V1. NOTE: Only available for MyComputer.

Properties: Port Number IP Port Number Used for DICOM. NOTE: Only available for MyComputer.

Properties: MAC Address Unique network card address. NOTE: Only available for MyComputer.
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Service

For each Device that you added to the system, you need to set 
up the service(s) that device supports (you must be an 
administrator to update these screens). 

Figure 16-46. Connectivity Services Preset Menu

The Services screen has the following sections of information:

1. Destination Device - lists information about destination 
devices. You can select from a list of currently existing 
devices.

2. Service Type to Add - lists information about services for 
the destination device. You can add services, select from a 
list of currently existing services, and remove services.

3. Service Parameters - lists parameters for the service 
currently selected in the Services section. The name and 
parameters in this section change, depending on what 
service is currently selected.
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Adding a service to a destination device

1. Select the service from the pull-down menu. Press Add. 

2. Specify the properties for this service. Press Save. 

3. Verify the service. 

Removing a service

1. Select the service. Press Remove. 

2. Press Save. 

Changing parameters for a service

There are certain parameters that may need to be set up for 
each service: 

Table 16-52:  Service Parameters: Common Service Parameters

Preset Parameter Description

Name Free text: give a descriptive name to the device.

AE Title The Application Entity Title for the service.

Port Number The port number of the service.

Maximum Retries Max # – the maximum number of times to try establishing a connection to the 
service.

Retry Interval (sec) Specify how often (in seconds) the system should try to establish a 
connection to the service. 

Timeout The amount of time after which the system will stop trying to establish a 
connection to the service.
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Changing parameters for a service  (continued)

Many service parameters are specific to each type of service. 
The parameters are described on the following pages:

• DICOM Image Storage

• DICOM Performed Procedure

• DICOM Print

• DICOM Query/Retrieve

• DICOM Storage Commitment

• DICOM Worklist

• Standard Print

• USB Quick Save

• Save As

• HD Export

• Network storage



Configuring Connectivity

LOGIQ V2/LOGIQ V1 – Basic User Manual 16-75
Direction 5610735-100 English Rev. 2

DICOM Image Storage

DICOM Image Storage allows the system to send or receive 
ultrasound images in a format that can be interpreted by PACS.

Figure 16-47. DICOM Image Storage Service

CAUTION GE does not warrant the operation if the DICOM format of send 
image (US, USMF, SC) does not correspond with the DICOM 
Server. 

Table 16-53:  DICOM Image Storage

Preset Parameter Description

Allow Multiframe Select to allow cine loop storage.

Allow raw data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 
save in DICOM format only.

Compression Select the compression type.

Max Framerate Select the maximum frame rate.

Color Support Select the support color.

Reopen per image Reopen per image 

Enable Structured 
Reporting

Select for Structured Reporting. 

Key Image Notes Image deletion notification. ONLY available for the Direct Store Workflow and 
ONLY generated when there are images deleted during the exam. Selecting 
this lets the reader at the PACS system know which images have been 
deleted. An indicator is placed on deleted images with a reason, “Rejected for 
Quality Reasons,” for example. 
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DICOM Performed Procedure

DICOM Performed Procedure provides an acknowledgement 
that a study has been performed.

Figure 16-48. DICOM Performed Procedure Service
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DICOM Print

DICOM Print provides the ability to send or receive ultrasound 
image data to DICOM printers.

Figure 16-49. DICOM Print Service

Table 16-54:  Properties 

Preset Parameter Description

Format Indicates how many prints to print per page. Partial prints are displayed as one print 
job.

Priority Specify the print job priority.

Medium Select the print medium.

Copies Enter the number of copies. 

Orientation Specify whether to print the image Portrait (vertically) or Landscape (horizontally).

Film Size Specify the dimensions of the film size.

Film Destination Specify the film destination for the exposed film. 
Magazine – Store in a film magazine.
Processor – Develop in a film processor.

Magnification Specify how the printer magnifies the image to fit it onto the film.

Smoothing Type Specify the printer’s magnification interpolation for the output.

Trim Specify whether you want a trim box to be printed around each image on the film.

Min Density Enter a number indicating the minimum density level of the film.

Max Density Enter a number indicating the maximum density level of the film.

Border Select to have the border area surrounding and between the images of the film.

Empty Image Select to have a Black or White empty image.

Color Select whether to have the image Color or Grey.
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Configuration 
Information

Enter vendor-specific image quality settings.

Film Session Label Type a name for the group of film labels associated with the print job.

Table 16-55:  Annotation 

Preset Parameter Description

Enable Lets you annotate the image. 

Table 16-54:  Properties  (continued)

Preset Parameter Description
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DICOM Query/Retrieve

DICOM Query/Retrieve provides a list of patients sorted by 
query parameters. 

NOTE: Some PACS vendors only offer Query/Retrieve as an option. 
Please confirm that this service is available. 

Figure 16-50. DICOM Query/Retrieve Service

NOTE: If you are experiencing problems with slow responses from 
DICOM servers, increase the time-out in the DICOM server 
properties dialog. (Utility -> Connectivity -> Service -> Properties 
-> Maximum Retries and Timeout). Problems with slow 
responses may result in images being re-sent automatically and 
low transfer rates. The retry settings can be used to make jobs 
retry on bad networks. When portable (off-line), use minimum 
time-out and no retries or it will affect shutdown speed.

Table 16-56:  DICOM Query/Retrieve

Preset Parameter Description

Maximum Result Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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DICOM Query/Retrieve  (continued)

Query/Retrieve Per Series

You can now display/retrieve multiple series by patient on the 
Archive--> Data Transfer--> Q/R page. 

 Figure 16-51. Q/R Per Series Example

Table 16-57:  DICOM Query/Retrieve Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters. 

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician’s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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DICOM Storage Commitment

DICOM Storage Commitment provides acknowledgement from 
PACS that the study has been accepted into archive.

Figure 16-52. DICOM Storage Commitment Service

Table 16-58:  DICOM Storage Commitment

Preset Parameter Description

Associated Storage This selection is based on the services entered by the user. 
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DICOM Worklist

DICOM Worklist provides a list of patients sorted by query 
parameters.

Figure 16-53. DICOM Worklist Service

Table 16-59:  DICOM Worklist

Preset Parameter Description

Maximum Result Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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DICOM Worklist  (continued)

Table 16-60:  DICOM Worklist Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters.

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician’s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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Standard Print

Figure 16-54. Standard Print Service

Table 16-61:  Standard Print

Preset Parameter Description

Printer Select the printer. 

Rows Specify rows. 

Columns Specify columns. 

Orientation Specify Landscape/Portrait

Top Margin (mm) Specify the top margin

Bottom Margin (mm) Specify the bottom margin

Left Margin Specify the left margin

Right Margin Specify the right margin
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Setting up a Printer

Use Standard Print for digital peripherals. These are printers 
with either a USB interface or Ethernet interface (Sony 
UP-D25MD, for example). 

On the Utility --> Connectivity --> Button page, select the Print 
key in the upper, left-hand corner of the display. In the middle 
portion of the page, under Available Input/Outputs, select the 
printer you want to configure. Next, press the two right arrows 
(>>) in the upper, right-hand corner of the page to move this 
printer into the Printflow View. 

You can also configure the Standard Print button that appears 
on the Active Images screen. 

Example: For instance a report printer, on the Utility --> 
Connectivity --> Service page, in the Service Type to Add box, 
and press Add. In the properties box on the upper, right-hand 
side, select the type of device and in the Properties box in the 
lower, left-hand side, type in a unique descriptive name for this 
device. 
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USB Quick Save
You can save individual CINE loops (moving images - avi 
format), still images (jpg format) or report (pdf format) directly to 
a USB Memory Stick by pressing a print key or to network 
storage.

If network storage is selected (under Properties) for USB Quick 
Save, the network storage function needs to be set up. See 
‘Network Storage’ on page 16-88 for more information. 

Figure 16-55. USB Quick Save Service

NOTE: After selecting either the USB Key or Network Storage, select 
Save to save the preset.

NOTE: The print key that has been assigned to the USB Quick Save 
function should not have any other service functions (except 
Copy to Dataflow function) assigned to it.

Figure 16-56. Defining Print Key Operation

Table 16-62:  DICOM Worklist Search Criteria 

Preset Parameter Description

Properties: Name Type the name. 

Properties: Destination Select the destination.

Properties: 
DirectoryNamingFormat

Select the Directory Naming Format.
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Save As

Figure 16-57. Save As

HD Export

You can save individual CINE loops (moving images - avi 
format) or still images (jpg format) directly to a CD/DVD or Hard 
Disk by pressing a print key or store key.

 Figure 16-58. HD Export Service

Table 16-63:  Save As

Preset Parameter Description

Destination Specify destination device. 
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Network Storage

The Network Storage service provides the following:

• MPEGvue patient data to a Windows compatible file share.

• Send images (JPEG), video (AVI) and reports (PDF) to a 
Windows compatible file share with the USB Quick Save 
service.

• Exporting is allowed to a network storage location.

NOTE: Before setting up the ultrasound system, a Windows 
compatible file share must be setup on the network to 
connect to. To create the share, the user that is connecting 
to the share must have the Share permissions of Full 
Control Or the NTFS permissions or Full Control if the share 
is located on a NTFS volume. For additional help creating or 
configuring file shares, please consult your system 
operating documentation.

NOTE: Do not connect multiple ultrasound systems to the same 
share.

Figure 16-59. Network Storage Service

Table 16-64:  Network Storage Service

Preset Parameter Description

Name Enter unique name that identifies this service.
NOTE: Do not use the same name for any other Service or device.

Password Enter the password used for logging onto the PC.

User Name Enter the user name used for logging onto the PC.

Shared Dir Enter the Share name of the folder, not the UNC path. For example if the path 
is \\server\images, you would enter images as the name
NOTE: Only use alphanumeric characters for the Shared Dir.
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Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

Figure 16-60. Dataflow Preset Menu

CAUTION DO NOT rename the factory default dataflow. 

Table 16-65:  Dataflow 

Preset Parameter Description

Name Select the dataflow from the list.

Direct Store Select to store data directly to archive (no buffer storage).

Hidden Select so that this dataflow does not appear as a Dataflow on the Patient 
menu. 

Default Dataflow Select to use this dataflow as the default dataflow when you start the system.
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Button
You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of 
the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 

Figure 16-61. Button Preset Menu

Table 16-66:  Button

Preset Parameter Description

Format RawDICOM, DICOM, or M&A. 

Image Frames Single (captures a DICOM single frame image), Multiple (captures a DICOM 
multiframe, CINE) -- only select this if the PACS supports multiframe, and 
Secondary Capture (forces all DICOM images to Secondary Capture). 

Capture Area For use with Secondary Capture: Video Area, Image Area or Whole Screen.

Compression Always set to None. 

Single Association Only visible with DICOM image storage destinations. When selected, the 
spooler sends multiple images in one store job.

Standard Print Lets you send to a Windows-based printer. 
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Removable Media

The Removable Media tab allows you to:

• Verify the DICOM directory on removable media.

• Verify the free space of the media.

• Verify that the media is finalized or unfinalized.

• Verify that the media is formatted or unformatted.

• Format removable media (rewritable CD/DVD or USB 
device).

Figure 16-62. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 16-67:  Tools

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify • Select to verify DICOM directory on removable DICOM disk.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 
media is formatted with a full format. New media should always be formatted 
with a full format. 
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Removable Media  (continued)

Formatting removable media

1. Select the removable media from the Media list.

2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ]

3. Select Format. Confirm OK or Cancel. 

4. An information window confirms when the format has been 
completed. Select OK to exit. 

Verifying removable media

1. Select the removable media from the Media list.

2. Select Verify.
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Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

Figure 16-63. Miscellaneous Preset Menu

Table 16-68:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the birth
date: when selected, enter birth date, then the age is calculated; when
cleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system 
automatically searches through the selected patient archive, while the user 
enters patient information.When cleared, the automatic search tool is turned 
off. If you are trying to keep the past patient data confidential, DO NOT use 
this feature. 

Automatic generation of
patient ID

In the Search/Create Patient window: When selected, the Patient ID is not
required when entering a new patient in the archive. The system
automatically generates an ID number. When cleared, the Patient ID is
required when entering a new patient in the archive.

Auto Archiving patient data Archives patient data automatically. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Show BBT Show BBT field on the OB patient screen to input the basal body 
temperature.
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Export to USB HDD: 
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory 
and DICOM files structured for diagnostic portable media behave. It is 
important for portability between the LOGIQ V2/LOGIQ V1 to PACS. If you 
want to save exams to the USB Hard drive and look at it on the PACS, the 
DICOMDIR is a must.

Export to Network storage 
HDD: Create DICOMDIR

Automatic Disable Patient 
Data

Select to automatically disable patient data. 
If selected, locks the patient name, date of birth and gender (like Patient ID). 
The Factory Default for this preset is unchecked.

Remember Cursor Position 
on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 
1. Select the “Remember cursor position in the Transfer screen” preset and 

press Save. 
2. On the Data Transfer screen, move the cursor to the desired field. 
3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Table 16-69:  Patient/Exam Message Options

Preset Parameter Description

Request acknowledge of 
End Exam action

When selected, the user is asked to confirm action when ending an 
examination.

Warn Image Store without 
Patient

Select to receive a warning when you press the Print key without an active 
patient.

Warn Register to No 
Archive

Select to receive a warning when you register a patient to the “No Archive” 
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 
Only dataflow

The system posts a warning message if you attempt to store images to a 
read-only Dataflow. 

Warn video titles exist in 
the internal storage

The system posts a warning if the video titles exist on the internal DVR flash 
memory. 

Table 16-70:  Print and Store Options

Preset Parameter Description

P[1-3] Key Sound Select the key sound. 

Store Dual as Dicom Only Select to always store dual images as a DICOM (secondary capture) store, 
rather than Raw DICOM. 

Dual When Color Support 
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS, 
send black and white images as gray; send color images as color. Set up 2 
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. 
Each button needs to be tied to a different service.
Select if you want to keep the user preset for Color Photometric Interpretation 
while in Dual mode.

Store Multiframe for Sec 
Capture Loops

Select if you want the CINE loop stored as secondary capture.

Table 16-68:  Patient/Exam Menu Options (continued)

Preset Parameter Description
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Enable Smart Capture 
Area

Check box to select. 

Store 2D Loop with 
Timeline Data

Check box to select. 

Patient List Print-Font Size Select font size. 

DICOM Multi-Frame image 
resolution

Select Default, Medium, or Large for recalled DICOM Multi-frame Frame 
Cine loops.

Show progress bar while 
storing image

Show and hide the progress bar while image store on the scan screen.
When “Show progress bar” is On (default), the progress bar is shown while 
storing images when 1 sec is passed since starting image store and 
completed frames is less than 50% of total frames.
When “Show progress bar” is Off (uncheck the box), No progress bar is 
shown while storing images. Instead system shows status of image store on 
status bar while system is storing image. 
Affect the following print flow service and function;
Copy to Dataflow, DICOM Image Storage, DICOM Print, HD Export, SaveAs 
(Raw DICOM or DICOM is selected as format) 
SaveAs from SaveAs dialogue other than Avi format.

Image Order Scheme Select to Direct Store images in Acquisition Order, Scan Assistant Order, or 
Off.
• Off. The clipboard on the Ultrasound system shows the image in the order it 

was acquired. Therefore, re-stored images appear where you’d expect. 
However, on the PACS system, images appear in arrival order or in image 
number order. 

• Acquisition Order. From the Ultrasound system perspective, the same as 
“Off.” But on the PACS system (if based on image number order), images 
are displayed consistently with the way they are stored on the Ultrasound 
system. 

• Scan Assistant Order. You can define the storage order (reading order) via 
Scan Assistant Creator. Therefore, based on the order defined in Scan 
Assistant, images are re-ordered and displayed in this manner both on the 
Clipboard and on the PACS system. 

Table 16-71:  Other ID Options 

Preset Parameter Description

Enable Other ID Not selected is the Default.
If selected, allow entering Other ID, such as Citizen Service Number, Burger 
Service Number (BSN), National Health System (NHS) number, along with 
patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of 
“Other ID” when an ID is entered. Choose: NHS Number *** ** *****, Letters 
and Numbers, Numbers, or Any (no restriction)

Table 16-70:  Print and Store Options

Preset Parameter Description
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Measure

Please refer to Chapter 7, General Measurements and 
Calculations for more information on setting up Measurement 
and Analysis Presets. 
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Reports

Refer to Chapter 14 for more information. 
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System Administration

Overview

The Admin screen has the following three sections:

• System Administration – lists all the options implemented 
in the system.

• Users – allows you to define user IDs, specify operator’s 
registration, operator’s rights, and registration of staff 
related to an examination (for example, referral doctors and 
sonographers).

• Logon – defines logon procedures.
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System Admin
The System Admin screen has information about any options 
implemented for the system.

Figure 16-64. Administrative System Admin Preset Menu 

Table 16-72:  System Administration

Preset Parameter Description

Product The name of the product.

HW Number The hardware number of the product.

System Serial Number The serial number of the product.

SW Option Key The software option key section.

Enter New Option Key Type the key for the option you wish to add and press Add. 

Installed Option Keys Lists the key for the installed options. 

Remove To remove a software option key, select the key in the SW Option Key list, 
and then select Remove.

Options A list of the option name and status.

Status Lists each option’s effectivity. 

Table 16-73:  Service

Preset Parameter Description

Enable Automatic Request 
for Service

Check this box to enable the system to send system-generated requests for 
service, without your intervention. 

Table 16-74:  Protecting Health Information (PHI) 

Preset Parameter Description

Prevent Writing to 
Removable Media-CD/DVD/
USB (requires reboot)

Prevent from copying data including Patient Information to external storage 
device. 
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Users

The Users screen allows you to define user IDs. It also allows 
you to specify operators registration, operator’s rights setting, 
and registration of staff related to an examination (for example, 
referring and interpreting physicians).

Figure 16-65. Users Preset Menu

Table 16-75:  User List 

Preset Parameter Description

User List Lists the user ID for all system users. 

Identity Type the operator’s user ID, Password, Prefix, Last Name, First Name, Middle 
Name, Suffix, Phone Number. 

Group Membership Select the user’s group.
Operator (sonographers, doctors, or any person using the ultrasound system);
Ref.Phys. (referring physician can be associated to the patient examination in 
the extended Patient information window;
Perf.Phys. – physician performing the exam can be associated to the patient 
examination in the extended Patient information window.

Operator Rights Admin – If selected, the operator has extended rights with access to the 
administrative setup functionality. The operator can also perform advanced 
operations
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Creating a user

1. Select Add.

2. Type the user ID. ENSURE that you DO NOT include the 
following characters in a user’s ID: slash (/), dash (-), 
asterisk (*), question mark (?), an underscore (_), 
ampersand (&) or blank spaces. Also, DO NOT set up a 
user with the same initials/signifier. 

3. Type the user’s information in the Identity section.

4. Select the user’s group(s).

5. If the user needs full configuration and advanced operations 
access, select Admin.

6. Press Save. 

NOTE: DO NOT add users with the same initials/signifier. The system 
allows you to do this; however, the first user is erased and only 
the second remains.

NOTE: When adding a new user, press Add first. Then edit the ID from 
the default of “NewUser” and edit the other fields. DO NOT 
press Add again unless you actually want to create another 
user. Press Save after adding one or more users. The user 
listed as NewUser on the list will be updated with the edited ID 
when you re-enter this screen.

Changing a user configuration

1. Move the Trackball to a user ID in the User List.

2. Make the desired changes.

Deleting a user

1. Move the Trackball to a user ID in the User List.

2. Select Remove.

The user is removed from the User List.
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Logon

The Logon section defines log on procedures.

Figure 16-66. Administrative Logon Preset Menu 

Table 16-76:  Logon

Preset Parameter Description

Auto Logon Specifies logon procedures:
• When blank, the user must select a user ID and enter a password when 

logging on.
• When selected, the system is started automatically, using the last user 

logon.

Common Network Login Specifies the user ID and password used to access the network. User – User 
ID for network access. Password – Password for network access

Connectivity Maintenance Reset to factory default.
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Service

Press Service to activate the Service browser interface. 
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Scan Assistant

Scan Assistant Manager

Please refer to Chapter 5 for information on using the Scan 
Assistant Manager to Import and Export Scan Assistant 
Programs. This section covers how to use the Scan Assistant 
Creator and how to export the Scan Assistant Creator from the 
LOGIQ V2/LOGIQ V1 to a PC. 

Activating the Scan Assistant Creator

To activate the Scan Assistant Creator on the LOGIQ V2/LOGIQ 
V1, press the Creator key. 

Figure 16-67. Scan Assistant Manager
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Scan Assistant Creator

Overview

The Scan Assistant Creator is used to build customized 
Programs that can be imported onto the LOGIQ V2/LOGIQ V1. 
These Programs automate many of the steps normally 
performed manually by the user, thereby reducing the number of 
user actions and the amount of time to perform an exam.

 Figure 16-68. Tool Layout Overview

The Scan Assistant Creator tool can be used both on the 
scanner and as an off scanner tool. Where there are differences 
in behavior, this user’s guide uses the term ‘on scanner’ to 
indicate when the tool is running on the scanner and ‘off 
scanner’ to indicate when the tool is running off the scanner. 

1. Menu and ToolBars
2. Scan Coach Button
3. Steps
4. Scan Coach Attributes
5. Rule Checking
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File Handling

When using Scan Assistant Creator off the scanner, it is very 
important to organize the programs in a way that will make it 
easy to import the programs onto the scanner. Each Program is 
a computer file. While these computer files can be copied, 
pasted and deleted like any other computer file, the Program 
files are only viewable using the Scan Assistant Creator.

Off-Scanner Directory Structure

The Scan Assistant Creator organizes the Programs in a 
directory structure that allows easy importing into the LOGIQ 
V2/LOGIQ V1. In order to be imported, all Programs must be 
stored in a LOGIQ_SCAN_ASSISTANT Programs Directory. 
Within this directory, one or more user-specified directories are 
created. Within each of these user-specified directories are the 
category directories (VAS, ABD, etc.) that hold the actual 
Programs.

The dialog in the figure below allows the user to specify the 
location of the LOGIQ_SCAN_ASSISTANT directory (root 
directory) and to either select an existing User Program 
Directory or create a new one.

Figure 16-69. Directory Structure
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Off-Scanner Directory Structure  (continued)

The Directory Structure dialog can be accessed via the File 
menu. 

Figure 16-70. File Menu

Figure 16-71. File Toolbar

File Extensions

Factory defined Programs have an .ep (exam Program) 
extension while user-defined Programs have an .uep (user 
exam Program) extension. Both factory and user-defined 
Programs can be read into the Scan Assistant Creator, but only 
user-defined Programs are created. If a factory Program is read 
into the Scan Assistant Creator and then edited, it is saved as a 
user-defined Program.

Upon installation of the Scan Assistant Creator, files with a .ep 
or .uep extension are automatically associated with the Scan 
Assistant Creator.
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Exporting Programs from LOGIQ V2/LOGIQ V1

Factory or user-defined Programs on the LOGIQ V2/LOGIQ V1 
are easily exported for editing with the Scan Assistant Creator.

On the LOGIQ V2/LOGIQ V1:

1. Insert a USB storage device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Export.

4. Select the media type and specify a directory. If a directory 
is specified that already exists, the Export adds the 
Programs along with any existing Programs. If the names of 
Programs are the same, use the resulting dialog to decide 
how to continue.

5. Select the Program to be exported and export them.

On the computer with the Scan Assistant Creator installed:

1. Insert the USB storage device (or CD/DVD) used above.

2. Copy the LOGIQ_SCAN_ASSISTANT directory from the 
USB storage device (or CD/DVD) to the hard drive. The 
hard drive directory that you copy to is the root directory. If 
you want to work with the Programs directly on the USB 
storage device, this step can be skipped.

3. Either open a Program by double-clicking it or selecting 
File -> Open from the Scan Assistant Creator.
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Importing Programs to LOGIQ V2/LOGIQ V1

Programs created with the Scan Assistant Creator are easily 
imported to the LOGIQ V2/LOGIQ V1.

On the computer with the Scan Assistant Creator installed:

Copy the complete LOGIQ_SCAN_ASSISTANT directory from 
the computer hard drive to a USB device (or CD/DVD). The 
LOGIQ_SCAN_ASSISTANT directory needs to be at the top 
level (not in a subdirectory) on the USB device (or CD/DVD).

Example of Directory structure:

LOGIQ_SCAN_ASSISTANT

MyUserNameDirectory

ABD

CARD

GYN

OB

PED

SMP

UR

VAS

On the LOGIQ V2/LOGIQ V1:

1. Insert the USB device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Import.

4. Select the media type.

5. Select the Programs to be imported and import them. If you 
attempt to import Programs that already exist with the same 
name, use the resulting dialog to decide how to continue.
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Creating New Programs

A new Program is created by selecting File -> New, by clicking 
on the New document icon in the Toolbar, or by using the 
keyboard shortcut Ctrl+N. 

1. Before creating a New Program, select Single Step in the 
Toolbar.

Figure 16-72. File Toolbar

2. Proceed to add/update your settings for the Step: Step 
Name, Instructions, etc.

3. Once finished, highlight the finished Step.

 Figure 16-73. Highlight Step to Copy
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Creating New Programs  (continued)

4. Select Edit -> Copy

Figure 16-74. Edit -> Copy

5. In the Toolbar along the left, select Insert Step Before 
Selected or Insert Step After Selected.

Figure 16-75. Insert Step

6. Highlight the copied step and proceed to edit accordingly.

7. Proceed to follow the same procedure to add more steps to 
your Program.

8. When you are done, select Check to verify your Steps.

Figure 16-76. Rule Check and results area

9. The results are listed as to whether the Scan Assistant Rule 
Check Passed or if any Issues were detected. Issues found 
when running the check do not mean the Program is 
unusable. 

NOTE: The rule check may report an unequal number of left and 
right steps. This may or may not be the expected result. If a 
change is made in response to the rule check results, a new 
rule check can be run to see if the issue has been resolved.
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Opening New Programs

Multiple Programs can be open at the same time by selecting 
File -> Open. Each Program will open within the primary Scan 
Assistant Creator window.

Opening Existing Programs

An existing Program is opened by selecting File -> Open, by 
clicking on the File -> Open icon in the Toolbar, or by using the 
the shortcut Ctrl+O. Finding the Program file (.ep or .uep) and 
opening the file automatically opens the file in the Scan 
Assistant Creator. Multiple Programs can be opened at the 
same time.

Saving Programs

Programs are saved via the Save or Save As functions available 
on the File Menu and the File Toolbar. Save is also available via 
the Ctrl+S keyboard shortcut. “Save” saves the Program using 
its current name and file location. “Save As” allows the name 
and file locations to be edited.

When Saving a Program, the Scan Assistant Creator provides 
an opportunity to run a rule check on the Program before saving 
it as shown in the following figure. Yes runs the rule check, No 
bypasses the rule check and Cancel cancels the Save request. 
See ‘Rule Checking’ on page 16-135 for more details on Rule 
Checking Programs.

Figure 16-77. Program Rule Check Reminder

NOTE: The name of a Program is appended with an asterisk (*) when 
the Program has been changed, but those changes have not yet 
been saved.

A Program can be closed without saving it using the Close 
selection on the File Menu or by using the “X” in the upper right 
corner of the Program window.
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Sharing Programs

If you want to share a program with someone else, the file can 
simply be sent via e-mail as an attachment or copied onto a 
media. If the person receiving the program has the Scan 
Assistant Creator tool installed, he can simply open the file and 
then use “Save As” to save it to an appropriate directory. If the 
person receiving the program does not have the Scan Assistant 
Creator tool installed, he can still load the program onto a 
scanner by creating the following directory structure on a media 
device, copying the file to one of the category directories and 
then importing the protocol onto the scanner.

Top Level Directory on media: LOGIQ_SCAN_ASSISTANT User 
Program Directory: Any user name Category Directories: Abd, 
Card, Gyn, OB, Ped, SMP, UR, Vas

If you want to share an entire portfolio of programs with some 
else, the entire user program directory can be zipped. Make 
sure to set the options to include subfolders and to include 
relative path information. On the receiving end, the user can 
unzip the directory into a LOGIQ_SCAN_ASSISTANT directory. 

Views

A Program is made up of a series of steps. Each step is made 
up of various step attributes. The step and step attribute data 
can be viewed in many ways using the Scan Assistant Creator. 
The different ways to look at the data are called Views. The view 
of choice is selected from the View Selection Menu or the View 
Toolbar Menu.

Figure 16-78. View Selection Menu

Figure 16-79. View Toolbar Menu
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Single Step Views

The step names are shown on the left with the active step 
highlighted. The step attributes appear on the right and are 
separated into four groupings:

General attributes at the top

Imaging and Comment attributes on the left

Measure attributes on the right.

 Figure 16-80. Single Step View

Scan Assistant Features

Scan Assistant allows the user to program the steps in an exam 
and to program certain attributes for each step. The attributes 
are what give the Scan Assistant Program behavior. The tables 
below provide the names of all attributes along with a 
description of how each one is interpreted by the Scan Assistant 
feature.

1. Steps
2. Step Attributes
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General Attributes

Table 16-77:  General Attributes

Attribute 
Name Selections Description

First Step 
Default

Other Steps 
Default

Step Number Numeric Number of the step that 
appears in the Scan 
Assistant Navigation 
menu

1 Previous plus 
one

Step Name Any Number of the step that 
appears in the Scan 
Assistant Navigation 
menu

Step Name Same as 
previous step

Advance On Store Advance to the next step 
and go live after Print / 
Image Store (e.g Store 
key). This can be a 
single image store or a 
loop store. 

Store Same as 
previous step

Store & Unfreeze Advance to the next step 
after Print / Image Store 
(e.g. store key) and 
unfreeze. This can be a 
single image store or a 
loop store.

User Selection Advance to next step 
only after next step is 
manually selected 
(e.g. down arrow)

Instructions [Any Text] User notes displayed in 
the Scan Assistant 
Navigation menu when 
the step is active

Blank Same as 
previous step

Optional Optional (checked) An optional step is given 
a check mark during 
Program execution even 
if no image is acquired

Mandatory Same as 
previous step

Mandatory 
(unchecked)

A mandatory step is 
given a check mark only 
if an image is acquired 
for the step

Learn Probe On (checked) Learn and change the 
probe for the user

Off Off

Off (unchecked) No probe change
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Comment Attributes

Table 16-78:  Comment Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Comment 1, 
Comment 2

[Any Text] User annotation 
associated with 
the step.

Same as Step 
Name attribute

Same as Step 
Name attribute

Location 1, 
Location 2

Top Left Annotation is 
placed in the top 
left corner of the 
image area

Location 1: Bottom 
Center
Location 2: Dual 
Right: Bottom 
Center

Same as previous 
step

Middle Left Annotation is 
placed in the 
middle left side of 
the image area

Bottom Left Annotation is 
placed in the 
bottom left corner 
of the image area

Top Center Annotation is 
placed in the top 
center of the 
image area

Bottom Center Annotation is 
placed in the 
bottom center of 
the image area

Top Right Annotation is 
placed in the top 
right corner of the 
image area

Mid Right Annotation is 
placed in the 
middle right side of 
the image area

Bottom Right Annotation is 
placed in the 
bottom right 
corner of the 
image area

Dual Left: Bottom 
Center

Annotation is 
placed on the 
bottom center of 
the left image in 
dual screen
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Dual Left: Bottom 
Right

Annotation is 
placed on the 
bottom right of the 
left image in dual 
screen

Dual Left: Top Left Annotation is 
placed on the top 
left of the left 
image in dual 
screen

Dual Right: 
Bottom Center

Annotation is 
placed on the 
bottom center of 
the right image in 
dual screen

Dual Right: 
Bottom Right

Annotation is 
placed on the 
bottom right of the 
right image in dual 
screen

Dual Right: Top 
Left

Annotation is 
placed on the top 
left of the right 
image in dual 
screen

BP1, 2 Blank Body Pattern not 
specified. Scan 
Assistant does not 
set Body Pattern.

Blank Same as previous 
step

BP1, 2 Body pattern 
graphics with or 
without probe 
position

Selected Body 
Pattern with or 
without probe 
position will be set.

Blank Same as previous 
step

BP Specify (Not applicable) Button used to 
enable the Body 
Pattern Selection 
dialog so that the 
Body Pattern 
graphic can be 
selected and 
probe position can 
be set

BP Clear (Not applicable) Clears BP1, BP2 
defined for the 
step

Table 16-78:  Comment Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Probe Mark On (checked) BP Probe mark 
will be set by Scan 
Assistant

Off Same as previous 
step

Off (unchecked) Probe mark not 
specified. Scan 
Assistant does not 
set Probe mark.

Table 16-78:  Comment Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Mode Attributes

The probe and application associated with a program is not 
configurable. Instead, the scanner remembers the last probe 
and application used for a given Scan Assistant program and 
automatically selects them the next time the program is started.

Table 16-79:  Imaging Mode Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Color Mode On (checked) Color Doppler is on Off Same as previous 
step

Off (unchecked) Color Doppler is off

PW Doppler Mode On (checked) PW Doppler is on. If 
PW Doppler is not on 
and the new 
activated step 
indicates that 
Doppler should be 
on, the Mode Cursor 
is displayed or, if the 
Mode Cursor is 
already displayed, 
then PW Doppler is 
turned on.

Off Same as previous 
step

Off (unchecked) PW Doppler is off

CW Mode On (checked) CW-Mode is on Off Same as previous 
step

Off (unchecked) CW-Mode is off Off

M Mode On (checked) M-Mode is on Off Same as previous 
step

Off (unchecked) M-mode is off

3D On (checked) 3D on Off Same as previous 
step

Off (unchecked) 3D off

LOGIQ View On (checked) LOGIQ View on Off Same as previous 
step

Off (unchecked) LOGIQ View off
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Dual Off Dual screen not in 
use

Off Same as previous 
step

Left Active Dual screen is active 
and the left image is 
the active image.

Right Active Dual screen is active 
and the right image 
is the active image.

DualView DualView is active 
(both left and right 
images are live)

Dual on Freeze Dual View is active 
on Freeze

Table 16-79:  Imaging Mode Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Preference Attributes

Imaging Preferences work slightly different than other attributes. 
For example, if an abdomen Program has 20 steps and all steps 
have the Harmonics attribute set to Default, then Scan Assistant 
will not affect the harmonics setting. Now, assume that steps 
10-12 are gallbladder steps and that the harmonics attribute has 
been set to on for these steps. When transitioning into this group 
of steps (step 9 to step 10, e.g.), harmonics will be turned on (or 
remain on if it was previously on). If harmonics is then manually 
turned off in step 10 then Scan Assistant will not turn it back on 
when advancing to step 11. In other words, a group of 
consecutive steps with the same Imaging Preference are treated 
as a group by Scan Assistant and not as individual steps.

Table 16-80:  Imaging Preference Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Harmonics Off Harmonics off Default Same as previous 
step

On Harmonics on

Default Harmonics not 
specified. Scan 
Assistant does not 
set Harmonics on 
or off.

Virtual Convex Off Virtual Convex off Default Same as previous 
step

On Virtual Convex on

Default Virtual Convex not 
specified. Scan 
Assistant does not 
set Virtual Convex 
on or off.

CrossXBeam Off CrossXBeam off Default Same as previous 
step

On CrossXBeam on

Default CrossXBeam not 
specified. Scan 
Assistant does not 
set CrossXBeam 
on or off.
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PDI Off PDI off Default Same as previous 
step

On PDI on

Default PDI not specified. 
Scan Assistant 
does not set PDI 
on or off.

Color/Doppler 
Steer

Left Color/Doppler 
steered to the left

Center Same as previous 
step

Center Color/Doppler not 
steered

Right Color/Doppler 
steered to the right

Color Shortcuts Various Specify the Color 
Shortcuts

Depth Various Specify the Depth

Color Scale Various Specify the Color 
Scale

Doppler Scale Various Specify the 
Doppler Scale

SV Various Specify the SV

Table 16-80:  Imaging Preference Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Measurement Attributes

Table 16-81:  Measure Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

B/M Measure 
Trigger

Measure Key Initiate “Measure 1" 
attribute when the 
Measure key is 
manually selected.

None None

Freeze Key Initiate “Measure 1" 
attribute when the 
image is frozen.

Store Image Initiate “Measure 1" 
attribute when the 
Measure key is 
manually selected or 
the image is stored. 
This is used to store / 
print an image and 
then measure on it 
and then store it 
again. Therefore, the 
Advance On Print 
attribute is ignored on 
the first store / print 
when the Measure 
Trigger attribute is set 
to Image Store.

None Measurements are 
not triggered by Scan 
Assistant. The 
“Measure 1" attribute 
is ignored.

Side Rt The side 
measurement 
qualifier is set to 
Right side of the body

Rt Derived from 
Step Name 
attribute if 
possible. 
Otherwise, same 
as previous step

Lt The side 
measurement 
qualifier is set to Left 
side of the body

None The side 
measurement 
qualifier is not used 
(neither Right nor 
Left)
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Fetus A The fetus 
measurement 
qualifier is set to 
Fetus A

A Same as 
previous step

B The fetus 
measurement 
qualifier is set to 
Fetus B

C The fetus 
measurement 
qualifier is set to 
Fetus C

D The fetus 
measurement 
qualifier is set to 
Fetus D

Location Prox The location 
measurement 
qualifier is set to 
Proximal

Prox Same as 
previous step

Mid The location 
measurement 
qualifier is set to 
Middle

Dist The location 
measurement 
qualifier is set to 
Distal

None The location 
measurement 
qualifier is not used

B/M Measure 1 Various 2D or 
M-mode 
measurements

Specifies the first 2D 
or M-mode 
measurement to be 
initiated. The point at 
which the 
measurement is 
initiated is based 
upon the Measure 
Trigger attribute.

Blank Blank

Table 16-81:  Measure Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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B/M Measure 2 Various 2D or 
M-mode 
measurements

Specifies the second 
2D or M-mode 
measurement to be 
initiated after the 
measurement 
associated with the 
Measure 1 attribute is 
completed.

Blank Blank

B/M Measure 3 Various 2D or 
M-mode 
measurements

Specifies the third 2D 
or M-mode 
measurement to be 
initiated after the 
measurement 
associated with the 
Measure 2 attribute is 
completed.

Blank Blank

Doppler Vessel 
Assign

Various Doppler 
measurement 
Vessel folders

Specifies the Vessel 
folder to assign auto 
calcs to. The 
assignment happens 
when the image is 
stored / printed (Store 
key, e.g.).

Blank Blank

Auto Calcs Default Auto Calcs state not 
specified. Scan 
Assistant does not set 
Auto Calcs state.

Default Same as 
previous step

Off Auto Calcs state set 
to Off

Frozen Auto Calcs state set 
to Frozen

Live Auto Calcs state set 
to Live

Auto Calc Params Various Auto Calc 
parameters

Specifies the auto 
calc parameters to be 
used. 

Default Same as 
previous step

Default Auto Calc parameters 
are not specified. 
Scan Assistant does 
not set the Auto Calc 
parameters.

Table 16-81:  Measure Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Auto Calc Specify [Not Applicable] Button used to enable 
the Auto Calcs 
Parameter Selection 
dialog so that the 
Auto Calc Params 
attribute can be set

[Not Applicable] [Not Applicable]

Auto Calc Default [Not Applicable] Button used to set the 
Auto Calcs Params 
attribute to Default.

[Not Applicable] [Not Applicable]

Double Print (with/
without 
measurements)

On (checked) If an Image Store / 
Print (Store key, e.g.) 
is performed on an 
image with 
measurements, the 
image is stored / 
printed two times, 
once with the 
measurements and 
once without.

Off Same as 
previous step

Off (unchecked) No special Store / 
Print behavior.

Double Print (with 
or without color)

On (checked) If an Image Store / 
Print (Store key, e.g.) 
is performed on an 
image with color, the 
image is stored / 
printed two times, 
once with color and 
once without. If 
double print on color 
and double print on 
measurements are 
both configured to be 
on, the image is 
stored / printed two 
times, once with the 
measurements and 
once without.

Off (unchecked) No special Store / 
Print behavior.

View Worksheet On (checked) The worksheet is 
turned on

Off Off

Off (unchecked) The worksheet is not 
turned on

Table 16-81:  Measure Attributes (continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Measurements

Because there are many measurements available on the LOGIQ 
V2/LOGIQ V1 and because the measurement package is highly 
customizable, there is some special handling for measurements. 
The Measurement attributes affected by this special handling 
are Measure 1-3 and Vessel.

Selecting a Measurement Package

The Measurement selection menu can be used to specify which 
measurement package is to be used for the Program. The 
Measurements packages are organized by category and 
subcategory. The choices for the Measure 1-3 and Vessel 
attributes are limited by the selection of category and 
subcategory. To select a subcategory, select a category, move to 
the subcategory list and select a subcategory. To select all 
subcategories for a given category, select the category and then 
reselect the Measurements menu item to remove the menu.

A single Program is not allowed to have measurements from 
multiple categories, but it may have measurements from 
multiple subcategories.

Figure 16-81. Measurements Menu
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User-Defined Measurements

User-defined subcategories and individual measurements can 
be used with the Scan Assistant feature. To do so, the Scan 
Assistant Creator needs to know about the user-defined 
measurements on the LOGIQ V2/LOGIQ V1.

On the LOGIQ V2/LOGIQ V1, use the Scan Assistant utility 
menu to Export Programs to a USB storage device (or CD/
DVD). On the export menu, check the “Export user config data” 
checkbox to store the user-defined measurement information to 
the Program User Directory on the media. The name of the file is 
UserConfigSystemFile.res. When this file exists in the Program 
User Directory, then it is used. Otherwise, the default file 
installed with the Scan Assistant Creator is used.

Figure 16-82. Program Export Menu on LOGIQ V2/LOGIQ V1
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Navigating Programs

In addition to moving the windows pointer and selecting an item, 
there are several keyboard controls that navigate a Program.

Table 16-82:  Keyboard Program Navigation

Keyboard Entry Step Selected Step Attribute Selected

Enter Moves to next step. If on the last 
step, it creates a new step and 
selects it.

Single Step View: Varies based on 
the step attribute selected. If on the 
last step, it creates a new step and 
selects it.

Tab Single Step View: Moves to next 
step. On the last step it moves to the 
first step attribute.

Moves to next step attribute. If last 
attribute for the step, moves to next 
step.

Up Arrow/Page Up Moves to previous step Single Step View: Varies based on 
the step attribute selected.

Down Arrow/Page down Moves to next step Single Step View: Varies based on 
the step attribute selected.

Left Arrow No action Single Step View: Varies based on 
the step attribute selected.

Right Arrow Single Step View: No action. Single Step View: Varies based on 
the step attribute selected.
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Editing Programs

When editing Programs, changes can be made at both the step 
level and the step attribute level. Steps can be added, inserted, 
moved, deleted, copied and pasted. Step attributes can be 
modified for a given step or across multiple steps.

Editing Steps

The step toolbar allows steps to be inserted, moved up and 
down, and deleted. For steps to be moved, one or more 
consecutive steps must be selected. Some of the controls have 
shortcuts (Control Key + another key).

When the last step in a Program is selected, the Enter key 
automatically appends a new step to the end of the Program 
and selects the new step. When the Enter key is pressed on any 
other step, the next step is activated. The up and down arrows 
can also be used to move between steps.

Figure 16-83. Step Toolbar

1. Insert Step above selected step (Ctrl+l)
2. Insert Step below selected step
3. Move selected step(s) up (Ctrl+Up Arrow)
4. Move selected step(s) down (Ctrl+Down Arrow)
5. Delete selected step(s)
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Editing Steps  (continued)

The Edit Menu and Edit toolbar provides access to the Cut, 
Copy, Paste and Paste Special features. The Undo and Redo 
actions also appear on Edit Menu and Edit Toolbar.

Figure 16-84. Edit Menu

Figure 16-85. Edit Toolbar

When selecting multiple steps for Cutting or Copying, the Shift + 
Left Mouse and Ctrl + Left Mouse key combinations can be 
used. Multiple steps are also selected by holding the Left Mouse 
key and dragging across the steps of interest. When pasting 
steps they are added after the currently selected step.

The Paste Special control allows copied steps to be pasted with 
some modification. For example, the steps associated with the 
Right Kidney can be Copied and Pasted so that they are 
converted into Left Kidney steps during the paste. The Paste 
Special dialog is shown in the figure below. Simply select the 
desired Conversion and choose the “Paste” key. 
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Editing Steps  (continued)

• Step Name (Text)

• Comment 1 (Text)

• Comment 2 (Text)

• Side (Measurement qualifier)

• Location (Measurement qualifier)

• Fetus (Measurement qualifier)

Figure 16-86. Paste Special Dialog
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Editing Steps  (continued)

The Define Conversions key is used to define the text that is 
converted. An example is shown in the figure below. If an exact 
case match is found, it is used for the conversion. If there is a 
match, but with different case, it is used only if there is not an 
exact case match.

There are 3 user-defined conversions that can be edited and 
named. These user-defined conversions can also be used to 
perform a find and replace capability.

Figure 16-87. Define Conversions Dialog

Editing Step Attributes

To edit a step attribute simply select the step attribute and edit it, 
such as picking from a drop down menu, checking or 
unchecking a box or typing in text.

This will take the original step's content and copy it down the 
highlighted steps. This is also available when multiple attributes 
are selected within the same step.

If a step attribute is not editable, it may be because the attribute 
requires a different attribute to be set a particular way in order to 
become enabled. These dependencies are outlined below.

Table 16-83:  Step Attribute Dependencies

Step Attribute Dependency

PDI Color step attribute must be checked

Color / Dop Steer Color or PW step attribute must be checked

Measure 1 Measure Trigger must not be set to None

Measure 2 Measure 1 must be set

Measure 3 Measure 1 and Measure 2 must be set
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Editing Multiple Programs

Multiple Programs can be opened at the same time. To switch 
between Programs, the title banner of the window is selected or 
the Program is selected from the Window Menu. An asterisk 
indicates that the Program has been edited but not saved.

Figure 16-88. Window Menu

With multiple Programs open, steps copied from one Program 
can be put inserted into another Program via the paste or paste 
special features.

Undo/Redo

The Undo feature allows the previous action to be undone. For 
example, pressing undo 6 times will undo the last 6 changes. 
Redo cancels the Undo of an action. For example, pressing 
undo 6 times will undo the last 6 changes and then pressing 
Undo 2 times will cause only the last 4 actions to be undone.

Editing the Current Program on the Scanner

If you are currently using a Scan Assistant program and choose 
to edit that program while using it, the program will be reloaded 
when scanning is restarted. If the number of steps is changed, 
the checkmarks that were in place before editing are cleared. If 
the number of steps in the program has not changed, the 
checkmarks that were in place before editing are maintained.

The current program can be restarted at any time by selecting 
the Stop button on the Scan Assistant navigation window and 
selecting restart.
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Rule Checking

Scan Assistant Creator allows Programs to be checked. During 
a rule check, Scan Assistant Creator applies a series of rules 
against the Program being checked and reports any 
inconsistencies between the rules and the Program. This rule 
check is intended to find potential issues in the Program before 
it is tested on a LOGIQ V2/LOGIQ V1. Issues found when 
running the check do not mean the Program is unusable. It 
means that if there happens to be a problem with running the 
Program, the first place to look would be at the Issue noted 
when you ran the Check.

For example, if there is a step name Right Kidney and the 
Measurement Location is set to “Left”, the rule check would 
report this inconsistency. 

Running a Rule Check

The “Check” button below the Program area is used to initiate a 
rule check. The results are displayed in the Rule Check Results 
window to the right of the button. A rule check is also initiated 
when attempting to save a Program that has not previously 
passed a rule check.

 Figure 16-89. Rule Check Button and Rule Check Results
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Rule Check Results

If the issue is specific to a particular step, double-clicking on the 
issue number in the Rule Check Results window selects the 
step associated with the issue. The results are intended to be 
potential issues and therefore may be ignored at the discretion 
of the user. For example, the rule check may report that there 
are an unequal number of left and right steps. For a particular 
Program, this may be the expected result. If a change is made in 
response to the rule check results, a new rule check can be run 
to see if the issue has been resolved.

Customization

The Customize Menu is shown below.

Figure 16-90. Customize Menu

The column widths of the steps and step attributes are 
customizable. The desired width is set by selecting and dragging 
the line separating column headers. These adjustments are 
remembered for the next time the Scan Assistant Creator is 
used.

The locations of the toolbars are customizable. The location is 
set by selecting and dragging the toolbar gripper as shown in 
the figure below. The toolbars can be placed at the top, left, right 
or bottom of the Scan Assistant Creator.

Figure 16-91. Gripper used for Toolbar placement

1. Toolbar Gripper
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Exporting the Scan Assistant Creator to a PC

To export the Scan Assistant Creator to a PC, 

1. Insert a USB Flash Drive in a USB port on the Control 
Panel. 

2. Press Utility--> Scan Assistant. 

3. Press Export. 

4. Place a checkmark in the Export Scan Assistant Creator 
Installation. 

5. Press Export. 

Figure 16-92. Export Scan Assistant Creator Installation
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Search

Opens up a search window to find a parameter on the utility 
pages. 

To search for a utility parameter, 

1. Select Search. 

2. Type in the search string. For instance, if you’re searching 
for Patient info, you could just type ‘patient’. 

Figure 16-93. Search Example

3. A list of possible matches appears to the right. Select the 
correct match. 

NOTE: You cannot perform a search on the Measure, Reports, or 
Service utility pages. 
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Chapter 17

Probes and Biopsy

This chapter consists of the information of each probe 
and describes some special concerns, biopsy kits and 
accessories as well as basic procedures for attaching a 
biopsy guide to the different types of probes. 
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

• Handle and manipulate with ease

• Connect to the system with one hand

• Be lightweight and balanced

• Have rounded edges and smooth surfaces.

• Stand up to typical wear by cleaning and disinfectant 
agents, contact with approved gel, etc.

Cables have been designed to:

• Connect to system with appropriate cable length

Cable handling

Take the following precautions with probe cables:

• Keep free from wheels

• Do not bend the cable acutely

• Avoid crossing cables between probes.
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Probe orientation

Each probe is provided with an orientation marking. This mark is 
used to identify the side of the probe corresponding to the side 
of the image having the orientation mark on the display.

Figure 17-1. Orientation Marking on Probe (Example)

1. Orientation Mark

Labeling

Each probe is labeled with the following information:

• Seller's name and manufacturer

• GE part number

• Probe serial number

• Month and year of manufacture

• Probe designation-provided on the probe grip and the top of 
the connector housing, so it is easily read when mounted on 
the system and is also automatically displayed on the 
screen when the probe is selected.

 Figure 17-2. Displayed Probe Information

Probe Naming Conventions

Table 17-1:  Probe Naming Convention

Type Frequency Connector Type

C=Convex
L=Linear
S=Sector

“4” in 4C-RS RS
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Probe Usage

For details on connecting, activating, deactivating, 
disconnecting, transporting and storing the probes, See ‘Probes’ 
on page 3-44 for more information.

Care and Maintenance

Inspecting probes

Before each use

1. Inspect the probe's lens, cable, casing, and connector for 
cracks, cuts, tears, and other signs of physical damage.

Inspect probes for cracks or openings in the housing and 
holes in and around the acoustic lens or other damage that 
could allow liquid to enter the probe.

2. Test the functionality of the probe.

After each use

1. Inspect the probe's lens, cable, casing, and connector for 
cracks, cuts, tears, and other signs of physical damage.

2. Look for any damage that would allow liquid to enter the 
probe.

CAUTION If any damage is found, DO NOT use the probe until it has 
been inspected and released for further use by a GE service 
representative.
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Environmental Requirements

Probes should be operated, stored, or transported within the 
parameters outlined below.

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

Table 17-2:  Probe Environmental Requirements

Operational Storage Transport

Temperature 10° - 40° C
50° - 104° F

0° - 50° C
32° - 122° F

-40° - 55° C
-40° - 131° F

Humidity 5 - 85%
non-condensing

5 - 85%
non-condensing

5 - 85%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Check the room temperature before you use the probe. 
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Probe Safety

Handling precautions 

Electrical shock hazard 

WARNING Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling.  Use care 
when handling and protect from damage when not in use.  DO 
NOT use a damaged or defective probe.  Failure to follow 
these precautions can result in serious injury and equipment 
damage.

Electrical
Hazard

The probe is driven with electrical energy that can injure the 
patient or user if live internal parts are contacted by conductive 
solution:

• DO NOT immerse the probe into any liquid beyond the 
level indicated by the immersion level diagram.  Refer to 
the immersion illustration in the Probe Cleaning Process 
section.  Never immerse the probe connector or probe 
adaptors into any liquid.

• DO NOT drop the probes or subject them to other types of 
mechanical shock or impact.  Degraded performance or 
damage such as cracks or chips in the housing may result.

• Prior to each use, visually inspect the probe lens and case 
area for cracks, cuts, tears, and other signs of physical 
damage. DO NOT use a probe which appears to be 
damaged until you verify functional and safe performance. 
You must perform a more thorough inspection, including 
the cable, strain relief, and connector, each time you clean 
the probe. 

• Before inserting the connector into the probe port, inspect 
the probe connector pins. If a pin is bent, do not use the 
probe until it has been inspected and repaired/replaced by 
a GE Service Representative.

• DO NOT kink, tightly coil, or apply excessive force on the 
probe cable.  Insulation failure may result.

• Electrical leakage checks should be performed on a routine 
basis by GE Service or qualified hospital personnel.  Refer 
to the service manual for leakage check procedures.
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Mechanical hazards 

CAUTION A defective probe or excessive force can cause patient injury or 
probe damage:

• Observe depth markings and do not apply excessive force 
when inserting or manipulating intercavitary probes.

• Inspect probes for sharp edges or rough surfaces that 
could injure sensitive tissue.

• DO NOT apply excessive force to the probe connector 
when inserting into the probe port. The pin of a probe 
connector may bend.
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Special handling instructions

Using protective sheaths

Instructions.  Custom made sheaths are available for each 
probe.  Each probe sheath kit consists of a flexible sheath used 
to cover the probe and cable and elastic bands used to secure 
the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for 
those probes intended for use in biopsy procedures.  In addition 
to the sheath and elastic bands, there are associated 
accessories for performing a biopsy procedure which are 
included in the kit.  Refer to the biopsy instructions for the 
specific probes in the Discussion section of this chapter for 
further information.

Reordering.  To reorder sheaths, please contact your local 
distributor or the appropriate support resource. 

CAUTION Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra-operative procedures. Use of legally marketed, 
sterile, pyrogen free probe sheaths is REQUIRED for 
neurological intra-operative procedures.

CAUTION Devices containing latex may cause severe allergic reaction in 
latex sensitive individuals.  Refer to FDA's March 29, 1991 
Medical Alert on latex products.

CAUTION Do not use pre-lubricated condoms as a sheath.  In some 
cases, they may damage the probe.  Lubricants in these 
condoms may not be compatible with probe construction.

CAUTION DO NOT use an expired probe sheath. Before using probe 
sheaths, verify whether the term of validity has expired.
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Endocavitary Probe Handling Precautions

If the sterilization solution comes out of the endocavitary probe, 
please follow the cautions below.

CAUTION Sterile/sanitary sheaths are to be used on the probe during its 
actual use with patients. Wearing gloves protects the patient 
and operator.

CAUTION Sterilant Exposure to Patient (e.g., Cidex)—Contact with a 
sterilant to the patient’s skin or mucous membrane may cause 
an inflammation. If this happens, refer to the sterilant’s 
instruction manual.

Sterilant Exposure from Probe Handle/Connector to 
Patient (e.g., Cidex)—DO NOT allow the sterilant to contact 
the patient. Only immerse the probe to its specified level. 
Ensure that no solution has entered the probe’s handle before 
scanning the patient. If sterilant comes into contact with the 
patient, refer to the sterilant’s instruction manual.

Endocavitary Probe Point of Contact—Refer to the 
sterilant’s instruction manual.
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Probe handling and infection control

This information is intended to increase user awareness of the 
risks of disease transmission associated with using this 
equipment and provide guidance in making decisions directly 
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that 
must be coupled to the patient by direct physical contact.  
Depending on the type of examination, this contact occurs with a 
variety of tissues ranging from intact skin in a routine exam to 
recirculating blood in a surgical procedure.  The level of risk of 
infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between 
patients is with single use or disposable devices.  However, 
ultrasound transducers are complex and expensive devices that 
must be reused between patients.  It is very important, therefore, 
to minimize the risk of disease transmission by using barriers 
and through proper processing between patients. 

CAUTION Risk of Infection. ALWAYS clean and disinfect the probe 
between patients to the level appropriate for the type of 
examination and use FDA-cleared probe sheaths where 
appropriate.  

CAUTION Adequate cleaning and disinfection are necessary to prevent 
disease transmission.  It is the responsibility of the equipment 
user to verify and maintain the effectiveness of the infection 
control procedures in use.  Always use sterile, legally marketed 
probe sheaths for intra-cavitary and intra-operative procedures.

For neurological intra-operative procedures, use of a legally 
marketed, sterile, pyrogen free probe sheath is REQUIRED.  
Probes for neuro surgical use must not be sterilized with liquid 
chemical sterilants because of the possibility of neuro toxic 
residues remaining on the probe.
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Probe Cleaning Process

Cleaning probes

To clean the probe:

NOTE: Do not immerse the probe into any liquid beyond the level 
specified for that probe. Never immerse the transducer 
connector into any liquid.

1. Inspect the probe's lens, cable, casing, and connector for 
cracks, cuts, tears, and other signs of physical damage.

2. Disconnect the probe from the ultrasound console and 
remove all coupling gel from the probe by wiping with a soft 
cloth and rinsing with flowing water. 

NOTE: DO NOT wipe the probe with a dry cloth.

3. Soak the probe head in water. Scrub the probe as needed 
using a soft sponge, gauze, or cloth to remove all visible 
residue from the probe surface. 

4. Rinse the probe with enough clean potable water. 

5. Air dry or dry with a soft cloth.

6. After cleaning, inspect the probe's lens, cable, casing and 
connector. Look for any damage that would allow liquid to 
enter the probe. Also, inspect the probe functionality by live 
scan. If any damage is found, do not use the probe until it 
has been inspected and repaired/replaced by a GE service 
representative.

CAUTION Take extra care when handling the lens face of the 
ultrasound transducer. The lens face is especially sensitive 
and can easily be damaged by rough handling. NEVER 
use excessive force when cleaning the lens face.
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Cleaning probes  (continued)

Figure 17-3. Probe Immersion Levels

Table 17-3:  Description of Pictogram for Probe Immersion 
Levels

Pictogram Description

Fluid Level
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Disinfecting probes

Perform After 
Each Use

Ultrasound probes can be disinfected using liquid chemical 
germicides. The level of disinfection is directly related to the 
duration of contact with the germicide. Increased contact time 
produces a higher level of disinfection. Refer to Probe Care 
Card that was shipped with each LOGIQ V2/LOGIQ V1 probe.

CAUTION Ensure that you follow the probe disinfection procedure 
provided by GE.

Table 17-4:  Description of Pictogram on Probe Care Card

Pictogram Description

“ATTENTION” - Consult accompanying documents” is intended to alert the 
user to refer to the operator manual or other instructions when complete 
information cannot be provided on the label.

“CAUTION” - Dangerous voltage (the lightning flash with arrowhead) is used to 
indicate electric shock hazards.

Biohazard - Patient/user infection due to contaminated equipment.
Usage
• Cleaning and care instructions
• Sheath and glove guidelines

Ultrasound probes are highly sensitive medical instruments that can easily be 
damaged by improper handling. Use care when handling and protect from 
damage when not in use. 

Do not immerse the probe into any liquid beyond the level specified for that 
probe. Refer to the user manual of the ultrasound system.

Since there is a possibility of having negative effects on the probe, observe the 
specified immersing time by the germicide manufacturer strictly. Do not 
immerse the probe in liquid chemical germicides more than the time prescribed 
in the care card.
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“Consult accompany document” - Refer to the ultrasound system user manual 
for important probe care and cleaning instruction.

Table 17-4:  Description of Pictogram on Probe Care Card (continued)

Pictogram Description
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Disinfecting probes  (continued)

1. Prepare the germicide solution according to the 
manufacturer's instructions. Be sure to follow all precautions 
for storage, use and disposal.

2. Place the cleaned and dried probe in contact with the 
germicide for the time specified by the germicide 
manufacturer.  High-level disinfection is recommended for 
surface probes and is required for endocavitary and 
intraoperative probes (follow the germicide manufacturer's 
recommended time).

3. After removing from the germicide, rinse the probe following 
the germicide manufacturer's rinsing instructions.  Flush all 
visible germicide residue from the probe and allow to air dry.

CAUTION Review the probe care card that is packed with each probe. 
Please refer to the probe  care card for GE approved probe 
disinfectants. 

CAUTION In order for liquid chemical germicides to be effective, all visible 
residue must be removed during the cleaning process. 
Thoroughly clean the probe, as described earlier before 
attempting disinfection.

You MUST disconnect the probe from the LOGIQ V2/LOGIQ 
V1 prior to cleaning/disinfecting the probe. Failure to do so 
could damage the system.  

DO NOT soak probes in liquid chemical germicide for longer 
than is stated by the germicide instructions for use. Extended 
soaking may cause probe damage and early failure of the 
enclosure, resulting in possible electric shock hazard. 

CAUTION Probes for neuro surgical intra-operative use must NOT be 
sterilized with liquid chemical sterilants because of the 
possibility of neuro toxic residues remaining on the probe.  
Neurological procedures must be done with the use of 
legally marketed, sterile, pyrogen free probe sheaths.

WARNING There should be no chemical residuals on the probe after 
cleaning or disinfection.
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Disinfecting probes  (continued)

CAUTION CREUTZFIELD-JACOB DISEASE

Neurological use on patients with this disease must be 
avoided.  If a probe becomes contaminated, the probe must be 
destroyed. there is no adequate disinfecting means.

Biological
Hazard

WARNING Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals. Failure to 
follow these precautions can result in serious injury and 
equipment damage.

• Do not immerse the probe into any liquid beyond the level 
specified for that probe. Never immerse the transducer 
connector or probe adapters into any liquid.

• Avoid mechanical shock or impact to the transducer and do 
not apply excessive bending or pulling force to the cable.

• Transducer damage can result from contact with 
inappropriate coupling or cleaning agents:

• Do not soak or saturate transducers with solutions 
containing alcohol, bleach, ammonium chloride 
compounds or hydrogen peroxide

• Avoid contact with solutions or coupling gels containing 
mineral oil or lanolin

• Avoid temperatures above 60°C (except with Trophon 
for approved probes.)

• Inspect the probe prior to use and after use for damage or 
degeneration to the housing, strain relief, lens and seal.  
Do not use a damaged or defective probe.
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Coupling gels

Applying In order to assure optimal transmission of energy between the 
patient and probe, a conductive gel or couplant must be applied 
liberally to the patient where scanning will be performed.

Precautions Coupling gels should not contain the following ingredients as 
they are known to cause probe damage:

• Methanol, ethanol, isopropanol, or any other alcohol-based 
product

• Mineral oil

• Iodine

• Lotions

• Lanolin

• Aloe Vera

• Olive Oil

• Methyl or Ethyl Parabens (para hydroxybenzoic acid)

• Dimethylsilicone

• Polyether glycol based

• Petroleum

WARNING Do not use unrecommended gels (lubricants). They may 
damage the probe and void the warranty. Please refer to the 
probe care card for GE approved probe gels.

CAUTION Do not apply gel to the eyes. If there is gel contact to the eye, 
flush eye thoroughly with water.



Probes and Biopsy

17-18 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

Planned Maintenance

The following maintenance schedule is suggested for the 
system and probes to ensure optimum operation and safety.

Returning/Shipping Probes and Repair Parts

US Department of Transportation and GE policy requires that 
equipment returned for service MUST be clean and free of blood 
and other infectious substances.

When you return a probe or part for service (Field Engineer or 
customer), you need to clean and disinfect the probe or part 
prior to packing and shipping the equipment.

Ensure that you follow probe cleaning and disinfection 
instructions provided in the User Manual.

This ensures that employees in the transportation industry as 
well as the people who receive the package are protected from 
any risk.

Sterile Ultrasound Procedures

ONLY ultrasound gel that is labeled as sterile, is sterile. 

Ensure you always use sterile ultrasound gel for those 
procedures that require sterile ultrasound gel.

Once a container of sterile ultrasound gel is opened, it is no 
longer sterile and contamination during subsequent use is 
possible.

Table 17-5:  Planned Maintenance Program

Do the Following Daily After Each Use As Necessary

Inspect the Probes X X X

Clean the Probes X X

Disinfect Probes X X
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Probe Discussion

Introduction

The LOGIQ V2/LOGIQ V1 supports the following types of 
probes: 

• Convex Array. Convex Array probes.

• Micro Convex Array. Micro Convex Array probes.

• Linear Array. Linear Array probes.

• Sector Phased Array. Sector Phased Array probes.

CAUTION Probes for transvaginal and transrectal applications require 
special handling. Transvaginal/transrectal examinations and 
probe insertions should be performed only by personnel with 
adequate training. Refer to the user documentation enclosed 
with these probes.
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Application

Table 17-6:  Probe Indications for Use

Probe Application 4C-RS 8C-RS 3Sc-RS
L6-12-

RS E8C-RS
LK760

-RS 12L-RS

Abdominal X X

Obstetrics X X

Gynecological X X

Cardiac X X

Vascular X X X

Transcranial X X

Musculoskeletal X X X X X

Urological X X

Small Parts X X

Pediatrics and Neonatal X X X

Transvaginal X

Transrectal X

Biopsy X X X X X
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Features

NOTE: Not all features, products, probes or peripherals described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

Specifications

Table 17-7:  Probe Features

Probe 
Application 4C-RS 8C-RS 3Sc-RS L6-12-RS E8C-RS

LK760-
RS 12L-RS

LOGIQ View X X X X X X X

Easy 3D X X X X X X X

CWD X

TVI/TVD X

CrossXBeam X X X X X X

SRI-HD X X X X X X X

Scan Coach X X X X X X

Virtual Convex X X X X

B/Harmonic X X X X X X X

PWD X X X X X X

M Mode X X X X X X X

AMM X X X

CMM X

Needle X X

Table 17-8:  Probe Specifications

Probe 
Designation

Center Image 
Frequency (MHz)

Frequency Range 
(MHz)

Doppler Frequency 
Range (MHz)

4C-RS 3.10 2.00 ~ 5.00 2.00 ~ 3.60

3Sc-RS 2.75 2.00 ~ 4.00 1.70 ~ 3.30

L6-12-RS 7.75 6.00 ~ 13.00 4.00 ~ 6.00

E8C-RS 6.50 6.00 ~ 10.00 4.20 ~ 6.30

8C-RS 6.50 6.00 ~ 10.00 4.20 ~ 6.30
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LK760-RS 7.15 5.00 ~ 10.00 NA

12L-RS 7.75 6.00 ~ 13.00 4.20 ~ 7.70

Table 17-8:  Probe Specifications (continued)

Probe 
Designation

Center Image 
Frequency (MHz)

Frequency Range 
(MHz)

Doppler Frequency 
Range (MHz)
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Slice Thickness Specification

Table 17-9:  Probe Slice Thickness Specification

Probe Designation Probe Slice Thickness Specification [mm]

8C-RS <=13.0mm

E8C-RS <=13.0mm

L6-12-RS <=15.0mm

3Sc-RS <=16.0mm

4C-RS <=12.0mm

LK760-RS <=12.0mm

12L-RS <=15.0mm
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Probe Illustration

Convex Probe

Linear Probe

Table 17-10:  Convex Probe Illustration

Probe Illustration Probe Illustration

4C-RS 8C-RS

E8C-RS

Table 17-11:  Linear Probe Illustration

Probe Illustration Probe Illustration

L6-12-RS LK760-RS

12L-RS
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Sector Probe

Table 17-12:  Sector Probe Illustration

Probe Illustration

3Sc-RS
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Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING Do not freeze the image during a biopsy procedure.  The image 
must be live to avoid a positioning error.

Biopsy guidezones are intended to assist the user in 
determining optimal probe placement and approximate the 
needle path.  However, actual needle movement is likely to 
deviate from the guideline.  Always monitor the relative 
positions of the biopsy needle and the subject mass during the 
procedure.

CAUTION The use of biopsy devices and accessories that have not been 
evaluated for use with this equipment may not be compatible 
and could result in injury.

CAUTION The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

• Follow the probe cleaning and disinfection procedures and 
precautions to properly prepare the probe.

• Follow the manufacturer's instructions for the cleaning of 
biopsy devices and accessories.

• Use protective barriers such as gloves and probe sheaths.

• After use, follow proper procedures for decontamination, 
cleaning, and waste disposal.



Biopsy Special Concerns

LOGIQ V2/LOGIQ V1 – Basic User Manual 17-27
Direction 5610735-100 English Rev. 2

Precautions Concerning the Use of Biopsy Procedures  (continued)

CAUTION Improper cleaning methods and the use of certain cleaning and 
disinfecting agents can cause damage to the plastic 
components that will degrade imaging performance or increase 
the risk of electric shock. 

See ‘Probe Safety’ on page 17-6 for more information.

WARNING NEVER reuse the TR5° disposable biopsy guide attachment 
and Disposable sterile Ultra-Pro II Needle guide kits.
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Preparing for a Biopsy

Displaying the Guidezone

Activate the Biopsy Kit by selecting it from the B-Mode menu. If 
necessary, configure the Biopsy kit to the B mode menu controls 
in Utility -> Application -> Imaging Controls - > Primary menu.

 Figure 17-4. Biopsy Guidezones example

The available biopsy options appear when Biopsy Kit is 
selected. There are fixed and adjustable angle biopsy kits and 
plastic/disposable and reusable biopsy guides available with the 
LOGIQ V2/LOGIQ V1 depending on the probe. Select the 
desired biopsy kit. 

NOTE: You can set biopsy guideline display via Utility -> System -> 
System Image -> Biopsy Guide screen.
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Displaying the Guidezone  (continued)

NOTE: You can display the biopsy guideline on the CFM image in 
simultaneous mode. Select the Show Biopsy Mark on CFM 
simultaneous Mode preset in the Utility -> System -> System 
Image -> Biopsy Guide screen.

The biopsy guidezone represents a path of the needle. The dots 
which make up the guidezones is the depth readout where: 

• Yellow represent 1 cm increments. 

• Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for 
any needle deviation from the center line or guidezone.

Before scanning, verify the needle can be visualized within the 
imaging plane.  User appropriate needle length to reach target 
area. 

The Biopsy Guidezone adjusts along with image adjustments, 
such as image inversion/rotations, zoom and depth changes.

The needle may vary from the center line or guidezone for 
various reasons:

• Needle barrel to needle clearance or strength.

• Bracket manufacturing tolerance.

• Needle deflection due to tissue resistance.

• Needle size chosen. Thinner needles may deflect more.

Table 17-13:  Biopsy Guide Availability

Biopsy Guide E
8C

-R
S

L
6

-1
2-

R
S

3S
c

-R
S

4C
-R

S

1
2L

-R
S

Fixed Angle E8C_TR5 Biopsy Depths (cm) 15.3

E8C_RU Biopsy Angle (degree) 90

Multi-Angle MBX1 Biopsy Depths (cm) 1.5 4.2 4.0 1.5

MBX2 Biopsy Depths (cm) 2.5 5.7 6.0 2.5

MBX3 Biopsy Depths (cm) 3.5 8.2 10.0 3.5
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Displaying the Guidezone  (continued)

DANGER
 

Failure to match the guidezone displayed to the guide may 
cause the needle to track a path outside the zone.

It is extremely important that when using the adjustable angle 
biopsy guides, the angle displayed on the screen matches the 
angle set on the guide, otherwise the needle will not follow the 
displayed guidezone which could result in repeated biopsies or 
patient injury.
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Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide 
attachments for each probe.  The guide consists of a 
non-disposable bracket to attach to the probe, disposable 
needle clip to attach to the bracket, sheath, gel (sterile gel if 
necessary) and disposable needle barrels.

The disposable needle barrels are available for a variety of 
needle sizes.

The bracket is packaged non-sterile and is reusable. To avoid 
possible patient contaimination, ensure bracket is properly 
cleaned, sterilized or disinfected before each use.

Disposable components are packaged sterile and are single-use 
only. Do not use if integrity of packing is violated or if expiration 
date has passed.

CAUTION Please refer to the manufacturer's instructions included in the 
biopsy kit.

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood.
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Fixed Needle Biopsy Guide Assembly

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for 
any damage.

2. If the biopsy guide is to be attached, use the filling removal 
tool to clean out the attachment area on the probe head.

Figure 17-5. Attachment Filling Removal

a. Probe Head

b. Attachment

c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE: Ensure that protective gloves are worn.

WARNING DO NOT use the needle with the catheter (soft tube). There is a 
possibility of breaking the catheter in the body.

CAUTION Before inserting the needle, scan the patient to determine the 
correct puncture depth and site. Only the sterile/sanitary 
sheath and rubber band are on the probe during the pre-needle 
placement scanning.
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Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the 
sheath.

NOTE: Remember to rinse all sanitary probe sheaths of powder 
before placing on the probe. Powder can degrade the 
displayed image.

2. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

3. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

4. Inspect the sheath for nicks, cuts or tears.

Figure 17-6. E8C-RS Probe with Sheath

a. Probe Handle

b. Probe Body

c. Sanitary Sheath

5. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.
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Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic 
biopsy guide on to the probe over the sheath.

Figure 17-7. Disposable Biopsy Guide 5 degree Angle

Figure 17-8. Reusable Biopsy Guide

a. Fix with a screw

2. Place an adequate amount of ultrasound gel on the gel-filled 
sheath tip’s outer surface.

3. Ensure the guide is properly seated and secure by pushing 
forward on the needle insertion end of the guide until the 
attachment node is firmly in place in it’s hole.

CAUTION Patient injury or repeated biopsies may result. The needle 
placement will not be as intended if the needle guide is not 
properly seated and secure.

a
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Multi Angle Biopsy Guide Assembly

1. Scan the patient and identify the target for biopsy. Move the 
probe to locate the target to the center of the image. Enable 
the system biopsy guidezone and try guidezone angles 
MBX1 to MBX3 to decide the best angle setting for needle 
path.

Figure 17-9. Example

2. Pull up on the knob (Figure 17-10 a) to freely move the 
needle guide attachment. Align the knob with the selected 
position of the needle guide attachment.

Push the knob down (Figure 17-10 b) into the desired slot to 
secure the angle position of the needle guide attachment.

Figure 17-10. Pull up and push down the knob

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood.
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Multi Angle Biopsy Guide Assembly  (continued)

3. Fit a convex of the biopsy bracket (a) in a concave of the 
probe (b).

Figure 17-11. Probe/Bracket Alignment

Hold the side (a) and tuck down the needle guide side (b) 
until it clicks or locks in place. 

Figure 17-12. Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the 
probe.



Preparing for a Biopsy

LOGIQ V2/LOGIQ V1 – Basic User Manual 17-37
Direction 5610735-100 English Rev. 2

Multi Angle Biopsy Guide Assembly  (continued)

5. Place the proper sanitary sheath tightly over the probe and 
biopsy bracket. Use the rubber bands supplied to hold the 
sheath in place.

Figure 17-13. Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 17-14. Snap the needle guide
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Multi Angle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock (a). Make sure the needle guide is firmly attached to 
the bracket.

Figure 17-15. Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 17-16. Needle Barrel

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 17-17. Needle Barrel Installation
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Multi Angle Biopsy Guide Assembly  (continued)

Remove the biopsy guide

1. Hold the other side and push out the needle clip attachment 
side. See Figure 17-18.

Figure 17-18. Remove the biopsy guide

CAUTION Prevent damage to the probe lens with finger nails. 
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Releasing the needle

According to the following procedure, you remove the needle 
from a probe and an assembly without moving the needle.

Figure 17-19. Release the needle from assembly

a. Push the knob portion of a sleeve in the direction of the 
arrow.

b. The needle is released from the assembly.

c. Push the probe and the assembly in the direction of the 
larger arrow to remove the needle.

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

• Properly install the bracket and biopsy guide.

• Scan in a container filled with water (47° C).

• Display the biopsy guidezone on the monitor.

• Ensure that the needle echo falls within the guidezone 
markers.
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The Biopsy Procedure

1. Place coupling gel on the scanning surface of the probe/
sheath/biopsy guide assembly.

2. Activate the biopsy guidezone on the system through the 
B-Mode menu. When using multi-angle guides, ensure that 
the proper guidezone angle is displayed.

3. Scan to locate the target.  Center the target in the electronic 
guidezone path.

NOTE: Enabling color flow would allow for visualization of the 
vascular structure around the area to be biopsied.

4. Place the needle in the guide between the needle barrel and 
needle clip.  Direct it into the area of interest for specimen 
retrieval.

WARNING Biopsy procedures must only be performed on live images.

CAUTION Ensure that all guide parts are seated properly prior to 
performing a biopsy.
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Post Biopsy

When the biopsy is complete, remove the needle barrel, needle 
clip and probe sheath.  Properly dispose of these items in 
accordance with current facility guidelines.

Clean and disinfect the probe. See ‘Probe Cleaning Process’ on 
page 17-11 for more information.

The biopsy bracket can be cleaned and disinfected in a 
recommended disinfecting agent and reused.

CAUTION When the biopsy needle guide kit is opened, all parts must be 
discarded after the procedure whether they have been used or 
not.
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Surgery/Intra-operative Use

Preparing for Surgery/Intra-operative Procedures

Preparing the transducer for intra-operative use follows the 
same sterile procedure as for biopsy use except that no biopsy 
attachments are used. See ‘Preparing the Biopsy Guide 
Attachment’ on page 17-31 for more information. Sterile gel is 
applied to the transducer face and a sterile sheath completely 
covers the transducer and cable which has first undergone a 
thorough cleaning and high-level disinfection.

The invasive nature of surgery/intra-operative procedures 
requires proper preparation and technique to control infection 
and disease transmission.  Equipment must be cleaned as 
appropriate for the procedure prior to use.

CAUTION For surgery/intra-operative procedures, a sterile environment is 
required.  Therefore, both the operator and probe needs to be 
sterile. 
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Preparing for Surgery/Intra-operative Procedures  (continued)

To ensure a sterile environment during the procedure, it is 
recommended that this be a two-person job. 

1. Perform a high level disinfection of the probe. 

2. The scanner (surgeon, sonographer, etc.) should be sterile 
and gloved.

3. Place an adequate amount of sterile coupling gel on the 
face of the probe.

4. Place the proper sterile sheath over the probe and cord.

Figure 17-20. Applying Sterile Sheath

5. Depending on the type of procedure, use either sterile water 
or sterile gel on the sheath cover.

NOTE: Follow your institutions guidelines on post surgery/
intra-operative procedures for probe cleaning and disinfection.
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Chapter 18

User Maintenance

This chapter supplies system data, assistance 
information, and system care and maintenance 
instructions. 
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System Data

Features/Specifications

Table 18-1:  Physical Attributes

Console Dimensions and Weight
• Height: approximately 120 mm (4.72 in)
• Length: approximately 396 mm (15.59 in)
• Width: approximately 368 mm (14.49 in)
• Weight (with battery, but without any probes or 

peripherals): less than 6 kg (13.23 lbs.)

Console Design
• Integrated SDD type HDD
• Integrated speakers 
• User adjustable audio output control on keyboard
• USB flash drive, HDD, DVD-RW, SD card as 

option to archive patient data
• Lithium Ion Battery
• Laptop Style 

Console Electrical Power
• Voltage:100-240 Vac
• Frequency: 50/60 Hz
• Power: Consumption maximum of 200 VA with 

on-board peripherals

Keyboard
• Alphabetic and numeric keyboard  
• Ergonomic hard key layout
• Interactive back-lighting

15” LCD Monitor
• High-Resolution LCD display
• Opening angle adjustment: 170 degrees 
• Horizontal/Vertical View angle: 80 degrees
• Brightness adjustment
• The LCD panel physical resolution:1024 x 768
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Table 18-2:  System Overview

Applications
• Abdominal
• Obstetrics
• Gynecological
• Cardiac 
• Vascular
• Transcranial
• Musculoskeletal
• Urological
• Small parts
• Pediatric and Neonatal

Scanning Methods
• Electronic Sector
• Electronic Convex
• Electronic Linear

Transducer Types
• Sector Phased Array
• Linear Array
• Convex Array
• Micro Convex Array

Operating Modes
• B-Mode
• M-Mode
• Color Flow Mode (CF)
• Coded Harmonic Imaging (Phase Inversion 

Harmonic)
• PW Doppler (with HPRF)
• Anatomical M Mode
• Color M Mode
• PDI Mode and Directional PDI
• CWD Mode (option)
• Cine Mode
• Easy 3D (option)
• Tissue Velocity Imaging with Q analysis and 

Tissue Velocity Doppler (option)

Standard Features
• Automatic Optimization (ATO/ASO) 
• Auto Depth 
• Virtual Convex
• Zoom
• Other ID
• Biopsy
• Patient information database
• Image Archive integrated on CD/DVD and Hard 

Drive
• Real-time automatic Doppler calcs
• General B Mode measurement /calculation
• General M Mode measurement /calculation
• General Doppler Mode measurement /calculation
• Abdominal measurement /calculation
• OB measurement /calculation
• Fetal Trending
• Multi gestational Calcs
• Hip Dysplasia Calcs
• Gyn measurement /calculation
• Vascular measurement /calculation
• Cardiac measurement /calculation
• Pediatric measurement /calculation
• Urological measurement /calculation
• Small parts measurement /calculation
• inSite ExC Capability

Options
• Report
• CWD
• CFM (For LOGIQ V1 only)
• DICOM
• SonoBiometry (AFB)
• Auto IMT
• LOGIQ View
• Scan Coach
• Easy 3D
• TVI/TVD
• Anatomical M Mode
• Needle

Peripheral Options
• B/W image printer
• Color image printer
• Report printer
• USB Footswitch
• Wireless Adapter
• 2 probe ports
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Table 18-3:  System Parameters

Controls Available on Freeze or Recall
• Automatic Optimization
• SRI-HD
• B/M Mode (Gray Map; TGC, Colorized B and M; 

Frame Average [Loops only]; Dynamic Range)
• Anatomical M-Mode
• Read Zoom
• Base Line Shift
• Sweep Speed
• PW-Mode (Gray Map; Post Gain; Baseline Shift; 

Sweep Speed; Invert Spectral Waveform; 
Compression; Rejection, Colorized Spectrum; 
Display Format; Angle Correct; Quick Angle 
Correct, Auto Angle Correct)

• Color Flow (Overall Gain [Loops and Stills]; Color 
Map; Transparency Map; Frame Averaging [Loops 
only]; Flash Suppression, CFM Display Threshold; 
Spectral Invert for Color/Doppler)

• Anatomical M-Mode on CINE Loop

Controls Available While “Live”
• Write zoom
• B/M-Mode (Gain; TGC; Dynamic Range; Acoustic 

Output; Transmission Focus Position; 
Transmission Focus Number; Line Density 
Control; Sweep Speed for M-Mode; # of Angles for 
CrossXBeam)

• PW-Mode (Gain; Dynamic Range; Acoustic 
Output; Transmission Frequency; PRF; Wall Filter; 
Spectral Averaging; Sample Volume Gate for 
PW-Mode Length and Depth; Velocity Scale)

• Color Flow (CFM Gain; CFM Velocity Range; 
Acoustic Output; Wall Echo Filter; Packet Size; 
Frame Rate Control; CFM Spatial Filter; CFM 
Frame Averaging; CFM Line Resolution; 
Frequency/Velocity Baseline Shift) 

Scanning Parameters
• Displayed Imaging Depth: 2 - 33 cm
• Minimum Depth of Field: 0 - 2 cm (Zoom) (probe 

dependent)
• Maximum Depth of Field: 0 - 33 cm (probe 

dependent)
• Continuous Dynamic Receive Focus / Continuous 

Dynamic Receive Aperture
• Adjustable Dynamic Range
• Adjustable Field of View [FOV]
• Image Reverse: Right/ Left
• Image Rotation: 0°, 180°

Image Storage 
• On-board database of patient information from 

past exams
• Storage Formats: 

• DICOM - compressed/ uncompressed, single/ 
multiframe, with/ without Raw Data

• Export JPEG,JPEG2000, WMV (MPEG 4), 
and AVI formats

• Storage Devices:
• USB Flash Device: 64MB to 4GB (for 

exporting individual images/clips)
• CD-RW storage: 700MB
• DVD storage: -R (4.7GB) 
• Hard Drive Image Storage: ~50GB

• Compare old images with current exam
• Reload of archived data sets

CINE Memory/Image Memory 
• Selectable CINE Sequence for CINE Review
• Measurements/Calculations & Annotations on 

CINE Playback 
• Scrolling timeline memory
• Dual Image CINE Display
• Quad Image CINE Display
• CINE Gauge and CINE Image Number Display
• CINE Review Loop
• CINE Review Speed
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Table 18-4:  Measurements and Calculations

B-Mode
• Depth and Distance
• Circumference and Area (Ellipse/Trace)
• Volume (Ellipsoid) 
• Angle between 2 Lines
• % Stenosis (Area or Diameter) 

M-Mode
• M Depth and Distance
• Time 
• Slope
• Heart Rate

Doppler Measurements/Calculations
• Velocity
• Time
• A/B Ratio (Velocities/Frequency Ratio)
• PS (Peak Systole)
• ED (End Diastole)
• PS/ED (PS/ED Ratio)
• ED/PS (ED/PS Ratio)
• AT (Acceleration Time)
• Accel (Acceleration)
• TAMAX (Time Averaged Maximum Velocity)
• Volume Flow [TAMEAN and Vessel Area]
• Heart Rate
• PI (Pulsatility Index)
• RI (Resistivity Index)

Vascular Measurements/Calculations
• Carotid, Vertebral, Subclavian Measurements, 

Auto IMT
• Summary Reports

Obstetrics Measurements/Calculations
• Gestational Age Calculation
• EFW Calculation
• Calculations and Ratios
• Measurements/Calculations
• Fetal Graphical Trending
• Growth Percentiles
• Multi-Gestational Calculation
• Fetal Qualitative Description (Anatomical Survey)
• Fetal Environmental Description (Biophysical 

profile)
• Programmable OB Tables
• Over 20 selectable OB Calcs
• Expanded Worksheets 

Gynecology Measurements/Calculations
• Right/Left Ovary Length, Width, Height
• Uterus Length, Width, Height
• Cervix Length, Trace
• Ovarian Volume
• ENDO (Endometrial thickness)
• Ovarian/Uterine RI
• Summary Report

Urology Calculation
• Bladder, Prostate, Renal, Generic Volume 

Measurements
• Post-Void Bladder Volume

Cardiology Measurements/Calculations
• Cardiology Measurements and Calculations
• Summary Worksheet
• Summary Report

Table 18-5:  Probes

• 4C-RS (Applications: Abdomen, Obstetrics, 
Gynecology, Urology, Mulsculoskeletal, Biopsy)

• 8C-RS (Applications: Cardiac, Transcranial, 
Pediatrics and Neonatal, Musculoskeletal)

• 3Sc-RS (Applications: Abdomen, Cardiac, 
Transcranial, Biopsy)

• 12L-RS (Applications: Vascular, Musculoskeletal, 
Small Parts, Pediatrics and Neonatal, Biopsy 

• L6-12-RS (Applications: Vascular, 
Musculoskeletal, Small Parts, Pediatrics and 
Neonatal, Biopsy)

• LK760-RS (Applications: Musculoskeletal)
• E8C-RS (Applications: Obstetrics, Gynecology, 

Transvaginal, Transrectal, Biopsy)

Table 18-6:  Inputs and Outputs Signal

External Inputs and Outputs
• 1 dedicated Isolated USB printer port
• 2 general USB ports
• 1 SD card port
• S-Video out port

• Composit ourt port
• Ethernet port
• HDMI port
• VGA output through an external video adapter 

from HDMI
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Clinical Measurement Accuracy

Basic Measurements

The following information is intended to provide guidance to the 
user in determining the amount of variation or measurement 
error that should be considered when performing clinical 
measurements with this equipment. Error can be contributed by 
equipment limitations and improper user technique. Be sure to 
follow all measurement instructions and develop uniform 
measurement techniques among all users to minimize the 
potential operator error. Also, in order to detect possible 
equipment malfunctions that could affect measurement 
accuracy, a quality assurance (QA) plan should be established 
for the equipment that includes routine accuracy checks with 
tissue mimicking phantoms.

Please be advised that all distance and Doppler related 
measurements through tissue are dependent upon the 
propagation velocity of sound within the tissue. The propagation 
velocity usually varies with the type of tissue, but an average 
velocity for soft tissue is assumed. This equipment is designed 
for, and the accuracy statements listed on are based on, an 
assumed average velocity of 1540 m/s. The percent accuracy 
when stated applies to the measurement obtained (not the full 
scale range). Where the accuracy is stated as a percent with a 
fixed value, the expected inaccuracy is the greater of the two.
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Basic Measurements  (continued)

Table 18-7:  System Measurements and Accuracies

Measurement Units Useful Range Accuracy Limitations or Conditions 

Depth mm Full Screen <=10% NA

Angle degree Full Screen <=5% NA

Distance:

Axial mm Full Screen <5% Linear Probes, Convex 
Probes, Sector Probes

Lateral mm Full Screen <5% Linear Probes, Convex 
Probes, Sector Probes

Circumference:

Trace mm Full Screen <=10% Linear Probes, Convex 
Probes, Sector Probes

Ellipse mm Full Screen <=5% Linear Probes, Convex 
Probes, Sector Probes

Area:

Trace mm2 Full Screen <=5% Linear Probes, Convex 
Probes, Sector Probes

Ellipse mm2 Full Screen <=5% Linear Probes, Convex 
Probes, Sector Probes

Time s Timeline Display <5% M mode,  AM mode, CM mode, 
PWD mode, CWD mode

Slope mm/s Timeline Display <=10% M mode,  AM mode, CM mode,

Doppler SV 
Position

mm Full Screen <=2 mm PWD mode

Doppler Velocity cm/s Form 0 to 100 cm/s
From 100 to 130 cm/s

<15%
<10%

PWD mode, CWD mode

Doppler Angle 
Correction

cm/s From 0-80° <=5% PWD mode
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Clinical Calculation Accuracy

Estimate the overall inaccuracy of a combined measurement 
and calculation by including the stated inaccuracy from the basic 
measurement accuracy statements.

Calculation formulas and databases are provided as a tool to 
assist the user, but should not be considered an undisputed 
database, in making a clinical diagnosis. The user is 
encouraged to research the literature and judge the equipment 
capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.

CAUTION Diagnostic errors may result from the inappropriate use of 
clinical calculations. Review the referenced source of the 
stated formula or method to become familiar with the intended 
uses and possible limitations of the calculation.
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Anti-Virus Software Note

Anti-virus software IS NOT present on the LOGIQ V2/LOGIQ V1 
system. Since the LOGIQ V2/LOGIQ V1 is already protected 
against attack by the measures listed below, no Anti-virus 
software is deemed necessary. 

• Only communication ports required for system operation are 
enabled. 

• Only operating system services required by system 
application software are enabled. 

• Software programs CANNOT be loaded onto the LOGIQ V2/
LOGIQ V1 (e.g., e-mail, web browser, etc.). 

• An auto-executable file CANNOT be run automatically on 
the LOGIQ V2/LOGIQ V1. 

• The LOGIQ V2/LOGIQ V1 software includes the latest MS 
Windows security protection. 

Due to the safety measures noted above, and the security 
standards of Windows XP Service Pack 3, the highest safety 
against viruses, worms, etc., has been provided to ensure 
sufficient safety measures. In addition, additional security 
information can be found at http://www.gehealthcare.com/usen/
security/index.html.
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System Care and Maintenance

Overview

The user must ensure that safety inspections are performed at 
least every 12 months according to the requirements of the 
patient safety standard IEC 60601-1. Refer to the Service 
manual, Chapter 10.

Refer to Section 10 of the LOGIQ V2/LOGIQ V1 Service Manual 
for any additional maintenance guidance.

Only trained persons are allowed to perform the safety 
inspections mentioned above.

Technical descriptions are available on request.

To ensure that the unit constantly operates at maximum 
efficiency we recommend that the following procedures be 
observed as part of the customer’s internal routine maintenance 
program.

Contact the local Service Representative for parts or periodic 
maintenance inspections.

CAUTION Standard maintenance must be performed by authorized 
service personnel for the lifetime of the product (7 years).
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Inspecting the System

Examine the following on a monthly basis (or whenever there is 
a reason to assume that any issue may have occurred):

• Connectors on cables for any mechanical defects.

• Entire length of electrical and power cables for cuts or 
abrasions.

• Equipment for loose or missing hardware.

• Control panel and keyboard for defects.

• Trackball movement

If the trackball is dusty, please clean it. See ‘Trackball’ on 
page 18-15 for more information. 

CAUTION To avoid electrical shock hazard, do not remove panels or 
covers from console. This servicing must be performed by 
qualified service personnel. Failure to do so could cause 
serious injury.

Electrical
Hazard

If any defects are observed or malfunctions occur, do not 
operate the equipment but inform a qualified service person.  
Contact a Service Representative for information.
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Weekly Maintenance

The system requires weekly care and maintenance to function 
safely and properly. Clean the following:

• System Cabinet

• LCD Monitor

• Operator control panel

• Footswitch

• Printers

Failure to perform required maintenance may result in 
unnecessary service calls.

CAUTION Ensure that you follow the probe disinfection procedure 
provided by GE.
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Cleaning the system

Prior to cleaning any part of the system:

1. Turn off the system power. Disconnect the power cord. See 
‘Power Off’ on page 3-35 for more information.

2. Remove the battery.

System Cabinet

To clean the system cabinet:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

2. Wipe down the top, front, back, and both sides of the system 
cabinet. Be careful with the output and input ports of the 
system and do not allow anything especially liquid enter into 
the ports.

3. Wipe off excess cleaning agents. 

NOTE: Do not spray any liquid directly into the unit.

LCD Monitor

To clean the monitor face:

Use a soft, folded cloth. Gently wipe the monitor face.

Do NOT use a glass cleaner that has a hydrocarbon base (such 
as Benzene, Methyl Alcohol or Methyl Ethyl Ketone) on monitors 
with the filter (anti-glare shield). Hard rubbing will also damage 
the filter.

NOTE: When cleaning the screen, make sure not to scratch the LCD.
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Operator Control Panel

To clean the operator control panel:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

2. Wipe down operator control panel.

3. Use a cotton swab to clean around keys or controls. Use a 
toothpick to remove solids from between keys and controls.

NOTE: When cleaning the operator control panel, make sure not to spill 
or spray any liquid on the controls, into the system cabinet, or in 
the probe connection receptacle.

NOTE: In case of SARS, use bleach, alcohol, or Cidex in a normal 
diluted form for cleaning/disinfecting the operator panel. 

NOTE: DO NOT use T-spray or Sani Wipes on the control panel. 

Footswitch

To clean the footswitch:

1. Disconnect the footswitch from the LOGIQ V2/LOGIQ V1.

2. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

3. Wipe the external surfaces of the unit then dry with a soft, 
clean, cloth.

CAUTION Before cleaning the control panel, make sure the key cap is 
firmly in place. 
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Trackball

1. Rotate the retainer counterclockwise until it can be removed 
from the keyboard.

Figure 18-1. Rotate the retainer

2. Separate the trackball and the retainer. Wipe off any oil or 
dust from the trackball, retainer and the trackball housing 
using a cleaner or cotton swab.

3. Assemble the trackball and retainer, then put it into the 
housing and rotate it clockwise until its notches are set in 
position.

Other Peripheral Maintenance

Refer to the peripheral manufacture’s manuals for more 
information.

CAUTION When cleaning, make sure not to spill or spray any liquid into 
the trackball housing (keyboard or system).
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Other Maintenance

Replacing illuminated key caps/lamps

Contact a local Service Representative when a key cap or lamp 
needs to be replaced.

Battery Replacement and Disposal

Battery replacement every three years is recommended.

Contact a local Service Representative for the replacement of 
the battery. Used batteries will be discarded appropriately by 
GE.

NOTE: Disposing of the battery should meet local law and regulatory 
requirements.

Prevention of static electricity interference

Interference from static electricity can damage electronic 
components in the system. The following measures help to 
reduce the likelihood of electrostatic discharge:

• Wipe the alphanumeric keyboard and monitor with lint-free 
tissue or a soft cloth dampened with anti-static spray on a 
monthly basis.

• Spray carpets with anti-static spray because constant 
walking on carpets in or near the scanning room may be a 
source of static electricity.
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Disposal

This symbol indicates that waste electrical and electronic 
equipment must not be disposed of as unsorted municipal waste 
and must be collected separately. Please contact an authorized 
representative of the manufacturer for information concerning 
the decommissioning of your equipment.

Disposal of Old Electrical & Electronic Equipment (applicable in 
the European Union and other European countries with 
separate collection systems).This symbol on the product or on 
its packaging indicates that this product shall not be treated as 
household waste.Instead it shall be handed over to the 
applicable collection point for the recycling of electrical and 
electronic equipment. By ensuring this product is disposed of 
correctly, you will help prevent potential negative consequences 
for the environment and human health, which could otherwise 
be caused by inappropriate waste handling of this product. The 
recycling of materials will help to conserve natural resources. 
For more detailed information about recycling of this product, 
please contact your local city office, your household waste 
disposal service or the shop where you purchased the product.

NOTE: Dispose of the system according to local law and regulatory 
requirements.

Table 18-8:  WEEE symbol

Bottom of the system and Probe connector
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Troubleshooting

Please refer Service Manual if other messages appear on the 
monitor display.

Table 18-9:  Troubleshooting

System temperature is too high. System will shut down.
1. Select OK and shutdown the system.
2. Check whether the ventilation hole is blocked, if yes, 

clean the ventilation hole. 
3. If it still not works, stop operating the equipment and 

perform the proper action for the patient. Inform a 
qualified service person and contact a Service 
Representative for information.

System voltage fault. System will shut down.
1. Select OK and shutdown the system.
2. If the same message appears after reboot, shut 

down the system then turn on the system according 
to ‘Power On’ on page 3-31.

3. If it still not works, stop operating the equipment and 
perform the proper action for the patient. Inform a 
qualified service person and contact a Service 
Representative for information.

System Error. Please reboot the system.
1. Select OK and reboot the system.
2. If the same message appears after reboot, shut 

down the system then turn on the system according 
to ‘Power On’ on page 3-31.

3. If it still not works, stop operating the equipment and 
perform the proper action for the patient. Inform a 
qualified service person and contact a Service 
Representative for information.
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System Software Updates (Software Download)

Software Updates for the unit may be available for download 
and installation. When a Software Update is available, a 
message icon is displayed on the system exit window.

Only users with administrator rights are allowed to download 
Software Updates. You first download the software, then install 
the software. It is a two-step process. 

Once the software installation has begun, the system is not 
usable until the software installation is done.  The installation 
can take up to 45 minutes to complete.  While installing, DO 
NOT turn off system power or the system can be left in a 
unusable mode.  For this reason, you may want to perform the 
software download one evening and then install the software the 
next evening.  

After the software installation is complete, you will be asked to 
perform a few system functional checks to determine normal 
system operation. 

NOTE: A software download may take more than 1 hour (and may take 
several hours), depending on local network conditions. During 
this time, you cannot perform any other function. Please allow 
sufficient time to complete the software download and 
installation.

NOTE: Please ensure network connection when downloading software.

NOTE: After you press a software download button, it may take up to 
three (3) seconds for the system to respond. 

NOTE: Software Updates through the GE service platform may not be 
available in all countries.
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Software download and installation

You receive notification of available software updates via the 
envelope icon that appears in the status bar on the bottom of the 
monitor. 

NOTE: To update the software, you must login with administrator 
privileges.

1. Press the on/off button on the control panel. The Exit dialog 
window with software download displays.

Figure 18-2. System - Exit Dialog Window

• Decline: You decline the software download; the 
software is not downloaded, no update will be 
performed. The software download will not occur and 
you will not be informed about this package again. 

• Download: Starts the software download.
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Software download and installation  (continued)

2. Select Download.

Figure 18-3. System - Exit Dialog Window

The download process starts. The progression of the 
download process is displayed. 

NOTE: The download step can be paused. While paused, you can 
return to normal operation. However, once the software 
installation has begun, the system is not usable until the 
software installation is done. While installing, DO NOT turn 
off system power.

NOTE: A typical software update of about 600 Mb may take up to 
60 minutes to download, but times may vary depending on 
your location and network connection.

• Pause: Pauses the software download process. If you 
select Pause, you can cancel out of this dialog and 
return to normal scanning or you can power off the 
scanner. A paused download can be resumed by 
logging in as Administrator, pressing the power switch, 
and selecting Resume.

• Resume: Press Resume to continue the software 
download.
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Software download and installation  (continued)

3. The following dialog is displayed when the software 
download is complete. Select Install.

Figure 18-4. Software Ready To Be Installed

• Decline: DO NOT install the downloaded software; no 
software upgrade will be performed. If you decline this 
installation, you WILL NOT be offered the chance to 
install this software package again. You can contact with 
GE Service Engineer to perform the install at a later 
time. 

Multiple screens appear during the software installation 
process. DO NOT interrupt this process AND follow 
instructions as they appear on the display. 

NOTE: A typical installation may take up to 15 minutes.
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Software download and installation  (continued)

4. After the installation complete, select Shutdown and then 
press Power On/Off button to reboot the system.

Figure 18-5. Shutdown after Software Installation

5. When the system starts up after the software installation has 
finished, press Power On/Off button any then select Verify.

Figure 18-6. Shutdown after Software Installation
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Software download and installation  (continued)

6. The new software verification checklist is displayed, this 
dialog is critical. You MUST perform software verification 
after downloading and installing the new software. 

Figure 18-7. New Software Verification Checklist

CAUTION Perform a check for all the features listed which is 
supported in the system. You MUST ensure that the entire 
system functions normally as expected. 

If any of the features in the list is not supported in the 
system, fill in Passed and do not need to verify it.

These verification results are tracked for regulatory 
purposes, sent back to GE for tracking, and approved with 
your signature. 
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Software download and installation  (continued)

7. As you verify that each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is filled 
in for all features, type your signature and press OK. The 
system is now ready for use. 

Figure 18-8. Features check Passed 

WARNING However, if any of the features DO NOT function as 
expected, you need to select “Failed” for this feature. Type 
your signature and press OK. Then the System-Exit 
Window is displayed, select Exit and then reboot the 
system, the system will return to the previous software 
version.
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Wipe Tool

Wipe tool is intended to erase all the patient data with the 
software to wipe the partitions on the system before the system 
will be shipped for service. 

NOTE: Wipe tool will be performed with the software USB flash drive. 
Be sure your software USB flash drive is well kept.

See ‘System/Backup and Restore Preset Menu’ on page 16-16 
for more information about the backup procedure.

NOTE: Before starting the wipe tool, please ensure that the power can 
be continuously supplied and there is no risk of power cut off 
during loading procedure.

1. Insert USB flash drive labeled “System & Application 
Software” to the system. 

2. Properly turn off the system by momentarily pressing the 
Power/On/Off Switch. In System-Exit window, select 
Shutdown to shutdown the system.

NOTE: If the system will not shut down normally, hold down the 
Power On/Off Switch until the light turns off.

3. Power on the system. The system will detect the USB flash 
drive automatically.

CAUTION The system can not be boot up after wipe process.

WARNING The wipe procedure will erase all the patient data and all 
existing software on the system. While the wipe procedure is 
designed to preserved data, you should save any patient data, 
images, system setups and customer presets to CD, DVD, 
USB Flash Drive, or USB Hard Disk before doing the wipe 
process.
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Wipe Tool  (continued)

4. Select [2] Wipe tool and then select Next to continue.

NOTE: All patient data cannot be recovered after this operation. 
Contact GE service for support.

NOTE: All patient data (if any) will be destroyed! Please backup 
patient data before executing erasing patient data!

Figure 18-9. Upgrade USB message 

5. The system indicates all data will be erased, select Yes to 
continue.

Figure 18-10. Confirmation Dialog
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Wipe Tool  (continued)

6. The software is wiping the partitions. Wait for the wipe 
procedure to complete. On the screen, it displays how much 
has been completed. 

NOTE: Do not interrupt the wipe tool process at any time until all the 
partitions wiping is completed.

Figure 18-11. Wiping progress

7. Select OK when the process is complete, and the system 
will shutdown automatically.

Figure 18-12. Process Complete
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Wipe Tool  (continued)

NOTE: As the SSD is empty after wipe process, the system cannot 
boot up. The software should be loaded first after the wipe 
process.

8. The wipe tool procedure has erased all patient data and all 
existing software.

NOTE: After the system is returned from service, restore the patient 
data, images, system setups and customer presets on your 
system. Contact GE service for support.

See ‘System/Backup and Restore Preset Menu’ on page 16-16 
for more information about the restore procedure.
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Quality Assurance

Introduction

A good Quality Assurance Evaluation program consists of 
periodic systematic actions that provide the user with adequate 
confidence that their diagnostic ultrasound system will produce 
consistently high quality images and quantitative information.

Therefore, it is in the best interests of every ultrasound user to 
routinely monitor equipment performance.

The frequency of Quality Assurance evaluations should be 
based on user's specific needs and clinical practice.

Periodic monitoring is essential in order to detect the 
performance changes that occur through normal aging of 
system components. Routine equipment evaluations may also 
reduce the duration of exams, number of repeat exams, and 
maintenance time required.

For details on system and peripheral routine preventive 
maintenance instructions, See ‘System Care and Maintenance’ 
on page 18-10 for more information.
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Typical Tests to Perform

Quality assurance measurements provide results relating to 
system performance. Typically these are:

• Axial Measurement Accuracy

• Lateral Measurement Accuracy

• Axial and Lateral Resolution

• Penetration

• Functional & Contrast Resolution

• Gray Scale Photography.

With these tests, a performance baseline can be set at 
installation with the phantom in your department. Future test 
results can be compared to the baseline in order to maintain a 
record of system performance trends.

Frequency of tests

Quality assurance tests are used to determine whether a 
scanner is providing the same level of performance from day to 
day.

The frequency of testing varies with the amount of system usage 
and modes to be tested. It is recommended that the user 
perform quality assurance tests at least every three months or 
every 400 patient studies. Tests should also be performed when 
a question about system performance exists.

A mobile system may require more frequent tests.

Image quality should also be tested immediately after the 
following events:

• Service calls

• System upgrades/modifications

• Dropped probe, power surge, etc. 
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Phantoms

Quality Assurance Evaluations should be done with phantoms 
and test objects that are applicable to the parameters being 
evaluated or to the user's clinical practice.

Typical phantoms are composed of material that acoustically 
mimic human tissue. Pins, anechoic and echogenic targets are 
physically positioned to provide information for a variety of tests.

Doppler phantoms are currently expensive and complicated to 
deal with on the user level. If a problem with any Doppler 
parameters or measurement is suspected, contact a local 
service representative for evaluation.

The RMI 403GS phantom is still available. Due to the superior 
penetration and resolution capabilities of GE ultrasound 
systems, the RMI 405GSX is recommended. It is the most 
current one available to our field service personnel and will 
provide the targets and extended life necessary for consistent 
system testing.



Quality Assurance

LOGIQ V2/LOGIQ V1 – Basic User Manual 18-33
Direction 5610735-100 English Rev. 2

Phantoms  (continued)

 Figure 18-13. Phantoms

1. Penetration

2. Axial Distance Measurement

3. Functional Resolution

4. Lateral Resolution

5. Lateral Distance Measurement

6. Axial Resolution

7. Contrast Resolution and Gray Scale Photography

8. Gray Scale Plane Targets
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Baselines

An absolute necessity for a quality assurance program is 
establishing baselines for each test or check. Baselines are 
established after the system has been verified to be working 
properly at installation or after a repair. If a probe or major 
assembly is replaced, new baselines should be generated.

Baselines can be made by adjusting system parameters to 
prescribed levels or to the best possible image. The key factor to 
remember is reproducibility. The same conditions must be 
reproduced for each periodic check.

All system parameters not displayed on the monitor should be 
recorded for the permanent record.

Periodic Checks

Periodic checks should be performed in accordance with your 
facility’s quality assurance requirements. For the data to be 
valid, periodic checks should mimic the baseline setup 
parameters.

The resulting image, when scanning the phantom exactly as 
before, should be recorded and compared to the baseline. 
When a matching image is obtained, it can be assumed that the 
system performance has not degraded from the baseline.

If a significant difference between the baseline and periodic 
check is noted, double check the system setup and repeat the 
test. If the difference between the baseline and periodic check 
persists, contact a local Service Representative.

Failing to reproduce the control settings as in the baselines will 
introduce errors in the data and potentially invalidate the results.
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Results

Lack of standardization among test instruments, the wide range 
of acceptance criteria, and incomplete knowledge regarding the 
significance of certain performance parameters prohibit the 
establishment of absolute performance criteria for these tests.

Quality Assurance Evaluation results should be compared to 
previously-recorded results. 

Performance trends can then be detected. Unacceptable 
performance or diminishing trends should be identified for 
maintenance or repair before a malfunction or inappropriate 
diagnosis occurs. 

The user should determine the best method for recording and 
archiving the baseline and periodic checks. In most cases the 
choice is hard copy.

It is important to maintain good consistent records for 
inspections that may arise, as well as to detect system 
performance trends.



User Maintenance

18-36 LOGIQ V2/LOGIQ V1 – Basic User Manual
Direction 5610735-100 English Rev. 2

System Setup

The user should tailor the tests to their particular needs. It is 
certainly not necessary to make all checks with all probes. A 
representative example, with the probes used most often by the 
customer, should be adequate in judging system performance 
trends.

Use a gray scale phantom as the scan object for the tests. 
Commercial phantoms are supplied with its own operator 
manual. Be familiar with proper phantom operating procedures 
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set 
to the normal viewing of a good gray scale image.

2. Check all recording devices for proper duplication of image 
monitor. Ensure that what is seen is what is recorded. 

3. Annotate non-displayed image processing controls. 

4. Set TGC slide pots to center (detent) position. 

5. Place focal zone marker(s) in area of interest for an 
optimum image.

Test Procedures

The following are recommended Quality Assurance tests. A brief 
description of the test, the benefit it provides and steps to 
accomplish the test are supplied.

The importance of recording scan parameters and consistent 
record keeping cannot be stressed enough. Reproducibility to 
monitor system trends is the key to quality assurance 
evaluations.

Using the system's dual image display format is often very 
convenient and saves recording media.
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Axial distance measurements

Description

Axial measurements are the distance measurements obtained 
along the sound beam. See Figure 18-13 for more information.

Benefit

The accurate measurement of the size, depth and volume of a 
structure is a critical factor in determining a proper diagnosis. 
Most imaging systems use depth markers and/or electronic 
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields 
as well as in zoom. If necessary, different depths or fields of 
view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets to typical depths for the probe being 
used.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the vertical pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if vertical measurements differ by 
more than 5% of the actual distance.
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Lateral distance measurements

Description

Lateral measurements are distance measurements obtained 
perpendicular to the axis of the sound beam. See Figure 18-13 
for more information.

Benefit

The purpose is the same as vertical measurements. 
Precisely-spaced horizontal pin targets are scanned and results 
compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far 
fields as well as in zoom. If necessary, different depths of fields 
of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the horizontal pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if horizontal measurements differ by 
more than 5% of the actual distance.
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Axial resolution

Description

Axial resolution is the minimum reflector separation between two 
closely-spaced objects to produce discrete reflections along the 
axis of the sound beam. It can also be monitored by checking 
the vertical size of known pin targets. See Figure 18-13 for more 
information.

Axial resolution is affected by the transmitting section of the 
system and the probe.

Benefit

In clinical imaging, poor axial resolution displays small 
structures lying close together as a single dot. This may lead to 
improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. 

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets to typical depths for the probe being used.

3. Press Freeze to stop image acquisition.

4. Perform a standard distance measurement of the pin 
vertical thickness at different points in the image. Record all 
images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale 
factors.

6. Press Freeze to stop image acquisition; repeat the vertical 
thickness measurements of the pins and record the images 
for archiving.

7. Document the measurements for reference and future 
comparison.

Axial resolution should remain stable over time. Contact a 
Service Engineer if any changes are observed.
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Lateral resolution

Description

Lateral resolution is the minimum reflector separation between 
two closely spaced objects to produce discrete reflections 
perpendicular to the axis of the sound beam. It can also be 
monitored by checking the horizontal size of known pin targets. 
See Figure 18-13 for more information.

Lateral resolution is dependent upon the beam width produced 
by the probe. The narrower the beam, the better the lateral 
resolution.

The beam width is affected by the frequency, degree of focusing, 
and distance of the object from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures 
lying close together as a single dot. This may lead to improper 
interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets.

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets from side to side.

3. Press Freeze to stop image acquisition and perform a 
standard distance measurement of the horizontal thickness 
of a pin at different points in the image. Record all images 
for archiving.

4. Scan the horizontal pins in zoom or at different depth/scale 
factors.

5. Press Freeze to stop image acquisition; repeat the 
horizontal thickness measurements of the pins and record 
the images for archiving.

6. Document the measurements for reference and future 
comparison. 

Pin width should remain relatively constant over time (“1mm). 
Dramatic changes in pin width may indicate beam forming 
problems. Contact a Service Engineer if beam width changes 
consistently over 2 to 3 periodic tests. 
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Penetration

Description

Penetration is the ability of an imaging system to detect and 
display weak echoes from small objects at large depths. See 
Figure 18-13 for more information.

Penetration can be affected by the system's: 

• Transmitter/receiver

• Degree of probe focusing

• Attenuation of the medium

• Depth and shape of reflecting object

• Electromagnetic interference from local surroundings. 

Benefit

Weak reflecting echoes are commonly produced from the 
internal structure of organs. Definition of this tissue texture is 
important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is 
increased. The maximum depth of penetration is the point at 
which homogeneous material in the phantom begins to lose 
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom along the vertical pin targets to typical 
depths for the probe being used.

4. Perform a standard distance measurement from the top of 
the image displayed to the point at which homogeneous 
material in the phantom begins to lose brightness.

5. Document the depth measurement for reference and future 
comparison. 

Contact a Service Engineer if the depth of penetration shifts 
more than one centimeter (1cm) when using the same probe 
and same system settings.
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Functional resolution

Description

Functional resolution is an imaging system's ability to detect and 
display the size, shape, and depth of an anechoic structure, as 
opposed to a pin target. See Figure 18-13 for more information.

The very best possible image is somewhat less important than 
reproducibility and stability over time. Routine tests at the same 
settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest 
structure the system is capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst 
targets to typical depths for the probe being used.

4. Evaluate the cysts at various depths for a good (round) 
shape, well-defined borders and no fill in. Remember, TGC 
slide pots are centered and should remain fixed. This may 
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is 
obtained.
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Contrast resolution

Description

Contrast resolution is the ability of an imaging system to detect 
and display the shape and echogenic characteristics of a 
structure. See Figure 18-13 for more information.

Specific values measured are less important than stability over 
time. Routine tests at the same settings should produce the 
same results.

Benefit

A correct diagnosis is dependent upon an imaging system's 
ability to differentiate between a cystic or solid structure versus 
echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths 
should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths 
available.

4. Evaluate the echogenic targets for contrast between each 
other and between the surrounding phantom material. 
Remember, TGC slide pots are centered and should remain 
fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or 
shapes of the targets appear distorted.
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Gray Scale photography

Description

Poor photography will cause loss of low level echoes and the 
lack of contrast between large amplitude echoes. See 
Figure 18-13 for more information.

Benefit

When photographic controls and film processors are properly 
adjusted, weak echoes, as well as strong echoes, are accurately 
recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's 
instructions until the hard copy and video display are equal.

2. Scan the phantom and it's echogenic contrast targets.

3. Make a hard copy photograph of the display and compare it 
to the image on the video monitor for contrast and weak 
echo display.

4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is 
on the image monitor.

NOTE: Optimization of brightness/contrast controls on the display 
monitor is imperative in order to make sure that the hardcopy 
and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or 
printer is adjusted to match the display monitor.
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Setting up a Record Keeping System

Preparation

The following is needed: 

• Quality Assurance binder.

• Hard copy or electronic file of images.

• Quality Assurance Checklists. 

• Display the following information while testing quality 
assurance: 

• Acoustic Output

• Gain

• Depth

• Probe

• Dynamic Range

• Set up new patient to be the name of the test.

• Annotate the following: 

• Any control where its value is NOT displayed. 

• Significant phantom information.

Record Keeping

Complete the following: 

1. Fill out the Ultrasound Quality Assurance Checklist for each 
probe, as scheduled. 

2. Make a hard copy or archive the image. 

3. Compare images to baseline images and acceptable 
values. 

4. Evaluate trends over previous test periods. 

5. File hard copy or electronic file of images and checklist in 
Quality Assurance binder. 
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Ultrasound Quality Assurance Checklist 

Table 18-10:  Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 18-11:  (Part 2)

Test

Baseline
Value
Range

Tested 
Value

Image 
Hardcopy/
Archived

Acceptable? 
Yes/No

Service 
Called 
(Date)

Date
Resolved

Vertical
Measurement
Accuracy

Horizontal
Measurement
Accuracy

Axial
Resolution

Lateral
Resolution

Penetration

Functional
Resolution

Contrast
Resolution

Gray Scale
Photography
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Assistance

Supplies/Accessories

Not all features, probes, peripherals or products described in 
this document may be available or cleared for sale in all 
markets. Please contact your local GE Ultrasound 
representative to get the latest information.

Contact the distributor, GE affiliate or sales representative for 
approved peripherals. For HCATs, contact your sales person.

CAUTION DO NOT connect any probes or accessories without approval 
by GE.

CAUTION Use only GE approved internal equipment when replacing an 
internal peripheral.

The user or the operator should never install/replace the 
internal peripheral. Service representatives authorized by 
GEHC will install/replace the internal peripheral.
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Supplies/Accessories  (continued)

The following supplies/accessories have been verified to be 
compatible with the system:

Peripherals

Table 18-12:  Peripherals and Accessories

Accessory Units

Footswitch FSU-1000 Each

Footswitch MKF 2-MED GP26 Each

USB Flash Drive 8G Each

USB3.0 HDD 1TB Each

DVD-RW Each

Sony UPD25 Color Printer Each

Sony UP-D897 Printer Each

Sony UP-D898MD Printer Each

HP Officejet 100 Printer Each

HP Officejet Pro 8100 Printer Each

Wireless Network USB Adapter Each

2 Probe ports Each

Table 18-13:  Probes and Accessories

Probe HCAT Biopsy Guide
Biopsy Guide

HCAT
Biopsy Guide

HCAT

8C-RS
Micro 
Convex

H40402LS Not Available N/A N/A

E8C-RS
Micro 
Convex

H40402LN Fixed angle, Disposable 
with a Plastic Bracket

E8385MJ

Fixed angle, Reusable with 
a Stainless Steel Bracket

H40412LN

L6-12-RS
Linear

H48062AC Multi-angle, Disposable 
with a Reusable Bracket

H40432LC
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3Sc-RS
Sector

H45041DL Multi-angle, Disposable 
with a Reusable Bracket

H46222LC

4C-RS
Convex

H4000SR Multi-angle, disposable 
with a reusable bracket

E8385NA

LK760-RS
Linear

H44901AF Not Available N/A N/A

12L-RS
Linear

H40402LY Multi-angle(in plane biopsy 
kit), Disposable with a
Reusable Bracket

H40432LC

Transverse Bracket (out of 

plane biopsy kit),

Disposable with a 
Reusable Bracket

H48392LL

Infinite-angle (in plane 

biopsy kit), Disposable with

a Reusable Bracket

H48392LT

Table 18-13:  Probes and Accessories

Probe HCAT Biopsy Guide
Biopsy Guide

HCAT
Biopsy Guide

HCAT
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Index

Symbols

% Stenosis, 9-12
generic measurement, 7-61
M-Mode, 9-15

’SaveAs’ Images, 15-13

Numerics

3D Acquisition, 5-85

A

A/B Ratio
Doppler generic measurement, 7-75
generic measurement, 7-68
M-Mode generic measurement, 7-70
M-Mode measurements, 9-15

abdomen exam
general guidelines, 8-2

Abdominal Circumference (AC), measuring, 9-5
accessories

ordering, 1-8
requesting a catalog, 1-8

accessory
connector panel, 3-17

accessory connector panel illustration, 3-18
Acclimation time, 3-30
accuracy

clinical calculation, 18-8
clinical measurement, 18-6

acoustic output
default levels, 2-28

Active Images, 4-19
Admin

overview of Utility screen, 16-98
Admin screen

Logon, 16-102
System Admin, 16-99
Users, 16-100

administrator
specifying system, 16-100

AFI, see Amniotic Fluid Index (AFI)
ALARA (as low as reasonably achievable), bioeffects, 
2-4
Alpha Hip, pediatric measurement, 13-6
Amniotic Fluid Index (AFI), measuring, 9-8, 9-9
Anatomical M-Mode

activating, 5-29
overview, 5-29

Angle Correct, adjusting
Doppler Mode, 5-56

Angle Steer, adjusting
Color Flow, 5-38
Doppler Mode, 5-56

Angle, B-Mode generic measurement, 7-67
annotating an image

introduction, 6-14
text overlays, 6-17
using the annotation library, 6-18
using typed words, 6-18

Annotations Libraries Presets Menu, 16-42, 16-45
annotations, prresets, 16-44
Antero-postero trunk diameter and transverse trunk 
diameter (APTD-TTD), 9-9
Antero-postero trunk diameter by transverse trunk 
diameter (AxT), 9-9
application presets

selecting, 4-21
user-defined, 4-21

Applications
setting presets, 16-53

Applications Preset Menu, 16-51
area measurements

ellipse, 7-40
spline, 7-42
trace, 7-41, 7-42

AUA
OB worksheet, 9-20

Audio Volume, adjusting in Doppler Mode, 5-57
Auto Optimize (Auto), adjusting, 5-8
Auto Vascular Calculation, see also Manual Vasuclar 
Calculation

overview, 11-16
Auto Vascular Calculation, see also Manual Vasuclar 
calculations

activating, 11-17
setting up calculation parameters, 11-17

B

back view, console, 3-7
backing up data

EZBackup/Move, see EZBackup/Move, using
Backup and Restore Preset Menu, 16-16
Baseline, adjusting
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Color Flow, 5-37
Doppler Mode, 5-58

beginning a new patient, 4-3, 4-5
biological hazards, 2-10, 2-12
Biparietal Diameter (BPD), 9-6
Bladder volume, measuring, 12-5
B-Mode imaging

intended uses, 5-2
optimizing, 5-2
scanning hints, 5-4
typical exam protocol, 5-3

B-mode measurement
Echo Level, 7-44

B-Mode measurements
Gynecology exam, 9-53
OB, 9-5

B-Mode measurements, general, 7-38
B-Mode measurements, generic

% Stenosis, 7-61
A/B Ratio, 7-68
Angle, 7-67
Volume, 7-63

B-Mode measurements, mode
circumference and area (ellipse), 7-40
circumference and area (spline trace), 7-42
circumference and area (trace), 7-41
distance, 7-39

body pattern application libraries, selecting, 16-51
Body Patterns, 6-21

General tab, 16-50
Body Patterns Preset Menu, 16-50
brightness, video, 3-42
Buttons screen

Connectivity, 16-90

C

Calculations
selecting, 7-8

calculations
OB worksheet, 9-22
urology, 12-3

calipers, description, 7-5
Cardio-Thoracic Area Ratio (CTAR), 9-9
Care and maintenance

cleaning the system, 18-13
footswitch, 18-14
operator controls, 18-14
system cabinet, 18-13

inspecting the system, 18-11
maintenance schedule, 18-12

Caution icon, defined, 2-3
CF/PDF Focus Depth(%), adjusting color, 5-42
CF/PDI Auto Sample Volume, adjusting, 5-42
CF/PDI Center Depth, adjusting, 5-42
CF/PDI Frequency, adjusting, 5-43
CF/PDI Vertical Size, adjusting, 5-36, 5-43
CF/PDI Width, adjusting, 5-36, 5-43

CINE loop
previewing only, 15-8
storing and previewing, 15-8
storing without previewing, 15-8

CINE mode
activating, 6-10
introduction, 6-10
synchronizing loops, 6-12
using, 6-11

circumference measurements
ellipse, 7-40
spline, 7-42
trace, 7-41, 7-42

cleaning probes, 17-11
Clinical

calculation accuracy, 18-8
measurement accuracy, 18-6

Coded Harmonic Imaging (CHI), activating, 5-13
Color Flow imaging

intended uses, 5-30
optimizing, 5-30
Power Doppler, 5-44

colorizing an image, 5-19
comments, see annotating an image
Compression, adjusting

Doppler Mode, 5-59
Connectivity

Buttons, 16-90
configuring, 16-59
overview of screens, 16-59
presets, 16-59
TCPIP, 16-61

console
back view, 3-7
front view, 3-7
moving, 3-39
transporting, 3-39

contacts
clinical questions, 1-8
Internet, 1-8
service questions, 1-8

contraindications, 1-7
Control Panel

description, 3-53
Control panel

replacing key caps, 18-16
replacing key lamps, 18-16

controls
annotation function, 3-57
display function, 3-56
keyboard, 3-54
measurement function, 3-57
mode function, 3-56
operator, 3-53
record function, 3-56

Crown Rump Length (CRL), measuring, 9-6
CUA

OB worksheet, 9-20
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Cursor Moving, adjusting, 5-59
CW Doppler

activating, 5-62
exiting, 5-62
overview, 5-62
steerable, 5-62

D

D/S ratio, 7-74
Danger icon, defined, 2-3
Data transfer

MPEGvue, 15-22
dD Ratio, pediatric measurement, 13-7
Depth, adjusting, 5-5
device labels, 2-31
devices

acceptable, 2-25
unapproved, 2-25

disinfecting probes, 17-13
disinfecting solutions, probes, 17-13
distance measurement

general, 7-39
Doppler Auto Calc Average Cycle, using, 7-50
Doppler measurements

GYN exam, 9-57
OB/GYN, 9-16

Doppler measurements, generic
A/B Ratio, 7-75
D/S ratio, 7-74
Heart Rate, 7-74
Pulsatility Index (PI), 7-73
Resistive Index (RI), 7-73

Doppler measurements, mode
TAMAX/TAMEAN, 7-48
time interval, 7-47
velocity, 7-46

Doppler Mode
generic study, 7-72

Doppler Mode, general measurements, 7-46
Doppler Mode, PW

activating, 5-53
intended uses, 5-50
optimizing, 5-50
typical exam protocol, 5-52

dual image mode, see split-screen imaging
DVD Multi drive

location, 15-35
Dynamic Range, adjusting

B-Mode, 5-16

E

Easy 3D, 5-87
Echo level measurement, 7-44
Edge Enhance, adjusting, 5-20
editing

patient information, 4-16

user-defined calculations, 7-31
EFW growth percentile

OB worksheet, 9-22
electrical

configurations, 3-3
electrical hazard, 2-10
electromagnetic compatiblity (EMC), 2-15
ellipse measurement, general, 7-40
EMC (electromagnetic compatiblity), 2-15
Endometrium thickness (Endo), GYN exam, 9-54
Environmental requirements

probes, 17-5
environmental requirements, 3-5
equipment safety, 2-10
Erasing

measurements, 7-10
Estimated Fetal Weight (EFW), 9-10
exam

definition of terms, 7-3
deleting, 4-17
OB, 9-2
workflow, 7-3

explosion hazard, 2-11
EZBackup/Move, using, 16-24

F

Fast Key, 6-26
fast key, create, 6-26
fast key, start, 6-27
Federal law (USA), requirements, 1-7
Femur Length (FL), measuring, 9-6
Fetal growth bar graph, 9-25, 9-30
Fetal growth curve graph, 9-25

description, 9-26
multiple fetus, 9-33
quad view, 9-27
selecting, 9-27

Fetal trending
fetal growth curve graph, 9-28
multiple fetuses, 9-35

Fetal Trunk Area (FTA), measuring, 9-11
Fetus

entering number of, 9-31
selecting on an OB worksheet, 9-20

Fetus Compare
multiple fetus, 9-33

Flash Suppression, adjusting, 5-41
Flow Volume, 7-76
focal zone, see Focus, adjusting
Focus, adjusting, 5-7
folders, measurement

adding, 7-25
Follicle measurements, GYN exam, 9-54
Foot Length (Ft), measuring, 9-12
Footswitch, 3-26
Frame Average, adjusting

B-Mode, 5-20
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Color Flow, 5-41
freezing an image, 6-7
Frequency, adjusting, 5-13
front view, console, 3-7
FV, 7-76

G

Gain, adjusting
B-Mode, 5-6
Color Flow, 5-34

Gels, coupling, 17-17
General imaging

changing presets, 16-41
generic studies and measurements, 7-59
Generic study

Doppler mode, 7-72
Gestational Sac (GS), 9-6
GYN exam

Doppler measurements, 9-57
endometrium thickness, 9-54
follicle measurements, 9-54
M-Mode measurements, 9-56
ovaries measurements, 9-55
uterus measurements, 9-55

Gynecology exam, 9-51
B-Mode measurements, 9-53
starting, 9-52

H

hazards, 17-16
biological, 17-8
electrical, 17-6
mechanical, 17-7

hazards, safety symbols, 2-4
hazards, types

biological, 2-10, 2-12
electrical, 2-8, 2-10
explosion, 2-11
mechanical, 2-8

Head circumference (HC), 9-7
Heart Rate

Doppler generic measurement, 7-74
M-Mode generic measurement, 7-71

Hip Dysplasia, pediatric measurement, 13-5
Humerus Length (HL), measuring, 9-12

I

iLinq, using, 6-28
images

deleting, 4-17
recalling from clipboard, 15-6
reviewing, 4-19
storing, 15-7

Imaging presets, changing
General, 16-41

Imaging presets, overview, 16-37

Indications for Use, 1-6
information, requesting, 1-8
Intravessel ratio, calculating, 11-28

K

keyboard
special keys, 3-54

L

labeling probes, 17-3
Libraries Preset Menu, 16-47
Line Density Zoom, adjusting B-Mode, 5-18, 5-39
Line Density, adjusting

B-Mode, 5-18
Color Flow, 5-39

log on procedures
defining, 16-102

Logon
Admin screen, 16-102

M

M Color Flow imaging, 5-48
M color flow, activating, 5-49
managing images

media handling tips, 15-37, 15-40
Manual Vascular Calculation, 11-21
Map values, changing, 5-21
Measurement & Analysis screen

accessing, 7-12, 9-36
selecting a study or measurement, 7-14

measurement controls, location, 7-4
Measurement information

OB worksheet, 9-21
measurement parameters, changing or adding, 7-29
Measurements, 9-16

% Stenosis, 9-12
% Stenosis (M-Mode), 9-15
erasing, 7-10
general instructions, 7-7, 7-10
OB, 9-4

AFI, 9-8, 9-9
measurements, general, 7-6
measurements, generic

overview, 7-59
Measurements, types

AxT, 9-9
cardio-thoracic area ratio, 9-9

measurements, types
abdominal circumference, 9-5
amniotic fluid index (AFI), 9-8
antero-postero trunk diameter and transverse 

trunk diameter (APTD-TTD), 9-9
biparietal diameter, 9-6
crown rump length, 9-6
estimated fetal weight, 9-10
femur length, 9-6
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fetal trunk area, 9-11
foot length, 9-12
gestational sac, 9-6
head circumference, 9-7
humerus length, 9-12
nuchal translucency, 9-12
occipitofrontal diameter, 9-12
spinal length, 9-13
thorax transverse diameter, 9-13
tibia length, 9-14
transverse abdominal diameter, 9-13
transverse cerebellar diameter, 9-13
ulna length, 9-14

measurements, using
adding, 7-25
automatically starting in workflow, 7-23
calipers, 7-5
changing, 7-24
deleting, 7-33
post-assignment for side/location, 7-9
selecting in different category, 7-9

Method
OB worksheet, 10-30

method, OB worksheet, 9-21
M-Mode imaging

intended uses, 5-26
optimizing, 5-26
scanning hints, 5-28
typical exam protocol, 5-26

M-Mode measurements, 9-15
GYN exam, 9-56
OB, 9-15

M-Mode measurements, generic
% Stenosis, 7-69
A/B Ratio, 7-70
Heart Rate, 7-71

M-Mode measurements, mode
time interval, 7-54
tissue depth, 7-53

M-Mode, general measurements, 7-53
Mode Cursor, displaying

B-Mode, 5-14
moving the system

during transport, 3-39
precautions, 3-39

MPEGvue, 15-22
E-mail support, 15-30
On your PC, 15-25
on your PC, 15-25

Multiple fetuses, 9-31
fetal trending, 9-35
identifying, 9-31
on OB worksheet, 9-34

N

Network Storage Service, 15-43
new patient

beginning, 4-3, 4-5
scanning, 4-9

nl
Calculation Formulas

Left Ventricular, 10-3
Cardiac Output, 10-32
Cardiology

Cubed Method, 10-3
Cubed Method, 10-3
General Calculations

Cardiac Output (CO), 10-32
Left Ventricular

Calculation Formulas, 10-3
Measurements

Cubed Method, 10-3
Nuchal Translucency (HL), measuring, 9-12

O

OB
graph, 9-25
identifying multiple fetuses, 9-31
measurements, 9-4
patient data, 9-3, 9-52

OB exam
preparing, 9-2
starting, 9-3

OB graphs, 9-25
fetal growth bar graph, 9-30
patient data, 9-29
viewing, 9-25

OB measurements
B-Mode, 9-5
Doppler mode, 9-16
M-Mode, 9-15

OB measurements, types
abdominal circumference (AC), 9-5
amniotic fluid index (AFI), 9-8
antero-postero trunk diameter and transverse 

trunk diameter (APTD-TTD), 9-9
antero-postero trunk diameter by transverse 

trunk diameter, 9-9
biparietal diameter, 9-6
cardio-thoracic area ratio, 9-9
crown rump length, 9-6
estimated fetal weight, 9-10
femur length, 9-6
fetal trunk area, 9-11
foot length, 9-12
gestational sac, 9-6
head circumference, 9-7
humerus length, 9-12
nuchal translucency, 9-12
OB/GYN vessels, 9-16
occipitofrontal diameter, 9-12
spinal length, 9-13
thorax transverse diameter, 9-13
tibia length, 9-14
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transverse abdominal diameter, 9-13
transverse cerebellar diameter, 9-13

OB mulitgestational, 9-31
OB worksheet, 9-19

AUA, 9-20
calculations, 9-22
CUA, 9-20
EFW growth percentile, 9-22
measurement information, 9-21
method, 9-21, 10-30
multiple fetuses, 9-34
patient data, 9-20
selecting ultrasound age, 9-20

OB/GYN vessel measurements
selecting, 9-18

OB/GYN vessel study, 9-16
Occipitofrontal Diameter (OFD), measuring, 9-12
Operator controls, 18-14
optimizing images

B-Mode, 5-2
Color Flow, 5-30
Doppler, PW, 5-50
M-Mode, 5-26

options
system, 16-99

ovaries, measurement, 9-55

P

Packet Size, adjusting, 5-42
Patient data

OB, 9-3, 9-52
OB graphs, 9-29
OB worksheet, 9-20

patient data
deleting, 4-17
entering new, 4-3, 4-5
searching, 4-15

patient exam
reviewing, 4-18

patient safety, 2-6
patient, beginning a new, 4-3, 4-5
Peak systole/end diastole ratio, Doppler generic 
measurements, 7-74
pediatric exam

calculations, 13-3
preparing, 13-2

pediatric measurements, types
alpha HIP, 13-6
dD ratio, 13-7
hip dysplasia, 13-5

peripherals
connector panel, 3-17
connector panel illustration, 3-18
location, 3-7

peripherals, digital
setting up, 15-49

Phantoms, 18-32

Plot Both, fetal trending, 9-28
Position, adjusting color, 5-36
post-processing controls, overview, 6-8
Power

On/Off, 3-31
On/Off Standby, 3-33
switch, location, 3-31, 3-33

power
power up sequence, 3-32
shut down, 3-35

Power Doppler imaging, 5-44
prescription device, caution, 1-7
Preset Program menu

Acoustic Output
Fetal Exposure, 9-2
General Warning, 9-2
Prudent Use, 9-2

presets
organizing folders and measurements, 7-20

presets, changing
Anootations/Libraries, 16-42
Body Patterns, 16-47, 16-50, 16-51
Connectivity, 16-59
Imaging, 16-37
System, 16-3

presets, overview, 16-2
PRF, adjusitng, 5-20
PRF, adjusting

Color Flow, 5-34
print keys

assigning to a device or dataflow, 16-90
printers, network

setting up, 15-52
Probe handling and infection control, 17-10
Probes

connecting, 3-45
probes

cable handling, 3-47, 17-2
care and maintenance, 17-4
cleaning, 17-11
coupling gels

coupling gels, probes, 17-17
deactivating, 3-47
disconnecting, 3-48
disinfecting, 17-13
environmental requirements, 17-5
ergonomics, 17-2
labeling, 17-3
planned maintenance, 17-18
probe orientation, 17-3
safety, 17-6

using protective sheaths, 17-8
storing, 3-52
transporting, 3-52

Prostate volume, measuring, 12-6
prudent use, 2-3
PS/ED or ED/PS Ratio, measuring, 7-74
Pulsatility Index (PI), Doppler generic measurement, 
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7-73

Q

QAnalysis, 5-63, 5-65
Drift Compensation, 5-75
Exit, 5-78
generating a trace, 5-68
manipulating the sample area, 5-70
Select Image Range, 5-67
smoothing, 5-75

QAPlot Control
horizontal sweep, 5-75

Quality Assurance, 18-30
baselines, 18-34
frequency of tests, 18-31
Introduction, 18-30
periodic checks, 18-34
phantoms, 18-32
record keeping, 18-45
system setup, 18-36
test descriptions, 18-36
typical tests, 18-31

Quick Angle, adjusting, 5-56

R

Read Zoom, activating, 6-3
Record keeping, 18-45
rejecting low level echos, 5-21
removable media

verifying, 16-92
Renal volume, measuring, 12-9
Report Writer report templates, customizing, 14-24
Report Writer reports

activating, 14-3
creating, 14-2
Direct Report, using, 14-49
editing, 14-8
factory templates, 14-7
inserting images, 14-17

Resistive Index (RI), Doppler generic measurement, 
7-73
Results window, 7-7
reverse, adjusting, 5-17
rotating an image, 5-21

S

S/D Ratio, Doppler measurement, 7-74
safety

electromagnetic compatiblity (EMC), 2-15
equipment, 2-10
hazards, 2-4, 2-10, 2-11, 2-12, 2-28, 17-6, 17-7, 

17-8
biological, 17-16
smoke and fire, 2-10

labels, 2-31
patient, 2-6

acoustic output hazard
hazard, types

acoustic output, 2-9
electrical hazards, 2-8
mechanical hazards, 2-8
patient identification, 2-6

patient training, ALARA, 2-9
personnel, 2-10
precaution icons, defined, 2-3
precaution levels, defined, 2-3
probes, 17-6

handling precautions, 17-10
Sample Volume, adjusting, 5-42
sample volume, adjusting

gate position, 5-55
length, 5-55

Scan Assistant
Availability, 5-91
Definitions, 5-92
Description, 5-93
Exporting Programs, 5-101
Setting Up, 5-94
Using, 5-99

service, requesting, 1-8
Simultaneous, activating, 5-58
site requirements, before the system arrives, 3-3
Size, adjusting

Color Flow, 5-36
small parts exam

thyroid measurements, 8-5, 8-6
Spatial Filter, adjusting, 5-41
Spectral Doppler, see Doppler Mode, PW
Spectral Trace method, 5-61
Spinal Length (SL), measuring, 9-13
split-screen imaging, 3-56
starting an OB exam, 9-3
Steer, adjusting, 5-14
studies

OB/GYN vessels, 9-16
study

adding, 7-25
definition, 7-3
deleting, 7-33
generic, 7-59
organizing, 7-20

Sweep Speed, adjusting, 5-28
System

acclimation time, 3-30
system

electrical configurations, 3-3
environmental requirements, 3-5
options, 16-99
power down, 3-35

System Admin
Admin screen, 16-99

System cabinet, 18-13
System Imaging Preset Menu, 16-10
System Measure Preset menu, 16-13
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System presets, changing
General, 16-4
System About, 16-36
System Imaging, 16-10
System Measure, 16-13
System Peripherals, 16-34
System/Backup and Restore, 16-16

System presets, overview, 16-3
System/General Preset Menu, 16-4

T

TAD (transverse abdominal diameter), 9-13
TAMAX/TAMEAN, Doppler mode measurement

manual trace, 7-48
TCD (transverse cerebellar diameter), 9-13
TCPIP

Connectivity, 16-61
Test Patterns

overview, 16-58
TGC, adjusting, 5-15
Thorax transverse diameter (ThD), 9-13
Threshold, adjusting, 5-40
Thyroid measurements, 8-5, 8-6
Tibia Length, measuring, 9-14
Tilt, adjusting, 5-16
Time Gain Compensation, see TGC, adjusting, 5-15
Time interval

Doppler mode measurement, 7-47
M-Mode measurement, 7-54

Tissue depth, M-Mode measurement, 7-53
Tissue Velocity Imaging, 5-45
Trace Direction, adjusting, 5-61
Trace measurement, general, 7-41, 7-42
Trace Sensitivity, adjusting, 5-61
Transparency Map, adjusting, 5-41
Transverse Abdominal Diameter (TAD), 9-13
Transverse Cerebellar Diameter (TCD), 9-13
TVI, 5-47

Quantitative Analysis, 5-65

U

Ulna Length, OB measurements, types, 9-14
Ultrasound age

selecting on OB worksheet, 9-20
Update, activating, 5-58
urology exam, preparing, 12-2
urology measurements

bladder volume, 12-5
prostate volume, 12-6
renal volume, 12-9

user IDs
defining, 16-100

user-defined calculations, editing, 7-31
user-defined measurement, adding, 7-27
Users

Admin screen, 16-100

Uterine cavity, amniotic fluid index (AFI), 9-8
Uterus measurements, 9-55
Utility function

changing measurements and studies, 7-33, 
7-36

Utility screens
Admin, 16-98
connectivity, 16-59

V

Vascular exam preparation, 11-2
Vascular worksheets

editing, 11-24
saving and printing, 11-31
typing examiner’s comments, 11-27
vessel summary, 11-29
viewing, 11-22

Velocity, Doppler measurement, 7-46
verifying

removable media, 16-92
Vessel summary, vascular exam, 11-29
Virtual Convex, adjusting, 5-14
Volume measurement, B-Mode generic 
measurement, 7-63

W

Wall Filter, adjusting
Color Flow, 5-35
Doppler Mode, 5-61

Warning icon, defined, 2-3
width, adjusting, 5-15
word wrap, annotation, 6-18
Worksheet

changing data, 7-57
OB, 9-19
viewing, 7-55

Write Zoom, activating, 6-3

XYZ

zooming an image
bioeffects, 6-2
introduction, 6-2
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